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Welcome to This Guide

This guide explains how to configure and work with an IT model that 
enables you to build a topology of your system. You populate the model 
with configuration items and their relationships, and then use the model to 
measure and manage critical business processes. 

This chapter includes:

➤ How This Guide Is Organized on page 13

➤ Who Should Read This Guide on page 14

➤ How Do I Find the Information That I Need? on page 14

➤ Additional Online Resources on page 17

➤ Documentation Updates on page 18

How This Guide Is Organized

The guide contains the following chapters:

 Part I Introduction to RTSM

Introduces the RTSM and provides general information about Topology 
Query Language, the CI Selector, and Topology Map.
13
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 Part II Modeling

Describes how to model your business environment by defining views 
and by building TQL queries that retrieve the required information from 
the RTSM; describes how to view and modify the definitions of 
configuration item types (CITs) defined in the RTSM and the relationships 
that define the connections between them.

 Part III RTSM Data Model

Includes documents that explain and quantify the BTO Data Model 
(BDM) version 1.1.1 and the CMS data model. 

 Part IV Reference Information

Contains general reference information.

Who Should Read This Guide

This guide is intended for the following users:

➤ Business Service Management administrators

➤ Business Service Management platform administrators

➤ Business Service Management application administrators

➤ Business Service Management data collector administrators

Readers of this guide should be knowledgeable about enterprise system 
administration, have familiarity with ITIL concepts, and be knowledgeable 
about Business Service Management in general and the Operational 
Database technology specifically.

How Do I Find the Information That I Need?

This guide is part of the HP Business Service Management Documentation 
Library. This Documentation Library provides a single-point of access for all 
Business Service Management documentation.
14
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You can access the Documentation Library by doing the following:

➤ In Business Service Management, select Help > Documentation Library.

➤ From a Business Service Management Gateway Server machine, select 
Start > Programs > HP Business Service Management > Documentation.

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 
15
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Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. Step-by-
step guidance to help you 
work with the application and 
accomplish your goals. Some 
task steps include examples, 
using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
17
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
18
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1
Topology Query Language

This chapter includes:

Concepts

➤ Topology Query Language (TQL) Overview on page 23

➤ Creating TQL Queries in the RTSM Managers on page 24

➤ Viewing TQL Query Results on page 25

➤ Compound Relationship on page 27

➤ Join Relationship on page 27

➤ Query Node Conditions on page 28

➤ Subgraph Definition on page 31

➤ The ALLOW_VOLATILITY Qualifier on page 31

Tasks

➤ How to Define a TQL Query on page 33

➤ How to Add Query Nodes and Relationships to a TQL Query on page 35

➤ How to Define a Compound Relationship – Scenario on page 36

➤ How to Define a Join Relationship – Scenario on page 39

➤ Define a Complex Type Condition - Scenario on page 41

➤ How to Create a Subgraph Definition – Scenario on page 42

Reference

➤ Shortcut Menu Options on page 44

➤ Attribute Operator Definitions on page 49

➤ TQL Logs on page 51
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➤ Topology Query Language User Interface on page 57

Troubleshooting and Limitations on page 114
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Chapter 1 • Topology Query Language
Concepts

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, 
organizing, and managing IT infrastructure data. It enables you to create 
TQL queries that retrieve business service data from the RTSM. TQL queries 
also help you display the data in a visual representation that facilitates data 
monitoring and managing. 

This section includes the following topics:

➤ "Topology Query Language" on page 23

➤ "The Roles of TQL" on page 24

Topology Query Language
TQL extends the standard SQL language by adding two important 
capabilities:

➤ TQL enables you to draw conceptual relationships between configuration 
items (CIs), which represent their actual interdependencies. Using 
predefined operators, the different types of interconnections 
(relationships) that exist between CIs can be established, and 
consequently the infrastructure design and performance are more 
accurately represented. This representation serves as a basis and a model 
for the discovery, arrangement, query, and management of complex 
infrastructures.

➤ TQL includes a graphical aspect, consisting of visual symbols and syntax, 
that represents the resources and their interconnections. This 
visualization of an IT infrastructure simplifies the understanding, 
monitoring, and managing of the IT business operations.
23
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The Roles of TQL
TQL plays several roles:

➤ Builds a business service model that defines and delineates the 
interconnection between IT assets that function together as business 
services. The business service model guides the discovery and 
identification of these business services, from the ever-increasing number 
and complexity of infrastructure resources. After the resources that 
comprise the business services are discovered, the business service model 
structures the way they are organized and managed in the RTSM.

➤ Constantly searches the RTSM for changes that occur in the state of 
managed resources. When such changes are detected, the relevant 
subsystems are informed and updated. 

➤ Creates queries that retrieve business service data from the RTSM, and 
displays the data in a visual representation that facilitates data 
monitoring and managing.

Creating TQL Queries in the RTSM Managers

The following managers enable you to create TQL queries that retrieve 
specific data from the RTSM and to display that data:

➤ Impact Analysis Manager. An Impact rule simulates how infrastructure 
changes can impact your system and enables you to determine the true 
origin of a problem and its business impact. During rule creation, you 
define the base TQL query type, which can be a new query or an existing 
query. For details, see "Impact Analysis Manager" on page 457.

➤ Enrichment Manager. An Enrichment rule enables enlarging the RTSM, 
deleting CI instances from the RTSM, or updating the attributes of a CI 
that already exists in the RTSM. During rule creation, you define the base 
TQL query type, which can be a new query or an existing query. For 
details, see "Enrichment Manager" on page 527.
24
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➤ Modeling Studio. You can build a new TQL query using the TQL Query 
Editor or you can build a new query while defining a new view, template, 
or perspective using the Pattern View Editor. You can also define the 
topology report settings for any view in the Pattern View Editor. For 
details, see "Modeling Studio" on page 343.

Viewing TQL Query Results

You view the resulting data in a visual representation in IT Universe 
Manager. The queries define the structure of the resulting topology map. 
The view displays only those CIs and relationships that meet the query 
definition. You can also view the results of a query by clicking the Preview 
button in the toolbar to open a preview display identical to IT Universe 
Manager. For more details about IT Universe Manager, see "IT Universe 
Manager" on page 235.

TQL Query Types and Priorities
When you define a TQL query, you define the type of the TQL query in the 
Type field of the Query Definition Properties dialog box. The following 
query types are available:

➤ View. TQL queries used as the basis for pattern views.

➤ Integration. TQL queries used for integrations.

➤ Discovery. TQL queries used as the basis for DFM patterns.

➤ Template. TQL queries used as the basis for templates.

➤ Perspective. TQL queries used as the basis for perspectives.

➤ Impact Analysis. TQL queries used as the basis for Impact rules. This is the 
default type for queries created in Impact Analysis Manager.

➤ Enrichment. TQL queries used as the basis for Enrichment rules. This is 
the default type for queries created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies 
(such as views, templates, and so on).
25
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If a query imported though an integration is not assigned a type, it is 
considered a hidden query and does not appear in the query list in the 
Modeling Studio. To display hidden queries in the query list, change the 
setting for hidden queries under General in the User Preferences dialog box. 
For details, see "User Preferences Dialog Box" on page 113.

You can also set the priority level of a TQL query, which determines how 
often the query is rerun automatically to include updated information. The 
following priorities are available:

➤ Low. The TQL query is refreshed every 2 minutes.

➤ Medium. The TQL query is refreshed every 30 seconds.

➤ High. The TQL query is refreshed every 10 seconds.

➤ Express. The TQL query is refreshed continuously.

➤ Not Active. The TQL query is inactive.

Note: The above refresh times are average values.

If you set the priority of a TQL query to Not Active, the query becomes 
inactive and is not run automatically, however it can be used for manually 
building a view.

Base Queries
You can select a base query for a TQL query in the Query Definition 
Properties dialog box. In this case, the base query is first applied to the entire 
IT Universe, generating results. The new query is then applied to that subset 
of the universe, further refining the results. Selecting a base query enables 
you to filter the query results more finely and generate results more quickly 
in certain cases.

The base query you select must be both active and persistent for your new 
query to be active. If the base query is not active and persistent, the new 
query is automatically assigned a priority of Not Active.
26
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Compound Relationship

A compound relationship represents a path in the topological graph. You use 
a compound relationship to define the allowed steps in the path between 
the source and the target CIs.

Each row represents one of the allowed steps in the path leading from the 
source CI to the target CI in the topology map.

For an example of a compound definition, see "How to Define a Compound 
Relationship – Scenario" on page 36. For details on defining compound 
relationships, see "Add/Edit Compound Relationship Dialog Box" on 
page 60.

Join Relationship

A join relationship is a logical connection that represents the relationship 
between two CIs (and which appears only in the topology map containing 
the TQL query results). It does not exist in the RTSM. A join relationship is 
created by defining an attribute for each query node, whose values are used 
for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions 
defined in the join definition.

For example, you can create a join definition that links all node CIs 
connected to IP Address CIs whose Created By attribute values are equal (see 
the example below).

Each join definition represents one condition defined for the join 
relationship.
27
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Note: You can define multiple conditions.

For an example of a join definition, see "How to Define a Join Relationship – 
Scenario" on page 39. For details on defining join relationships, see 
"Add/Edit Join Relationship Dialog Box" on page 65.

Query Node Conditions

You can add conditions to the query nodes and relationships of a TQL query 
in the Query Node Properties dialog box. The conditions filter the query 
results by retrieving only CIs and relationships that match the conditions 
defined in the query. There are several types of conditions you can define: 

➤ Attributes. Conditions based on CI property values.

➤ Cardinality. Conditions based on the number of related query nodes.

➤ Qualifiers. Conditions based on CI type qualifiers.

➤ Element type. Conditions based on CI subtypes. See below for details.

➤ Identity. Conditions based on CI element IDs.

Each one has a separate tab in the dialog box. For details, see "Query 
Node/Relationship Properties Dialog Box" on page 90.

Element Type Conditions
The Element type conditions enable you to specify the subtypes of a query 
node that should appear in the query results. There are two options for 
defining this condition: the simple type condition and the complex type 
condition.

Simple Type Condition

The simple type condition enables you to either include all subtypes of the 
selected query node in the query results, or to exclude all of them.
28
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Complex Type Condition

The complex type condition enables you to select the specific subtypes of 
the query node to be included in the query results. A CI type tree appears 
with all the subtypes of the selected query node. By default, instances of all 
the displayed subtypes are included in the query results. For each subtype, 
you can select Exclude <subtype> from the query which excludes instances 
of that subtype from the query results. If you select the Apply this condition 
recursively on all subtypes check box, instances of the subtype and all of its 
descendants are excluded from the results.

If you select a subtype from the tree and you select Include <subtype> in the 
query without selecting the Apply this condition recursively on all subtypes 
check box, only instances of the specified subtype are included, but not 
instances of its descendants.

For both the Include and Exclude options, there is a further selection in the 
Conditions pane. If you select By CI type, all instances of the specified 
subtype are then included or excluded from the results. If you select By 
qualifiers and then select qualifiers from the popup list, only the instances 
of the selected subtype with the selected qualifiers are included or excluded 
from the query results.

For example, suppose CIT_B and CIT_C are subtypes of CIT_A, and CIT_A 
and CIT_B have qualifier Q1. The following are some of the possible 
configurations of options:

➤ Select Exclude for CIT_A and all of its descendants. No CITs are included.

➤ Select Exclude for CIT_A without its descendants. Only CIT_B and CIT_C 
are included.

➤ Select Exclude for CIT_A and all of its descendants with qualifier Q1. Only 
CIT_C is included.
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Note: 

➤ It is possible to apply the Exclude option to the root of the tree (that is, 
the CI type of the original query node). If the Apply this condition 
recursively on all subtypes check box is selected, no CIs are included in 
the results. If the check box is not selected, instances of the root CI type 
are excluded, but instances of its descendants are included.

➤ The Element Type Conditions feature is only available in the Modeling 
Studio. If you define a complex type condition in the Modeling Studio, 
and then modify the TQL query in Enrichment Manager or Impact 
Analysis Manager, the condition may be overwritten and will no longer 
be in effect.

➤ If you want to define a qualifier condition on a query node as using the 
functionality of previous UCMDB versions, select Customize subtypes 
and select the root query node in the CI types tree. Then select the 
Include option, select By qualifiers, and select the required qualifiers.

➤ It is sometimes possible to define an attribute condition (using the 
CI_type attribute) that generates the same results as a complex type 
condition. However, the complex type condition ensures better 
performance.

For details on defining a complex type condition, see "Define a Complex 
Type Condition - Scenario" on page 41.
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Subgraph Definition

A subgraph definition enables you to create a graph that represents 
additional TQL query data related to a specific CI. The DFM job searches for 
the results from both the TQL query and the subgraph definitions. The 
query recursively retrieves all related CIs for a defined depth matching the 
definition of the subgraph. For details on defining subgraph definitions, see 
"Subgraph Definition Dialog Box" on page 110.

In the graph, you can define the relationship that is connected to a specific 
query node. For example, if one of the query nodes is of type node, you can 
specify different relationships for Windows, router, and IP Address. You can 
also define attribute conditions for query nodes. For details, see "Subgraph 
Condition Definition Dialog Box" on page 108.

DFM jobs retrieve data that meets the criteria defined in the subgraph. 

For an example of a subgraph definition, see "How to Create a Subgraph 
Definition – Scenario" on page 42.

The ALLOW_VOLATILITY Qualifier

This qualifier is used to mark attributes that enable minor deviations to their 
value. For example, there is probably no need to report a small disk size 
change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, HP Business 
Service Management checks the new value against the old value. This check 
is performed on the server as part of the record update. If the difference 
between the two values is lower that the allowed deviation, an update is not 
performed (the action is considered a false update).
31



Chapter 1 • Topology Query Language
This qualifier must contain one of the following data items that hold the 
allowed deviation:

➤ ALLOWED_DEVIATION_FIX. The type of deviation is the same as the 
attribute type for numeric attributes, and the integer type for date 
attributes. Deviation is measured by a fixed value, of the same unit as the 
attribute value. (For date attributes, the deviation is measured in seconds.)

➤ ALLOWED_DEVIATION_PERCENT. Deviation is measured by percentage. 
For date values, the percentage is checked against the millisecond date 
representation. This data item type is always integer, and the value range 
is 0 to 100. 

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Admin > Platform > Setup and 
Maintenance > Infrastructure Settings). Locate the Allow Volatility option. 
Change the value to False.
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Tasks

How to Define a TQL Query

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating 
Impact rules, Enrichment rules, Views, Templates, and Perspectives. 

This task includes the following steps:

➤ "Create a TQL Query" on page 33

➤ "Add Query Nodes and Relationships to the Query" on page 33

➤ "Set the Query Properties" on page 34

 1 Create a TQL Query

In the Modeling Studio, select New > Query to open the TQL Query 
Editor. For details, see "TQL Query Editor" on page 448. 

 2 Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The 
TQL query nodes represent the CITs, as defined in the CI Type Manager, 
and the relationships represent the connections between them. 
Relationships are defined one at a time for each pair of TQL query nodes 
in the query. For details, see "How to Add Query Nodes and Relationships 
to a TQL Query" on page 35. 

Note: You can also define a self-relationship from a query node to itself.
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 3 Set the Query Properties

Query Definition Properties. Opens the Query Definition Properties 
dialog box. Set the query type, scope, priority, and other properties. For 
details, see "Query/View Definition Properties Dialog Box" on page 434.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is 
dependent on the other. The following example displays two nodes, an IP 
Service Endpoint, and a Client Port, which are linked to one another via a 
client/server connection. The TQL query results must comply with the 
direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see "Troubleshooting and Limitations" on page 114.
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How to Add Query Nodes and Relationships to a TQL 
Query

This task describes how to add query nodes and relationships to a TQL 
query. It is relevant for Impact Analysis Manager, Enrichment Manager, and 
the Modeling Studio.

Note: For TQL queries to be valid, they must comply with certain 
restrictions. For details, see "Troubleshooting and Limitations" on page 114.

To add query nodes and relationships to a TQL query:

 1 In Impact Analysis Manager or Enrichment manager, select the required 
query from the tree in the left pane or click the New button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select 
Queries as the Resource type, and select the required query from the tree 
or click New > Query to create a new one.

 2 In Impact Analysis Manager or Enrichment manager, click and drag one 
or more required TQL query nodes from the tree displayed in the CI Type 
Selector, onto the editing pane. In the Modeling Studio, select the CI 
Types tab in the left pane and drag the required TQL query nodes from 
the tree onto the editing pane. These are the TQL query nodes that are 
included in the query.

 3 To add a relationship between two query nodes, do one of the following:

➤ Select the required TQL query nodes by holding down CTRL and 
clicking the TQL query nodes, right-click and select Add Relationship. 
The Add Relationship dialog box opens. Select the required 
relationship. For details, see "Add/Edit Relationship Dialog Box" on 
page 68.

➤ Click the Create Relationship icon and draw a line between the 
required query nodes. The Select Relationship Type dialog box opens. 
Select the required relationship type. For details, see "Select 
Relationship Type Dialog Box" on page 107.
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 4 Click OK. The selected query nodes are linked by the relationship you 
have selected.

How to Define a Compound Relationship – Scenario

This section describes how to define the allowed steps that form a 
compound relationship between an IP Subnet CI and an IP Address CI.

Note: To reach the required result, you must implement each one of the 
following steps.

To define a compound relationship between a IP Subnet CI and an IP 
Address CI:

 1 Create a TQL query of type view and drag the following query nodes onto 
the editing pane:

➤ IP Subnet

➤ IP Address

 2 Right-click the IP Subnet and IP Address query nodes and select Add 
Compound Relationship to open the Add Compound Relationship dialog 
box.

 3 Click the Add button. In Enrichment Manager and Impact Analysis 
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row 
is added to the table. Make the following selections:

➤ From the Source list, select IP Subnet.

➤ From the Target list, select Node.

➤ From the Relationship list, select Membership.

➤ Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.
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 4 Click the Add button again and make the following selections:

➤ From the Source list, select Node.

➤ From the Target list, select IP Address.

➤ From the Relationship list, select Containment.

➤ Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.

 The following shows an example of compound definitions following the 
changes: 

 5 Click OK to save your changes.

The TQL query in the editing pane now looks like this:

 6 Create a view based on your TQL query and save it.
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 7 Go to the required view in IT Universe Manager to view the results. If you 
did not select the Show full path between source and target CIs option, 
then the results display the names of the relationships that link the CIs as 
Virtual-Compound rather than the actual names of the relationships. See 
the illustration below:

You can double-click the Virtual - Compound relationship in IT Universe 
Manager to open the Link Map, which displays the CIs and relationships 
that comprise the allowed steps used to link the IP Subnet and IP Address 
CIs.
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In the example above, the 192.168.168.0 (IP Subnet) CI is linked to the 
192.168.0.1 (IP Address) CI through the labm1ccm15 (Node) CI.

If you selected the Show full path between source and target CIs option, 
then the results in IT Universe Manager display the actual names of the 
relationships that link the CIs and the full path between the source and 
target CIs. See the illustration below:

How to Define a Join Relationship – Scenario

This task describes how to define a join relationship that links Node CIs to 
IP Address CIs whose Created by attribute values are equal.

Note: To reach the required result, you must implement each one of the 
following steps.
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To define a join relationship that links all IP Address and Node CIs whose 
Created by attribute values are equal:

 1 Create a TQL query and drag the following query nodes from the CI Type 
Selector onto the editing pane:

➤ Node

➤ IP Address

 2 Select the Node and IP Address query nodes and right-click to open the 
Add Join Relationship dialog box.

 3 Click the Add button to add a row to the table and do the following:

➤ In the Node Attribute box, select Created by.

➤ In the Operator box, select Equal.

➤ In the IP Address Attribute box, select Created by.

In Enrichment Manager and Impact Analysis Manager, you make these 
selections in the Join Relationship Condition dialog box.

The Join Definition area now looks like this.

 4 Click OK to save your changes.

The TQL query in the editing pane now looks like this:
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Define a Complex Type Condition - Scenario

This section describes how to define a complex type condition in the Query 
Node Properties dialog box. In this example, you add subtype conditions to 
a Node query node in a TQL query.

To define a complex type condition:

 1 Create a TQL query and drag a query node of type Node onto the editing 
pane.

 2 Right click the query node and select Query Node Properties. The Query 
Node Properties dialog box opens.

 3 Select the Element Type tab and select Customize subtypes.

 4 In the CI Types pane, select Computer, and in the Conditions pane, select 
Exclude <Computer> from the query. Select the Apply this condition 
recursively on all subtypes of <Computer> check box. This excludes all 
CIs of type Computer and its descendants in the query results.

 5 In the CI Types pane, select Unix, and in the Conditions pane, select 
Include <Unix> in the query. This includes all Unix CIs in the query 
results.

 6 In the CI Types pane, select IBM Frame, and in the Conditions pane, 
select Include <IBM Frame> in the query. Then select By qualifiers and 
select the CONTAINER qualifier. This includes all IBM Frame CIs with the 
CONTAINER qualifier in the query results.

 7 In the CI Types pane, select Firewall, and in the Conditions pane, select 
Exclude <Firewall> from the query. Select By qualifiers and select the 
HIDDEN_CLASS and MAJOR_APP qualifiers. This excludes all Firewall CIs 
with the HIDDEN_CLASS and MAJOR_APP qualifiers from the query 
results.

 8 Click OK to save your conditions and exit the dialog box.
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How to Create a Subgraph Definition – Scenario

This section describes how to create a subgraph definition. In this example, 
the TQL query results retrieve all CIs that are connected to a Business Service 
CI by a Containment relationship up to a depth of 3.

Note: To reach the required result, you must implement each one of the 
following steps.

To create this sample subgraph definition:

 1 Create a TQL query and drag a query node of type Business Service onto 
the editing pane.

 2 Right-click the Business Service query node and select Subgraph 
Definition to open the Subgraph Definition dialog box.

 3 Click the Add  button. In Enrichment Manager and Impact Analysis 
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row 
is added to the table. Make the following selections: 

➤ From the Source drop-down list, select Managed Object.

➤ From the Target drop-down list, select Managed Object.

➤ From the Relationship drop-down list, select Containment.

➤ Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save 
your changes.

The Subgraph Definition dialog box now looks like this.

 4 Set the Depth setting to 3.

 5 Click OK in the Subgraph Definition dialog box.
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Go to the required view in IT Universe Manager to view the results.

The results show the Business Service CI aaa and all of the CIs linked to it 
in succession by Containment relationships down to three levels.
43



Chapter 1 • Topology Query Language
Reference

Shortcut Menu Options

This section includes a list of TQL query shortcut menu options (listed 
alphabetically):

UI Element (A-Z) Description

Add Calculated 
Relationship

Enables you to create a calculated relationship.

➤ For details on how to create a calculated relationship, 
see "Triplets Page" on page 512.

➤ For details about Impact Modeling, see "Impact 
Modeling" on page 119

Add Compound 
Relationship

Enables you to define the connection between two query 
nodes using a compound relationship.

For details, see "Add/Edit Compound Relationship Dialog 
Box" on page 60.

Add Join Relationship Enables you to define join relationships. You create them 
by defining an attribute for each query node. These query 
node values are used for comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box" 
on page 65.

Add Related Query 
Node Wizard

Displays the Add Related Query Node Wizard which 
enables you to build a TQL query. For details, see "Add 
Related Query Node Wizard" on page 70.
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Add Relationship Enables you to create a relationship for your query nodes 
by selecting it from a predefined list. Displays the Add 
Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on 
page 68.

Note: In Enrichment Manager, this option adds an 
Enrichment relationship to the rule when working in 
Enrichment mode. Applicable for regular and Enrichment 
query nodes. For details, see "Enrichment Manager" on 
page 527. Added relationships are denoted by an added 

 indicator.

Add to Hierarchy Adds the selected query node to the hierarchy as a 
separate query node.

Note: Only relevant for the Modeling Studio.

Add to Model Output Designates the selected query node as output for the 
pattern-based model.

Note: Only relevant for pattern-based models in the 
Modeling Studio.

Change Query 
Node/Relationship 
Type

Displays the Change Query Node Type dialog box. 
Enables you to change the CI type of the query node after 
you have created it. For details, see "Change Query 
Node/Relationship Type Dialog Box" on page 389.

Note: Only relevant for the Modeling Studio.

Clear Available by right-clicking a query node or relationship 
when working in Enrichment mode in the Enrichment 
Manager. Clears the query node/relationship’s 
Enrichment rule definition. For details, see "Enrichment 
Manager" on page 527.

Appears only if you have updated or deleted a query 
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

UI Element (A-Z) Description
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Copy/Paste Copy/paste an existing TQL query node/relationship in 
the same query or into another TQL query.

The copied TQL query node/relationship includes all TQL 
definitions.

You can copy and paste relationships provided that the 
TQL query nodes to which the relationships are 
connected are also selected. A relationship on its own 
cannot be copied without its connecting TQL query 
nodes.

You can select multiple TQL query nodes/relationships as 
well.

Note: The Copy and Paste options are only available in 
the Modeling Studio. The Paste option is available only 
after using the Copy option to copy an existing TQL 
query node/relationship.

Define Impacted Define which query node in the TQL query is the trigger 
Impact Analysis query node and which query nodes are 
impacted by the changes that occur in the system. For 
details, see "Impacted Query Nodes Dialog Box" on 
page 475.

Note: Only relevant for Impact Analysis Manager.

Delete Deletes the selected query node/relationship/CI.

Note: This option is not available for calculated 
relationships.

Delete 
Relationship/Query 
Node

Available by right-clicking a query node or relationship 
when working in Enrichment mode.

Creates a specific Enrichment rule that is designed to 
delete CIs/relationships from the RTSM. Applicable to 
regular query nodes and relationships only. You can use 
this option, for example, for removing unnecessary data 
from the RTSM. For details, see "Enrichment Manager" on 
page 527.

Deleted query nodes and relationships are denoted by a 
removed  indicator.

Note: Only relevant for Enrichment Manager.

UI Element (A-Z) Description
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Edit Relationship Displays the Refine Relationship Type dialog box. For 
details, see "Refine Query Node Type Dialog Box" on 
page 106.

Note: 

➤ Not relevant in the Modeling Studio.

➤ This option appears only when the selected 
relationship has descendants.

Hide Element in 
Query Results

When this option is selected, a Hidden in Query Results 
indicator  appears to the right of the selected TQL 
query node in the editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. At least one query node must be visible for the 
view to be valid.

Note: Only relevant for the Modeling Studio.

Query 
Node/Relationship 
Properties

Displays the Query Node/Relationship Properties dialog 
box, enabling you to define the attribute conditions for 
the selected TQL query node/relationship. For details, see 
"Query Node/Relationship Properties Dialog Box" on 
page 90.

Note: This option is not available for calculated 
relationships.

Refine Query Node 
Type

Displays the Refine Query Node Type dialog box. Enables 
you to change the CI type of the query node after you 
have created it. For details, see "Refine Query Node Type 
Dialog Box" on page 106.

Note: This option only appears if a child of the CI type 
exists. Only relevant for Impact Analysis Manager and 
Enrichment Manager.

Remove Subgraph Only appears if you have defined a subgraph definition. 
For details, see "Subgraph Definition Dialog Box" on 
page 110.

UI Element (A-Z) Description
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Reset Impacted Removes the Define Impacted definition applied to that 
query node. For details on the Define Impacted 
definition, see "Impacted Query Nodes Dialog Box" on 
page 475.

Note: Only relevant for Impact Analysis Manager.

Reset Inner 
Relationship

Redraws a self-referential relationship in the Topology 
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships that 
are not square.

Set As Contact Query 
Node

Designates the selected query node as a contact query 
node for the perspective.

Note: Only relevant for perspectives in the Modeling 
Studio.

Set Data Sources Opens the Set Data Sources dialog box which enables you 
to select the required data sources for a TQL query node.

Note: Only relevant for the Modeling Studio.

Show Element in 
Query Results

When this option is selected, the results pertaining to the 
TQL query node are displayed in the topology map.

Note: Only relevant for the Modeling Studio.

Show Element 
instances

Displays the Element Instances dialog box which displays 
all the instances found for each query node in a table. For 
details, see "Element Instances Dialog Box" on page 82.

Show Node 
Parameters

Opens the Template Parameter Values dialog box, which 
enables you to set the values of the query node’s 
parameters.

Note: Only relevant for template-based views in the 
Modeling Studio.

Subgraph Definition Displays the Subgraph Definition dialog box, where you 
can create a graph that represents additional TQL query 
data related to a specific query node. For details, see 
"Subgraph Definition Dialog Box" on page 110.

UI Element (A-Z) Description
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Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions 
in various dialog boxes, such as the Subgraph Condition dialog box, Impact 
Rules Definition dialog box, or the Query Node/Relationship Properties 
dialog box.

Update 
Relationship/Query 
Node

Use an Enrichment rule to update the value of CI 
attributes in the RTSM, or to add data to attributes that 
currently do not have values. Opens the Query Node 
Definition - Attributes dialog box. For details, see "Query 
Node/Relationship Definition Dialog Box" on page 554. 
This is applicable for both regular and Enrichment query 
nodes. 

Updated query nodes are denoted by an updated  
indicator.

Note: Only relevant for Enrichment Manager.

Operator Description

Changed during (Displayed only when you select an attribute of type 
Date.) Displays only the instances that changed 
during the period specified in the Value box.

Equal Checks whether the attribute value is equal to the 
value specified in the Value box.

Equal ignore case Checks whether the attribute value is equal to the 
value specified in the Value box regardless of the 
case.

Greater Checks whether the attribute value is greater than 
the value specified in the Value box.

Note: When comparing attributes of type string, the 
comparison is based on the ASCII values of the 
string characters.

UI Element (A-Z) Description
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Greater than or equal Checks whether the attribute value is greater than 
or equal to the value specified in the Value box.

In Displays only the instances where this attribute 
value equals one of the selected values. For 
example, for CIs that have a Change state that 
equals Plan and New, select the operator In from the 
Operator list and select both Plan and New from 
the Value box.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the 
value specified in the Value box.

Note: When comparing attributes of type string, the 
comparison is based on the ASCII values of the 
string characters.

Less than or equal Checks whether the attribute value is less than or 
equal to the value specified in the Value box.

Like Uses a wildcard (%). Use Like when you are not sure 
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you 
are not sure of the complete name for which you 
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to 
the value specified in the Value box.

Unchanged during (Displayed when you select a date type attribute.) 
Displays only the instances that did not change 
during the period specified in the Value box.

Operator Description
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Note: 

➤ For the Not equal operator, query results do not include data from the CI 
instances that are not assigned a value. For example, a system contains 
three nodes: Node1 is assigned the value A, Node2 is assigned the value 
B, and Node3 is not assigned a value. If you create a query to retrieve all 
nodes that are Not equal to A, the results of your query include Node2 
only, because Node3 is not assigned a value.

➤ HP Business Service Management supports both Microsoft SQL Server 
and Oracle Server databases. Microsoft SQL Server is not case sensitive by 
default (unlike Oracle database which is case sensitive). Consequently, if 
you are using Microsoft SQL Server, the Equal operator retrieves the same 
query results as the Equal ignore case operator. For example, if you select 
the attribute City, the operator Equal, and type NEW YORK in the Value 
comparison box, case differences are ignored and query results include 
NEW YORK, New York and new york. 

TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

➤ "Pattern Log" on page 52

➤ "Pattern Statistics Log" on page 54

➤ "Audit Short/Detailed Log (TQL Perspective)" on page 54

➤ "Incremental Statistics Log" on page 55

➤ "Incremental Splitter Log" on page 56

➤ "Incremental Detailed Log" on page 57
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Pattern Log
The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled 
and calculated in the RTSM. 

Only TQL queries stored in the RTSM are included. 
Information about ad hoc TQL queries is not included.

Information 
Level

Not available.

Error Level Not available.

Debug Level Possible actions performed on each TQL query include:

➤ Status changes. Each TQL query has an internal state during 
its lifecycle. For example, all inactive queries are always in 
the INACTIVE state. Active queries begin in the NEW state. 
When they are first calculated, they move to the IN_CALC 
state. When a query is removed, it moves to the 
WAIT_FOR_DELETE state until it is removed completely. 

➤ Model changes. Whenever a change occurs in the CMDB 
model, the TQL determines if it is relevant to its results. If 
so, it calculates the required change in the query results. 
The log displays the number of changes processed by this 
TQL.

➤ Query changes. When the TQL is modified, the log indicates 
that the query was modified and displays its new priority.

Basic 
Troubleshooting

Check if a TQL query has the same status for a long time:

➤ new – the query is in lazy loading

➤ inactive 

➤ calculation – the calculation may have failed but the 
scheduler was not informed

You can also view the number of notifications that a TQL 
query received.
52



Chapter 1 • Topology Query Language
Examples of typical log entries:

The TQL query named TQL1 is added and is in NEW state:

TQL1 is asked to be calculated and is moved to IN CALCULATION state:

The calculation finishes and moves to IDLE state (waits for changes):

Changes took place in the model (total of 5 changes):

Moving to a state that checks whether these change are relevant for this TQL 
query:

The pattern is changed. The new priority is medium:

2011-01-25 07:44:48,763 DEBUG - TQL1 [NEW] State change NEW --> NEW

2011-01-25 07:44:48,763 DEBUG – TQL1 [NEW] State change NEW --> IN_CALC 

2011-01-25 07:44:48,778 DEBUG - TQL1 [IN_CALC] State change IN_CALC --> 
IDLE

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE] Model Change Recieved 5 model 
changes. 

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE] State change IDLE --> 
IN_IMMEDIATE_1 

2011-01-25 07:45:39,647 DEBUG - TQL1 [IDLE] Pattern change New priority  
MED_PRIORITY
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Pattern Statistics Log
The log name is cmdb.pattern.statistics.log.

Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose General calculation data for each TQL query, updated at 
predefined intervals.

Information 
Level

The following information is given for each TQL query:

➤ name

➤ average, minimum, and maximum calculation times

➤ number of calculations

➤ last calculation time

➤ result size

Error Level Not available.

Debug Level Not available.

Basic 
Troubleshooting

➤ Verify that a specific TQL query was updated.

➤ Evaluate a TQL query’s calculation time.

➤ Evaluate a TQL query’s result size. 

Log File Description

Purpose RTSM state changes, CI Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.

Information 
Level

Not available.

Error Level Not available.
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Incremental Statistics Log
The log name is cmdb.incremental.statistics.log. 

Debug Level ➤ Final calculation for TQL queries is logged.

➤ If the final TQL query calculation is unchanged from the 
previous calculation, this is noted.

➤ If the final TQL query calculation is changed from the 
previous calculation, results of the CIs and relationships are 
recorded in the detailed log. The number of CIs and 
relationships are recorded in the short log.

Basic 
Troubleshooting

➤ Use this log to verify which notifications are published by 
the TQL query subsystem.

➤ Check the section at the end of each result. This section 
includes added, removed, and updated CIs and 
relationships.

➤ Track the CIT changes and see if the query results also 
change. You can thus correlate the CIT changes to the 
results of the query calculations.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every 
query.

Information 
Level

Not available.

Error Level Not available.

Log File Description
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Incremental Splitter Log
The log name is cmdb.incremental.splitter.log.

Debug Level ➤ Gives the date, time, query name, and whether an 
incremental statistic calculation was performed (yes/no). 

➤ If an incremental statistic calculation was not performed, 
states the reason, the number of subcalculations (relevant 
for incremental calculations only), and the complete 
calculation time.

Basic 
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a 
full or incremental calculation:

➤ If full, check whether a full calculation is necessary.

➤ If incremental, check how many subcalculations have been 
performed.

Log File Description

Purpose Monitors the incremental splitter result made during an 
incremental calculation.

Information 
Level

Not available.

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph 
created by the incremental splitter.

Basic 
Troubleshooting

If the TQL result calculated by the incremental calculator is 
wrong, verify that the splitter result is correct.

Log File Description
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Incremental Detailed Log
The log name is cmdb.incremental.detailed.log.

Topology Query Language User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Calculated Relationship Dialog Box on page 58

 ➤ Add/Edit Compound Relationship Dialog Box on page 60

 ➤ Add/Edit Join Relationship Dialog Box on page 65

 ➤ Add/Edit Relationship Dialog Box on page 68

 ➤ Add Related Query Node Wizard on page 70

 ➤ Add Triplet Dialog Box on page 78

 ➤ Conditions Preview Dialog Box on page 81

 ➤ Element Instances Dialog Box on page 82

 ➤ Filter CI Instances Dialog Box on page 85

Log File Description

Purpose Monitors the incremental calculation process. 

Information 
Level

Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

➤ the trigger query node 

➤ the number of elements classified to the trigger query node 

➤ whether the subcalculation step is driven by new elements 
added to the model or by existing elements

➤ the calculated query graph

Basic 
Troubleshooting

Follows the basic steps of an incremental calculation.
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Chapter 1 • Topology Query Language
 ➤ Join Relationship Condition Dialog Box on page 87

 ➤ Layout Settings Dialog Box on page 89

 ➤ Query Node/Relationship Properties Dialog Box on page 90

 ➤ Refine Query Node Type Dialog Box on page 106

 ➤ Select Relationship Type Dialog Box on page 107

 ➤ Subgraph Condition Definition Dialog Box on page 108

 ➤ Subgraph Definition Dialog Box on page 110

 ➤ User Preferences Dialog Box on page 113

Add/Edit Calculated Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a calculated relationship from the CI Type model.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
Right-click the required query node in the editing pane in 
Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Calculated Relationship option.

To access in Adapter Management in Data Flow 
Management (DFM):
1  Select an adapter in the Resources pane.

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Calculated Relationship.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

See also ➤ "Impact Modeling" on page 119

➤ "CI Type Relationships" on page 487

UI Element (A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

Tree View Tree View. Selects the display format of the calculated 
relationship tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

<Calculated 
relationship tree>

Select the calculated relationship that defines the 
connection between two query nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the calculated relationship.
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Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a compound relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships Only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships Only. Self-relationships 
do not appear in the query results.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane 
in Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Compound Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Compound Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane. 

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Compound Relationship.

UI Element (A-Z) Description
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User interface elements are described below:

Important 
information

You can create as many compound definitions as 
necessary.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

See also ➤ "Compound Relationship" on page 27

➤ "How to Define a Compound Relationship – Scenario" 
on page 36

UI Element (A-Z) Description

Add a compound definition. 

In Impact Analysis Manager and Enrichment Manager, it 
opens the Add Triplet dialog box. In the Modeling Studio, 
it enters a default compound definition in the table. Click 
the Edit buttons to edit the definition components.

Delete the selected compound definition.

Edit the selected compound definition. 

In Impact Analysis Manager and Enrichment Manager, it 
opens the Add Triplet dialog box. In the Modeling Studio, 
it opens the Compound Relationship Condition 
Definition dialog box.

Max steps The longest path allowed between the two CIs in the 
RTSM to be included in the discovery process.

Default is: 5
61



Chapter 1 • Topology Query Language
Min steps The shortest path allowed between the two CIs in the 
RTSM to be included in the discovery process.

Default is: 1

Relationship The relationship connecting the two query nodes. 

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the compound relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

UI Element (A-Z) Description
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Show element in 
query results

Select Show element in query results to include query 
results relating to a join or compound relationship. By 
default, this option is selected. When the check box is 
cleared, a Hidden in Query Results indicator  appears to 
the left of the relationship’s name in the editing pane, 
denoting that any query results pertaining to the 
relationship are not displayed in the topology map.

Show full path 
between source and 
target CIs

If you select this option, then the query results display 
the actual names of the relationships that link the CIs 
and the full path between the source and target CIs.

Source The required source query node.

UI Element (A-Z) Description
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Stop at first 
compound level

Select this option if you want the system to stop looking 
for TQL query results once it reaches the first target in the 
path. 

In the following sample compound link definition, Depth 
is defined as 10 and Stop at first compound level is 
selected.

The TQL query results include the Target 1, Target 3, and 
Target 4 because they are all at level 1 (the first CI found 
in the path). Target 2 is not included in the TQL results 
because it is at level 2 (the second CI found in the path).

Target The required target query node.

UI Element (A-Z) Description
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Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane 
in Enrichment Manager, Impact Analysis Manager, or the 
Modeling Studio and select Add Join Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Join Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane. 

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add Join 
Relationship.

Important 
information

When you access the dialog box from the Modeling 
Studio, you select the attributes and operator within the 
dialog box itself. When you access the dialog box from 
Impact Analysis Manager or Enrichment Manager, you 
select the attributes and operator from the Join 
Relationship Condition dialog box.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

See also ➤ "Join Relationship" on page 27

➤ "How to Define a Join Relationship – Scenario" on 
page 39

UI Element (A-Z) Description

Define a join definition. In Impact Analysis Manager and 
Enrichment Manager, it opens the Join Relationship 
Condition dialog box. In the Modeling Studio, it adds the 
selected attributes and operator to the list.

Delete the selected join definition.

Edit the join definition. Opens the Join Relationship 
Condition dialog box.

Note: This option is not relevant in the Modeling Studio.

<Query node1 
Attribute> box

Select an attribute for the <end_1> query node.

Note: This option is only available in the Modeling 
Studio.

<Query node2 
Attribute> box

Select an attribute for the <end_2> query node.

Note: This option is only available in the Modeling 
Studio.

<Selected query 
node1> column

A selected query node. The first attribute applies to 
<end_1>. 

<Selected query 
node2> column

A selected query node. The second attribute applies to 
<end_2>.

And All join definitions are linked by the And operator.

Note: This is not relevant in the Modeling Studio.

Operator box Select an operator. For details on the available operators, 
see "Join Relationship Condition Dialog Box" on page 87.

Note: This option is only available in the Modeling 
Studio.
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Operator column The operator selected in the Join Relationship Condition 
dialog box. For details about operator definitions, see 
"Attribute Operator Definitions" on page 49.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the join relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.

Show relationship in 
query results

Select Show relationship in query results to include query 
results relating to a join or compound relationship. By 
default, this option is selected. When the check box is 
cleared, a Hidden in Query Results indicator  appears 
to the left of the relationship’s name in the editing pane. 
Any query results pertaining to the relationship are not 
displayed in the topology map.

UI Element (A-Z) Description
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Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query 
nodes in a TQL query.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio, do one of the 
following:
➤ Right-click the required query node in the editing pane 

in Enrichment Manager, Impact Analysis Manager, or 
the Modeling Studio and select Add Relationship.

➤ Click the Create Relationship  icon and draw a line 
between the required query nodes. The Select 
Relationship Type dialog box opens. Select Regular 
Relationship.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Relationship option.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane.

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Add 
Relationship.

Important 
information

This option does not appear when two selected query 
nodes (or a single selected query node) do not have a 
valid relationship between them.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Expand All. Expands all the folders in the relationship 
tree.

Collapse All. Collapses all the folders in the relationship 
tree.

Tree View Tree View. Selects the display format of the relationship 
tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

<Relationship tree> Select the relationship that defines the connection 
between two query nodes.

Relationship 
Direction

The direction of the relationship that indicates which 
query node is dependent on the other.

Relationship Name The name of the relationship.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This list appears only when you select one query 
node or two identical query nodes.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships do 
not appear in the query results.
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Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Add Related Query Node.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Add 
Related Query Node option.

To access in Discovery Control Panel in DFM:
1  Select a job in the Discovery Modules pane. 

2  Select a Trigger Query in the Properties tab. Click the 
Open the Query Editor  button to open the Trigger 
Query Editor.

3  Right-click the required query node and select Add 
Related Query Node Wizard.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane. 

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box 
to open the Input Query Editor.

3  Right-click the required query node and select Add 
Related Query Node Wizard.

Important 
information

If the TQL query is empty, drag the required TQL query 
nodes on to the editing pane from the tree displayed in 
the CI Type Selector or the CI Types tab of the left pane.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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Related Query Node Type Page
This wizard page enables you to add a query node to the TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page

See also "Topology Query Language (TQL) Overview" on page 23

Important 
information

If the TQL query is empty, drag the required TQL query 
node on to the editing pane from the tree displayed in 
the Configuration Item Types pane.

For general information on the Add Related Query Node 
Wizard, see "Add Related Query Node Wizard" on 
page 70.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type 
Page > Related Query Node Properties Page > Related 
Query Node Instances Page

UI Element (A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

Tree View Tree View. Selects the display format of the CI type tree. 
The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Note: This feature is only available in the Modeling 
Studio.
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<query node> is 
required

Define the relationship cardinality. For details, see 
"Cardinality Tab" on page 95.

➤ Select the <query node> is required check box for each 
query node to include a minimum of one instance of 
the query node at the other end of the relationship in 
the query results. Selecting the check box gives the 
relationship a cardinality value of 1..*.

➤ Clear the <query node> is required check box to give 
the relationship a cardinality value of 0..*.

<TQL Query Node 
hierarchy tree>

Select the required query node. The query node you select 
appears in the Element name box.

This list only includes the query nodes of the CI type that 
have valid relationships to the selected (source) query 
node. 

To the right of each query node, the number of CI 
instances that exist in the RTSM for that CI type is 
displayed. The number of instances is only updated after 
you close the Add Related Query Node Wizard and open 
it again.

Note: The first query node in the hierarchy tree is selected 
by default.

Element name (Optional) Contains the name of the selected query node. 
By default, the CI type is assigned as the element’s name.

You can rename a TQL query node in the Element name 
box giving it a unique label. This can be helpful when 
there is more than one query node of the same CI type in 
the TQL query.

Show only CITs with 
instances

Select this check box to display only the CITs of which 
there are instances in the RTSM. If this box is not 
selected, the tree includes all CITs with a valid link to the 
source query node.

Note: The Show only CITs with instances check box is 
selected by default.

UI Element (A-Z) Description
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Relationship Type Page
This wizard page enables you to add a relationship to a TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page 
> Related Query Node Properties Page > Related Query 
Node Instances Page

UI Element (A-Z) Description

Tree View Tree View. Selects the display format of the Relationship 
tree. The following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Note: This feature is only available in the Modeling 
Studio.

<TQL Query 
Relationship 
hierarchy tree>

Select the required relationship. 

Relationship 
Direction

Select the required relationship direction. The direction 
indicates which query node is dependent on the other.

Relationship Name The name of the relationship.

Note: This feature is only available in the Modeling 
Studio.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

Note: This feature is only available in the Modeling 
Studio.
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Related Query Node Properties Page
This wizard page enables you to create an expression that restricts the 
number of query nodes that appear in the query by adding an attribute 
condition to a query node or relationship.

User interface elements are described below:

Relationship Type A valid relationship that defines the connection between 
the selected query nodes. The box displays the 
relationship you selected in the relationship hierarchy 
tree.

Note: This feature is only available in Enrichment 
Manager and Impact Analysis Manager.

Show only 
relationships with 
instances

Display only the relationships of which there are 
instances in the RTSM. If this box is not selected, the tree 
includes all valid relationships between the selected 
query nodes.

Important 
information

When you access the wizard from the Modeling Studio, 
this wizard page has two tabs: Attribute and Element 
Type. The Attribute tab includes the elements described 
below. For details on the Element Type tab, see "Element 
Type Tab" on page 99.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page

UI Element (A-Z) Description

Adds an attribute condition.

Deletes an attribute condition.

Moves a selected row up.

UI Element (A-Z) Description
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Moves a selected row down.

Views the condition definition.

Advanced layout 
settings

Opens the Layout Settings dialog box which enables you 
to determine which attributes are used in the calculation 
of the TQL query when querying the RTSM using third-
party or custom tools. 

Note: This option is only relevant when accessing the 
wizard from the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Include subtypes Display both the selected CI and its children in the 
topology map.

Note: This check box is only available in the Enrichment 
Manager and Impact Analysis Manager.

NOT Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 49.

UI Element (A-Z) Description
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Show element in 
query results

Select Show element in query results to display the 
selected TQL query node in the editing pane. When the 
check box is cleared, a Hidden in Query Results indicator 

 appears to the right of the selected TQL query node in 
the editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. For example, Windows are connected to the 
network by defining specific IP Addresses, but in any 
query results you may want to view the IP Address 
elements only and not the Windows elements.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

UI Element (A-Z) Description
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Related Query Node Instances Page
This wizard page displays all the instances found for the selected TQL query 
node in a table. 

Important 
information

The columns displayed in the report vary according to 
the CI type selected. 

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the CI 
Type Manager are displayed as columns in the dialog box. 
For details, see "Attributes Page" on page 507. 

If required, you can click the Display Hidden Columns 
button to display the attributes that are defined as Visible 
but not Static. For details on Static attributes, see 
"Attributes Page" on page 507.

Note: For information on the elements included in the 
Related Query Node Instances page, see "Element 
Instances Dialog Box" on page 82.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > 
Related Query Node Properties Page > Related Query 
Node Instances Page
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Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the 
topology graph leading from the source CI to the target CI when creating a 
subgraph definition, a compound relationship, or a calculated relationship.

To access ➤ In the Add Compound Relationship dialog box, click 
the Add  button. For details, see "Add/Edit 
Compound Relationship Dialog Box" on page 60.

➤ In the Subgraph Definition dialog box, click  Add. 
For details, see "Subgraph Definition Dialog Box" on 
page 110.

➤ In CI Type Manager, select Calculated Relationships 
from the drop-down list in the CI Types pane. In the 
editing pane, select the Triplets page and then click 

 Add.

Important 
information

Select the query nodes and relationships to be included 
in the topology graph.

Important: The Condition fields are displayed only when 
you access the Add Triplet dialog box from the Subgraph 
Definition dialog box.  

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

See also ➤ "Compound Relationship" on page 27

➤ "How to Define a Compound Relationship – Scenario" 
on page 36

➤ "Subgraph Definition" on page 31
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User interface elements are described below:

UI Element (A-Z) Description

Define attribute conditions for the source and target 
query nodes you selected. When the Add Triplet dialog 
box is opened from the Subgraph Definition dialog box, 
it opens the Subgraph Condition Definition dialog box. 
When the Add Triplet dialog box is opened from the Add 
Compound Relationship dialog box, it opens the 
Compound Relationship Condition Definition dialog 
box.

The Condition button is enabled only after you select a 
query node from the Source or Target lists.

Note: You cannot define attribute conditions for the 
source and target query nodes in the CI Type Manager.

Relationship Select an available relationship connecting the two query 
nodes. The list of available relationships appears only 
after defining both query nodes. 

Relationship 
Direction

Select the required direction. Setting different 
relationship directions can achieve different query 
results. For an example, see "Setting Different 
Relationship Directions for Compound Definitions" on 
page 80.

Note: The Relationship list remains empty until you have 
selected a source and target.

Source Select the required source query node.

Target Select the required target query node.
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Setting Different Relationship Directions for Compound 
Definitions

You can achieve different TQL results by setting different relationship 
directions. For example, in your business world, as illustrated below, you 
want to create a compound relationship that connects between a query 
node of the CIT a and a query node of the CIT b. Depth is defined at 5 (for 
details, see "Depth" on page 111). 

In the Add Triplet dialog box, you can create compound definitions to link 
query nodes a and b using different relationship directions.

➤ Compound definitions 1 and 2 result in the following query:

Compound 
Definition

Source Target Relationship
Relationship 
Direction

#1 query node a query node c <relationship> source --> target

#2 query node c query node b <relationship> source --> target

#3 query node c query node b <relationship> source <-- target
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➤ Compound definitions 1 and 3 result in the following query:

➤ Compound definitions 1, 2, and 3 result in the following query:

Conditions Preview Dialog Box

This dialog box displays the conditions selected when selecting a complex 
type condition in the Element Type tab of the Query Node Properties dialog 
box.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Click the Preview  button from the Element Type tab 
of the Query Node Properties dialog box.

UI Element (A-Z) Description

CI Type Displays the subtypes for which you defined conditions.

Condition Displays the icon of the selected condition, as defined in 
the Legend.

Filter by Specifies the selected condition (i.e. by CI type or by 
qualifier and by which qualifiers).
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Element Instances Dialog Box

This dialog box displays all of the CI instances found for the selected TQL 
query node in a table. 

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Show Element Instances.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Show 
Element Instances option.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane.

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box to 
open the Input Query Editor.

3  Right-click the required query node and select Show 
Element’s Instances.

To access in Integration Studio:
Create an integration point based on a discovery jython 
adapter. In the Trigger CI Instance menu, choose Select 
Existing CI.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The columns in the table display the attributes of the 
selected CI type. The attributes displayed vary according 
to the CI type selected.

By default, only columns corresponding to attributes that 
have been defined with the Asset Data, Change 
Monitored, and Comparable attribute qualifiers in the 
CIT Manager are displayed as columns in the dialog box. 
For details, see "Attributes Page" on page 507. 

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

➤ "How to Work with Population Jobs" in RTSM Data 
Flow Management Guide

➤ "How to Work with Data Push Jobs" in RTSM Data Flow 
Management Guide

UI Element (A-Z) Description

Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Deletes the selected CI.

Show CI Properties. Opens the Configuration Item 
Properties dialog box for the selected CI.

Refreshes the list of CI instances.

Filters the CI instances you want to display for the 
selected query node. Opens the Filter CI Instances dialog 
box.
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Clears the filter definitions you created in the Filter CI 
Instances dialog box.

Enables you to select the columns to be displayed. For 
details, see "Select Columns Dialog Box" on page 580.

Enables you to set the sort order of the CI instances. For 
details, see "Sort Column Content Dialog Box" on 
page 582.

Find. Displays the Find toolbar.

Send Mail. Sends the table data in an email.

Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable 
number of columns to display to ensure that the report 
is legible. 

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. 

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file

UI Element (A-Z) Description
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Filter CI Instances Dialog Box

This dialog box enables you to reduce the number of CI instances to be 
displayed in a list by selecting a condition and a value for a specific CI.

Rows per 
page

Select the number of rows to be displayed on each page. 
You can also manually enter value for the number of rows 
per page.

Navigates through the results page by page or to jump to 
the first or last page.

<Element Instances> The CI instances found for the selected TQL query node.

You can double-click an instance to open the 
Configuration Item Properties dialog box for that CI.

<Element instances 
shortcut menu>

For details, see "IT Universe Manager Shortcut Menu" on 
page 289.

Display Label The name of the CI instance as it appears in the topology 
map.

To access Click the Filter  button in the Element Instances 
dialog box.

UI Element (A-Z) Description
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User interface elements are described below:

Important 
information

A description of the filter condition you defined appears 
above the table columns in the Element Instances dialog 
box. For example, the following illustration shows that a 
filter condition was created to display only CI instances 
whose CI type is Windows.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

Attribute Displays all the attributes of the CI type to which the CI 
belongs.

Condition Select the required operator. For details, see "Attribute 
Operator Definitions" on page 49.

NOT Select to filter the results by the negation of a condition 
and value.

Value Select or enter the required value.
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Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query 
nodes using a join relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In Enrichment Manager or Impact Analysis Manager, 
click the Add  button in the Add Join Relationship 
dialog box.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide.

UI Element (A-Z) Description

<Selected query 
node1>

A selected query node. The first attribute applies to 
<end_1>.
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<Selected query 
node2>

A selected query node. The second attribute applies to 
<end_2>.

Operator Select one of the following operators: 

➤ Equal. The system checks whether two selected 
attributes are equal.

➤ Not equal. The system checks whether two selected 
attributes are not equal.

➤ Sub string. The system checks whether the value of the 
first attribute is a substring of the value of the second 
attribute.

➤ Sub string ignore case. The system checks whether the 
value of the first attribute is a substring of the value of 
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure 
that both sides of the join relationship have a limited 
result size. It is recommended to define more specific 
conditions so as not to overload the system with large 
results.

UI Element (A-Z) Description
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Layout Settings Dialog Box

This dialog box enables you to determine which attributes are used in the 
calculation of the TQL query when using the UCMDB API. For details, see 
"RTSM (HP Universal CMDB) Web Service API" in the RTSM Developer 
Reference Guide. 

User interface elements are described below:

To access Click Advanced layout settings in the Query 
Node/Relationship Properties dialog box.

Important 
information

Since this option is only relevant when querying the 
CMDB API, the query results in the user interface are not 
impacted by the attributes you select in this dialog box.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the 
query’s calculation.
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Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the 
selected TQL query node/relationship.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Query Node/Relationship Properties.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Query 
Node Properties option.

To access in DFM:
1  To access from the Adapter Definition tab, select an 

adapter. Click the Edit Input Query  button to the 
right of the Input Query box to open the Input Query 
Editor. 

2  Right-click the required query node/relationship and 
select Query Node Properties or Relationship 
Properties.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

See also "Query Node Conditions" on page 28
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User interface elements are described below:

UI Element (A-Z) Description

Element name (Optional) The Element name box contains the name of 
the selected query node/relationship. By default, the CI 
type is assigned as the element’s name. You can rename a 
TQL query node in the Element name box giving it a 
unique label. This can be helpful when there is more than 
one query node of the same CI type in the TQL query.

Element type Displays the CI type of the selected query node. If you 
want to change the query node type to a child of the 
original type, select a subtype from the drop-down list.

Note: 

➤ If you have already defined a complex type condition 
for the query node, the condition is lost when you 
change the query node type.

➤ This feature is only available in the Modeling Studio.

Include subtypes Select to display both the selected CI and its children in 
the topology map.

Note: This feature is only available in Enrichment 
Manager and Impact Analysis Manager.
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Query Result Displays a topology map of the TQL query showing the 
number of instances of each query node/relationship.

Note: This feature is only available in the Modeling 
Studio.

Show element in 
query results

Select Show element in query results to display the 
selected TQL query node in the editing pane. When this 
option is cleared, a Hidden in Query Results indicator  
appears to the right of the selected TQL query node in the 
editing pane.

Any query results pertaining to that TQL query node are 
not displayed in the topology map. This can be useful 
when certain relationships or TQL query nodes are 
required to build the query but are not needed in the 
results. For example, Windows are connected to the IP 
Subnet by defining specific IP Addresses, but in any query 
results you may want to view the IP Address elements 
only and not the Windows elements.

UI Element (A-Z) Description
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Attribute Tab

This area enables you to create an expression defining conditions that 
restrict the number of query nodes that appear in the query. You can add an 
attribute condition to a query node or relationship and filter the query 
results.

User interface elements are described below:

To access Click the Attribute tab in the Query Node/Relationship 
Properties dialog box.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute definition.

Move a selected row up.

Move a selected row down.

Display the criteria in a popup dialog box.

Advanced layout 
settings

Opens the Layout Settings dialog box which enables you 
to determine which attributes are used in the calculation 
of the TQL query when querying the RTSM using third-
party or custom tools. 
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And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Select an attribute from the drop-down list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Default Value For parameterized attributes, enter a default value for the 
parameter.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 49.

Parameterized Select Yes to define a parameterized value for the 
attribute. Select No to define a fixed value for the 
attribute.

Note: This feature is only available in the Modeling 
Studio. 

UI Element (A-Z) Description
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Cardinality Tab

In this area, you can define a relationship cardinality, which enables you to 
define how many CI instances you expect to have at the end of a 
relationship in your query result.

Parameter Name If you are defining a parameterized value for the 
attribute, you must enter the parameter name.

Note: This feature is only available in the Modeling 
Studio.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

Note: You can paste a copied value into the window by 
pressing CTRL+V on the keyboard.

To access Click the Cardinality tab in the Query Node Properties 
dialog box.

UI Element (A-Z) Description
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User interface elements are described below:

Important 
information

Select the required relationship to which the selected 
query node is attached. Then define the lower and upper 
limits for including the query node at the other end of 
the relationship in the query results.

You can define relationship conditions that enable the 
relationship’s connecting query node to be included in 
the TQL query results by creating an expression defining 
that condition. For an example, see "Example of a 
Relationship Condition" on page 98.

Note: This tab only appears when a query node is 
selected.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

Add the cardinality definition you have defined.

Delete a cardinality definition from the Cardinality area.

Move a selected row up.

Move a selected row down.

Display the criteria in a popup dialog box.

Inserts 1 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.
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Inserts 0 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the cardinality condition definition as defined 
in the Element Instances Dialog Box.

Max Enter the value that defines the upper limits for including 
the query node at the other end of the relationship in the 
query results. 

Note: You can use an asterisk (*) in the Max box to 
represent an infinite value.

Min Enter the value that defines the lower limits for including 
the query node at the other end of the relationship in the 
query results.

For example, if <end_1> is IpAddress and <end_2> is 
Windows, entering 1 in the Min box and asterisk (*) in 
the Max box instructs the system to retrieve only those IP 
Addresses that are connected to at least one Windows 
operating system. (The asterisk indicates an infinite 
value.) Entering 3 in the Min box and asterisk (*) in the 
Max box instructs the system to retrieve only those 
Windows operating systems that are connected to at least 
three IP Addresses.

UI Element (A-Z) Description
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Example of a Relationship Condition

The example of relationship conditions is based on the following TQL 
query:

 

Query Node Select the required relationship to which the selected 
query node is attached. The list contains all the 
relationships that are linked to the selected query node.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three nodes: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

UI Element (A-Z) Description
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In the Relationship Cardinality dialog box, the following relationship 
conditions are defined for the query:

➤ Containment – Min: 2, Max: 4

➤ Membership – Min: 1, Max: *

Using the OR operator, the definitions appear in the Cardinality section, as 
follows:

➤ [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)] 
means that the node must either have between two and four IP Addresses 
OR be a member of the IP Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as 
follows:

➤ [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)] 
means that the node must have between two and four IP Addresses AND 
also be a member of the IP Subnet.

Element Type Tab

This area enables you to specify subtype conditions for the selected query 
node or relationship.

To access Click the Element Type tab in the Query 
Node/Relationship Properties dialog box.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

This tab is only available in the Modeling Studio.

Relevant tasks ➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

➤ "Define a Complex Type Condition - Scenario" on 
page 41

UI Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based 
on the selected conditions:

➤  Include the subtype without its descendants.

➤  Include the subtype with its descendants.

➤  Exclude the subtype without its descendants.

➤  Exclude the subtype with its descendants.

CI 
Types/Relationships 
pane

When Customize subtypes is selected, the CI Types pane 
displays a tree with all subtypes of the selected CI type 
(for relationships, the Relationships pane displays a tree 
with all subtypes of the selected relationship). After 
selecting conditions in Conditions pane, click the 
Preview  button to open the Conditions Preview 
dialog box.

Conditions pane For details, see "Conditions Pane" on page 101.

Customize subtypes Select Customize subtypes to set a complex type 
condition. Select the required subtypes from the tree in 
the CI Types/Relationships pane and select conditions for 
them in the Conditions pane, as described below.

Element type Select Element type to set a simple type condition. If you 
want to include all subtypes of the selected CI type, select 
the Include subtypes check box. If you do not want to 
include all subtypes, clear the check box.
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Conditions Pane

UI Element (A-Z) Description

Apply this condition 
recursively on all 
subtypes of <selected 
CI type>

Select this check box to apply the specified condition for 
the selected CI type to all of that CI type’s descendants, 
recursively. 

By CI types Select By CI types to include or exclude all instances of 
the selected CI type in the query results.

By qualifiers Select By qualifiers to include or exclude instances of the 
selected CI type with specific qualifiers in the query 
results. A popup appears with a list of qualifiers. Select the 
required qualifiers for the selected subtype. For details on 
the qualifiers, see "Qualifier Tab" on page 102.

Condition Select a condition for the selected CI type. The following 
options are available:

➤ None. No condition is selected for this CI type. 
Instances of this CI type and all its descendants are 
included in the query results, unless a parent CI type of 
this CI type was selected for exclusion and the Apply 
recursively check box was selected. 

➤ Include <selected subtype> in the query. Includes 
instances of the selected CI type in the query results 
(according to the condition selected). An example of a 
situation where this option is relevant is where a 
parent of the CI type was selected to be excluded and 
the Apply recursively check box was selected. You can 
select certain subtypes to be included, so the query 
results exclude all subtypes of the parent CI type 
except for the specified ones.

➤ Exclude <selected subtype> from the query. Excludes 
instances of the selected CI type from the query results 
(according to the condition selected). 
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Qualifier Tab

This area enables you to define qualifier conditions for the selected query 
node or relationship. For example, you can use a qualifier to define a CIT as 
abstract, meaning you cannot create instances from it.

To access Click the Qualifier tab in the Query Node/Relationship 
Properties dialog box.

Important 
information

By default, multiple selection links the conditions with 
the OR operator.

Note: This tab is only available in the Enrichment 
Manager and Impact Analysis Manager.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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User interface elements are described below:

UI Element (A-Z) Description

ABSTRACT_CLASS You cannot create instances of this CIT.

ALLOW_VOLATILITY Used to mark attributes that enable minor deviations 
to their value. For example, there is probably no need 
to report a small disk size change (from 8.00008 to 
8.00009 GB).

By default, ALLOW_VOLATILITY is enabled for the 
following numeric or date attributes only:

➤ CIT: Node

➤ MemorySize

➤ SwapMemorySize

These attributes also include comparable and static 
qualifiers.

➤ CIT: Host

➤ HostLastBootTime

➤ CIT: CPU

➤ CpuClockSpeed

➤ CIT: Filesystem

➤ Disk_size

For details of this qualifier’s attributes and the 
procedure for activating and deactivating this feature, 
see "The ALLOW_VOLATILITY Qualifier" on page 31.

BDM_SCOPE Indicates that the CI type is part of the BDM scope of 
the class model.

BLE_LINK_CLASS A relationship that has been assigned this qualifier is 
loaded by an online BLE engine TQL and becomes 
part of the Dashboard status calculations.

CALCULATED_LINK This qualifier is assigned to calculated relationships

CONTAINER This qualifier is assigned to relationships that signify a 
containment relationship, such as Membership, 
Composition, Containment.

HIDDEN_CLASS Instances of this CIT do not appear anywhere in the 
application.
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ID_CLASS_NAME_OVER
RIDE

Indicates that the class ID is calculated based on 
another class. 

ITU_HIDDEN_CLASS Instances of this CIT do not appear in the topology 
map application.

MAJOR_APP CI types that are assigned this qualifier appear in the 
Application Breakdown overview report. For details, 
see "Application Breakdown Report" on page 566.

MODELING_ENABLED Enables a CIT to act as a model in Modeling Studio. 
For details, see "Business CI Models" on page 354.

NETWORK_DEVICES A qualifier common to all the CI types that represent a 
network device. It can be used for TQL queries related 
to network devices and serves as a replacement for CI 
types in a query.

Negate Qualifiers If this check box is selected, then the element is 
included in the query results only if it has no qualifier 
in the list of selected qualifiers.

PM_SUSPECT Used by Problem Isolation to determine which CIs are 
to be considered as suspects when isolating a problem. 
For details, see "Problem Isolation" in Using Problem 
Isolation. 

READ_ONLY_CLASS This CIT cannot be edited.

RECURSIVE_DELETE Relevant for relationships. When the CI at one end of 
a relationship is deleted, the system checks the CI at 
the other end of the relationship. If it is not related to 
any other CIs, it is also deleted.

TRACK_LINK_CHANGES Changes that occur in the specified relationship 
appear in Change reports. 

UI Element (A-Z) Description
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Identity Tab

This area enables you to filter the TQL query results according to the 
element ID of the instances found for the selected TQL query node.

The following elements are included (unlabeled elements are shown in 
angle brackets):

To access Click the Identity tab in the Query Node Properties dialog 
box.

Important 
information

Move the required element from the Optional identities 
pane on the left to the Selected identities pane on the 
right to define what you want included in the TQL query 
results using the left and right arrows.

Note: This tab only appears when a query node is 
selected.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

<Toolbar> For descriptions of the toolbar buttons, see "Element 
Instances Dialog Box" on page 82.

Optional identities 
pane 

Displays all the instances found for the selected TQL 
query node. 

Selected identities 
pane

Displays the elements that are used to define what should 
be included in the TQL query results. 
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Refine Query Node Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node after 
you have created a TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In Impact Analysis Manager or Enrichment Manager, right-
click the required query node and select Refine Query Node 
Type.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the Refine 
Query Node Type option.

Important 
information

You can change the CI type to a type from one of the CI 
type’s children, if one exists. If no such CI type exists, this 
option does not appear.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description

<List of CI types from 
which to choose>

Select the required CI type.
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Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be 
created.

To access In the editing pane of Impact Analysis Manager, 
Enrichment Manager, and the Modeling Studio, click the 
Create Relationship  button in the toolbar and draw a 
line between two query nodes. The Select Relationship Type 
dialog box opens automatically. 

Important 
information

Select one of the following relationship types:

➤ Regular Relationship. For details, see "Add/Edit 
Relationship Dialog Box" on page 68.

➤ Join Relationship. For details, see "Add/Edit Join 
Relationship Dialog Box" on page 65.

➤ Compound Relationship. For details, see "Add/Edit 
Compound Relationship Dialog Box" on page 60.

➤ Calculated Relationship. For details, see "Add/Edit 
Calculated Relationship Dialog Box" on page 58.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of 
query nodes that appear in the query.

To access In Impact Analysis Manager and Enrichment Manager, 
click Condition  in the Add Triplet dialog box.

In the Modeling Studio, click Condition  in the 
Subgraph Definition dialog box.

Important 
information

Contains the following tabs:

➤ Attribute. Enables you to define attribute conditions 
for query nodes and relationships. See a description of 
the elements in the Attribute tab in the table below.

➤ Qualifiers (for Enrichment Manager and Impact 
Analysis Manager). Enables you to define qualifier 
conditions for the selected query node or relationship. 
For details, see "Qualifier Tab" on page 102.

➤ Element Type (for the Modeling Studio). Enables you 
to define subtype conditions for the selected query 
node or relationship. For details, see "Element Type 
Tab" on page 99.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370
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User interface elements are described below:

UI Element (A-Z) Description

Add the subgraph condition definition.

Delete the subgraph condition definition.

Move a selected row up.

Move a selected row down.

View the subgraph condition definition.

Advanced layout 
settings

Opens the Layout Settings dialog box which enables you 
to determine which attributes are used in the calculation 
when querying the RTSM using third-party or custom 
tools. 

Note: This option is only relevant when accessing the 
dialog box from the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Choose an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances Dialog Box.

Element Name Contains the CIT selected from the Source and Target 
lists.
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Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL 
query data related to a specific CI.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, let us assume that your system contains three 
nodes. Node1 is assigned the value A, Node2 is assigned 
the value B and Node3 is not assigned a value. If you 
create a query in which you want to retrieve all nodes 
that are equal to A and you select NOT, the results of your 
query only include Node2 because Node3 is not assigned 
a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 49.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.

To access To access in Enrichment Manager, Impact Analysis 
Manager, and the Modeling Studio:
In the editing pane, right-click the required query node 
and select Subgraph Definition.

Note: If you are using Enrichment Manager, select Query 
mode at the top of the editing pane to display the 
Subgraph Definition option.

To access in Adapter Management in DFM:
1  Select an adapter in the Resources pane. 

2  In the Adapter Definition tab, click the Edit Input 
Query  button to the right of the Input Query box 
to open the Input Query Editor.

3  Right-click the required query node and select 
Subgraph Definition.

UI Element (A-Z) Description
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User interface elements are described below:

Important 
information

The following icon is displayed next to the query node 
for which you define a subgraph:

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

See also ➤ "Subgraph Definition" on page 31

➤ "How to Create a Subgraph Definition – Scenario" on 
page 42

UI Element (A-Z) Description

Add a subgraph definition. In Enrichment Manager and 
Impact Analysis Manager, opens the Add Triplet dialog 
box. In the Modeling Studio, adds a row to the table.

Delete a subgraph definition.

Edit a subgraph definition. In Impact Analysis Manager 
and Enrichment Manager, opens the Edit Triplet dialog 
box. In the Modeling Studio, opens the Subgraph 
Condition Definition dialog box.

Depth A number that represents the longest path (that is, the 
maximum connecting query nodes) allowed between two 
CIs in the RTSM that should be included in the DFM 
process.

Default: 5
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Element condition 
exists

A green asterisk appears next to either the source, 
relationship, or target in the subgraph definition if an 
attribute condition has been defined for one of them in 
the Subgraph Condition Definition dialog box. For 
details, see "Subgraph Condition Definition Dialog Box" 
on page 108.

Relationship The relationship selected connecting the source to the 
target query node.

Relationship 
Direction

The direction of the relationship selected, indicating 
which query node is dependent on the other.

Source The required source query node selected.

Target The required target query node selected.

UI Element (A-Z) Description
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User Preferences Dialog Box

This dialog box enables you to reset system preferences.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Tools > User Preferences or click the Configure 
User Preferences  button in the Status Bar.

Important 
information

All the preferences you select (such as whether to display 
certain wizard pages or warning message preferences) are 
stored in the system. This dialog box enables you to reset 
those preferences.

UI Element (A-Z) Description

<Left pane> Select the preferences page to edit. The following options 
are available:

➤ Wizard Preferences. Enables you to define whether to 
hide or display certain wizard pages.

➤ Optional Messages Preferences. Enables you to define 
whether to hide or display certain messages.

➤ Discovery Preferences. Enables you to define:

➤ Whether to hide or display certain Discovery 
warning messages

➤ The required default external editor (such as 
Notepad)

➤ Whether to use Basic or Advanced Discovery mode

➤ General. Enables you to define general application 
preferences. 

<Preferences list> The list of warning messages and their user-selected 
preferences.

Filter by Enter a search word to filter the list of options.

Reset All Resets all the preferences to their default values.

Reset Page Resets the selected preference to its default value.
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Troubleshooting and Limitations

This section describes troubleshooting and limitations for Topology Query 
Language.

For TQL queries to be valid, they must comply with certain restrictions.

This section includes the following topics:

➤ "Understanding Validation Restrictions" on page 114

➤ "Impact Analysis TQL Query Validation" on page 116

➤ "Enrichment TQL Query Validation" on page 117

Understanding Validation Restrictions
For Impact Analysis, Discovery, and Enrichment TQL query types to be 
valid, they must comply with the following restrictions:

➤ Unique Names. TQL query elements must have unique names.

➤ Self Relationships. A TQL query must not contain self relationships, that 
is, a relationship must not lead from a query node to itself, as the 
following example illustrates:
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➤ Cyclic Graph. The TQL query structure cannot be a closed circle, as shown 
in the following example:

➤ Separate Query Nodes and Groups. All the TQL query nodes must be 
linked to one another, that is, the TQL query cannot contain separate 
query nodes or groups, as the following example illustrates:
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Impact Analysis TQL Query Validation
Impact Analysis TQL queries must also comply with the following 
restrictions:

➤ Number of query nodes. An Impact Analysis TQL query must consist of at 
least two query nodes.

➤ Trigger and affected query nodes must be connected. There must be a 
path of relationships from the triggered query node to the affected query 
nodes.

➤ Selecting query nodes to function as Impact Analysis triggers. When 
selecting query nodes to function as Impact Analysis triggers, the query 
nodes must comply with the following restrictions:

➤ You can select more than one query node as a trigger. However, you 
cannot define a query node both as affected and as a trigger.

➤ If a query node has a relationship whose minimum limit is 0 (meaning 
that one of its ends does not necessarily have a query node linked to 
it), the query node that is linked to its other end cannot be a root cause 
query node (because it may or may not exist in the TQL query). For 
details about minimum limits, see "Cardinality Tab" on page 95. For 
example, Configuration Item cannot be either a root cause or affected 
query node because it is connected to the query node with a Min limit 
of 0. 
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Note: A query node that is hidden cannot be a root cause or an affected 
query node.

➤ The connection between trigger and affected query nodes. The trigger 
query node and affected query nodes you define must be connected by a 
path of relationships from the triggered query node to the affected query 
nodes.

Enrichment TQL Query Validation
Enrichment TQL queries must comply with the following restriction:

Required elements. You cannot perform Enrichment on a non-required 
query node, that is, a query node that does not necessarily appear in the 
TQL query results.

Example 1. In this example, the TQL query results can be either A and B or A 
and C. Therefore, you cannot add an Enrichment query node to query nodes 
B or C because they are not required elements. You can add an Enrichment 
query node to query node A because it always appears in the TQL query 
results. For details on how to add Enrichment query nodes and 
relationships, see "How to Add Enrichment Query Nodes and Relationships 
to an Enrichment TQL Query" on page 537.
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Example 2. In this example, both A and B are required elements that always 
appear in the TQL query results. Only C is not a required element because it 
has a cardinality of 0. Therefore, you cannot add an Enrichment query node 
to it.
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Impact Modeling

This chapter includes:

Concepts

➤ Impact Modeling Overview on page 120

➤ Impact Layer on page 121

➤ Impact Rules on page 121

➤ Propagation Reversal on page 123

➤ Calculated Relationship Types on page 124

➤ Creating Views Based on the Impact Model on page 125
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Concepts

Impact Modeling Overview

The impact model enables you to determine the direction of the 
propagation of the IT infrastructure CIs in your business world. The 
direction of the impact is not always the same direction as the physical 
relationships taken from the CI Type model.

The impact model uses the impact layer to change the propagation 
direction. The impact layer is used in the applications where propagation 
occurs. You change the direction of the impact using the impact layer, 
regardless of the direction of the physical relationships.

All KPI propagation is affected by the impact model. For details on KPI 
propagation in Service Health, see "Propagation Rules" in Using Service 
Health. For details on KPI propagation in Service Level Management, see 
"Propagation Rules" in Using Service Level Management.
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Impact Layer

The impact layer changes the direction of the impact. The impact layer 
separates the impact direction from the CI Type model, creating an 
independent layer on top of the CI Type model. This means that 
components affected by the impact model are no longer relying on the 
physical relationships as defined in the CI Type model. As a result, the 
impact direction is no longer necessarily identical to the direction of the 
physical relationships in the CI Type model.

Impact Rules

The impact layer consists of impact rules. The impact rules are defined in 
the CI Type Manager. For details, see "Triplets Page" on page 512.

An impact rule is defined by one or more triplets. Each triplet is defined by 
the following components:

➤ One source CI type

➤ One target CI type

➤ A physical relationship type (for example, Containment) that links the 
two CI types

➤ The required impact direction. The direction of the impact can be 
identical to or opposite from the direction of the physical relationship 
between the source and target CIs. 

HP Business Service Management implements the impact layer by creating 
calculated relationships that are defined by impact rules. Once one of the 
triplets fulfills the impact rule condition, HP Business Service Management 
automatically creates the calculated relationship based on the triplet 
definition. 

Since calculated relationships are defined by physical relationships from 
within the class model, their lifetime is determined by the lifetime of the 
physical relationships defined in the impact rule. When the physical 
relationship in the class model is removed, the corresponding calculated 
relationship is removed from all view results as well.
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Note: If you create a new CI type or relationship in the CI Type Manager, 
you need to define the required triplets. For example, to enable the impact 
model to properly affect KPI propagation. If the triplets are not defined, the 
required KPIs are not included in the Dashboard views and SLA agreements.

You can use calculated relationships to create TQL queries just like any other 
relationship in the CI Type model. This enables you to base Enrichment 
rules, Impact rules, and views on calculated relationships. Calculated 
relationships affect the results of all TQLs that use that calculated 
relationships since calculated relationships are part of the class model.

Example of an Impact Rule Definition:
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Propagation Reversal

The following example illustrates a scenario in which propagation is 
reversed.

Based on the impact rules defined in the CI Type Manager, the impact is 
propagating from the Business2 CI to Business1, the same direction as the 
physical relationship that is connecting the Running Software CI to 
Business2. 
123



Chapter 2 • Impact Modeling
According to the direction of the physical relationship between the Running 
Software CI and the Node, the Running Software CI should impact the 
Node. 

But based on the following impact rule, a calculated relationship is 
automatically created and HP Business Service Management reverses the 
impact of the propagation.

The impact is now propagated from the Node to the Running Software. 

Calculated Relationship Types

There is one out-of-the-box calculated relationship called Impacted By. 
Impacted By contains two subtypes, each one representing a different type 
of dependency relationship (complete dependency vs. potential 
dependency.)

➤ Impacted by (Directly). Represents the fact that one CI that is linked to 
another CI using an Impacted By (Directly) relationship is part of that CI. 
You use an Impacted By (Directly) relationship for those CIs that you 
want to see in your model. The ownership of the two CIs may be the 
same, but this is not always the case.

➤ Impacted By (Potentially). Represents the fact that one CI consumes the 
products of another. CIs that are linked by an Impacted By (Potentially) 
relationship are not part of that model, but are listed as related CIs. For 
details, see "Model Editor" on page 404.
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Creating Views Based on the Impact Model

As a best practice, you should use Modeling Studio to create a view of 
calculated relationships based on a model. Modeling Studio enables you to 
create perspective based views that use calculated relationships instead of 
physical relationships. For details, see "Modeling Studio" on page 343.

For details on how to create and edit models, see "Model Editor" on 
page 404.

Note: For an in-depth description of the Impact Modeling Solution, see 
"Best Practices for Modeling" on page 223.
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Create a URL for a Direct Link

This chapter includes:

Concepts

➤ Generate a Direct Link – Overview on page 128

Tasks

➤ How to Generate a Direct Link – Scenario on page 130

➤ How to Create a Direct Link to a Template with Parameter Values 
on page 130

➤ How to Encrypt the Password of a Direct Link Using the JMX Console 
on page 132

Reference

➤ Generate a Direct Link User Interface on page 133
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Concepts

Generate a Direct Link – Overview

Direct Links enables you to create a URL that guides another user to a 
specific target view or CI in HP Business Service Management.

You can create a URL that:

➤ Opens a specific HP Business Service Management view or CI directly 
in HP Business Service Management. This enables users to retrieve 
information from HP Business Service Management without being 
located in the HP Business Service Management context. 

Note: To open a specific view or CI directly in HP Business Service 
Management, use the Open in context links option. For details, see 
"Select Command Page" on page 135.

➤ Enables integration with HP Business Service Management:

If you create a URL using the Embedded links option, the URL takes 
you first to the HP Business Service Management login page. After you 
enter your login name and password, the target page opens in your 
browser.

Note: To open the target page in your browser, use the Embedded links 
option. For details, see "Select Command Page" on page 135.

When you create a URL, you can:

➤ Send the URL to an email recipient

➤ Copy the URL to the clipboard
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➤ Test the URL to ensure that the target application page can be found

The user to whom you are sending the URL must have an account with 
sufficient privileges to open the target page. You must apply the appropriate 
viewing and editing permissions to the users and user groups that want to 
access the target view. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, see 
"How to Assign Permissions" in Platform Administration.

Note: You can use Link to this Page function to open a target HP Business 
Service Management page in your browser. While the Link to this Page 
function enables you to access another application page in HP Business 
Service Management, it does not enable you to access a specific CI or view. 
For details, see "Linking to a Specific Page" in Platform Administration.
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Tasks

How to Generate a Direct Link – Scenario

This scenario describes how to generate a direct link to email the URL of a 
specific CI to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has 
encountered a problematic CI in a view she has created. She wants to inform 
Henry Jones, who is working with the same view through HP ServiceCenter, 
about the problematic CI. Since the view Jane has created contains many 
hundreds of CIs, she decides to email Henry the URL of the CI so that he 
does not have to spend a lot of time searching for that specific CI.

In IT Universe Manager, Jane selects Generate Direct Link from the Edit 
menu. In the Select Command page, she selects Open in context links and 
then the Show view option, and clicks Next. 

In the Direct Link Parameters — Show View page, she selects the view she 
created, the problematic CI, and View topology as the mode in which Henry 
should open the CI. When the URL is created, she emails Henry the link to 
the problematic CI.

For details, see "Generate Direct Link Wizard" on page 134.

How to Create a Direct Link to a Template with 
Parameter Values

This task describes how to create a direct link to a template by including the 
parameter values in the URL.

This task includes the following steps:

➤ "Create a Direct Link to a Template" on page 131

➤ "Edit the URL" on page 131

➤ "Paste the URL into a Browser" on page 131
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 1 Create a Direct Link to a Template

In IT Universe Manager, select Edit > Generate Direct Link to run the 
Generate Direct Link wizard. On the Select Command page, select 
Embedded links. Select Show view topology from the list of options. On 
the Direct Link Parameters page, select the required template from the 
drop-down list.

 2 Edit the URL

When the wizard finishes, click Copy URL and paste the URL into a text 
editor such as Notepad. 

Append the following text to the end of the URL: 

&params=[parameter1=value1,parameter2=value2]

where parameter1 and parameter2 are the parameter names for the 
selected template and value1 and value2 are the values you want to enter 
for the parameters.

Note: Any special characters must be entered using the URL encoding. In 
the above example, the URL encoding for the [ character is %5B, the URL 
encoding for the ] character is %5D, and the URL encoding for the comma 
is %2C. Thus, the actual text to enter is:

&params=%5Bparameter1=value1%2Cparameter2=value2%5D

 3 Paste the URL into a Browser

Paste the URL into a browser. HP Business Service Management opens to 
the selected template with the parameters assigned the specified values.
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How to Encrypt the Password of a Direct Link Using the 
JMX Console

This task describes how to encrypt the password contained within a direct 
link using the JMX console.

To encrypt the password of a direct link using the JMX console:

 1 Launch your Web browser and enter the following address: 
http://<server_name>:<port number>/jmx-console, where 
<server_name> is the name of the machine on which HP Universal 
CMDB is installed.

 2 Under UCMDB-UI, locate UCMDB Integration.

 3 Under encryptString, enter your password in the Value box.

 4 Click Invoke to view the encrypted string.
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Reference

Generate a Direct Link User Interface

This section includes (in alphabetical order):

 ➤ Generate Direct Link Dialog Box on page 133

 ➤ Generate Direct Link Wizard on page 134

Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can 
access HP Business Service Management.

To access From the Admin > RTSM Administration > Modeling 
main menu, select Edit > Generate Direct Link. After you 
configure the Direct Link parameters in the "Generate 
Direct Link Wizard" on page 134, click Finish in the 
Finish page.

Alternatively, click the Generate Direct Link to View  
button in the CI Selector toolbar in IT Universe Manager.

Relevant tasks "How to Generate a Direct Link – Scenario" on page 130
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User interface elements are described below:

Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific 
target view or CI in HP Business Service Management.

UI Element (A-Z) Description

Advanced Enables you to build a direct link and choose specific 
elements such as views or CIs, for the end user to access. 
For details, see "Generate Direct Link Wizard" on 
page 134.

Note: This feature is only relevant when accessing the 
Generate Direct Link dialog box from the CI Selector 
toolbar in IT Universe Manager.

Copy URL Copies the URL to the clipboard.

Description Describes the parameters that are included in the URL. 
For details on selecting the parameters, see "Select 
Command Page" on page 135.

Link URL The created URL that accesses the specified HP Business 
Service Management function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application 
page can be found.

To access From the Admin > RTSM Administration > Modeling 
main menu, select Edit > Generate Direct Link.

Important 
information

By default, this wizard is set to display a Welcome page. 
You can choose not to display the Welcome page by 
selecting the Do not show this page again check box.
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Select Command Page
This wizard page enables you to select the required parameters that must be 
added to the URL. 

You can create two types of links:

➤ Open in context links. Creates a URL that opens a specific view or CI 
directly in HP Business Service Management without having to be in the 
HP Business Service Management context:

➤ Embedded links. Creates a URL that enables you to embed an RTSM 
applet into external applications.

Relevant tasks "How to Generate a Direct Link – Scenario" on page 130

Wizard map The Generate Direct Link wizard contains:

Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page

Important 
information

By default, this wizard is set to display a Welcome page. 
You can choose not to display the Welcome page by 
selecting the Do not show this page again check box.

Wizard map The Generate Direct Link wizard contains:

Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page

See also "Generate Direct Link Wizard" on page 134
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Left pane> A graphic illustration of the selected command.

CII Grid Creates a URL that displays all the CI instances found in 
the RTSM for a selected CI type and its children. For 
details, see "Direct Link Parameters – CII Grid Page" on 
page 141.

Note: Available when you select the Embedded links 
option.

CI Selector Creates a URL that embeds the CI Selector displaying the 
CIs of a selected view, into external applications. For 
details, see "Direct Link Parameters – CI Selector Page" on 
page 139.

Note: Available when you select the Embedded links 
option.

CI Type Selector Creates a URL that embeds the CI type selector into 
external applications. For details, see "Direct Link 
Parameters – CI Type Selector Page" on page 139.

Note: Available when you select the Embedded links 
option.

Description A description of the selected command.

Impact Map Creates a URL that embeds an impact map into an 
external application. For details, see "Direct Link 
Parameters – Impact Map Page" on page 142.

Note: Available when you select the Embedded links 
option.

Model Editor Creates a URL that embeds the Model Editor into an 
external application, highlighting the selected CIs in the 
CI Selector in the Model Editor. For details, see "Direct 
Link Parameters – Model Editor" on page 143.

Note: Available when you select the Embedded links 
option.
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Query Editor Creates a URL that embeds the Model Editor into an 
external application, displaying the selected TQL query. 
For details, see "Direct Link Parameters – Query Editor" on 
page 144.

Note: Available when you select the Embedded links 
option.

Related CIs Creates a URL that opens a topology map displaying the 
selected CI and its immediate neighbors within the 
selected view. For details, see "Direct Link Parameters – 
Related CIs Page" on page 145.

Note: Available when you select the Embedded links 
option.

Report Viewer Creates a URL that opens a specific report. For details, see 
"Direct Link Parameters – Report Viewer Page" on 
page 146.

Note: Available when you select the Embedded links 
option.

Report Viewer - 
Saved Report

Creates a URL that opens a saved topology or custom 
report. For details, see "Direct Link Parameters – Report 
Viewer – Saved Report Page" on page 146.

Note: Available when you select the Embedded links 
option.

Show CI properties Creates a URL that displays a CI’s properties. For details, 
see "Direct Link Parameters – Show CI Properties Page" on 
page 147.

Note: Available when you select the Embedded links 
option.

Show view Creates a URL that displays the selected view and 
optionally preselects a query node in it. For details, see 
"Direct Link Parameters – Show View Page" on page 150.

Note: Available when you select the Open in context links 
option.

UI Element (A-Z) Description
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Show view topology Creates a URL that displays the topology map of the 
selected view and embeds it in an external application. 
For details, see "Direct Link Parameters – Show View 
Topology Page" on page 148.

Note: Available when you select the Embedded links 
option.

Start in mode Creates a URL that opens HP Business Service 
Management at the selected page. For details, see "Direct 
Link Parameters – Start in Mode Page" on page 151.

Note: Available when you select the Open in context links 
option.

Steps The current step in the procedure.

View Editor Creates a URL that opens a specific view in the Pattern 
View Editor in Modeling Studio. For details, see "Direct 
Link Parameters – View Editor Page" on page 148.

Note: Available when you select the Embedded links 
option.

Views Selector Creates a URL that embeds the View Selector in an 
external application, enabling you to select and display a 
view in that application. For details, see "Direct Link 
Parameters – Views Selector Page" on page 149.

Note: Available when you select the Embedded links 
option.

UI Element (A-Z) Description
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Direct Link Parameters – CI Selector Page
This wizard page enables you to create a URL that embeds the CI Selector 
displaying the CIs of a selected view, into external applications.

User interface elements are described below:

Direct Link Parameters – CI Type Selector Page
This wizard page enables you to create a URL to a hierarchical tree or list of 
selected CI types, which can be embedded into an external application.

Wizard map Select Command Page (Embedded links > CI Selector) > 
Finish Page

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

UI Element (A-Z) Description

Allow multi selection Allow single or multiple selection of CIs.

Selected view Select the required view from which you want to select 
the required CIs.

➤ Click  to open the View Selector dialog box. Select 
the view you want to appear in the CI Selector.

➤ Click  to delete the selected view. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > CI Type 
selector) > Finish Page
139



Chapter 3 • Create a URL for a Direct Link
User interface elements are described below:

UI Element (A-Z) Description

CI type selector 
mode

View the selected CI types in either a hierarchical tree or 
list.

Invisible CITs (tree 
only)

Select the CI types you do not want to appear in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types you want to appear in the tree.

➤ Click  to delete the selected CI types. 

Root CI Type (tree 
only)

Select the CI type you want to use as the root CI type in a 
hierarchical tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI type you want to use as the root CI type 
in the tree. 

➤ Click  to delete the selected CI type. The default is 
Configuration Item.

Selection mode Allow single or multiple selection of CI types.

Unselectable CITs 
(tree only)

Select the CI types which cannot be selected in the tree.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which cannot be selected in the 
tree.

➤ Click  to delete the selected CI types. 

Visible CITs (list only) Select the CI types which you want to appear in the CI 
type list.

➤ Click  to open the CI Type Selector dialog box. 
Select the CI types which you want to appear in the CI 
type list.

➤ Click  to delete the selected CI types. 

Note: If you choose to view the CITs in a list, then you 
are required to select at least one CI type.
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Direct Link Parameters – CII Grid Page
This wizard page enables you to display all of the CI instances found in the 
RTSM for selected CI type, and its children.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > CII Grid) > 
Finish Page

See also "Element Instances Dialog Box" on page 82

UI Element (A-Z) Description

Class type Select the required CI type. 

➤ Click  to select the required CI type. 

➤ Click  to clear the box. 
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Direct Link Parameters – Impact Map Page
This wizard page enables you to run an Impact Analysis rule defined in 
Impact Analysis Manager. The URL you create enables you to embed a 
topology map showing a simulation of all the CIs that are affected by the 
selected trigger CI for the selected severity and state. For details, see "Run 
Impact Analysis Dialog Box" on page 302.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Impact map) 
> Finish Page

See also "IT Universe Manager" on page 235

UI Element (A-Z) Description

Filter by CI types Select the CI types you do not want to appear in the 
impact analysis results.

➤ Click  to select the required CI types.

➤ Click  to delete the selected CI types. 

Rule bundle Enables you to define where you can run Impact Analysis 
rules.
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Direct Link Parameters – Model Editor
This wizard page enables you to embed the Model Editor into an external 
application, highlighting the selected CIs in the CI Selector in the Model 
Editor.

Severity Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the 
System Type Manager. For details, see "System Type 
Manager" on page 488.

For example, you can create an Impact rule in the Impact 
Analysis Manager (see the "Impact Rules Definition 
Dialog Box" on page 476), that defines the severity of the 
trigger query node as other than No Change. If you select 
a severity other than No Change, for example, Plan, the 
condition is met and the simulated changes in the system 
are triggered.

For details, see "Run Impact Analysis Dialog Box" on 
page 302.

Trigger CIs ➤ Click  to select the CIs that are used as the triggers 
in an impact map. These CIs represent the simulated 
changes to be made to the system. Opens the CI 
Selector dialog box. For details on how to use the CI 
Selector pane, see "CI Selector" on page 173.

➤ Click  to delete the selected CIs. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Model Editor) 
> Finish Page

See also "Business CI Models" on page 354

UI Element (A-Z) Description
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User interface elements are described below:

Direct Link Parameters – Query Editor
This wizard page enables you to embed the Model Editor into an external 
application, displaying the selected TQL query.

User interface elements are described below:

UI Element (A-Z) Description

Model name Select the model you want to display in the Model Editor.

➤ Click  to open the Select Model dialog box. Select 
the model you want to appear in the Model Editor.

➤ Click  to delete the selected model. 

Selected CI in search Select the CIs you want to appear highlighted in the CI 
Selector in the Model Editor.

➤ Click  to open the CI Selector.

➤ Click  to delete the selected CIs. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Query Editor) 
> Finish Page

See also "Business CI Models" on page 354

UI Element (A-Z) Description

Query name Select the model you want to display in the Model Editor.

➤ Click  to open the Select Query dialog box. Select 
the query you want to appear in the Model Editor.

➤ Click  to delete the selected query. 
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Direct Link Parameters – Related CIs Page
This wizard page enables you to embed into an external application, a 
topology map that displays a specific CI, and all the CIs that are linked to it 
by a distance of no more than one relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Related CIs) > 
Finish Page

UI Element (A-Z) Description

CIs Select the CI type you want to appear in the topology 
map. 

➤ Click  to select the required CI types. Opens the CI 
Selector dialog box.

➤ Click  to delete the value in the CIs box. 

Filter by CI types Restrict the results of the topology map to related CIs of 
one or more CI types.

➤ Click  to select the required CI types.

➤ Click  to delete the value in the Filter by CI types 
box. 

Restrict to view Restrict the results of the topology map to related CIs 
from a specific view.

➤ Click  to select the required view. Opens the View 
Selector dialog box.

➤ Click  to delete the selected view in the Restrict 
results to view box.
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Direct Link Parameters – Report Viewer Page
This wizard page enables you to create a URL that opens a specific report. 

User interface elements are described below:

Direct Link Parameters – Report Viewer – Saved Report 
Page
This wizard page enables you to create a URL that opens a saved topology or 
custom report. 

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Report 
Viewer) > Finish Page

UI Element (A-Z) Description

Report type Select the required report type. For information about the 
different report types, see "Reports" on page 311.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Report Viewer 
- Saved Report) > Finish Page
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User interface elements are described below:

Direct Link Parameters – Show CI Properties Page
This wizard page enables you to view basic information for an existing CI.

User interface elements are described below:

UI Element (A-Z) Description

Report Select the required saved report. 

➤ Click  to open the Select Report dialog box. Select 
the required topology or custom report.

➤ Click  to delete the selected report. 

For information about saved reports, see "Reports" on 
page 311.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Show CI 
properties) > Finish Page

See also "Configuration Item Properties Dialog Box" on page 273

UI Element (A-Z) Description

Source CI object ID Select the required CI.

➤ Click  to select the source CI and retrieve its object 
ID. Opens the Select Source CI dialog box. For details, 
see "CI Selector" on page 173.

➤ Click  to delete the value in the Source CI object ID 
box. 
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Direct Link Parameters – Show View Topology Page
This wizard page enables you to display the topology map of the selected 
view and embed it in an external application.

User interface elements are described below:

Direct Link Parameters – View Editor Page
This wizard page enables you to create a URL that opens a specific view in 
the Pattern View Editor in Modeling Studio.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Show view 
topology) > Finish Page

UI Element (A-Z) Description

Show topology of 
view

➤ Click  to select the required view to be opened by 
the URL. Opens the View Selector dialog box.

➤ Click  to delete the selected view in the Show 
topology of view box.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > View Editor) > 
Finish Page

See also "Building a Business View" on page 347
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User interface elements are described below:

Direct Link Parameters – Views Selector Page
This wizard page enables you to embed into an external application, the View 
Selector, that enables you to select, and display a view in that application.

UI Element (A-Z) Description

View name ➤ Click  to select the required view to be opened by 
the URL. Opens the View Selector dialog box.

➤ Click  to delete the selected view in the View name 
box.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Embedded links > Views 
Selector) > Finish Page

See also "Building a Business View" on page 347
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Direct Link Parameters – Show View Page
This wizard page enables you to create a URL to a specific view and 
optionally select a specific query node in that view. When the view opens, 
the CI you chose is selected in the view. The view opens in IT Universe 
Manager.

User interface elements are described below:

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Open in context links > Show 
view) > Finish Page

UI Element (A-Z) Description

<Left pane> A graphic illustration of the selected option.

Advanced pane 
(visibility)

Hide or display the Advanced pane in IT Universe 
Manager.

Select CI from view 
result

(Optional) Selects a CI and retrieve its object ID. When 
the view opens, the CI you chose is selected in the view.

➤ Click  to choose the CI you want selected in the 
target view and retrieve its object ID. Opens the Select 
CI dialog box. For details, see "CI Selector" on 
page 173.

➤ Click  to delete the object ID for the selected CI in 
the Select CI from view result box.
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Direct Link Parameters – Start in Mode Page
This wizard page enables you to start the RTSM application at the selected 
page, for example, in the Modeling Studio page.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Selected View The target view to be opened by the URL.

➤ Click  to select the target view to be opened by the 
URL. Opens the Select View dialog box.

➤ Click  to delete the selected view in the Selected 
view box.

View mode The view options are:

➤ View Topology. Displays an entire layer within a view.

➤ Related in View. Displays the selected CI and its 
immediate neighbors within the current view.

➤ Related in CMDB. Displays the selected CI and its 
immediate neighbors in the RTSM.

Important 
information

➤ For general information about the Generate Direct 
Link wizard, see "Generate Direct Link Wizard" on 
page 134.

➤ Click Finish to close the wizard and create a URL. For 
details, see "Generate Direct Link Dialog Box" on 
page 133.

Wizard map Select Command Page (Open in context links > Start in 
mode page) > Finish Page

UI Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the RTSM application in the selected mode.

UI Element (A-Z) Description
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Finish Page
This is the final page of the Generate Direct Link wizard. Click Finish to close 
the wizard and create a URL. Opens the Generate Direct Link dialog box.

Important 
information

For general information about the Generate Direct Link 
wizard, see "Generate Direct Link Wizard" on page 134.

Wizard map Select Command Page (<Open in context links options> 
and <Embedded links options>) > Finish Page
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Embedding RTSM Applets Using Direct 
Links

This chapter includes:

Concepts

➤ Using the Direct Link Functionality to Embed RTSM Applets on page 154

➤ RTSM Applet Tag – Overview on page 155

Reference

➤ Direct Link Operation Flow on page 157

Note: This chapter is relevant to integration developers only.
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Concepts

Using the Direct Link Functionality to Embed RTSM 
Applets

You can directly embed RTSM applets into external applications using a 
direct link. A direct link is a URL that you create using the Direct Links 
wizard. For details, see "Generate Direct Link Wizard" on page 134.

You can embed RTSM applets in the following ways:

➤ Using the URL itself to display RTSM content in an external application. 
For example, you can create a URL in the Direct Links wizard to display 
the properties of a certain CI. The login page opens if you are not already 
logged into HP Business Service Management or if Lightweight Single 
Sign-On Authentication Support (LW-SSO) is not enabled for HP Business 
Service Management.

Note: Using the URL to enable the integration requires opening the link 
in an IFrame or a new window. This does not allow you to manage the 
resulting RTSM applet using Javascript due to cross-site scripting issues. 
For example, if you use a URL that displays the properties of a specific CI 
using the object ID, you cannot use the same URL to display the 
properties of another CI.

➤ Using the RTSM applet tag to embed the RTSM applet in an external 
application. This enables integration developers to display a part of the 
HP Business Service Management user interface as part of their own 
application. In addition, this enables interaction with the embedded 
HP Business Service Management user interface using Javascript.
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RTSM Applet Tag – Overview

The RTSM Applet tag creates the environment needed for the RTSM applet 
to run (HTML, Javascript, and server session parameters). The code behind 
the tag can log into the HP Business Service Management server in one of 
the following cases:

➤ The login parameters are specified and the user is not already logged in 
(or if Lightweight Single Sign-On Authentication Support (LW-SSO) is not 
enabled for HP Business Service Management).

➤ The clear session parameter is true. 

Once a user session is established, the tag continues to write the required 
applet environment (HTML and Javascript code) to the result of the JSP 
processor. The resulting HTML page includes the required Javascript code to 
load the RTSM applet from the specified server. On error, the specified error 
string is printed to the page. This string can be customized using the 
userErrorMessage parameter and may include HTML elements and HTML 
wrapped Javascript code to initiate error handling scenarios.

Example of the Usage of an RTSM Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://labm3mam17.devlab.ad:8080"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"
userPassword="password"
customerId="1"
encoded="false"
printDebugLogs="true"
userErrorMessage="This is your general error"
navigation="false"
clearSessionCookies="false"
command="ShowCISelector"/>
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Caution: You retrieve the directLinkParameters from the URL created in the 
Direct Links wizard. Insert the values for each parameter in the tag as 
displayed. If the URL contains values for parameters not displayed above, 
copy them into the directLinkParameters line of the tag.  For details on how 
to create a direct link, see "Generate Direct Link Wizard" on page 134.

The RTSM applet tag is located at <HP Business Service 
Management>\odb\deploy\ucmdb-ui\WEB-INF\tags\ucmdb_applet.tag 
on the Gateway Server machine. 

You can copy the RTSM applet tag to an external application server. The 
RTSM applet tag requests the login data from the HP Business Service 
Management server provided that:

➤ The external application server can communicate with JSP tags.

➤ The HP Business Service Management server is accessible to the 
external application server and to the browser.
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Reference

Direct Link Operation Flow

This section describes different scenarios in which direct links are used to 
embed RTSM applets into external machines.

This section includes the flow descriptions:

➤ "Regular Login" on page 158

➤ "An Embedded RTSM Applet Using a Direct Link URL" on page 160

➤ "An Embedded RTSM Applet Using an RTSM Applet Tag" on page 162
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Regular Login
This flow describes a regular login to the HP Business Service Management 
server. It serves as a base reference for the direct link flows.  

 1 The user enters the direct link URL (into the browser) to log into the 
HP Business Service Management server.

 2 The browser sends the login request to the HP Business Service 
Management server.

 3 The server checks the user credentials and creates a user session if 
required.

 4 The server returns the requested first page of HP Business Service 
Management. 
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Note: This can be any page. For this flow, we assume that it is the Admin > 
RTSM Administration > Modeling page in which the RTSM applet is 
loaded. 

 5 The browser loads the Java virtual machine (JVM) with the code base 
location parameter (which instructs the JVM from where to load the 
RTSM applet files) as the HP Business Service Management server.

 6 RTSM applet files (jars) and data are transferred between the HP Business 
Service Management server and the JVM loaded in the browser.

At this point, the RTSM applet is loaded and regards HP Business Service 
Management as the server with which it should communicate.
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An Embedded RTSM Applet Using a Direct Link URL
This flow shows how to use the direct link to open an RTSM applet (opened 
to a specified context) in a new browser frame. 

 1 The external application has a page that needs to show the RTSM applet.

 2 The returned page includes a directive to open the direct link in an 
IFrame or new browser window.

 3 The browser opens a new frame (IFrame or new window) with the direct 
link as the frame URL.

 4 The new frame sends the direct link to the HP Business Service 
Management server.
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 5 If the user is not already logged into HP Business Service Management, or 
if Lightweight Single Sign-On Authentication Support (LW-SSO) is not 
enabled for HP Business Service Management, HP Business Service 
Management displays the login page and waits for the user to enter 
credentials and click the login button.

 6 The user session is created, if required.

 7 The HP Business Service Management server returns a page that includes 
the directive to load the RTSM applet.

 8 The browser processes the page. When the browser encounters the 
directive to load the RTSM applet, it starts the JVM. The browser then 
passes the needed parameters to the JVM, including the HP Business 
Service Management server location as "code base."

 9 RTSM applet files (jars) and data are transferred between the HP Business 
Service Management server and the JVM loaded in the browser.

Caution: The HP Business Service Management server must be accessible 
from the browser machine. 
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An Embedded RTSM Applet Using an RTSM Applet Tag
This flow shows how to use the RTSM applet tag in conjunction with direct 
links to embed the RTSM applet (opened to a specified context) in an 
external application page. 

 1 The RTSM applet tag is included in the processed JSP in the external 
application.

 2 The RTSM applet tag uses the parameters given to it to create an HTTP/
HTTPS connection to the HP Business Service Management server and 
requests the applet HTML snippet code.

 3 If the user is not already logged in, the parameters from the RTSM applet 
tag are used (see the tag itself for reference information regarding this 
step). If login fails, the RTSM applet tag returns an error message, either 
the preset one or the one specified in the RTSM applet tag parameters.
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 4 The HP Business Service Management server returns the HTML snippet 
code (with embedded Javascript) that loads the RTSM applet. The external 
application can now incorporate this snippet code into the page, and 
send the page to the browser. 

 5 The external application sends the complete page that includes the HTML 
snippet code to the browser.

 6 The browser processes the page. When the browser encounters the HTML 
snippet code that loads the RTSM applet, the JVM is started. The browser 
then passes the needed parameters to the JVM, including the HP Business 
Service Management server location as "code base".

 7 RTSM applet files (jars) and data are transferred between the HP Business 
Service Management server and the JVM loaded in the browser.

Caution: The HP Business Service Management server must be accessible 
from the browser machine as well as the external application machine.
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5
Working with the CI Selector

This chapter includes:

Concepts

➤ CI Selector Overview on page 166

Tasks

➤ How to Display a View in Browse Mode on page 167

➤ How to Search for CIs in Search Mode on page 167

➤ How to Modify CI Selector Display Options on page 169

Reference

➤ CI Selector User Interface on page 171

Troubleshooting and Limitations on page 184
165



Chapter 5 • Working with the CI Selector
Concepts

CI Selector Overview

Note: The CI Selector was known as View Explorer in earlier versions of HP 
Business Service Management.

The CI Selector presents the elements of the IT universe model in HP 
Business Service Management through the medium of views. HP Business 
Service Management displays the CI Selector in the left pane of IT Universe 
Manager and the Modeling Studio.

When you select a view in the CI Selector, the configuration items (CIs) 
contained in the view are displayed in a hierarchical tree format according 
to the relationships defined between the CIs. A view may be empty if no CIs 
were found matching the TQL query. For details on views, see "View 
Formats" on page 346.

You can use the CI Selector to select views and to locate CIs. You can select a 
view and browse through the list of CIs, or you can search for a specific CI 
by name or by CI type. You can also save the search criteria for future use.

For information on the components of the CI Selector, see "CI Selector User 
Interface" on page 171.
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Tasks

How to Display a View in Browse Mode

When the CI Selector is set to Browse mode, you can display the contents of 
a selected view. For details on the CI Selector user interface in Browse mode, 
see "Browse Views Mode" on page 173.

This task includes the following steps:

➤ "Prerequisites" on page 167

➤ "Select a View to Display" on page 167

 1 Prerequisites

In the CI Selector pane, select Browse Views mode. 

 2 Select a View to Display

Click the ellipsis button to open the View Selector dialog box and select 
the view you want to display. The name of the selected view is shown in 
the View box. The CIs in the view appear in the CI tree in the lower part 
of the CI Selector pane. The view remains selected when you move to 
other applications in HP Business Service Management.

How to Search for CIs in Search Mode

The CI Selector search tool enables you to locate a specific CI. The search is 
executed on the entire RTSM.  For details on the CI Selector search tool user 
interface, see "Search CIs Mode" on page 177.

This task includes the following steps:

➤ "Prerequisites" on page 168

➤ "Search by CI Name" on page 168

➤ "Search by Configuration Item Type" on page 168
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➤ "Run the Search and Sort the Results" on page 169

➤ "Run an Advanced Search" on page 169

Prerequisites

In the CI Selector pane, select Search CIs mode and select the Simple tab.

Search by CI Name

To search for CIs by name, enter a string in the CI Name box, representing 
the name of the CI, or part of the name. The search returns all CIs that 
contain the entered string somewhere in their names (within the 
boundaries of the other search criteria that you define).

Note: The search by CI name option is not case sensitive.

Search by Configuration Item Type

You can search for CIs using the CI Type box. This search returns CIs of the 
type specified in the CI Type box.

Click the ellipsis button and select the required CI type. You cannot 
manually enter a CIT in the CI Type box. 

After defining a CI in the CI Type box, HP Business Service Management 
remembers your selection until you move to a different application, or until 
you define a different value.
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Run the Search and Sort the Results

Run the search. The results appear in the lower part of the CI Selector pane, 
showing the CI name and type for each entry. You can sort the search results 
by clicking the appropriate heading.

When you select the required CI from the results list, the right pane displays 
details for the CI you selected, in the context in which you are working. To 
see a CI in the context of its view, right-click the CI and select Locate CI in 
View. The CI Selector reverts to Browse mode and displays the view that 
contains the CI, with the CI selected in the view tree.

When you select a CI in the search results, the CI appears in the topology 
map with its related CIs in the RTSM.

Optionally, save the search criteria by clicking the Save button and entering 
a name for the search. For details, see "Save Search Criteria Dialog Box" on 
page 183.

Run an Advanced Search

You can select the Advanced tab for other search options. For details on the 
CI Conditional search, see "CI Conditional Search Dialog Box" on page 171. 
For details on the Running Software search, see "Running Software Search 
Dialog Box" on page 182.

How to Modify CI Selector Display Options

You can modify the display options for the CI Selector. These options are 
configured in the Infrastructure Settings Manager. 

Caution: Modifying certain settings in the Infrastructure Settings Manager 
can adversely affect the performance of HP Business Service Management. 
Do not modify settings without first consulting HP Software Support or your 
HP Professional Services representative. 
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This task includes the following steps:

➤ "Prerequisites" on page 170

➤ "Modify Selected Settings" on page 170

 1 Prerequisites

Access the Infrastructure Settings Manager by selecting Admin > 
Platform > Setup and Maintenance > Infrastructure Settings. 

 2 Modify Selected Settings

The following settings under RTSM - General properties can be modified:

➤ Immediate Children Count. Number of children immediately 
displayed when expanding their parent’s query node in the CI Selector.

➤ Maximal Children Count. Maximum number of children displayed 
under their parent’s query node in the CI Selector.

➤ Maximal search results size. Maximum number of CMDB instances 
that can be returned in one search operation.

➤ Recently Used Views List size. Maximal number of recently used views 
to store per user.
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Reference

CI Selector User Interface

This section includes (in alphabetical order):

 ➤ CI Conditional Search Dialog Box on page 171

 ➤ CI Selector on page 173

 ➤ Organize Searches Dialog Box on page 181

 ➤ Running Software Search Dialog Box on page 182

 ➤ Save Search Criteria Dialog Box on page 183

CI Conditional Search Dialog Box

This dialog box enables you to search for CIs by attribute conditions, by 
related CIs, and by attribute conditions of related CIs.

User interface elements are described below:

To access In the CI Selector, select the Advanced tab in Search 
mode and click the ellipsis button next to CI Conditional 
Search.

UI Element (A-Z) Description

Adds an attribute condition.

Deletes a selected row.

Moves a selected row up.

Moves a selected row down.
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Displays a preview of the attribute condition list.

Attribute name Select an attribute from the drop-down list.

CI Name Enter a CI name for which to search.

CI Type Enter the CI type for which to search.

Operator Select an operator from the drop-down list.

Related CI Name Enter the name of a related CI for the search.

Related CI Type Click the ellipsis  button to select a CI type from the 
tree for a search by related CI.

Relationship Type Click the ellipsis  button to select a relationship from 
the tree for a search by related CI.

Search by CI 
conditions

Select to run a search for CIs with the specified 
conditions.

Search by related CI 
conditions

Select to run a search for CIs related to CIs with the 
specified conditions.

Search by related CI 
criteria

Select to run a search for CIs related to the specified CIs 
or CI types.

Value Enter a value for the attribute condition.

UI Element (A-Z) Description
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CI Selector

This feature enables you to select views and to locate CIs.

Browse Views Mode

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Appears in the left pane of the IT Universe Manager page 
and the Modeling Studio.

Important 
information

The CI Selector consists of two functional formats: 
Browse Views mode and Search CIs mode.

➤ In Browse Views mode, you can search for and display 
a view, and browse through the view to locate a 
particular CI. You can also perform operations on the 
CI from a shortcut menu. 

➤ In Search CIs mode you can search for one or more 
CIs in the RTSM by name or by CI type. 

Note: Many of the features of the CI Selector are only 
relevant in the RTSM and not in other HP Business 
Service Management modules.

Relevant tasks "How to Display a View in Browse Mode" on page 167

"How to Search for CIs in Search Mode" on page 167

UI Element (A-Z) Description

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

Show Template Parameters. Opens the Template 
Parameter Values dialog box, which enables you to edit 
the parameters of the selected template.

Note: This button is only active when a template is 
selected.

Add selected CIs to model/view. Adds the selected CIs to 
the current model or view.

Note: This button only appears in the Modeling Studio.
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Add to model as related CIs. Adds the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

Open selected model in a new tab. Opens the selected 
model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Show models containing selected CI. Displays a list of 
models containing the selected CI.

Note: This button only appears in the Modeling Studio.

In IT Universe Manager, this represents Show View 
Definition, which takes you directly to the view 
definition in the Modeling Studio for the current view.

In the Modeling Studio, this represents Open selected 
view, which opens the selected view in the Editor pane.

Show views containing selected CI/model. Displays a 
list of views containing the selected CI or model.

Note: This button only appears in the Modeling Studio.

Generate view for selected model. Opens the Creating 
New View dialog box which enables you to build a view 
based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Show Discovery and Changes Summary. Rediscovers all 
the CIs in a selected view by manually starting the DFM 
jobs that originally discovered them. For details, see 
"Show Discovery Status and Changes Dialog Box" on 
page 306.

Note: This button only appears in IT Universe Manager.

Generate Direct Link to View. Creates a direct link to the 
view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager.

UI Element (A-Z) Description
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Choose the export format for the browse results. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable 
number of columns to display to ensure that the 
report is legible. 

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. 

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

UI Element (A-Z) Description
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Click the Snapshot button to work with snapshots. The 
following options are available:

➤ Save Snapshot. Select to open the Save Snapshot 
dialog box, which enables you to save a snapshot of 
the view. For details, see "Save Snapshot Dialog Box" 
on page 304.

➤ Compare Snapshots. Select to run the Compare 
Snapshots Report. For details, see "Compare 
Snapshots Report" on page 326.

➤ Schedule Snapshot. Select to open the Schedule Job 
dialog box. For details, see "Schedule Snapshot Dialog 
Box" on page 335.

➤ Show Scheduled Snapshot Jobs. Select to open the 
Job List dialog box. For details, see "Job List Dialog 
Box" on page 333.

Note: This button only appears in IT Universe Manager.

View Based Report. Displays the topology report for the 
selected view.

Note: This button only appears in IT Universe Manager.

Asset Report. Opens the Asset report for the selected 
view. For details, see "Asset Report" on page 319.

Note: This button only appears in IT Universe Manager.

Click the ellipsis button to the right of the View box, to 
open the View Selector dialog box. You can browse 
through the folder tree to locate the view you want to 
display.

Enables you to move to the next or previous result of the 
search for the string entered in the Find box.

<CIs> The CIs contained in the currently selected view.

<Tooltip> Hold the cursor over a CI to display a tooltip with the 
relevant CI type.

UI Element (A-Z) Description
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Search CIs Mode

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the CI tree. 

View The View box displays the currently selected view. To 
select a view to display, click the down arrow on the 
right side of the View box; this displays an abridged list 
of views, containing the most recently accessed views. 
Click the arrow at the bottom of the list to scroll 
through the entire list. The recently accessed views 
appear at the top of the drop-down, above the dividing 
line. The complete list of views appears below the line.

Alternatively, place the cursor in the list and begin 
typing the view name. If the first few letters that you 
type match an existing entry, HP Business Service 
Management completes the view name. If the names of 
several views begin with those letters, all matching 
views are displayed in the list.

Note: If the selected view in the View box fails to load, 
the value in the View box is set to the default (empty) 
selection.

UI Element (A-Z) Description

Show Search Results in Table. Opens a separate pane 
with a table of the CIs in the search results.

Note: This button only appears in IT Universe Manager.

Add selected CIs to model/view. Adds the selected CIs to 
the current model or view.

Note: This button only appears in the Modeling Studio.

UI Element (A-Z) Description
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Add to model as related CIs. Adds the selected CI to the 
model as a related CI.

Note: This button is only active in the Model Editor of 
the Modeling Studio.

Open selected model in a new tab. Opens the selected 
model in the Model Editor.

Note: This button is only active when a model is 
selected in the Modeling Studio.

Show models containing selected CI. Displays a list of 
the models containing the selected CI.

Note: This button only appears in the Modeling Studio.

Show views containing selected CI/model. Displays a 
list of the views containing the selected CI or model.

Note: This button only appears in the Modeling Studio.

Generate view for selected model. Opens the Creating 
New View dialog box which enables you to build a view 
based on the selected model.

Note: This button is only active when a model is 
selected in the Modeling Studio.

UI Element (A-Z) Description
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Choose the export format for the search results. The 
available options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable 
number of columns to display to ensure that the 
report is legible. 

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed 
in a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. 

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file

Opens the Organize Searches dialog box, where you can 
edit or delete searches from the list of saved searches.

Collapses or expands the search criteria area.

Runs the search. The search results are displayed in the 
lower part of the CI Selector pane. 

Saves the current search criteria for future use.

Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

UI Element (A-Z) Description
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<Search results> After you run the search, the results are listed in the 
lower part of the CI Selector pane. The results are shown 
in two columns:

➤ Name. Contains the name of the CI.

➤ CI Type. Contains the CI type of the CI.

If the CI or view name is abbreviated, hold the pointer 
over the entry to see the full name. You can sort the 
search results by clicking the appropriate heading.

Advanced tab The following detailed search options are available:

➤ CI Conditional Search. Enables you to search for CIs 
by attribute conditions, by related CIs, and by 
attribute conditions of related CIs.

➤ Running Software Search. Enables you to search for 
hosts by the applications running on them and for 
applications by the host on which they are running.

For each of the searches, click the ellipsis  button to 
open the search dialog box. After running a search, click 
the Save  button to save the search for future use.

CI Name To search for a CI by name, enter the name of the CI for 
which to search.

CI Type To search for CIs by CI type, click the ellipsis button to 
select a CI from the Select Configuration Item Type 
dialog box.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the search results.

Searches Select a search from the drop-down list of saved 
searches.

Search results count The Search results count below the Find box displays the 
total number of CIs found in the search.

Simple tab The Simple tab includes the standard search 
functionality. Click the Advanced tab for more detailed 
search options.

UI Element (A-Z) Description
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Shortcut Menu Options

Organize Searches Dialog Box

This dialog box enables you to edit or delete searches from the list of saved 
searches.

Menu Item Description

<IT Universe Manager 
shortcut menu 
options>

The regular shortcut menu for the topology map in 
IT Universe Manager is also available from the CI 
Selector. For details on the menu options, see 
"IT Universe Manager Shortcut Menu" on page 289.

Add Adds the selected CI to the current model or view.

Note: This feature only appears in the Modeling Studio.

Add to model as 
related CIs

Adds the selected CI as a related CI to the current model.

Note: This feature only appears in the Modeling Studio.

Generate view for 
selected model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Open selected model 
in a new tab

Opens the selected model in a new tab in the Model 
Editor.

Note: This feature only appears in the Modeling Studio.

Show containing 
models

Select Show models containing selected CI to display a 
list of the models containing the selected CI.

Note: This option only appears in the Modeling Studio.

Show containing 
views

Select Show views containing selected CI/model to 
display a list of the views containing the selected CI or 
model.

Note: This option only appears in the Modeling Studio.

To access Click the Manage the list of saved searches  button 
in the CI Selector.
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User interface elements are described below:

Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running 
on them and for applications by the host on which they are running.

UI Element (A-Z) Description

Edits the selected search. For simple searches, the CI 
Simple Search dialog box opens, which enables you to 
edit the name and type of the CI. For CI Conditional 
searches, the CI Conditional Search dialog box opens.

Deletes the selected search.

Expands the search tree.

Collapses the search tree.

<Searches tree> Displays all the saved searches in tree format.

Find Enter a search name or a portion of a search name in the 
Find box to locate it in the list.

Find Next Goes to the next occurrence of the selected search phrase 
in the list.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the list.

To access In the CI Selector, select the Advanced tab in Search 
mode and click the ellipsis button next to Running 
Software Search.
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User interface elements are described below:

Save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

User interface elements are described below:

UI Element (A-Z) Description

Host name Enter the name of the node for which you are searching.

Running Software Select a running software CI from the drop-down list.

Note: The drop-down list may not display an accurate list 
of available running software CI types (only the option 
Any appears). In this event, perform the Host name 
search only.

Search for Select Running Software or Node.

Note: To search for a running software CI running on a 
specific node, enter a node name, select the required 
running software CI and search for it.

To access Click the Save  button from Search mode in the CI 
Selector.

UI Element (A-Z) Description

Existing Queries Displays a list of existing searches in tree format.

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the 
Find box to locate it in the list.

Find Next Goes to the next occurrence of the selected search phrase 
in the list.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the list.
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Troubleshooting and Limitations

This section describes troubleshooting and limitations for the CI Selector.

Unavailable Views and CIs
The View list in the CI Selector may not display all views in the RTSM, or it 
may not display the contents of a view, for any of the following reasons:

➤ The View list includes only the views for which you have the necessary 
permissions. Similarly, Search mode is only available if you have CI 
Search permission. To set permissions, select Admin > Platform > Users 
and Permissions, select a user or a group and select Permissions. For more 
information, see "How to Assign Permissions" in Platform Administration.

➤ Views that are currently inactive appear in red in the View list, but they 
cannot be selected. In IT Universe Manager, inactive views appear in 
faded text.

➤ Out-of-the-box views for which you do not have a license may appear in 
the View list, but these views do not contain CIs. For information on the 
out-of-the-box views, see "Predefined Folders and Views" on page 351.

Note: After deleting one or more query nodes from a TQL query, it can take 
time for changes to be updated to the view; meanwhile, the removed CIs 
appear in the view. If you select one of these CIs before it is updated, an 
error message is displayed. Click the Refresh button to update the view.
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Working with Topology Map

This chapter includes:

Concepts

➤ Topology Map Overview on page 186

➤ Handling Large Views on page 187

Reference

➤ Topology Map User Interface on page 188
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Concepts

Topology Map Overview

The Topology Map provides a graphical display of a view. All the CIs in a 
given layer of the view are represented by icons and the connecting lines 
represent relationships. You can select a CI in the Topology Map or in the CI 
Selector in the left pane. You can also drill down in the CI Selector to display 
different layers of the view in the Topology Map.

The label of a CI appears under the icon. You can set the maximum number 
of characters per line and the maximum number of lines in a CI label in the 
User Preferences dialog box under General. For details, see "User Preferences 
Dialog Box" on page 113.

If a CI icon appears with a downward arrow icon in the Topology Map, there 
is an additional CI layer beneath it, created by the hierarchy set for the view. 
You can click the arrow to display the CIs contained in the sublayer.

The topology map is automatically updated dynamically with changes in 
the IT Universe data, such as new CIs discovered by the Data Flow 
Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom 
in, change the layout of the Topology Map, and print the Topology Map. 
Additional functionality is available from the shortcut menu by right-
clicking a CI in the Topology Map or in the CI Selector.
186



Chapter 6 • Working with Topology Map
Handling Large Views

The Topology Map cannot display a view with more than 900 CIs in a single 
layer. When you select a view which contains a layer with more than this 
number of CIs, the Topology Map appears empty. A layer with more than 
900 CIs can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following 
methods:

➤ Reduce the TQL query results by redefining the view in the Modeling 
Studio. For details, see "Change Query Node/Relationship Type Dialog 
Box" on page 389.

➤ Define a different hierarchy for the view to redistribute the CIs among the 
view’s layers. For details on defining hierarchy, see "Setting the View 
Hierarchy" on page 348.

➤ Reset the maximum number of CIs allowed in the configuration 
parameters. Select the Max Object Count GUI for TS parameter under 
RTSM - Viewing Settings in the Infrastructure Settings Manager. However, 
be aware that increasing the maximum number of CIs per layer may 
significantly slow down the redrawing of the Topology Map.

To modify the setting, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings > Foundations > RTSM. Locate Max Object 
Count GUI for TS and change the value to the required number.
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Reference

Topology Map User Interface

This section includes (in alphabetical order):

 ➤ Export Map to Image Dialog Box on page 188

 ➤ Layout Properties Dialog Box on page 190

 ➤ Main Menu on page 207

 ➤ Print Dialog Box on page 208

 ➤ Print Preview Dialog Box on page 209

 ➤ Print Setup Dialog Box on page 209

 ➤ Toolbar Options on page 211

 ➤ Topology Map Sidebar on page 219

Export Map to Image Dialog Box

This dialog box enables you to save a topology map to a file.

To access From a topology map, select Operations > Export Map to 
Image.

Relevant tasks "How to Print and Save a Topology Map to File" on 
page 265
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User interface elements are described below:

UI Element (A-Z) Description

Actual Size Save the view so that the graph node sizes are at 
maximum.

Current Zoom Level Save the view as you see it on the topology map. For 
example, if you have used the Interactive Zoom mode to 
decrease the view magnification, the graph nodes also 
appear smaller in the saved view. For details, see 
"Interactive Zoom" on page 214.

Custom Specify the size of the view you want to save in the Width 
and Height boxes.

File Name Specify the required file name and location (or click 
Browse to search for the file and location).

Fit in Canvas Expand or shrink the view so that it fits in the pane.

Image Quality The quality of the printed map. Select High, Medium, or 
Low. 

Selected Objects 
Only

Saves only the graph nodes/CIs and their relationships 
that you selected in the map.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the pane.
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Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a 
view, to achieve the clearest presentation possible and to better understand 
and monitor the managed data.

Global Tab

This area enables you to define global layout parameters.

User interface elements are described below:

To access Select Layout > Layout Properties.

Important 
information

You define the layout of a view’s layers by assigning 
logical positions for the graph’s nodes and relationships 
that appear in a layer. You customize the layer layouts by 
modifying the default values.

You set layout definitions for a specific layer only. The 
definitions cannot be saved for a different layer or a 
different view.

Parameter values are in pixels.

To access Click the Global tab in the Layout Properties dialog box. 

Important 
information

The Global tab enables you to define global settings for 
the layout.

UI Element (A-Z) Description

Drawing Fitting Select one of the following options for fitting the layout:

➤ Fit to Canvas. Fit the layout to the canvas on the 
screen.

➤ Fit for Printing. Fit the layout to a page for printing.

➤ No Fitting. Do not change the layout.
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All Styles Tab 

Labeling Select Perform Labeling to ensure that the labels appear 
when the layout is redrawn. If this field is not selected, 
labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to 
all nested layers of the topology map.

To access Click the All Styles tab in the Layout Properties dialog 
box. 

Important 
information

The All Styles tab enables you to define general layout 
parameters for disconnected graph nodes and connected 
components.

➤ A disconnected graph node is a node that is not 
connected to any other graph node.

➤ A disconnected component is a component that is not 
connected to any other component. It contains a set of 
graph nodes that can be connected to each other.

This illustrates a connected component with five graph 
nodes:

This illustrates a connected component with two graph 
nodes:

This illustrates four disconnected components, each 
made up of a single, disconnected graph node:

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Components The spacing between the components in a disconnected 
graph consists of both a constant value and a 
proportional value based on the sizes of the components.

Select Detect Components to view the disconnected 
components. You can specify that all components be laid 
out together or individually, regardless of the other 
components. If the grouping for components is selected, 
each component is laid out, and the resulting 
components are packed together.

When Detect Components is selected, enter values for 
the following settings:

➤ Constant Spacing. Set constant spacing (horizontal 
and vertical) around each disconnected component. 
Default value: 20

➤ Proportional Spacing. Set spacing (horizontal and 
vertical) that is proportional to the size of the 
component around each disconnected component.
Default value: 0.05
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Circular Tab

Disconnected Graph 
Nodes

The spacing between the graph nodes in a disconnected 
graph consists of both a constant value and a 
proportional value based on the sizes of the graph nodes.

Select Detect Disconnected Graph Nodes to view the 
disconnected graph nodes. You can specify that 
disconnected graph nodes be grouped into one 
component or laid out individually.

When Detect Disconnected Graph Nodes is selected, 
enter values for the following settings:

➤ Constant Spacing. Set constant spacing (horizontal 
and vertical) around each disconnected graph node. 
Default value: 20

➤ Proportional Spacing. Set spacing (horizontal and 
vertical) that is proportional to the size of the 
component around each disconnected graph node.
Default value: 0.05

Margin Spacing Enter values for the right, left, top, and bottom margin 
spacing for the layout.

To access To access: Click the Circular tab in the Layout Properties 
dialog box.

Important 
information

The Circular tab enables you to group a graph’s nodes 
into groups or clusters based on the grouping options you 
select. It is particularly suited for visualizing ring and star 
network topologies, and for link analysis.

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Clustering Set the values for the following settings:

➤ Cluster Size Factor. Specifies the ratio between the 
average cluster size and the number of clusters. The 
size of a cluster is defined as the sum of the weights of 
all graph nodes in the cluster. You can assign a weight 
value to each graph node.

➤ Min Number of Clusters. The minimum number of 
clusters in a layer.

➤ Max Number of Clusters. The maximum number of 
clusters in a layer.

Cluster Layout Style Displays clusters either in a symmetric or circular layout 
style.

Select one of the following options:

➤ Symmetric. Displays clusters in a symmetric layout 
style.

➤ Circular. Displays clusters in a circular layout style.
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Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options: 

➤ Draft. Produces faster results (faster than Medium and 
Proof).

➤ Medium. Produces a result that is a combination of 
Draft and Proof, that is, it produces a more accurate 
graph layout than Draft, but not as accurate as Proof.

➤ Proof. Produces a more refined result but takes more 
time.

Note: The differences between the speed and resulting 
layout of each quality setting varies depending on the 
nature of the graph being laid out. You can try each 
option to determine which works best for you.

UI Element (A-Z) Description
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Hierarchical Tab

Spacing Sets the spacing around each graph node within the same 
cluster and between clusters.

Enter values for the following settings:

➤ Between Graph Nodes. Sets the spacing around each 
graph node within the same cluster. The larger the 
spacing, the more graph nodes there are on the cluster 
boundary. 

Default value: 50

This illustration shows smaller graph node spacing.

This illustration shows larger graph node spacing.

➤ Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

This illustration shows larger cluster spacing.

To access Click the Hierarchical tab in the Layout Properties dialog 
box. 

UI Element (A-Z) Description
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User interface elements are described below:

Important 
information

The Hierarchical tab shows the precedence relationships 
that can represent organizational or information 
management system dependencies, as well as process 
models, software call graphs, and work flows. The 
hierarchical layout emphasizes dependencies by placing 
the graph nodes at different levels. 

UI Element (A-Z) Description

Backward Edges Specifies how backward relationships are displayed in the 
hierarchical layout.

Select one of the following options:

➤ Minimize Backward Edges. Sets the number of 
backward relationships displayed in a layer to a 
minimum.

➤ Optimize for Feedback Flow. Sets the number of 
backward relationships displayed in a layer to a 
maximum. This mode is more appropriate for flow 
charts.

Horizontal Spacing Enables you to set the minimum horizontal distance 
between two neighboring graph nodes at each level.

Enter values for the following settings:

➤ Between Graph Nodes. Sets a horizontal space around 
each graph node in the layer. 
Default value: 28

➤ Between Edges. This setting is available only when 
you select Routing > Orthogonal. It sets a horizontal 
space between edges in the graph.
Default value: 12
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Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options: 

➤ Draft. Produces faster results (faster than Medium and 
Proof).

➤ Medium. Produces a result that is a combination of 
Draft and Proof, that is, it produces a more accurate 
graph layout than Draft, but not as accurate as Proof.

➤ Proof. Produces a more refined result but takes more 
time.

Note: The differences between the speed and resulting 
layout of each quality setting varies depending on the 
nature of the graph being laid out. You can try each 
option to determine which works best for you.

UI Element (A-Z) Description
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Level Alignment Enables you to set the way graph nodes are vertically 
aligned.

Select one of the following options:

➤ Top. This illustration shows that the top of the graph 
nodes at the same level of the hierarchy are aligned.

➤ Center. This illustration shows that the center of the 
graph nodes at the same level of the hierarchy are 
aligned.

➤ Bottom. This illustration shows that the bottom of the 
graph nodes at the same level of the hierarchy are 
aligned.

UI Element (A-Z) Description
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Orientation Enables you to set the orientation of the hierarchy.

Select one of the following options:

➤ Top to Bottom. The children are located above the 
parent.

➤ Left to Right. The children are located to the left of the 
parent.

➤ Bottom to Top. The children are located below the 
parent.

➤ Right to Left. The children are located to the right of 
the parent. 

Orthogonal Routing - 
Fix Node Sizes

This setting is available only when you select Routing > 
Orthogonal. Maintain the size of a graph node. Clear this 
option if you want the layout to increase the size of a 
graph node, if it is necessary to maintain the specified 
relationship spacing, when more than one relationship is 
attached to the same side of the graph node.

Polyline Routing - 
Spacing Between 
Bends

This setting is available only when you select Routing > 
Polyline. Polyline routing routes edges (connecting lines) 
as one or more straight line segments with arbitrary 
angles. Path nodes are added automatically to prevent 
the edges (connecting lines) from overlapping.

Default Value: 12

Routing Select the type of routing for the layout. The available 
options are:

➤ Orthogonal

➤ Polyline

UI Element (A-Z) Description
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Orthogonal Tab

Undirected Layout Edge direction is not used to build the levels of the 
hierarchical drawing.

Variable Level 
Spacing

Variable level spacing adjusts the spacing between pairs 
of neighboring levels according to the density of edges 
between the levels. 

If the drawing’s edges are orthogonally routed, this 
ensures the desired vertical spacing between horizontal 
edges (in a top-to-bottom or bottom-to-top layout) 
routed between levels. 

If the routing is polyline, variable level spacing makes it 
easier to distinguish among edges in very dense 
drawings.

Vertical Spacing Enables you to set the minimum vertical distance 
between two neighboring graph nodes on different 
levels.

Enter values for the following settings:

➤ Between Graph Nodes. Sets a vertical space around 
each graph node in the level.
Default value: 28

➤ Between Edges. This setting is available only when 
you select Routing > Orthogonal. It sets a vertical 
space between edges in the graph.
Default value: 12

To access To access: Click the Orthogonal tab in the Layout 
Properties dialog box.

Important 
information

The Orthogonal tab enables you to set orthogonal layout 
route relationships horizontally and vertically. This 
results in relationships bending at 90-degree angles only.

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Fix Node Sizes Maintain the size of a graph node. Clear this option if 
you want the layout to increase the size of a graph node 
if it is necessary to maintain the specified relationship 
spacing when more than one relationship is attached to 
the same side of the graph node.

Horizontal Spacing Enables you to set the minimum horizontal distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a horizontal space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a horizontal space between 
elements in the layer.

Default value: 12

Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Set the layout to draft quality.

➤ Medium. Set the layout to medium quality.

➤ Proof. Set the layout to proof quality.

Vertical Spacing Enables you to set the minimum vertical distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a vertical space around 
each graph node in the layer.

Default value: 100

➤ Between Edges. Set a vertical space between elements 
in the layer.

Default value: 20
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Symmetric Tab

User interface elements are described below:

To access Click the Symmetric tab in the Layout Properties dialog 
box.

Important 
information

The Symmetric tab displays a clear representation of 
complex networks. The symmetric layout emphasizes the 
symmetries that may occur in a graph.

UI Element (A-Z) Description

Layout Quality Adjusts the quality of the layout produced to fit your 
application’s needs. The quality reflects the number of 
steps or the method used to produce the layout. For 
example, high quality is sharper but takes more time to 
set the layout.

Select one of the following options:

➤ Draft. Produces faster results (faster than Medium and 
Proof).

➤ Medium. Produces a result that is a combination of 
Draft and Proof, that is, it produces a more accurate 
graph layout than Draft, but not as accurate as Proof.

➤ Proof. Produces a more refined result but takes more 
time.

Note: The differences between the speed and resulting 
layout of each quality setting varies depending on the 
nature of the graph being laid out. You can try each 
option to determine which works best for you.
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Spacing Allows you to set constant horizontal and vertical 
spacing around each graph node in the layer. The value 
you specify is a guideline for the layout, so that it is 
possible that the spacing for a particular pair of graph 
nodes might be different from the one you specified. The 
larger the graph node spacing, the farther apart the graph 
nodes are spaced in the final layout.

Default value: 50

The following figure illustrates smaller and larger 
spacing.

UI Element (A-Z) Description
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Routing Tab

User interface elements are described below:

To access Click the Routing tab in the Layout Properties dialog box.

Important 
information

The Routing tab enables you to produce drawings that 
leave graph nodes essentially where they are, and reroute 
the lines orthogonally.

UI Element (A-Z) Description

Fix Node Positions Maintain the position of all the graph nodes in the 
display. Clear this option for the layout to move the 
graph nodes if it is necessary to improve the layout. The 
movement is minimal, avoids overlaps, and minimizes 
bend points.

Fix Node Sizes Maintain the size of a graph node. Clear this option if 
you want the layout to increase the size of a graph node 
if it is necessary to maintain the specified relationship 
spacing when more than one relationship is attached to 
the same side of the graph node.
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Horizontal Spacing Enables you to set the minimum horizontal distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a horizontal space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a horizontal space between 
elements in the layer.

Default value: 12

Vertical Spacing Enables you to set the minimum vertical distance 
between graph nodes.

Select one of the following options:

➤ Between Graph Nodes. Set a vertical space around 
each graph node in the layer.

Default value: 20

➤ Between Edges. Set a vertical space between elements 
in the layer.

Default value: 12

UI Element (A-Z) Description
206



Chapter 6 • Working with Topology Map
Main Menu

This feature contains the options for working with the topology map.

User interface elements are described below:

To access Located in the upper left portion of the screen.

Important 
information

The specific options contained within the Main Menu 
drop-downs are detailed in "Toolbar Options" on 
page 211.

UI Element (A-Z) Description

Edit Contains selection options for the topology map.

Editor Item Contains the topology map shortcut menu options for 
the current manager.

Note: This drop-down does not appear in CI Type 
Manager.

Layout Contains options for changing the layout of the topology 
map.

Operations Contains options for printing or exporting the topology 
map.

Resources Contains the left pane shortcut menu options for the 
current manager.

Note: This drop-down does not appear in IT Universe 
Manager, and in CI Type Manager it is called CI Types.

Tools Contains the User Preferences, Log Configuration, and 
Screen Capture tools.

View Enables you to hide or display the different panes of the 
module.
207



Chapter 6 • Working with Topology Map
Print Dialog Box

This dialog box enables you to print the contents of the topology map.

User interface elements are described below:

To access Select Operations > Print.

Important 
information

The results of printing a topology map is similar to a 
screen capture. Therefore, before printing, it is 
recommended to:

➤ Define your print settings and arrange the contents of 
the topology map according to your requirements. For 
details, see "Print Setup Dialog Box" on page 209.

➤ Arrange the contents of the topology map for print. 
You can use the Layout option and Layout Properties. 
For details about the layout options, see "Layout" on 
page 215. For details about layout properties, see 
"Layout Properties Dialog Box" on page 190.

Relevant tasks "How to Print and Save a Topology Map to File" on 
page 265

UI Element (A-Z) Description

Number of copies Enter the number of copies you want to print.

Properties Define document properties as required.
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Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map 
before printing.

User interface elements are described below:

Print Setup Dialog Box

This dialog box enables you to define the print settings for a topology map.

User interface elements are described below:

To access Select Operations > Print Preview.

Relevant tasks "How to Print and Save a Topology Map to File" on 
page 265

Menu Item Description

Print the map. For details, see "Print Dialog Box" on 
page 208.

Zoom out to view the map. 

Zoom in to focus on specific details of the map. 

Fit the complete view in the pane.

To access Select Operations > Print Setup.

Relevant tasks "How to Print and Save a Topology Map to File" on 
page 265

UI Element (A-Z) Description

Actual Size Print the view as it really is.

Color Set the text color.
209



Chapter 6 • Working with Topology Map
Font Set the required font.

Page Setup Set the printer settings.

Pages Divide the map into rows and columns and print each 
section separately. Enter the number of columns and rows 
in the Page Columns and Page Rows boxes.

Position Select the position of the caption from the Position list.

Print Background Print the background behind the view.

Print Border Print the map with a border. Click Color to select the 
required border color.

Print Caption Enter the caption in the text area and click Font to select 
the required custom font.

Print Crop Marks Print the crop marks.

Print Current 
Selection

Print the selected graph nodes and their relationships.

Print Current 
Window

Print the part of the view that appears in the pane.

Print Entire Drawing Print the complete view.

Print Page Numbers Print the page numbers.

Zoom Level Print the view at the current zoom level.

UI Element (A-Z) Description
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Toolbar Options

The following table contains a description of each Topology Map toolbar 
option, organized alphabetically.

Note: These toolbar options are relevant for RTSM applications.

Button Option Name Use This Option to...

Additions 
Count

Calculate the number of instances that are created as a result of 
an Enrichment Rule. The number of TQL query node instances 
and relationships that are created appear next to the 
Enrichment query nodes/relationships, as seen in the figure 
below.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Advanced Pane Toggle between hiding and displaying the Advanced Pane at the 
bottom center of the screen.

To access: Select View > Advanced Pane.

Calculate Query 
Result Count

Calculate the number of instances found for each TQL query 
node/relationship.
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Change Label 
Length/Propert
ies

Enter the maximum number of characters that the labels should 
contain.

To access: In IT Universe Manager and the Modeling Studio, 
select Layout > Change Label Properties. In the other managers, 
select Layout > Change Label Length.

CI Types Tree Toggle between hiding and displaying the CI Type Selector at 
the right of the screen.

To access: Select View > CI Types Tree.

Note: In the Modeling Studio, this option is called CI Types.

Create 
Relationship

In most managers, create a relationship between two existing 
TQL query nodes. For details, see "How to Add Query Nodes and 
Relationships to a TQL Query" on page 35.

In IT Universe Manager, create a relationship between existing 
CIs. For details, see "Attaching Existing CIs" on page 246. 

Delete Selected 
Item(s)

Delete a CI from IT Universe Manager or a TQL query node from 
Impact Analysis Manager or Enrichment Manager. 

Drag Map Drag the view.

To access: Open the drop-down menu in the Mode box or select 
View > Drag Map. In IT Universe Manager and the Modeling 
Studio, select Layout > Dragging Mode.

Drill Down One 
Layer

Move down one level in the topology map. This option is 
enabled only if there is an additional CI layer below it, created 
by setting the hierarchy of the view. For details on setting the 
hierarchy, see "Setting the View Hierarchy" on page 348. 

Note: This option appears only in IT Universe Manager.

Enable/Disable 
Related CIs 
Retrieval

Toggle between disabling and enabling the redrawing of the 
topology map with related CIs when selecting a new CI in the 
CI Selector.

Note: This option appears only in IT Universe Manager in the 
Related CIs tab.

Button Option Name Use This Option to...
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Entities Tree Toggle between hiding and displaying the manager specific 
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Note: In the Modeling Studio, each of the tabs of the Left pane 
(Resources, CI Types, CI Selector) is listed as a separate option.

Export Map to 
Image

Save the topology map to a file. For details, see "Export Map to 
Image Dialog Box" on page 188.

To access: Select Operations > Export Map to Image.

Fit to Window Fit the complete map in the pane.

To access: Select Layout > Fit to Window.

Generate Direct 
Link

Generate a direct link to a view or CI.

To access: Select Edit > Generate Direct Link.

Go Up One 
Layer

Move up one level in the topology map. This option is enabled 
only if there is an additional CI layer above it, created by setting 
the hierarchy of the view. For details on setting the hierarchy, 
see "Setting the View Hierarchy" on page 348. 

Note: This option appears only in IT Universe Manager.

Hide All 
Inheritance 
From Map

Toggle between showing and hiding Inheritance_f relationships 
and their connecting query nodes.

To access: Select Layout > Hide All Inheritance From Map.

Note: This option is only active in the toolbar in CI Type 
Manager.

Hide All Query 
Node Labels

Toggle between showing or hiding the CI/CIT/query 
node/pattern labels.

To access: Select Layout > Hide All Query Node Labels.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Hide All 
Relationship 
Labels

Toggle between showing or hiding the relationship labels.

To access: Select Layout > Hide All Relationship Labels.

Note: This option is called Hide edges’ labels in IT Universe 
Manager and the Modeling Studio.

Button Option Name Use This Option to...
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Hide All 
Relationships

Toggle between showing and hiding the relationships in the 
displayed map.

To access: Select Layout > Hide All Relationships.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Hide/Show Get 
Related CIs 
pane

Toggle between hiding and displaying the Get Related CIs pane.

Note: This option appears only in IT Universe Manager in the 
Related CIs tab.

Hide/Show 
Legend

Toggle between hiding and displaying the topology map legend.

Note: This option appears only in IT Universe Manager and the 
Modeling Studio.

Interactive 
Zoom

➤ Decrease the view magnification by clicking and pushing the 
pointer upwards.

➤ Magnify the view by clicking and pulling the pointer 
downwards.

To access: Open the drop-down menu in the Mode box or select 
View > Interactive Zoom.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

 Layout 
Properties

Define the view’s layer layout, by assigning positions for the 
query nodes and relationships of the view. For details, see 
"Layout Properties Dialog Box" on page 190. 

To access: Select Layout > Layout Properties.

Button Option Name Use This Option to...
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Layout Select the layout display from the list. The options are:

➤ Hierarchical Layout. Enables you to display the precedence 
relations in the topology map.

➤ Symmetric Layout. Enables you to display clear 
representations of complex networks.

➤ Circular Layout. Groups a graph’s nodes into groups or 
clusters.

➤ Orthogonal Layout. Enables you to display views of 
outstanding clarity that are achieved by employing only 
horizontal and vertical edge routing.

➤ Manual Layout. Enables you to display the changes you have 
made manually to the topology map. 

For further details about each of the options, see "Layout 
Properties Dialog Box" on page 190. 

Note: These layout options are only relevant for Enrichment 
Manager, CIT Manager, and Impact Analysis Manager.

Log 
Configuration

Open the Log Configuration dialog box.

To access: Select Tools > Log Configuration.

Map overview Open a small box with a copy of the topology map. This is 
useful in large views when zooming in.

To access: Select Layout > Map Overview. In IT Universe 
Manager and the Modeling Studio, select Layout > Show Map 
Overview.

Maximize 
Workspace/
Restore 
Workspace

Toggle between the regular display and a full-screen display of 
the topology map.

Button Option Name Use This Option to...
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Navigation Take the pointer to the next connected CI/CIT/TQL query node 
in a clockwise direction.

➤ Left-click to move in a clockwise direction.

➤ Right-click to point to the next CI/CIT/query node/pattern in 
a clockwise direction. 

To access: Open the drop-down menu in the Mode box or select 
View > Navigation.

Note: 

➤ You can use this option only on CI/CIT/query 
nodes/patterns that are connected by relationships.

➤ This option is not available in IT Universe Manager and 
the Modeling Studio.

New CI Define a new unrelated CI. For details, see "Working with CIs" 
on page 240.

Note: This option appears in the toolbar in IT Universe Manager 
only.

New Related CI Define a new related CI. For details, see "Working with CIs" on 
page 240.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Place in Center Place the selected CI/CIT/query nodes/pattern in the center of 
the map.

To access: Select Layout > Place in Center.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Print Print the contents of the topology map. For details, see "Print 
Dialog Box" on page 208.

To access: Select Operations > Print...

Print Preview Preview the contents of the map before printing.

To access: Select Operations > Print Preview.

Button Option Name Use This Option to...
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Print Setup Define print settings for printing the topology map. For details, 
see "Print Setup Dialog Box" on page 209.

To access: Select Operations > Print Setup...

Remove 
Enrichment 
Results

Remove the instances created from an Enrichment rule from the 
RTSM.

Note: This option appears in the toolbar in Enrichment 
Manager only.

Screen Capture Take a snapshot of the screen using the Screen Capture tool.

To access: Select Tools > Screen Capture.

Select Select a CI/CIT/TQL query node or multiple CIs/CITs/TQL query 
nodes.

To access: Open the drop-down menu in the Mode box or select 
View > Select. In IT Universe Manager and the Modeling Studio, 
select Layout > Selection Mode.

Select All Select all the CIs and relationships in a selected layer.

To access: Select Edit > Select All.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Select All Query 
Nodes

Select all the query nodes in a selected layer.

To access: Select Edit > Select All Query Nodes.

Note: This option is not available in IT Universe Manager and 
the Modeling Studio.

Select Columns Enables you to select the columns to be displayed. For details, 
see "Select Columns Dialog Box" on page 580.

Note: This option is displayed in Text mode of IT Universe 
Manager only.

Set Change 
Timeframe

Open the Change Timeframe dialog box, which enables you to 
set the period for the display of added or changed CI indicators.

Note: This option appears in the toolbar in IT Universe Manager 
only.

Button Option Name Use This Option to...
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Show 
Candidates for 
Deletion

Identify the CIs in the current view which are candidates for 
deletion with the following icon  .

Note: This option appears in the toolbar in IT Universe Manager 
only.

Show Schedule 
Info

Display the scheduling information for the selected job. For 
details, see "Discovery Scheduler Dialog Box" in the RTSM Data 
Flow Management Guide.

Note: This option appears in the toolbar in the Dependency 
Map tab of DFM. For details, see "Dependency Map Tab" in the 
RTSM Data Flow Management Guide.

Sort Column 
Content

Enables you to set the order of the visible columns. For details, 
see "Sort Column Content Dialog Box" on page 582.

Note: This option is displayed in Text mode of IT Universe 
Manager only.

Straighten Straightens any selected relationship between two query nodes 
that has angles. 

To access: Select Layout > Straighten.

Note: This option is only available in Enrichment Manager and 
Impact Analysis Manager.

User 
Preferences

Opens the User Preferences dialog box which enables you to 
reset warning message preferences. For details, see "User 
Preferences Dialog Box" on page 113.

To access: Select Tools > User Preferences.

User Profile Opens the User Profile dialog box which displays the user details 
for the user currently logged in.

To access: Select Tools > User Profile

Zoom In Zoom in on a specific section of the topology map by clicking 
and drawing a selection rectangle around the part to magnify. 
The area you select is displayed at the highest percentage that 
fits in the topology map.

To access: Open the drop-down menu in the Mode box or select 
View > Zoom In. In IT Universe Manager and the Modeling 
Studio, select Layout > Zoom in.

Button Option Name Use This Option to...
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Topology Map Sidebar

The following table contains a description of each Topology Map sidebar 
option. The Topology Map sidebar appears in IT Universe Manager and the 
Modeling Studio.

Button Option Name Use This Option to...

Move Layout 
Toolbar to 
Right/Left

Move the sidebar to the right or left side of the screen.

Zoom In/Out Zoom in or out on the topology map.

Selection 
Mode

Enable selection mode in the topology map.

Dragging 
Mode

Enable dragging mode in the topology map.

Refresh to get 
an optimal 
layout

Refresh the topology map to optimize the layout.

Fit to Window Fit the complete map in the pane.

Hide Edges’ 
Labels

Hide the labels of all relationships.

Change label 
properties

Open the Map Label Properties dialog box which enables you 
to set the maximum label length per line and maximum 
number of lines per label.

Show Map 
Overview

Open a small box with a copy of the topology map. This is 
useful in large views when zooming in.

Hierarchical 
Layout

Display the topology map in a layout displaying the 
precedence relations.
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Hierarchical 
Layout with 
Orthogonal 
Routing

Display the topology map in a layout displaying the 
precedence relations using only horizontal and vertical edge 
routing.

Circular Layout Display the topology map in a layout that groups a graph’s 
nodes into groups or clusters.

Orthogonal 
Layout

Display the topology map in a layout using only horizontal 
and vertical edge routing.

Symmetric 
Layout

Display the topology map in a layout showing clear 
representations of complex networks.

Print Print the topology map.

Export Map to 
Image

Save the topology map to a file.

Button Option Name Use This Option to...
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7
Best Practices for Modeling

This chapter includes:

Reference

➤ Using Modeling Studio on page 224

➤ Models and Perspectives on page 224

➤ Building Models on page 225

➤ Model Dependencies on Other CIs in the RTSM on page 230

➤ Modeling an Application with Running Software on page 231

➤ Creating Views Using the Modeling Studio on page 231
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Reference

Using Modeling Studio

The Modeling Studio is the RTSM module for building and modeling views 
for display in Service Health. This document details the required flow to 
create Service Health views using the Modeling Studio.

The motivation behind developing the Modeling Studio is to create a 
separation between the need to change the RTSM content by creating CIs 
and relationships and the need to consume (view) the RTSM content. In 
earlier versions, altering the RTSM content was part of the view creation 
workflow. Hence, users were unintentionally changing the RTSM and 
influencing other users’ views. In the Modeling Studio, you build models 
and transform your content into views to be consumed by HP Business 
Service Management.

Models and Perspectives

A model is a CI collection that represents a managed business entity such as 
an application, business service, or line of business. A model is usually 
created by solution or application architects who are familiar with the 
content and hierarchy of the model. The model content can include system 
CIs (typically nodes), running software CIs (such as web servers, databases, 
and J2EE servers), end user monitoring components (Business Process 
Monitor or Real User Monitor applications), business processes, groups, and 
other existing models.

To generate a view from a model, a perspective needs to be applied. A 
perspective is a TQL-based tool that enriches the model content by adding 
additional CIs, thus creating a view. The default perspectives that are applied 
to create Service Health views add all descendent CIs that are related by 
impact links down to the level of monitor CIs. There are other perspectives 
provided out of the box that can be used to address additional use cases. 
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The resulting view shows the model content as it is monitored by 
HP Business Service Management.

Building Models

The information required to define a model includes the CI content, the 
hierarchy, and the dependencies upon additional CIs.

HP Business Service Management is configured with a predefined list of CI 
types that represent your business entities. When creating a new model 
using the Modeling Studio, the following list of valid models appears: 
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The model CI types can be arranged in hierarchies to reflect the 
organization’s specific needs. Here is an example of a typical recommended 
model hierarchy:

A model can be nested in any logical hierarchy, but it is best to create a 
hierarchy that starts from high level business entities down to more specific 
model types.

It is strongly recommended to build models in a way that allows them to be 
reused as components of other models.

Building a model creates a contains link between the model and its CIs 
according to the defined hierarchy. 

The creation of a CI which is a model CI results in the creation of an empty 
model by default. Therefore, if you want to create a model for a CI that does 
not yet exist, you create a new model and thus, a new CI. If you want to 
model an existing CI for the first time, select the CI in the CI Selector, drag it 
onto the canvas and select Create a New Model. 
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Preconfigured Models
HP Business Service Management creates out-of-the-box models for 
applications monitored by Business Process Monitor and Real User Monitor. 

The Business Process Monitor model is of type business transaction flow and 
it contains business transaction CIs.

 

The Real User Monitor model is of type application and contains the End 
User Management Application related group and business process step CIs. 
The Real User Monitor model is also impacted by the Real User Monitor 
Sessions monitor CIs, Real User Monitor Errors events CIs, and Real User 
Monitor Informational events CIs, which are visible in the Related CIs pane.
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Building Model Content 
Create a model of the desired type and assign it a name. The new model 
appears as the top CI in the content pane of the Model Editor. Drag and 
drop CIs from the CI Selector into the content pane to build the model 
content.

A model can contain system CIs, running software CIs, SiteScope groups, 
and other models (both existing models and new ones created during the 
modeling process). 

The only CIs that cannot be part of a model containment tree are monitors. 
Monitor CIs are added to a model after you generate a view from the model 
using one of the monitor perspectives. You can include monitors in view by 
dragging them into the Related CIs pane when a model CI is selected in the 
upper pane of the Model Editor. If you try to drop a monitor CI into the 
upper pane, a message appears prompting you to add the monitor CI to the 
Related CIs pane.

The CI Selector pane offers two ways to search for a CI (both model CIs and 
non-model CIs):

➤ Browse Views 

Use this option when you are familiar with a view that contains the CI 
you are looking for. The following out-of-the-box views can help you find 
commonly used CIs:

➤ End User Monitors view - contains business process groups and their 
content.

➤ System Monitors view - contains SiteScope groups hierarchy.

➤ System Software Monitoring view - contains running software CIs and 
the servers on which they are deployed.

In the CI Selector, select Browse Views and begin entering the view name 
or use the view tree to look for a CI in a specific folder.

➤ Search CIs 

If you know the CI type you are looking for, select the Search CIs mode 
and use the quick search dialog to locate the desired CI. Use the Advanced 
Search option for CIs that do not appear in the quick search mode.
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The search result appears in the left pane. After the list of CIs is refreshed, 
you can drag and drop CIs into the model content pane. It is possible to 
drag and drop multiple CIs in a single selection.

Models can be placed in a hierarchical mode. During the process of building 
the content you can insert new models and create groups. 

Hierarchies between CI types which are not models is not supported. 

Grouping 
In some cases, there is a need to divide the model into logical groups 
according to ownerships, locations or any other custom representation.

In the following example the application contains two groups that represent 
data centers:

For details on creating groups in a model, see "CI Collection" on page 407.
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Model Dependencies on Other CIs in the RTSM 

Each model CI in the model can be dependent on other CIs that exist in the 
RTSM but are not part of the model itself. Examples of such CIs include 
shared resources such as database servers and storage devices. 

The model structure may vary between organizations according to policies 
and responsibilities in the IT department. There are organizations where 
shared resources are considered to be part of the application and are 
monitored as part of it, while in other organizations they are considered 
external to the application. In the first case, shared resources are part of the 
model and appear in the content pane, whereas in the second case they 
appear as related CIs (in the lower pane of the Model Editor).

To create a dependency between a CI in the model and another CI in the 
RTSM, search for a CI in the left pane and drag it into the Related CIs tab. 
This operation creates a usage link in the RTSM.

In order to create a dependency relationship between two CIs, there must be 
a valid link in the RTSM between the two CI types. By default, all business 
CIs can be dependent on other business CIs. 

The following example shows an application that depends on a web server 
and Oracle software elements:
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HP Business Service Management offers a revised out-of-the-box impact 
model. The impact model describes the impact relationships between CI 
types. For example, a running software CI is impacted by the node on which 
it is deployed. In the Modeling Studio, when you include a running software 
CI as part of a model, the node on which it is deployed appears in the 
Related CIs tab, since the running software is dependent on the server.

Modeling an Application with Running Software

Running software CIs are CIs that describe the implementation components 
of an application. Examples include web servers such as IIS or Apache, 
application servers such as Webshpere or Weblogic, and databases.

To build the implementation model of a three tier application using its 
running software CIs, create an application model.

You can use the Running Software search in the Advanced Search dialog or 
browse the System Software Monitoring view to locate running software CIs. 
The names of the running software CIs are formed by combining the 
running software CI type with the server name, for example, Microsoft IIS 
web server (Server1).

Drag the relevant running software CIs into the modeling pane. The server 
on which the running software was deployed as well as the monitor of the 
running software both appear automatically in the Related CIs pane. This 
change derives from the new SiteScope monitoring model. In previous 
versions, all monitors (of both hardware and software) were connected to 
the Server CI. The SiteScope model was enhanced and now hardware 
monitors are connected to the server CI, while software monitors are 
connected to the running software CIs.

Creating Views Using the Modeling Studio

There are two methods of creating perspective-based views using the 
Modeling Studio. The first option is to create a view based on a model (or on 
several models); the second one is to create a view out of CI collection that is 
not a model. 
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A view based on a model is updated automatically when the model content 
is updated. For example, a view was generated using a business process 
group model that initially contained five business process steps. The 
business process group was then updated to include additional business 
process steps. Those changes are automatically reflected in the view.

This option is the recommended one, since it creates a dynamic view. 

In a view based both on models and individual CIs, the view content is 
updated according to changes in the models.

Generating a View from a Model
After building a model and saving the model definition, select the top 
model and select Generate view for selected model. In the dialog box that 
opens, select the desired perspective according to the desired view content. 

The recommended perspective is the Impact Perspective. It creates a view 
with all the CIs in the model and for each CI, it adds all the child CIs 
including the monitor CIs. Additional perspectives that may be used for 
other purposes are described in "Predefined Perspectives" on page 352.

If the selected model includes dependent CIs (which appear in the Related 
CIs tab), they are also enriched by the perspective and become part of the 
view.

The Content Only perspective does not make any changes in the view, even 
for model CIs.

Hiding Irrelevant CIs from a View
The view result appears in the View Results pane. At this point, you may 
choose to hide CIs that appear in the view.

Hiding CIs from a view does not change the status calculation of CIs in the 
view (the status calculation is performed according to the RTSM hierarchy). 
For example, hiding two business process steps from a business process 
group with five steps does not affect the business process group status. If a 
hidden CI has a critical status and the remaining CIs are OK, the business 
process group shows a critical status.
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For details on hiding CIs and restoring them to a view, see "Including and 
Excluding Child CIs" on page 360.
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IT Universe Manager

This chapter includes:

Concepts

➤ IT Universe Manager Overview on page 236

➤ Working with Views in IT Universe Manager on page 237

➤ View Tree Structure on page 239

➤ Working with CIs on page 240

➤ Working with Relationships on page 244

Tasks

➤ How to Create CIs and Relationships in the RTSM on page 252

➤ How to View Related CIs on page 253

➤ How to Check Status of Application Discovery (Rediscover a View) 
on page 255

➤ How to Retrieve Impact Analysis Results – Scenario on page 258

➤ How to Take a Snapshot of a View on page 265

➤ How to Print and Save a Topology Map to File on page 265

Reference

➤ IT Universe Manager User Interface on page 266
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Concepts

IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe 
model. The following tasks represent the basic functionality of the 
application:

➤ Creating CIs without creating relationships. You can define new CIs that 
are added to the RTSM individually, so that no new relationships are 
created. For details, see "Creating a Non-Related CI" on page 241.

➤ Creating CIs with relationships for them. You can define new CIs and 
attach them to existing CIs, so defining a new CI and a new relationship 
in the RTSM. For details, see "Creating a Related CI" on page 241.

➤ Adding existing CIs and creating relationships for them. You can attach 
CIs to an existing CI, so creating new relationships for existing CIs. For 
details, see "Attaching Existing CIs" on page 246.

➤ Deleting CIs. You can delete CIs from the RTSM. For details, see "Deleting 
CIs" on page 242.

➤ Getting Impact Analysis results. You can run the Impact rules you defined 
for a view to simulate how certain defined changes impact your system, 
and to discover the root causes of the changes. For more information 
about Impact rules, see "Impact Analysis Manager Overview" on page 458. 

Populating the IT Universe Model
The IT Universe model in the RTSM contains the CIs and relationships 
produced by the CI-generating tools that operate within HP Business Service 
Management. Most CIs and relationships originate from one of the 
following sources:

➤ Data Flow Management (DFM). Automatically creates CIs and 
relationships based on the discovered IT resources and topology in your 
company’s infrastructure. For details, see "Data Flow Management 
Overview" in the RTSM Data Flow Management Guide.
236



Chapter 8 • IT Universe Manager
➤ IT Universe Manager. Enables you to manually create CIs and 
relationships that represent logical and physical elements of the business. 
For details, see "Working with CIs" on page 240.

➤ End User Management Administration and System Availability 
Management Administration. Enables you to manually create 
relationships between the CIs for monitor objects and CIs in the RTSM. 
For details, see "Integrating SiteScope Data with BSM’s Configuration 
Items" in Using System Availability Management.

➤ Enrichment Manager. Enables you to add CIs and relationships to the 
RTSM by receiving data from the attributes of Enrichment query nodes as 
defined in the Enrichment TQL query. For details, see "Enrichment 
Manager" on page 527.

Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets 
of the IT Universe, containing only those CIs relating to a specific area of 
interest. All views are based on a pattern which determines the content of 
the view. 

➤ Pattern views and template-based views are built from a TQL (Topology 
Query Language) query that defines the structure of the view. The view 
displays only those CIs and relationships that satisfy the query definition. 

➤ Perspective-based views are built manually, by selecting a group of CIs 
and applying perspectives to them. A perspective is a pattern used to 
define which related CIs are included in the view. 

You build all views in the Modeling Studio, using the appropriate editor for 
each view type. For information on the different view types and how they 
function, see "View Formats" on page 346.

Note: You must have Change permissions for a view to edit the view. If you 
do not have the necessary permissions, contact your HP Business Service 
Management Administrator.
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CIs created by DFM are automatically added to each view where the CIs (and 
their relationships) fit the TQL definition for the view. When you open a 
view in the CI Selector, the TQL query for the view queries the RTSM for CIs 
that match the defined pattern. If there are no matches (for example, in the 
case of a view for a DFM process where the process has not yet run) then the 
view remains empty.

When you define a new CI while working in any view in IT Universe 
Manager, the CI (and any associated relationship) is created in the RTSM. 
The CI is added to your current view only if it meets the view’s TQL 
specifications.

If the created CI and relationship do not meet the TQL requirements, then 
the CI and relationship are created in the RTSM but are not visible in the 
view. Similarly, if you attach an existing CI to a CI in the view, and the new 
pattern does not meet the TQL requirements, then the attached CIs do not 
appear in the view, but the relationship is still created.

Templates and Template-based Views
If you open a template in IT Universe Manager, it is displayed in the 
topology map like a pattern view. Click the Show Template Parameters 
button in the CI Selector toolbar to open the Template Parameter Values 
dialog box, where you can change the values of the template parameters and 
thereby affect the view results displayed in the topology map. You can try 
different parameter values and see the resulting topology map, but you 
cannot save changes to the template itself. To save the view results as a 
template-based view with the selected parameters, click the Save As View 
button in the Template Parameter Values dialog box.

You can also create a direct link to a template in IT Universe Manager and 
insert the parameter values directly into the URL. For details, see "How to 
Create a Direct Link to a Template with Parameter Values" on page 130.

View Lifecycle
If you do not access a view from the CI Selector for a specified period of 
time, the view is cleared out, to save memory in the system. It is not deleted 
from the RTSM; the view can be retrieved by clicking on it. The default time 
period for clearing out unused views is one hour. 
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Note: Views defined as persistent are not cleared out and always remain in 
the memory.

Hidden Views
You can designate a view as a hidden view that does not appear in 
IT Universe Manager by defining a bundle for hidden views and assigning 
the view to that bundle.

To designate a view as a hidden view:

 1 In the Infrastructure Settings Manager, select Hidden Bundles Names in CI 
Selector.

 2 Enter the name of the new bundle as the default value and save the 
setting.

 3 In the Modeling Studio, open the relevant view and click the View 
Definition Properties button in the toolbar. 

 4 In the View Definition Properties dialog box, select the hidden views 
bundle and assign the view to it. 

View Tree Structure

Views are organized in a hierarchical tree format in the left pane of 
IT Universe Manager, which is known as the CI Selector. The view name 
appears in the View box above the tree and acts as the containing folder for 
the CIs in the view. 

The first level of the CI Selector tree consists of the query nodes for the root 
CIs. A root CI is the starting point for a view subtree. A view may contain 
any number of subtrees. Under the root CIs come the branch CIs, expanding 
down to the leaf CIs as the last query nodes at the ends of each branch.
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The CIs at each level in a subtree are considered to be attached to the CI on 
the branch directly above. This attachment generally depicts a dependent 
relationship, so that the higher branch (closer to the root CI) represents a 
component of your business that depends on the CIs on the next branch 
down (closer to the leaf CIs) in the business process. For example, an 
application depends on the servers running the application.

The attachment between a higher and a lower query node is referred to as a 
parent-child relationship. The parent CI may have many attached child CIs, 
and the child CIs pass operational status to the parent. The status at each 
level is viewed in Service Health. 

The tree topology is determined by the hierarchy defined for the view. In a 
pattern view, these are defined for the specific view. In a template-based or a 
perspective-based view, the hierarchy is defined as part of the template or 
perspective. For details on defining the hierarchy, see "Setting the View 
Hierarchy" on page 348.

Working with CIs

In IT Universe Manager, you can create related and non-related CIs, delete 
CIs, edit the CI properties, and remove out-of-date CIs using the aging 
mechanism. 

This section includes the following topics:

➤ "Creating a Non-Related CI" on page 241

➤ "Creating a Related CI" on page 241
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➤ "Deleting CIs" on page 242

➤ "CI Properties" on page 243

➤ "Removing Out of Date CIs Using the Aging Mechanism" on page 244

Creating a Non-Related CI
You can define a new CI in IT Universe Manager by clicking the New CI 
button in the toolbar. The New CI dialog box opens, which enables you to 
define the properties for the new CI. The CI is created in the RTSM. For 
details, see "New CI/New Related CI Dialog Box" on page 296. 

Note: The CI is added to the view only if it meets the specifications of the 
pattern of the view, template, or perspective. 

A CI created in this way is added as an independent entity without any 
relationship to any other existing CI in the RTSM. 

Creating a Related CI
You can define a new CI to be added as a parent, child, or sibling of an 
existing CI. 

To define a new related CI:

 1 Select the CI in your view to which you want to attach the new CI.

 2 Click the New Related CI button in the toolbar.

 3 In the New Related CI dialog box, define the properties and relationship 
for the CI. For details, see "New CI/New Related CI Dialog Box" on 
page 296.

The CI and relationship are created in the RTSM.
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Note: The CI and relationship are added to the view only if they meet the 
specifications of the pattern of the view, template, or perspective. 

Deleting CIs
You can delete a CI by selecting Delete from CMDB from the shortcut menu 
in IT Universe Manager. The CI is deleted from the RTSM and from all views. 
If the CI has children, they are not automatically deleted when you delete 
the parent CI. If you delete a CI without first deleting the relationship 
between the CI and any child CIs that appear with the parent CI in a view, 
the child CIs are removed from the view.

If the child CIs do not appear in any other view, they remain in the RTSM 
without appearing in a view. The child CIs might appear in the future in 
views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and 
parent CI is a Composition relationship; in that case, when the parent CI is 
deleted, the contained CI is also removed from the RTSM. For example, if a 
node CI is the container for a child CPU CI, then when the node CI is 
deleted, the CPU is also removed from the RTSM.

When you delete a CI that was created by the DFM process, the CI is 
restored the next time that DFM runs (if the CI is still valid), and it reappears 
in all relevant views.
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CI Properties
In IT Universe Manager, you can edit the properties of a CI. The CI 
properties are divided into several categories which appear in the New CI 
dialog box:

➤ The general properties of a CI are common to all CIs. Some general 
properties are defined automatically during CI creation; others can only 
be defined manually in the New CI dialog box. 

➤ CIT-specific properties are created as part of the CIT definition in the CI 
Type Manager. The values for the CIT-specific properties are taken from 
the CIs discovered during DFM. The values can also be entered manually, 
when you manually create CIs to represent entities in your infrastructure. 
For details, see "CI Type Manager" on page 483.

➤ Key properties can be general or CIT-specific properties, which must be 
assigned a value to create an instance of the CI type.

You can access the Configuration Item Properties dialog box to view the CI 
properties from IT Universe Manager by right-clicking the CI and selecting 
Properties or by clicking the Properties tab in the Advanced pane. You can 
also edit the CI properties if you have the necessary permissions for editing 
CIs. For details on CI properties, see "Configuration Item Properties Dialog 
Box" on page 273.

The CIT-specific properties are displayed in the Specific Properties section of 
the Configuration Item Properties dialog box when you sort the properties 
using the Categorized button. Some properties for the automatically created 
CIs can be edited, however, if the CI is configured to Allow CI Update (in the 
General Properties), then DFM may override your changes when it updates 
the CI. A description of the selected property can be found in the 
Description area at the bottom of the Configuration Item Properties dialog 
box.

Some of the CIT-specific properties for DFM CIs are set by default to be 
monitored for changes. When one of these properties has been modified, 
information on the change can be viewed in a CI change report, and in 
some cases, an icon is displayed in Service Health. For more information, see 
"CI Change Report" on page 578.
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Removing Out of Date CIs Using the Aging Mechanism
If a CI or relationship is not updated or refreshed over a period of time (for 
example, a CI is not rediscovered by DFM and no manual update occurs), an 
aging mechanism deletes the CI from the RTSM. For details, see "CI Lifecycle 
and the Aging Mechanism" in the RTSM Administration Guide.

Working with Relationships

Many of the relationships between CIs in the RTSM are created 
automatically, for example, by DFM. In addition, you can create 
relationships manually in IT Universe Manager, Enrichment Manager, 
Impact Analysis Manager, or the Modeling Studio. You can also create 
relationships in System Availability Management and End User 
Management Administration. 

This section includes the following topics:

➤ "Creating Relationships" on page 244

➤ "Creating Hierarchical Relationships" on page 245

➤ "Attaching Existing CIs" on page 246

➤ "Setting the View Hierarchy" on page 247

➤ "Viewing Related CIs" on page 248

➤ "Deleting Relationships" on page 248

➤ "Inter-Layer Relationships" on page 249

Creating Relationships
You can create relationships in IT Universe Manager by right-clicking a CI or 
multiple CIs in the CI Selector pane or the Topology Map and selecting 
Relate to CI from the shortcut menu. In the Topology Map, you can define a 
relationship between two CIs in the view by drawing a line between the two, 
using the Create Relationship button from the toolbar. Either of these 
actions opens the Insert Relationship dialog box. For details, see "Insert 
Relationship Dialog Box" on page 280.
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You can create as many relationships as necessary between a CI in the RTSM 
and other CIs. Each new relationship exists as its own entity in the RTSM, 
and has its own properties that can be edited in IT Universe Manager (as 
described in "Configuration Item Properties Dialog Box" on page 273). You 
can also create more than one relationship between the same two CIs, when 
each relationship is based on a different relationship type. In the following 
example, host7 has both a Backbone and a Talk relationship with switch3.

Creating Hierarchical Relationships
By attaching one CI to another in IT Universe Manager or System 
Availability Management or End User Management Administration you 
create a hierarchical relationship (parent-child) between them, so that one 
CI is influenced by the other. 
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Certain relationships defined in this way are restricted to the relationship 
type usage (if the relationship is between two non-monitoring CIs), or the 
relationship type Monitored By (if the child CI in the relationship is a 
monitor type CI); however, other relationship types are used between 
specific types of CIs. For example, if a relationship is defined between two 
node CIs, there are several possible relationship types. 

 

Note: When you attach a child CI to a parent CI, you are creating that 
relationship in the RTSM. The child therefore impacts on the parent CI in 
every view where the relationship exists, and is displayed in every view 
where the child and relationship match the TQL query. 

When performing status calculations, the Business Logic Engine only 
recognizes calculated relationships. For details on calculated relationships, 
see "Impact Rules" on page 121.

Attaching Existing CIs
You can attach existing CIs using the Insert Relationship dialog box. The 
dialog box has two modes:

➤ Selecting the CIs that you want to attach.

➤ Defining the relationship between the original CI and the CIs to attach. 
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When selecting the CIs to attach, you can select multiple CIs from a view to 
attach to the original CI. However, all CIs that you want to attach in one 
operation must have the same relationship type. For example, you cannot 
attach a CI that uses the relationship usage in the same operation as a CI 
that uses the relationship Monitored By.

Note: SiteScope monitor CIs should not be attached to other CIs from 
within the RTSM. You should only create links to SiteScope monitor CIs 
from within SiteScope.

Setting the View Hierarchy
After setting the query node and relationship definitions of a view, you can 
set a hierarchy for the view. This enables you to define the organizational 
structure of CIs in the view by displaying selected CIs at different levels. 
When no hierarchy is defined, the Topology Map or table displays all CIs 
included in the query results on one level by default. For example, if the 
query results include nodes and IP Subnets, both CI types are displayed on 
the same level in the Topology Map or table.

Note: The maximum number of CIs that can be displayed in a single layer of 
the Topology Map is 900. If a view contains a layer with more than 900 CIs, 
the view is not displayed in the Topology Map until the hierarchy is 
changed. However, a layer with more than 900 CIs can be displayed in a 
table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on 
page 348.
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Viewing Related CIs
You can view all the CIs related to a selected CI in the topology map. Select 
a CI in a view and then select the Related CIs tab. The Get Related CIs pane 
enables you to select the scope of the display. If you select View, the 
topology map displays only the selected CI and its related CIs in the view 
(no matter where it is in the view hierarchy). If you select CMDB, it displays 
the selected CI and all of its related CIs in the RTSM. You can also filter the 
results from the Get Related CIs pane by CI type and apply perspectives to a 
CI. For details, see "Get Related CIs Pane" on page 294.

You can also display Related CIs using the Get Related CIs from CMDB 
dialog box. For details, see "Get Related CIs From CMDB Dialog Box" on 
page 279.

Deleting Relationships
The Topology Map shows only the relationships for the CIs that are part of 
the current view; however, the same relationships may also be part of other 
views. When you delete a relationship in IT Universe Manager, it is deleted 
from the RTSM and from all views.

When a relationship is deleted, the CI on the other end of the relationship 
may remain in the view, if it still matches the pattern of the view. However, 
if the deleted relationship is a composition link, the target CI is deleted with 
it.

In a perspective-based view, you can remove the CI completely from the 
view (without deleting it from the RTSM), by hiding it from the view in the 
Perspective-based View Editor in the Modeling Studio.

When you delete a relationship that was created by the DFM process, the 
relationship is restored the next time that DFM runs (if the relationship is 
still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple CIs and 
relationships, from a view.
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Inter-Layer Relationships
In certain circumstances, IT Universe Manager displays a relationship 
between CIs in a layer of a view that does not reflect an actual relationship 
between the CIs in that layer, but rather a relationship between CIs on 
deeper layers of the view. Such a relationship is known as an inter-layer 
relationship. 

For example, in the following view, two node CIs are related to each other 
with a dependency relationship. Each is also related to an IP Subnet by a 
membership relationship and the view hierarchy is defined such that the 
nodes are on the layer beneath the IP Subnet. 

When you consume the view in IT Universe Manager, the relationship 
between the node CIs (which are under different IP Subnets) is displayed in 
the higher layer of the view as a relationship between the parent IP Subnets, 
even though the actual relationship only exists between the CIs in the lower 
layer of the view. You can double-click the relationship to display the full 
path between the IP Subnets.
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Another form of inter-layer relationship occurs when the same CI appears 
under more than one parent CI of the same type in the layer above it. In 
such a case, the child CI and its relationships are duplicated in the view 
display, due to the hierarchy definition. The relationships of such child CIs 
result in inter-layer relationships between the parent CIs. This type of inter-
layer relationship is known as a duplication metalink.

For example, in the following view, a single node CI appears under two IP 
Subnet CIs in the hierarchy. The node and its children thus appear twice in 
the view - once under each IP Subnet. Each node is effectively related to the 
child CIs of the node under the other IP Subnet, which generates an inter-
layer relationship between the two IP Subnets.

Inter-layer relationships and duplication metalinks are displayed in gray in 
the topology map. IT Universe Manager provides the following options for 
viewing inter-layer relationships:

➤ None. Hide all inter-layer relationships.

➤ Inter Layer. Display inter-layer relationships of the first type, but not 
duplication metalinks.

➤ Full. Display all inter-layer relationships, including duplication metalinks.
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A tooltip for the inter-layer relationship displays the inner relationships 
which it represents. If there is only one inner relationship, the relationship 
label displays that relationship type. If there are multiple inner 
relationships, the label becomes Inter-layer and the tooltip displays a list of 
all the inner relationships. If there are more than ten inner relationships, 
only the first ten are displayed, and a note indicates that there are more 
inner relationships. 
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Tasks

How to Create CIs and Relationships in the RTSM

This task describes how to create related and non-related CIs, as well as 
relationships between CIs, in the RTSM.

This task includes the following steps:

➤ "Define a New Non-related CI" on page 253

➤ "Define a New Related CI" on page 253

➤ "Attach Existing CIs" on page 253
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Define a New Non-related CI

Click the New CI button in the toolbar. In the New CI dialog box, select a CI 
type from the tree and define the properties for the new CI. For details, see 
"New CI/New Related CI Dialog Box" on page 296.

Define a New Related CI

Click the New Related CI button in the toolbar. In the New Related CI 
dialog box, select a CI type from the tree and define the properties for the 
new CI. On the Relationship page of the dialog box, select the type of 
relationship and define its properties. For details, see "New CI/New Related 
CI Dialog Box" on page 296.

Attach Existing CIs

Select a CI in a view. Right-click the CI and select Relate to CI. In the Insert 
Relationship dialog box, select a target CI. On the Relationship page of the 
dialog box, select the type of relationship and define its properties. For 
details, see "Insert Relationship Dialog Box" on page 280.

How to View Related CIs

The following steps describe the options for viewing related CIs in 
IT Universe Manager.

➤ "Display Related CIs" on page 254

➤ "Select the Scope of the Display" on page 254

➤ "Filter the Related CIs" on page 254

➤ "Apply Perspectives to a CI" on page 254
253



Chapter 8 • IT Universe Manager
Display Related CIs

In IT Universe Manager, select a CI in the Topology map or the CI Selector 
and select the Related CIs tab. Click the Enable Related CIs Retrieval button. 
The selected CI is displayed with its related CIs. Select a different CI or 
multiple CIs from the CI Selector, and the display changes accordingly.

Note: You can display the Related CIs content in map mode or in text mode.

For details on the Get Related CIs user interface, see "Get Related CIs Pane" 
on page 294.

Select the Scope of the Display

In the Get Related CIs pane, select the scope of the related CIs display. Click 
the Show Related CIs button. The display changes according to your 
selection.

Filter the Related CIs

In the Filter Related CIs by CI Type section, select the CI types to appear in 
the related CIs display. Click the Filter Related CIs button. The filtered 
results appear in the tab. The scope selected above still applies and the 
display is reduced according to your filter selection.

Apply Perspectives to a CI

In the Apply Perspectives to CI section, select the perspectives to apply to 
your selected CI. Click the Apply Perspectives button. The results are 
displayed in the tab. 

Note: This feature is only relevant when CMDB is selected as the scope.
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How to Check Status of Application Discovery 
(Rediscover a View)

You, the application owner or administrator, need to be kept informed of 
any problems to your application. So, for example, you need to know that 
discovery is working correctly and that its current configuration can 
connect to the application database. This task describes how to run the 
rediscovery procedure that enables you to check the current status of the 
discovery of an application.

Note: 

➤ Set up and configuration is performed by the HP Business Service 
Management administrator. For details, see "Prerequisites" on page 256.

➤ Rediscovery is performed by the application owner/administrator. For 
details, see "Access the View" on page 256.

➤ You do not need any knowledge of Data Flow Management (DFM) to run 
this procedure.

➤ By default, you can run the rediscovery procedure on views that include 
less than 10,000 CIs. For details on changing this number, see "Important 
information" on page 306.

This task includes the following steps:

➤ "Prerequisites" on page 256

➤ "Access the View" on page 256

➤ "View Results in the View" on page 257

➤ "Schedule the Rediscovery" on page 257
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 1 Prerequisites

Note: This step is performed by the HP Business Service Management 
administrator.

 a In DFM, create a module that contains the jobs that must discover the 
application. For details, see "How to Use Discovery Control Panel – 
Advanced Mode Workflow" in the RTSM Data Flow Management Guide. 

 b Activate the module and all the jobs. The jobs must remain activated.

 c Verify that the module has run without errors. For details, see "Error 
Messages Overview" in the RTSM Developer Reference Guide and 
"Discovery Status Pane" in the RTSM Data Flow Management Guide. 

 d Correct any errors in the application and confirm that DFM finds no 
errors during the next run. 

Caution: The application owner cannot rediscover a view if DFM is 
reporting errors. You must set an error-free baseline.

 e In the Modeling Studio, define a view that includes the application CI 
or CIs to be rediscovered. These are the CIs that are created when you 
activate the jobs that discover the application. For details, see "How to 
Create a Pattern View" on page 367. 

 f Notify the application owner of the name of the view. 

 2 Access the View

Note: This step is performed by the application owner/administrator.
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In IT Universe Manager, access the view that includes the application CIs 
to be rediscovered. For details, see "How to Search for CIs in Search Mode" 
on page 167. 

 3 View Results in the View

 a You need to check the complete application. You click the Show 
Discovery and Changes Summary button in the CI Selector toolbar. 
The Show Discovery Status and Changes of View dialog box is 
displayed. The dialog box displays information about which jobs and 
trigger CI discovered the CIs in the view, on the last occasion that DFM 
ran the discovery for the jobs. For details, see "Show Discovery Status 
and Changes Dialog Box" on page 306.

To run the discovery, click the Rerun Discovery button. To view 
information about the jobs and trigger CIs, use the links to drill down. 
For details, see "Error Messages Overview" in the RTSM Developer 
Reference Guide.

 b You need to check specific components of your application. You select 
the component’s CI in the Topology Map pane and display the 
Discovery tab in the Advanced pane. For details, see "Show Discovery 
Status and Changes Dialog Box" on page 306.

To rediscover several CIs, press CTRL, select the CIs and display the 
Discovery tab.

To run the discovery, click the Rerun Discovery button.

 4 Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the 
Job Definition window, choose the Rerun Discovery on View action. For 
details, see "Job Definition Dialog Box" on page 89.
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How to Retrieve Impact Analysis Results – Scenario

Impact Analysis Manager enables you to create an Impact rule that allows 
you to simulate the impact certain infrastructure changes have on your 
system. The results of the Impact rule are displayed in IT Universe Manager. 
The Impact Analysis results in this task describe how a change in CPU 
operation impacts the node to which it is connected.

This task includes the following steps:

➤ "Define an Impact Analysis TQL Query" on page 258

➤ "Define an Impact Rule" on page 259

➤ "Create a View in the Modeling Studio" on page 261

➤ "Get Impact Analysis Results" on page 261

 1 Define an Impact Analysis TQL Query 

To define an Impact Analysis TQL query, you need to create an Impact 
rule and then add the TQL query nodes and relationships that define the 
query.

To create an Impact Analysis TQL query, select Admin > 
RTSM Administration > Modeling > Impact Analysis Manager. For details 
about how to add query nodes and relationships to a query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on page 35.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a 
Composition relationship.
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 2 Define an Impact Rule

When you define an Impact rule, you must specify the required causal 
relationship between the query nodes. Define one query node as the 
trigger, or the query node that represents the changes you want to make 
to the system, and another query node as the one that is impacted. 

Right-click the query node you want to define as the trigger and select 
Define Impacted to open the Impacted Query Nodes dialog box. Select 
the query node that you want the trigger query node to impact and click 
Next. Then click the Add button to open the Impact Rules Definition 
dialog box to set conditions for defining impacted query nodes. For 
details about how to define an Impact rule, see "Impact Rules Definition 
Dialog Box" on page 476. 

Note: The change state option in the Impact rule definition is no longer 
relevant for Impact Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Severity area defines the severity of the impact on the impacted query 
node.
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The Impact rule in this example states that when the CPU operation is 
not in the normal state, the node is impacted. Since the severity is set to 
100% of the trigger’s severity, the severity of the node is the same as the 
severity of the CPU, which is determined when Impact Analysis is run.

In the resulting TQL query, an upward arrow appears next to the query 
node defined as the trigger query node and a downward arrow appears 
next to the query node defined as the impacted query node.
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 3 Create a View in the Modeling Studio

Go to the Modeling Studio and create a view matching the TQL query of 
the Impact rule you defined. For details, see "Pattern View Editor" on 
page 421.

 4 Get Impact Analysis Results

Select Admin > RTSM Administration > Modeling > IT Universe Manager 
and select the required view in the CI Selector. To get Impact Analysis 
results, you need to run the Impact rule on a CI instance in the topology 
map that is a trigger. Right-click a trigger CI and select Run Impact 
Analysis to open the Run Impact Analysis dialog box. For details on how 
to run an Impact rule, see "Run Impact Analysis Dialog Box" on page 302.

Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node 
connected by a Composition relationship. The CPU query node is defined 
as the trigger query node and the query node of type node is defined as 
the impacted query node.

The following Impact rule is defined for the query.
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Right-click a CPU CI in the view, and select Run Impact Analysis to open 
the Run Impact Analysis dialog box. Set the trigger severity to a value 
other than Normal.
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To see results, click one of the following:

➤ Show in Views. This assigns a status to all the CIs in the view. Only the 
node CI connected to the CPU CI (whose severity was changed), 
becomes impacted. The trigger CI and the impacted CI turn orange 
because the trigger severity was set as Major (7) on the scale in the Run 
Impact Analysis dialog box, which is assigned an orange color. 

➤ Show Map. A map appears in a separate window containing only the 
trigger CPU CI and the node CI it impacted. The relationship 
connecting the two CIs contains the name of the Impact rule defined 
in Impact Analysis Manager. 
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Note: Optionally, you can create a URL that enables you to embed the 
map. For details, see "Direct Link Parameters – Impact Map Page" on 
page 142.

➤ Generate Report. Generates an Impact Analysis report that displays a 
list of CIs that are impacted in the system as a result of the simulated 
changes. For details, see "Run Impact Analysis Dialog Box" on 
page 302.
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How to Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then 
compare snapshots of the same view taken at different times using the 
Compare Snapshots Report. For details on how to take a snapshot of a view, 
see "Save Snapshot Dialog Box" on page 304. For details on how to view 
actual differences in the compared views, see "Compare Snapshots Report" 
on page 326.

How to Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. 
Before printing, it is recommended to define your print settings and arrange 
the contents of the topology map according to your requirements. 

➤ For details on how to define print settings, see "Print Setup Dialog Box" on 
page 209.

➤ For details on how to preview the content of the topology map before 
printing, see "Print Preview Dialog Box" on page 209.

➤ For details on how to print the content of a topology map, see "Print 
Dialog Box" on page 208.

➤ For details on how to save a topology map to file, see "Run Impact 
Analysis Dialog Box" on page 302.
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Reference

IT Universe Manager User Interface

This section includes (in alphabetical order):

 ➤ Add CIs to Model Dialog Box on page 266

 ➤ Add CIs to View Dialog Box on page 267

 ➤ Change Timeframe Dialog Box on page 268

 ➤ CI/Relationship History Dialog Box on page 269

 ➤ Configuration Item Properties Dialog Box on page 273

 ➤ Get Related CIs From CMDB Dialog Box on page 279

 ➤ Insert Relationship Dialog Box on page 280

 ➤ IT Universe Manager Page on page 285

 ➤ New CI/New Related CI Dialog Box on page 296

 ➤ Run Impact Analysis Dialog Box on page 302

 ➤ Save Snapshot Dialog Box on page 304

 ➤ Show Discovery Status and Changes Dialog Box on page 306

 ➤ Show Impact Pane on page 308

Add CIs to Model Dialog Box

This dialog box enables you to add selected CIs to a model. 

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Right click a CI or multiple CIs in 
the CI Selector and select Add CIs to Model. 

Important 
information

This feature is only relevant for instance based models. 
You cannot add selected CIs to a pattern based model.
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User interface elements are described below:

Add CIs to View Dialog Box

This dialog box enables you to add selected CIs to a perspective based view. 

User interface elements are described below:

UI Element (A-Z) Description

<Model tree> When Existing Model is selected, select a model from the 
tree.

Define New CI 
Properties

When New Model is selected, define the name and 
properties of the model.

Existing Model Select Existing Model to add the selected CIs to an 
existing model.

New Model Select New Model to add the selected CIs to a new model.

Select CI Type When New Model is selected, select a CI type for the 
model.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Right click a CI or multiple CIs in 
the CI Selector and select Add CIs to View. 

UI Element (A-Z) Description

<View tree> When Existing View is selected, select a view from the 
tree.

Existing View Select Existing View to add the selected CIs to an existing 
perspective based view.

New View Select New View to add the selected CIs to a new 
perspective based view

View Name When New View is selected, edit the name of the view.
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Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set 
the time frame for the changes to display. 

User interface elements are described below:

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Click the Set Change Timeframe 

 button in the main toolbar or the IT Universe status 
bar.

Important 
information

When the change indicators are displayed in the topology 
map, a message appears in the IT Universe status bar 
Change Timeframe is Active.

To hide the indicators, open the dialog box and select Do 
not display changes, or select the Reset Change 
Timeframe  button in the IT Universe status bar.

UI Element (A-Z) Description

Display changes 
according to the 
selected timeframe

Select this option to display an indicator next to each CI 
that was added or changed within the selected period as 
follows:

➤  Indicator for an added CI

➤  Indicator for a changed CI

Select a time period from the drop-down list. If you select 
Custom, click the ellipsis  button to select the Date 
From and Date Until fields. The changes to the CIs of the 
view within the selected period are displayed in the map.

When the indicators are displayed, you can click the 
indicator to open the CI History dialog box, which 
displays the history for the CI over the selected period.

Do not display 
changes

Select this option to hide the change indicators.
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CI/Relationship History Dialog Box

This dialog box displays a list of CI or relationship attributes in which 
changes have occurred as well as the differences between two configuration 
files. 

To access ➤ In IT Universe Manager, right-click the selected CI or 
relationship in the CI Selector or the Topology Map 
and select CI History.

➤ In Data Flow Management, in the Discovered by 
[Module or Job Name] CIs dialog box, right-click a CI 
and choose CI History. 

Note: CI and relationship history data is also available in 
the History tab of the Advanced pane in IT Universe 
Manager.

Important 
information

Only attributes marked with the Change Monitored or 
Comparable qualifiers are tracked in the CMDB History 
database. If you want an attribute to appear in the CI 
history, select the Change Monitored or the Comparable 
qualifier for it in the Attributes tab of the CI Type 
Manager. For CIs, some attributes are designated as 
Change Monitored by default. For relationships the 
attributes must be designated manually in the CI Type 
Manager.

In addition, to track history for a relationship, you must 
select the TRACK_LINK_CHANGES qualifier for the 
relationship in the Qualifier tab of the CI Type Manager.
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User interface elements are described below:

UI Element (A-Z) Description

Refresh. Refreshes the data in the table.

Show difference. View the difference between two history 
entries for the content of a configuration file. This is 
relevant in the following situations:

➤ Select two history entries for the Document Content 
attribute for CIs of the type Configuration Document 
to compare to each other.

➤ Select one history entry for the Document Content 
attribute for CIs of the type Configuration Document 
to compare to the current content for that CI.

Opens the Visualdiff report, which displays a comparison 
of the two entries. Text added to the second entry appears 
highlighted in yellow. Text removed from the first entry 
appears highlighted in red. Differences between the 
entries appear highlighted in green. 
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable 
number of columns to display to ensure that the report 
is legible. 

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. 

➤ XML. The table data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file 

Attribute The name of the attribute.

Change Date The date when the last change occurred.

Filter by Filter the data in the table by one or more of the 
following filters:

➤ Time Range. Select the time period for which the CI 
history is displayed.

➤ Change Type. Select the type of changes displayed in 
the table.

➤ Attribute. Select the attribute types displayed in the 
table.

UI Element (A-Z) Description
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Modified By Indicates the cause of the change. For example, the field 
can contain the name of a user or a DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

UI Element (A-Z) Description
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Configuration Item Properties Dialog Box

This dialog box enables you to view and edit basic information for an 
existing CI or relationship.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager and use one of the following:

➤ Select a CI in the topology map or the CI Selector. In the 
Advanced Pane, select the Properties tab and click Edit. 

➤ Right-click a CI in the CI Selector or the Topology map 
and select Properties.

Important 
information

The Configuration Item Properties dialog box contains two 
types of properties: 

➤ General properties, which include general information 
about the CI or relationship. These properties are 
common to all CITs and are documented below.

➤ CIT-specific properties, which include properties specific 
to that CI. These properties vary according to the type of 
CI or relationship and are not documented except in the 
case of TransactionVision Monitor CIs. For details about 
TV Monitor CIs, see "Transaction Configuration Page, 
Tracing Tab" in Using Transaction Management.

When you sort the properties by category, the CIT-specific 
properties appear at the top of the list and the general 
properties appear at the bottom.

You can view a description of the selected property in the 
Description Area at the bottom of the dialog box. Click the 
Show/Hide Description Area button to display the 
Description Area.

When accessing the Configuration Item Properties dialog 
box from within certain applications, the fields are not 
editable.

Mandatory fields are denoted by an asterisk.

Note: HP Universal CMDB does not fully support surrogate 
pairs and combining characters.

See also "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide
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User interface elements are described below:

UI Element (A-Z) Description

Displays the properties by category.

Displays the properties alphabetically.

Toggles between showing and hiding the description area at 
the bottom of the CI Properties dialog box.

Expand. Expands the properties tree when the properties are 
displayed by category.

Collapse. Collapses the properties tree when the properties 
are displayed by category.
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Choose the export format for the table data. The available 
options are: 

➤ Excel. The table data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The table data is exported in PDF format.
Note: When exporting to PDF, select a reasonable 
number of columns to display to ensure that the report is 
legible. 

➤ RTF. The table data is exported in Rich Text Format.

➤ CSV. The table data is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the Control 
Panel, and on the Numbers tab ensure that the comma is 
defined as the List Separator value. 

➤ XML. The table data is formatted as an XML file that can 
be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Save the file as HTML

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file

UI Element (A-Z) Description
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<Quick filter> Enter a string in the Quick filter box to filter the property 
names and values. Click the left end of the box to open the 
drop-down menu of filter options:

➤ Select All to search for the filter string in both property 
names and property values. Select Name to search for the 
filter string in property names only. Select Value to search 
for the filter string in property values only.

➤ Select Case sensitive to search for the filter string exactly 
as entered. Select Case insensitive to ignore the case of 
the filter string.

➤ Select Use wild cards to use the wildcard symbol * in the 
filter string.

➤ Select Match from start to search for the filter string at 
the beginning of a property name or value. Select Match 
exactly to search for the exact filter string. Select Match 
anywhere to search for the filter string anywhere in the 
properties.

Actual Deletion 
Period

The number of days after which the CI or relationship is 
deleted.

Allow CI Update When selected, this option allows the DFM process to 
automatically update the CI or relationship properties with 
information that it discovers. If you change the value of a 
property supplied by the DFM process, the value is 
overridden by the discovered value.

When this option is cleared, the CI or relationship 
properties are not overridden by the DFM process.

Apply Apply. Saves the changes made to the CI or relationship 
properties.

CI Type The type of the CI or relationship (read-only value). For 
information about CITs in HP Business Service 
Management, see "CI Type Manager" on page 483.

Created By The user name of the administrator who manually created 
the CI or relationship, where applicable (read-only value).

Create Time The date and time when the CI or relationship was created.

UI Element (A-Z) Description
276



Chapter 8 • IT Universe Manager
Deletion 
Candidate Period

The period after which the CI becomes a candidate for 
deletion when the aging mechanism is enabled.

Description A brief description of the CI or relationship.

Display Label The name of the CI or relationship as it appears in the CI 
Selector.

Edit In the Properties tab of the Advanced pane, you can view a 
CI’s properties but you cannot edit them. Click Edit to open 
the Configuration Item Properties dialog box where you can 
edit the properties.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the RTSM. For details, see "CI Lifecycle and the 
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: False. The default value for DFM CIs is True.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.

Global Id The internal ID of the CI or relationship in the RTSM (read-
only value).

Last Access Time The time that the CI or relationship was last accessed, 
whether when being updated or being discovered by DFM. 
This field is only displayed for certain CIs or relationships.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide.

Last Modified 
Time

The date and time when the CI or relationship properties 
were last updated.

Monitored By Indicates whether the CI is monitored by a SiteScope 
monitor or an EMS Integration monitor.

UI Element (A-Z) Description
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Shortcut Menu

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or 
relationship.

Origin An ID for the source that automatically created the CI or 
relationship, or the application where the CI or relationship 
was created (read-only value).

Reset Restores the original property settings of the CI or 
relationship.

Updated by The user name of the administrator who updated the CI or 
relationship properties.

User Label Enables you to define a display label for the CI or 
relationship. If no value is entered, the CI name appears as 
the default label.

Menu Item Description

Copy Property Name 
and Value

Copies the name and value of the selected property to the 
memory.

UI Element (A-Z) Description
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Get Related CIs From CMDB Dialog Box

This dialog box enables you to view the CIs related to a specified CI in the 
RTSM in map or table format.

To access In IT Universe Manager, right-click the required CI and 
select Get Related CIs.

Important 
information

The Get Related CIs From CMDB dialog box is a 
standalone version of the Related CIs tab in IT Universe 
Manager. You can control the content of the display using 
the features in the Get Related CIs pane. For details, see 
"Get Related CIs Pane" on page 294.

You cannot select the scope of the related CIs displayed in 
the Get Related CIs From CMDB dialog box. The scope is 
the entire CMDB. 

Note: The text mode format includes the icons found in 
the Element Instances dialog box. For details, see 
"Element Instances Dialog Box" on page 82.

Relevant tasks "How to View Related CIs" on page 253
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Insert Relationship Dialog Box

This dialog box enables you to attach CIs to the CI you selected in the CI 
Selector.

User interface elements are described below:

To access In IT Universe Manager, right-click a CI in the Topology 
Map or the CI Selector, and select Relate to CI.

Important 
information

To create a relationship between two CIs, select the source 
CI in the CI Selector or the Topology Map and then select 
Relate to CI from the shortcut menu. On the first page of 
the dialog box (the CI Selection page), you select the target 
CI(s). Then click Relationship, to select the relationship type 
on the second page of the dialog box.

You can also create a relationship between two CIs 
graphically by clicking the Create Relationship  button 
in the toolbar and drawing a line between the two CIs. In 
this case, a smaller version of the Insert Relationship dialog 
box opens, which contains the following tabs:

➤ Select Relationship. Displays a tree with the available 
relationship types. Select the required relationship.

Note: You can double-click the relationship you select to 
save using the default properties.

➤ Relationship Properties. Displays the properties of the 
selected relationship. You can edit the properties as 
described in "Define Relationship Properties Pane" on 
page 282.

Relevant tasks "How to Create CIs and Relationships in the RTSM" on 
page 252

See also "CI Selector" on page 173

UI Element (A-Z) Description

Adds the selected CIs in the left pane to the Target CIs pane.

Removes selected CIs from the Target CIs pane (this does 
not delete the CIs from the RTSM).
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Relationship Page
This page enables you to define the relationship to be created between the 
original CI and the CIs selected in the CI Selection page of the dialog box.

User interface elements are described below:

Select Relationship Pane

Select target CIs Select a view to display in the view tree and select CIs to 
move to the Target CIs pane.

For details on the Select target CIs pane, see "CI Selector" on 
page 173. 

Source CI The CI you selected as the source CI.

Target CIs Displays the CIs you have selected as target CIs for the 
relationship.

To access Click the Relationship button from the Insert Relationship 
dialog box.

Important 
information

When defining multiple relationships, you can define 
different descriptions and property values for each 
relationship. Skip the property definitions here and edit 
each relationship individually after it is created.

UI Element (A-Z) Description

Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or 
between a group CI and a monitor CI), only one direction is 
valid. 

Relationship Define the type of relationship created between the original 
CI and the CIs being attached. Select an option from the 
list. 

UI Element (A-Z) Description
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Define Relationship Properties Pane

Source CI Displays the name of the CI on the first end of the 
relationship. This is the CI that you selected in the view.

Target CI Displays the name of the CI on the second end of the 
relationship, that is attached to the original CI.

UI Element (A-Z) Description

Actual Deletion 
Period

The period after which the relationship is deleted when the 
aging mechanism is enabled.

Allow CI Update When the value is set to true, the DFM process 
automatically updates the relationship.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Deletion 
Candidate Period

The number of days after which the relationship becomes a 
candidate for deletion.

Description A detailed description of the relationship.

Destination 
Network Address

Defined only for route links. Indicates the destination 
network address to which this route is configured.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the RTSM. For details, see "CI Lifecycle and the 
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is only displayed for certain CIs.

UI Element (A-Z) Description
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Last Access Time The time that the relationship was last accessed, whether 
when being updated or being discovered by DFM. This field 
is displayed only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide.

Last Modified 
Time

The date and time when the relationship properties were 
last updated.

Must When the value is set to true, the child CI is dominant when 
the percentage rule is used to calculate status for the parent 
CI. If the CI has low status, the parent must take the child 
CI status, if necessary overriding the percentage rule 
calculation. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The must status defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
of the child CI. For details, see "Understanding the 
Percentage Rule" in Using Service Health.

Name A brief description of the relationship. If no value is entered, 
the relationship type is used in place of the name.

Note Enables you to enter other information about the 
relationship.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Updated By The user name of the administrator who updated the CI 
properties.

UI Element (A-Z) Description
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User Label Enables you to define a display label for the relationship. If 
no value is entered, the relationship name appears as the 
default label.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when percentage rule is 
used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies for that 
relationship only – it is not used in any other relationships 
the child CI may have. For more details, see "Understanding 
the Percentage Rule" in Using Service Health.

UI Element (A-Z) Description
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IT Universe Manager Page

This page enables you to define and manage the CIs and relationships in 
your views.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager.

Important 
information

The IT Universe Manager page contains the following 
panes:

➤ CI Selector. Displays the CIs of a selected view. You can 
select the view from a drop–down list or search for a 
specific CI. For details, see "CI Selector" on page 173.

➤ Topology Map. Displays the CIs of a selected view in 
Map mode or Text mode.

➤ Advanced Pane. Displays properties, history, and 
discovery for the selected CI or view.

➤ Get Related CIs. This pane can be accessed from the 
Related CIs tab of the Topology Map. It controls the 
content of the display in the tab.

In IT Universe Manager, you can create new CIs, modify 
existing CIs, or delete CIs. All of these actions have a 
direct effect on the entire IT Universe model. For 
example, if you delete a CI in your view, that CI is deleted 
from the IT Universe model and no longer appears in any 
view.
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Topology Map

This area displays the CIs of the currently selected view in graphical or table 
format. By default, the CIs are displayed in graphical format.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager.

Important 
information

You can customize the Topology Map shortcut menu to 
include other commands (for example, ping, run a 
program, open a URL) from within CI Type Manager. For 
details, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 505.

Note: For grouped CIs and the relationships between 
them, not all of the shortcut menu options are active. 
Grouped CIs appear in parentheses in the CI Selector and 
in the Topology Map. You can double-click a link to a 
grouped CI to open the Link Map, which displays the 
individual CIs and relationships. Right-click a CI or 
relationship in the Link Map to display the regular 
shortcut menu. For details about grouping CIs, see "Query 
Node Grouping Dialog Box" on page 433.

See also "Working with Topology Map" on page 185

UI Element (A-Z) Description

Map 
mode

Displays the selected layer of CIs in topology map format.

Note: If the selected layer of the view is too large to 
display in topology map format, a message appears with a 
link to display the layer in text format.

Text mode Displays the attribute properties of the CIs in the selected 
layer in table format.

For details on some of the toolbar icons in Text Mode, see 
"Element Instances Dialog Box" on page 82.
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Specify the CIT you want displayed in the table. The table 
also includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate 
the relevant query nodes in each layer of the view for the 
path to the selected layer. The first item in the path is the 
Top Layer. When you select a CI from the layer below, the 
parent CI forms the next item in the breadcrumb path. 
You can click on any item in the path to display that layer 
in the topology map.

<CI type attributes> The columns appearing in Text mode represent the CIT 
attributes of the selected CIs.

<IT_Universe Status 
Bar>

The status bar below the topology map indicates the 
status of the following processes:

➤ if Impact Analysis is active or not

➤ if Change Timeframe is active or not

➤ if Candidates for Deletion are shown or not

➤ the time of the last update of the data

<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Impacted. When Impact Analysis is active, indicates an 
impacted CI.

➤ Impacted and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is impacted.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, indicates 
that the CI was changed.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Main Menu> For details, see "Main Menu" on page 207.

UI Element (A-Z) Description
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<Query Node> The query nodes in the topology map represent CIs.

Hold the pointer over a query node to display its tooltip 
which describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

Note: When you select a calculated relationship, the 
Delete  button in the toolbar is disabled. 

<Toolbar> For details, see "Toolbar Options" on page 211.

Note: When accessing the Topology map via direct links, 
the toolbar includes options from the Related CIs Map. 
For details, see "Get Related CIs From CMDB Dialog Box" 
on page 279.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 219.

Related CIs Related CIs tab. Displays the interdependencies of the 
selected CI within the view or the entire RTSM. You can 
control the scope of the display from the Get Related CIs 
pane.

View Results View Results tab. Displays an entire layer within a view.

UI Element (A-Z) Description
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IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed 
alphabetically) available by right-clicking a CI or relationship in the CI 
Selector pane or the Topology Map:

Menu Item Description

Actions Select one of the following options:

➤ Add CI to Discovery Job. Displays the Add CI to 
Discovery Job dialog box, which enables you to 
manually invoke a DFM job for the selected CI. You 
can use this option to discover additional information 
about the CI through one of the available DFM jobs.

➤ Remove CI from Discovery Job. Displays the Remove 
CI from Discovery Job dialog box, which enables you 
to manually remove a CI from the DFM job.

➤ Show Discovery status. Opens the Discovery Status 
dialog box for the selected CI.

➤ Open CI Credentials. Displays the Protocol Parameter 
dialog box, which enables you to view the details of a 
previously-defined credential for that CI. You cannot 
make any changes. This option is only relevant for CIs 
that include a credentials property. 

For details, see "Protocol Parameter Dialog Box" in the 
RTSM Data Flow Management Guide.

➤ Edit CI Credentials. Displays the Choose Credentials 
dialog box, which enables you to choose another 
credentials set or edit the existing credentials. This 
option is only relevant for CIs that include a 
credentials property.

For details, see "Supported Protocols" in the RTSM Data 
Flow Management Guide.

Add CIs to Model Adds selected CIs to a new or existing model.

Add CIs to View Adds selected CIs to a new or existing perspective based 
view.

CI/Relationship 
History

Displays the CI History dialog box. For details, see 
"CI/Relationship History Dialog Box" on page 269.
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Compare CIs Report Run a Compare CIs Report for the selected CI. For details, 
see "Compare CIs Report" on page 587.

Delete from CMDB Enables you to delete the selected CI or relationship from 
the view and from the RTSM.

Note: When you delete a parent CI, the selected CI and 
its children are removed from the view, but only the 
selected CI is removed from the database.

Get Related CIs Opens the Get Related CIs from CMDB dialog box. For 
details, see "Get Related CIs From CMDB Dialog Box" on 
page 279.

Label Select one of the following options:

➤ Edit Label. Opens the Edit Label dialog box which 
enables you to edit the name of the CI.

➤ Restore Default Label. Resets the CI name to its default 
value from the RTSM.

Menu Item Description
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Merge CIs Opens the Merge CIs dialog box enabling you to 
manually merge Running Software, Node, and Business 
Element CIs. 

In the Merge CIs dialog box, select one of the CIs to be 
the main CI. The other CIs, the merging CIs, are merged 
into the main CI. CIs are merged as follows:

➤ Properties from the merging CIs that do not exist in 
the main CI are copied to the main CI. 

➤ Properties that exist in both the main and merging CIs 
are merged according to the defined reconciliation 
priority:

➤ If all the CIs have the same priority, then the 
main CI’s property is retained.

➤ If the CIs have different priorities, the property of 
the CI with the higher priority is used.

After the merge, the Global ID of the main CI remains, 
and the merging CIs are deleted. 

Note: 

➤ This option is only relevant when at least two CIs of 
type Running Software, Node, or Business Element are 
selected. CIs can only be merged if their CI types are 
on the same branch in the Class Model.

➤ When you merge CIs, the topologies of the views that 
contain those CIs are updated.

Example:

Menu Item Description
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Note Select one of the following options:

➤ Add Note. Opens an editing box where you can add a 
note to the CI.

➤ Delete Note. Deletes all text saved in a note for the 
selected CI.

Properties Displays the Properties page for the selected CI or 
relationship. For details, see "Configuration Item 
Properties Dialog Box" on page 273.

Relate to CI Opens the Insert Relationship dialog box. For details, see 
"Insert Relationship Dialog Box" on page 280.

Run Impact Analysis Enables you to run the Impact rule you defined in the 
Impact Analysis Manager. Displays the Run Impact 
Analysis dialog box. For details, see "Impact Analysis 
Manager" on page 457.

Note: You can only see Impact Analysis results if you 
defined an Impact rule for that view in Impact Analysis 
Manager. 

Show Compound 
Path

Appears only for compound relationships. Displays the 
Link Map for the selected relationship, which shows the 
CIs involved in the compound relationship.

Menu Item Description
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Show Impact Enables you to select a CI that is defined by an Impact 
rule as a root cause CI, and to display all the CIs that are 
impacted by it, and their statuses, in a separate window.

This option appears only after the following has occurred:

➤ You defined an Impact rule for the selected view in 
Impact Analysis Manager (for details, see "Impact 
Analysis Manager" on page 457).

➤ You clicked Show in Views in the Run Impact Analysis 
dialog box. 

➤ Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP 
Address CI) that specifies that the rule impacts nodes, 
ports, and client-servers linked to the IP Address.

By using the Show Impact option, you can display all CIs 
that are impacted by the IP Address CI.

Show Root Cause This option enables you to retrieve root cause 
information for CIs that are impacted by a chain of 
Impact rules. The output of Show Root Cause displays a 
logical map that describes a chain of trigger/impacted 
CITs that impact the CI.

The root cause CI is displayed in a separate window. If 
only one Impact rule is defined for this CI, the Impact 
Analysis window is directly displayed.

This option appears only after the following has occurred:

➤ You defined an Impact rule for the selected view in the 
Impact Analysis Manager (for details see, "Impact 
Analysis Manager" on page 457).

➤ You clicked Show in Views in the Run Impact Analysis 
dialog box. 

➤ Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause CI and 
all the other CITs in the Impact rule chain.

To view the information about specific CIs that are 
triggered or impacted by the Impact rule, double-click the 
relationship connecting the CIs. A map is displayed.

Menu Item Description
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Advanced Pane

User interface elements are described below:

Get Related CIs Pane

This pane enables you to control the different options for viewing related 
CIs for a selected CI.

UI Element (A-Z) Description

Discovery tab Displays the DFM run status for the selected CIs. For 
details, see "Show Discovery Status and Changes Dialog 
Box" on page 306 and "Discovery Status Pane" in the 
RTSM Data Flow Management Guide.

History tab  Displays the history for the selected CI. For details, see 
"CI/Relationship History Dialog Box" on page 269. 

Properties tab Displays the selected CI’s properties (the same properties 
that appear in the Configuration Item Properties dialog 
box). You can view the properties in the properties tab, 
but you must open the dialog box to edit the properties. 
For details, see "Configuration Item Properties Dialog 
Box" on page 273.

To access Appears in the Related CIs tab of IT Universe Manager. If 
it is hidden, click the Show Get Related CIs pane  
button in the toolbar to display it.

Important 
information

You can control the display in the Related CIs tab with 
the following controls:

➤ Set the scope of the display

➤ Filter the related CIs by CI type

➤ Apply perspectives to the selected CI

It is possible to display related CIs for several CIs at the 
same time. Use the CTRL key to select multiple CIs at the 
same time in the CI Selector or the topology map.

Note: The Get Related CIs functionality is not available 
for federated CIs.

Relevant tasks "How to View Related CIs" on page 253
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User interface elements are described below:

UI Element (A-Z) Description

Display the previous search results.

Display the next search results.

When the button is selected, the related CIs are added to 
the current results. When it is not selected, the current 
display content is cleared and only the new related CIs 
are displayed.

Apply perspectives to 
CI

Select perspectives from the list to apply to the selected 
CI. Only perspectives relevant to the selected CI appear in 
the list. The selected CI is used as content for the selected 
perspectives and the view results are displayed.

Note: 

➤ Application of perspectives is only relevant when 
CMDB is selected as the scope. The feature is inactive 
when View is selected as the scope.

➤ The perspectives displayed in the Apply Perspectives to 
CI list are filtered according to the value set for the 
Enable perspective permission enforcement on 
consumption functionality setting in RTSM - General 
Settings in Infrastructure Settings Manager.

➤ If the value is set to False, all the perspectives are 
displayed, regardless of the View permissions the 
user is given.

➤ If the value is set to True,  the perspectives that are 
displayed are based on the View permissions the 
user is given.

The default for the Enable perspective permission 
enforcement on consumption functionality setting is 
False.

Filter Related CIs by 
CI Type

Select the CI types from the list to display in the related 
CI results. Only the selected CI types appear in the 
displayed results.
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New CI/New Related CI Dialog Box

This dialog box enables you to define a new CI or a new related CI.

Select scope Select the scope of the related CIs displayed:

➤ View. All related CIs in the selected view.

➤ CMDB. All related CIs in the RTSM.

Note: This feature is not available in the Get Related CIs 
from CMDB dialog box opened from the shortcut menu.

Show Related CIs Displays the related CIs according to your selection.

To access In IT Universe Manager, click the New CI icon  in the 
toolbar to create a non-related CI. Select a CI in the 
topology map and click the New Related CI icon  to 
create a related CI.

Important 
information

To define a new CI, select the CI type from the tree at the 
top of the dialog box. The CI types in the tree that are 
available to be instantiated appear in black. The CI types in 
faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The 
table below includes the properties which are common to 
all CIs. In addition, there are other properties specific to 
each CI.

If you are creating a related CI, click the Relationship button 
to go to the relationship mode of the dialog box. Select a 
relationship and edit its properties.

Relevant tasks "How to Create CIs and Relationships in the RTSM" on 
page 252

See also ➤ "CI Selector" on page 173

➤ "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Actual Deletion 
Period

The period after which the CI is deleted when the aging 
mechanism is enabled.

Allow CI Update When the value is set to true, this option enables the DFM 
process to automatically update the CI properties with 
information that it discovers. If you change the value of a 
property supplied by the DFM process, the value is 
overridden by the discovered value.

When the value is set to false, the CI properties are not 
overridden by the DFM process.

Created By The user name of the administrator who manually created 
the CI, where applicable.

Create Time The date and time when the CI was created.

Deletion 
Candidate Period

The period after which the CI becomes a candidate for 
deletion when the aging mechanism is enabled.

Description A description of the CI.

Display Label The label that appears for the CI in the topology map.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the RTSM. For details, see "CI Lifecycle and the 
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.

Is Candidate For 
Deletion

Indicates if the CI is a candidate for deletion.
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Last Access Time The time that the CI was last accessed, whether when being 
updated or being discovered by DFM. This field is displayed 
only for certain CIs.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide.

Last Modified 
Time

The date and time when the CI properties were last updated.

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the CI, or 
the application where the CI was created.

Relationship For a related CI, click Relationship to go to the relationship 
mode of the dialog box.

Select CI Type Enables you to select the CI type from the tree for the new 
CI. The CI types that are available for the selected CI or view 
appear active in the CI type tree. The other CI types appear 
in faded text and cannot be selected.

To limit the CI type tree to CI types from the current view, 
select CI Types from the current view on the right. To 
display all CI types in the tree, select All CI Types.

Updated By The user name of the administrator who updated the CI 
properties.

User Label Enables you to define a display label for the CI. If no value is 
entered, the CI name appears as the default label.

UI Element (A-Z) Description
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Relationship Dialog Box
This page enables you to define the relationship between the new CI and 
the CI selected in the view, as well as the properties of the relationship.

User interface elements are described below:

To access Click the Relationship button from the New Related CI 
dialog box.

Important 
information

This page only appears for new related CIs.

UI Element (A-Z) Description

Allow CI Update When the value is set to true, the DFM process 
automatically updates the relationship.

CI Definition Returns to the CI properties mode of the dialog box.

Created By The user name of the administrator who manually created 
the relationship, where applicable.

Create Time The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.

Enable Aging If a CI or relationship is not updated or refreshed over a 
period of time (for example, a CI is not rediscovered by DFM 
and no manual update occurs), an aging mechanism deletes 
the CI from the RTSM. For details, see "CI Lifecycle and the 
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or 
relationship.

Default value: false. The default value for DFM CIs is true.

Note: 

➤ If the aging mechanism is disabled, this field is ignored.

➤ This field is displayed for certain CIs only.
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Last Access Time The time that the relationship was last accessed, whether 
when being updated or being discovered by DFM. This field 
is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details, 
see "CI Lifecycle and the Aging Mechanism" in the RTSM 
Administration Guide.

Must When the value is set to true, the child CI is dominant 
when the percentage rule is used to calculate status for the 
parent CI. If the CI has low status, the parent must take the 
child CI status, overriding the percentage rule calculation if 
necessary. This is useful to give emphasis to an important 
CI. For example, you might want to define Must for a 
database CI, so that status is critical all the way up the 
subtree if the database falls, regardless of the status of the 
other CIs in the subtree.

The Must status defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI. 

Name The name of the CI.

Network Address Defined only for route links. Indicates the destination 
network address to which this route is configured.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the 
relationship, or the application where the relationship was 
created.

Relationship Enables you to define the type of relationship that is created 
between the two CIs. 

Source CI The name of the CI on the first side of the relationship. This 
is the CI that you selected in the view.

Target CI The name of the CI on the second side of the relationship. 
This is the new CI that you are creating.

Updated By The user name of the administrator who updated the 
relationship properties.

UI Element (A-Z) Description
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Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child CI is given more 
weight in percentage calculations, when the percentage rule 
is used to calculate status for the parent CI. For example, if a 
child CI is given a weight of 3, then it has three times more 
impact on the parent status calculation than its unweighted 
siblings.

The weight defined for a relationship applies to that 
relationship only – it is not used in any other relationships 
of the child CI. 

UI Element (A-Z) Description
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Run Impact Analysis Dialog Box

This dialog box enables you to run the Impact rule you defined in Impact 
Analysis Manager for that view.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Right-click a trigger query node in 
the Topology Map and select Run Impact Analysis or click 
the Run Impact Analysis Now  button in the 
IT Universe status bar.

Important 
information

You can:

➤ Display in a new window all the CIs that are impacted 
by the trigger CI. The relationships in the map 
represent the Impact rules. The name of the 
relationship is the name of the Impact rule you defined 
in the Impact Analysis Manager. For details, see "Show 
Map" on page 304.

➤ Simulate how the statuses of the impacted CIs are 
impacted. For details, see "Show in Views" on page 303.

➤ Generate a report that displays a list of CIs that are 
impacted in the system as a result of the simulated 
changes. For details, see "Generate Report" on 
page 303.

Note: This dialog only appears if an Impact rule is defined 
for that view. For details, see "Impact Analysis Manager" 
on page 457.

Relevant tasks "How to Retrieve Impact Analysis Results – Scenario" on 
page 258
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User interface elements are described below:

UI Element (A-Z) Description

All Impact rules Select to execute all impact rules in the impact analysis.

Generate Report Generates an Impact Analysis report, which displays 
information that is divided as follows:

➤ Grouping by CIT. All the impacted CIs (the CIs that are 
impacted in the system as a result of the simulated 
changes), sorted by CIT.

➤ Affected Application. All the impacted CIs that belong 
to a specific business service. 

➤ Triggered CIs. The CIs that represent the changes you 
want to make to the system.

For details on the Impact Analysis report, see "Impact 
Analysis Report" on page 331.

Impact rules bundle Select the bundle containing the required impact rules 
for the impact analysis.

Only Impact rules 
located in specified 
bundle

Select to execute the impact rules from the specified 
bundle in the impact analysis.

Show in Views Simulates how the statuses of the impacted CIs are 
impacted for the selected state. The Topology Map 
displays the statuses of the trigger CIs as well as all 
statuses of the CIs that are impacted by it.

The Topology Map also displays the Impact Analysis 
indicators:

➤ A trigger CI is marked by this  (up arrow) indicator.

➤ A CI that is both an impacted and a trigger CI is 
marked by this  (up and down arrow) indicator.

➤ An impacted CI is marked by this  (down arrow) 
indicator.

Note: The statuses that appear here and the colors that 
represent each status are defined in the severity list for 
that state in the System Type Manager. For details, see 
"Create/Update List/Enumeration Definition Dialog Box" 
on page 522.
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Save Snapshot Dialog Box

This dialog box enables you to take a snapshot of a view and save it.

Show Map Enables you to select an Impact rule, and then display in 
a new window, a simulation of all the CIs that are 
impacted by the trigger CI for the selected state. If only 
one Impact rule is defined for this CI, the Impact Rules 
window is displayed directly. For more details, see "Show 
Impact Pane" on page 308. 

The relationships in the map represent the Impact rules 
and the name of the relationship is the name of the 
Impact rule you defined in the Impact Analysis Manager.

Note: Show Map enables you to view the results of 
multiple triggers.

Trigger Severity Select the required severity on the scale. 

Note: The severity scale was defined for the state in the 
System Type Manager. For details, see "System Type 
Manager" on page 488.

For example, you can create an Impact rule in the Impact 
Analysis Manager that defines the severity of the trigger 
query node as other than Warning (1). If you select a 
severity other than Warning (1), for example, Minor (3), 
the condition is met and the simulated changes in the 
system are triggered.

For details, see the "Impact Rules Definition Dialog Box" 
on page 476.

To access In IT Universe Manager, click the Snapshot  button in 
the CI Selector and select Save Snapshot.

Important 
information

You can compare snapshots of the same view taken at 
different times using the Compare Snapshots Report. For 
details, see "Compare Snapshots Report" on page 326.

Relevant tasks "How to Take a Snapshot of a View" on page 265

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in the CI Selector. This 
field cannot be edited.
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Show Discovery Status and Changes Dialog Box

This dialog box enables you to find recent changes, for example, to an 
application, by rediscovering the CIs and jobs in a view.

To access In IT Universe Manager:

➤ To rediscover all CIs of a view, click the Show 
Discovery and Changes Summary  button in the CI 
Selector toolbar. The Show Discovery Status and 
Changes dialog box is displayed.

➤ To rediscover one CI or several CIs in a view, select the 
CI and display the Discovery tab in the Advanced 
pane.

Important 
information

By default, you can run the rediscovery procedure on 
views that include less than 10,000 CIs. 

To increase the number of CIs that you can rediscover in 
a view:
1  Access the Infrastructure Settings Manager (Admin > 

Platform > Setup and Maintenance > Infrastructure 
Settings).

2  Select the Max CIs in view supported to rediscover 
setting in the infrastructure settings table. 

3  Click the Value column and change the number.

4  Restart the server for the change to take effect.

For details on working with the Infrastructure Settings 
Manager, see "Infrastructure Settings" in Platform 
Administration.

Relevant tasks "How to Check Status of Application Discovery 
(Rediscover a View)" on page 255

See also "Discovery Status Pane" in RTSM Data Flow Management 
Guide
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User interface elements are described below:

UI Element (A-Z) Description

Refreshes the status of the selected CIs.

This button is disabled when there is no data to be 
reloaded.

Reruns the discovery.

Discovery Progress 
Status on View

For details, see "Discovery Status Pane" in the RTSM Data 
Flow Management Guide.

History Changes on 
View

For details, see "CI/Relationship History Dialog Box" on 
page 269.
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Show Impact Pane

This page opens a window that displays the statuses of the trigger CI as well 
as all statuses of the CIs that are impacted by it. 

To access In the Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click on the Impact 
Analysis Is Active link in the IT Universe status bar.

Important 
information

The following tabs are available:

➤ Impact Results. Displays a map of all CIs impacted by 
the selected CI.

➤ Trigger CIs. Displays a table of information on the 
selected trigger CIs.

You can only see Impact Analysis results if you defined an 
Impact rule for that view in Impact Analysis Manager. For 
details, see "Impact Analysis Manager" on page 457.

To view information about specific CIs that are triggered 
or impacted by the Impact rule, double-click the 
relationship connecting the CIs. A map is displayed.

The relationships in the map represent the Impact rules. 
The name of the relationship is the name of the Impact 
rule you defined in the Impact Analysis Manager.

Relevant tasks "How to Retrieve Impact Analysis Results – Scenario" on 
page 258
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Impacted. When Impact Analysis is active, indicates 
an impacted CI.

➤ Impacted and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is impacted.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, indicates 
that the CI was changed.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Relationship> The relationships represent the Impact rule you defined 
in the Impact Analysis Manager. For details, see "Impact 
Rules Definition Dialog Box" on page 476.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that are defined in the severity 
list for that state in the System Type Manager. For details, 
see "Create/Update List/Enumeration Definition Dialog 
Box" on page 522.

<Toolbar> The Show Impact pane toolbar contains most of the 
buttons in the IT Universe Manager toolbar.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 219.
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Reports

This chapter includes:

Concepts

➤ Topology Reports Overview on page 312

Tasks

➤ How to Compare CIs on page 313

➤ How to Compare Snapshots on page 315

Reference

➤ Cron Expressions on page 317

➤ Reports User Interface on page 318
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Concepts

Topology Reports Overview

Topology reports provide a method of displaying the data from views in a 
report format. Every view defined in the Modeling Studio has a 
corresponding topology report. The report settings are defined in the view 
definition in Report mode in the Pattern View Editor. For details, see 
"Pattern View Editor" on page 421. 

For details on selecting the CIs to be displayed in a view, see "Working with 
the CI Selector" on page 165.

Templates and perspectives do not have topology reports. However, 
template-based views do have topology reports. The reports settings for such 
views are based on the settings defined in the base template or perspective.

Several additional reports are available in IT Universe Manager, including 
Asset Report, Compare CIs Report, Compare Snapshots Report, and Impact 
Analysis Report.
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Tasks

How to Compare CIs

This task explains how to compare the hierarchies of two compound CIs, 
view a CI’s configuration file, and show the difference between two 
configuration files.

This task includes the following steps:

➤ "Select the Required CIs" on page 313

➤ "View a CI’s Configuration File" on page 314

➤ "Show the Difference Between Two Configuration Files" on page 314

 1 Select the Required CIs

In IT Universe Manager, select the two CIs you want to compare. The 
hierarchies of the two compound CIs are compared in the Compare CIs 
report (for details, see "Compare CIs Report" on page 321). You can choose 
to compare two CIs that appear in a selected view, or in the RTSM. For 
details, see "CI Selector" on page 173.

Example of Nonmatching CIs:

The following example displays the following:

The No Matching CI icon next to the CI LABM3QCRNDDB03 because it 
has no corresponding CI on the other side.
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The Show Different Attribute Values icon is displayed next to the 
MemorySize properties for the CIs LABM3QCRNDDB02 and 
LABM3ASTDB01 since they have different MemorySize values.

 2 View a CI’s Configuration File

Select a CI of the CIT Configuration File and view the configuration file. 
For details, see "Compare CIs Report" on page 321.

 3 Show the Difference Between Two Configuration Files

Select two CIs of the CIT Configuration File and view the difference 
between the two configuration files. For details, see "Compare CIs Report" 
on page 321.
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How to Compare Snapshots

This task describes how to take a snapshot of a view, and then compare two 
snapshots of a specific view taken at different times.

This task includes the following steps:

➤ "Take a Snapshot of a View" on page 315

➤ "Save Snapshots on a Periodic Basis" on page 315

➤ "Compare Snapshots" on page 315

 1 Take a Snapshot of a View 

In IT Universe Manager, click the Snapshot button and select Save 
Snapshot to take a snapshot of a view and save it. For details, see the "Save 
Snapshot Dialog Box" on page 304.

 2 Save Snapshots on a Periodic Basis

Optionally, you can schedule snapshots to be taken of a certain view at 
specific times by defining a task. For details, see "Schedule Snapshot 
Dialog Box" on page 335.

 3 Compare Snapshots

Compare the snapshots of a view taken at different times. Click the 
Snapshot button and select Compare snapshots. For details, see "Compare 
Snapshots Report" on page 326.
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Example of Snapshots of a View Taken at Different Times:

In the following example, the Deleted Item icon next to the 
192.168.163.0 CI in the right pane, indicates that the CI has been deleted 
in the newer view.
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Reference

Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by 
white space. Six of the fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

The following table contains examples of how to use Cron expressions.

Field Name Allowed Values Allowed Special Characters

Seconds 0-59 , - * /

Minutes 0-59 , - * /

Hours 0-23 , - * /

Day of month 1-31 , - * ? / L W C

Month 1-12 or JAN-DEC , - * /

Day of week 1-7 or SUN-SAT , - * ? / L C #

Year (optional) empty, 1970-2099 , - * /

Cron Expression Meaning

0 0 12 * * ? The task runs every Wednesday at 12:00 PM.

0 15 10 ? * * The task runs at 10:15 AM every day.

0 15 10 * * ? 2005 The task runs at 10:15 AM every day during the 
year 2005.

0 0/5 14 * * ? The task runs every 5 minutes starting at 2 PM and 
ending at 2:55 PM, every day.

0 15 10 15 * ? The task runs at 10:15 AM on the 15th day of 
every month.
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For more details about Cron expressions, go to 
http://confluence.zutubi.com/display/pulse0101/Project+Cron+Triggers

Reports User Interface

This section includes (in alphabetical order):

 ➤ Asset Report on page 319

 ➤ Compare CIs Report on page 321

 ➤ Compare Snapshots Report on page 326

 ➤ Impact Analysis Report on page 331

 ➤ Job List Dialog Box on page 333

 ➤ Schedule Snapshot Dialog Box on page 335

 ➤ Toolbar Options on page 337

 ➤ Topology Report on page 340

0 15 10 ? * 6L The task runs at 10:15 AM on the last Friday of 
every month.

0 15 10 ? * 6#3 The task run at 10:15 AM on the third Friday of 
every month. 

Cron Expression Meaning
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Asset Report

This report displays a list of all the CIs in a specified view, their attribute 
values, as well as their child CIs in the RTSM. You use Asset reports to view 
and analyze the contents of the view and focus on the data that is of interest 
to you. For example, an Asset report can display a list of all the servers that 
are part of a specific application contained in the view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager and click the Asset Report  
button. 

Important 
information

The report contains only the attributes whose Asset Data 
check box was selected in the Attributes tab in the CI 
Type Manager. For more details, see "Add/Edit Attribute 
Dialog Box" on page 498.

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 337.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 289.
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Include information 
based on

Select one of the following:

➤ CMDB. Includes information from the selected view as 
well as information about the child CIs and their 
attribute values in the RTSM.

By choosing this option, the report includes CIs that 
are connected by the Container qualifier to the CIs in 
selected view. For example, the report would include 
the CPU and memory of a server that is contained in 
the view.

➤ View. Includes only information about the CIs and 
their attributes that are contained in the selected view.

View Enables you to select a view by opening the View Selector. 
For details, see "CI Selector" on page 173.

Note: When you generate an Asset report from a specific 
view, the report retains the same hierarchical structure as 
the relevant view in the Topology Map.

UI Elements (A-Z) Description
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Compare CIs Report

This report enables you to compare the hierarchies of two compound CIs. A 
compound CI is a CI that is linked to another CI by a relationship with 
CONTAINER qualifier. You can display the compared CIs and their child CIs 
that appear in a selected view, or in the RTSM.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Right-click a CI in the Topology 
Map and select Compare CIs Report. 
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User interface elements are described below:

Important 
information

➤ The Compare CIs page is divided into two panes. Each 
side displays a hierarchical tree structure of the CIs you 
selected. When you select a CI on one side, the 
corresponding CI on the other side is automatically 
selected, provided Synchronize Selection is pressed. 

➤ You can compare only two CIs of the same CI type or 
one of the CI type’s children in the hierarchy.

Relevant tasks "How to Compare CIs" on page 313

UI Elements (A-Z) Description

Finds the previous occurrence of an item marked as 
changed.

Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the 
difference between the content of the two configuration 
files. Configuration files use the .xml, .txt or .ini 
extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences (marked in blue) in the 
configuration files.

Show Only Different CIs in Tree. In the <Properties 
panes>, displays only the part of the tree structure 
containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties 
panes>, toggles between displaying all the comparable 
attribute values of the selected CI or only the attribute 
values that are different.
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Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default state for the Synchronize Selection button is 
selected. Deselecting this button allows you to select 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties. 

Contains An Updated Item. Indicates that a CI’s attribute 
value has changed. For example, a Contains an Updated 
Item icon is displayed next to the IpAddress CI in the 
figure below since the attribute of its child CI 
10.168.100.2 icon has changed.

No Matching CI. Indicates that a CI in one pane does not 
match any corresponding CI in the other pane. 

The following example displays the No Matching CI icon 
next to the Windows icon because it does not have a 
corresponding CI in the other pane.

UI Elements (A-Z) Description
323



Chapter 9 • Reports
Updated Item. Indicates that the attribute value of a CI 
has changed.

For example, the figure below shows that the CIs 10.0.0.2 
and 16.59.124.1 display the Updated Item icon because 
they was updated with a new IP Network Mask value, as 
indicated by the Show Only Different Attribute Values 

 icons (see the Name and Value columns in the 
bottom panes underneath the tree structure).

Enables you to move to the next or previous result of the 
search for the string entered in the Find field.

<Toolbar> For details, see "Toolbar Options" on page 337.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on 
page 289.

UI Elements (A-Z) Description
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<Properties pane> Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Name. Displays the attribute name for the selected CI, 
which was marked as Comparable in the CI Type 
Manager. "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 505

➤ Value. Displays the attribute value for the currently 
selected CI.

<Left and right 
panes>

Displays a tree of the compared CIs and their child CIs 
that appear in the selected view or in the RTSM, 
depending on whether you selected the View or the 
CMDB options.

Compare in Select one of the following:

➤ CMDB. Includes the selected CIs and their child CIs 
that appear in the entire RTSM.

➤ View. Includes the selected CIs and their child CIs that 
appear only in a specific view.

Compared CI Enables you to select the two CIs you want to compare. 
Click  to open the CIs Selector dialog box. For details, 
see "CI Selector" on page 173. The CI you select in the top 
box is displayed in the left pane and the CI you select in 
the bottom box is displayed in the right pane.

Find Find. Enter a search name or a portion of a search name 
in the Find field to locate it in the list.

Mutual View If the CIs that you are comparing both exist within the 
same view, the name of that view is displayed in this 
field. Otherwise, the field displays the words No mutual 
view.

UI Elements (A-Z) Description
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Compare Snapshots Report

This feature enables you to compare two snapshots of a specific view taken 
at different times. It enables you to visualize the differences between the 
views by comparing the statuses of the view at the times the snapshots were 
taken.

Compare Snapshots displays the status of a view in one snapshot by 
comparison with its status taken at a different time. You can compare a 
current snapshot to a previous snapshot or two snapshots both taken in the 
past.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Click the Snapshot  button and 
select Compare snapshots.

Important 
information

➤ You can compare a current snapshot to a previous 
snapshot or two snapshots both taken in the past.

➤ You can define a schedule that takes snapshots of a 
specific view on a periodic basis and saves them. For 
details, see "Schedule Snapshot Dialog Box" on 
page 335.

➤ Snapshots of views that are marked as Track Changes 
are created on a daily basis.

Relevant tasks ➤ "How to Compare Snapshots" on page 315

See also ➤ "Save Snapshot Dialog Box" on page 304

➤ "Schedule Snapshot Dialog Box" on page 335

UI Elements (A-Z) Description

Expands the entire hierarchical tree structure of the CIs 
you selected.

Collapses the hierarchical tree structure of the CIs you 
selected.

Finds the previous occurrence of an item marked as 
changed.

Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the 
difference between the content of the two configuration 
files. Configuration files use the .xml, .txt or .ini 
extensions.

Select a CI of the CIT Configuration File in both panes 
and click the Show Differences button. A window opens 
displaying the differences (marked in blue) in the 
configuration files. 
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Show Only Different CIs in Tree. In the <Properties 
panes>, displays only the part of the tree structure 
containing CIs that do not match.

Show Only Different Attribute Values. In the <Properties 
panes>, toggles between displaying all the attribute 
values of the selected CI or only the attribute values that 
have changed.

Enables you to select a CI on one side and have its 
corresponding CI automatically selected on the other 
side.

The default state for the Synchronize Selection button is 
selected. Deselecting this button allows you to select 
different CIs from each of the two trees. This enables you 
to compare two different CIs and see their different 
properties. 

Contains An Updated Item. Indicates that a CI’s attribute 
value has changed. For example, a Contains an Updated 
Item icon is displayed next to the 10.0.0.0 CI in the figure 
below since the attribute of its child CI 10.168.100.3 icon 
has changed.

Deleted Item. Indicates that a CI has been deleted from 
the view.

UI Elements (A-Z) Description
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New Item. Indicates that a new CI has been added to the 
view. 

Updated Item. Indicates that the attribute value of a CI 
has changed.

For example, the figure below shows that the CIs 
LABM3MAM16 displays the Updated Item icon because it 
was updated with a new Version value, as indicated by 
the Show Only Different Attribute Values  icons (see 
the Name and Value columns in the bottom panes 
underneath the tree structure).

<Left and right 
panes>

Displays a hierarchical tree structure of all the CIs in the 
view for that snapshot version. The left side always 
represents the newer of the two versions. 

UI Elements (A-Z) Description
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<Properties pane> Displays the attributes of the selected CI.

The Properties pane contains the following fields:

➤ Name. Displays the name of the selected CI as defined 
in the CI’s label.

➤ Value. Displays the attribute value for the currently 
selected CI.

<Toolbar> For details, see "Toolbar Options" on page 337.

Available Snapshots Displays the current status and previously saved 
snapshots of the view selected in the View with 
Snapshots field. Select the two snapshots you want to 
compare.

Note: Visible when Show Report Parameters button is 
pressed.

View with snapshots Displays the name of the view whose snapshots you want 
to compare. Only views for which snapshots have been 
taken are displayed.

Note: Visible when Show Report Parameters button is 
pressed.

UI Elements (A-Z) Description
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Impact Analysis Report

This report displays a list of CIs that are impacted in the system as a result of 
simulated changes. For details, see "Run Impact Analysis Dialog Box" on 
page 302.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In IT Universe Manager, click Generate Report from the 
Run Impact Analysis dialog box.

See also ➤ "Impact Analysis Manager" on page 457

➤ "Run Impact Analysis Dialog Box" on page 302

UI Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 337.

Rule Bundle  Enables you to select the rule group with which the 
Impact Analysis rule works. 

Severity Sets the severity level that we want to simulate for the 
triggered CIs.

Triggered CIs Select the CIs that represent the changes you want to 
make to the system. Opens the CI Selector.
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Affected Application Tab

This tab displays all the CIs that belong to a specific business application, 
which were affected by the triggered CI severity change.

User interface elements are described below:

Grouping by CIT Tab

This tab displays all the CIs related to the triggered CIs that are impacted in 
the system as a result of the simulated changes, sorted by CI type.

User interface elements are described below:

Triggered CIs Tab

This tab displays all the CIs that represent the changes you want to make to 
the system. The CIs in this tab are the CIs selected in the Triggered CIs box.

User interface elements are described below:

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.

Trigger Severity The severity selected in the Severity box.

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.

Trigger Severity The severity selected in the Severity box.

UI Elements (A-Z) Description

Display Label The name of the CI or relationship as it appears in the 
toplogy map.
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Job List Dialog Box

This dialog box displays a list of the reports/snapshots that were scheduled 
to run in the "Schedule Snapshot Dialog Box" on page 335.

User interface elements are described below:

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Click the Snapshots  button, 
and select Show Scheduled Snapshot Jobs.

UI Elements (A-Z) Description

Insert New Scheduled Report. Define a new job using the 
Schedule Job dialog box.

Edit Job. Edit the selected job using the Schedule Job 
dialog box.

Create Copy. Enables you to create a copy of the selected 
job. Opens a new job in the Schedule Job dialog box that 
uses the details of the selected job.

Remove Job. Deletes the selected job from the list of 
scheduled jobs.

Run Job Immediate. Runs the selected job.

Pause Job. Pauses the selected job. Enabled only if the job 
has a Pending status.

Resume Job. Resumes the selected job.

Note: The Resume button is enabled only for jobs that 
have a Paused status.

Refreshes the list of scheduled jobs.

Clears the current filter.

Change visible columns. Enables you to select the 
columns to be displayed.
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Current Status The current status of each scheduled job:

➤ Running. The job is currently executing.

➤ Pending. The job is waiting for the scheduling 
requirements to be fulfilled.

➤ Completed. The job has finished executing.

➤ Paused. The job has been paused.

Note. If a job has a Completed status, and you want to 
resume running the job, you can either click Run Job 
Immediate or change the Next Execution Time to the 
current time. If you change it to a future time, the status 
changes to Pending. 

Description A description of the scheduled job as defined in the 
Schedule Job dialog box.

Execution Status The job’s current execution status:

➤ Success. The job completed successfully.

➤ Failure. The job failed to execute.

➤ None. The job has not yet been executed.

Job Type A scheduled job can either be Schedule Report or 
Schedule Snapshot.

Last Execution Time The last time the report ran.

Name The name of the scheduled job as defined in the Schedule 
Job dialog box.

Next Execution Time The next time the report is scheduled to run.

UI Elements (A-Z) Description
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Schedule Snapshot Dialog Box

This dialog box enables you to define a schedule for taking snapshots of a 
specific view. You can see the list of reports/snapshots that have been 
scheduled to run in the "Job List Dialog Box" on page 333.

The following elements are included:

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager. Click the Snapshots  button in 
the CI Selector, and select Schedule Snapshot.

Relevant tasks ➤ "How to Compare CIs" on page 313

➤ "How to Compare Snapshots" on page 315

UI Elements (A-Z) Description

Validates the Cron expression you entered in the Cron 
Expression box.

Cron Expression Enter a Cron expression to schedule a job. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see, "Cron Expressions" on 
page 317.

Description A description of the scheduled job.

Ends Select one of the following options:

➤ Never. Do not specify an end date. Not relevant if you 
define a report to run only once.

➤ Until. Choose the date and time by which you want 
the action to stop running. Relevant only if you are 
using Cron expressions.

Locale Select the language for the report.

Name The name of the scheduled job.
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Repeat Select one of the following actions:

➤ Once. Activates a job only once.

➤ Daily. Runs a job on a daily basis.

➤ Weekly. Runs a job on a weekly basis. Select the day or 
days on which you want the action to run.

➤ Monthly. Runs a job on a monthly basis. Select the 
month or months in which you want the job to run.

➤ Yearly. Runs a job on a yearly basis. 

➤ Cron. Use a Cron expression to schedule a job. For a 
description of the fields used in Cron expressions and 
examples of how to use them, see, "Cron Expressions" 
on page 317.

Repeat every (Appears only when you select Daily, Weekly, Monthly or 
Yearly.) Select a value for the interval between successive 
runs. 

For example, if you select Weekly and then 2, the job runs 
every second week.

Server Time The exact server time according to the client’s time zone.

Starts Choose the time and date when you want the job to 
begin running.

Time Zone Set the required time zone.

UI Elements (A-Z) Description
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Toolbar Options

This section describes the toolbar options for reports.

UI Elements (A-Z) Description

Displays the parameters that are defined for the report.

Save Report. Saves the selected report.

Schedule Report. Opens the Schedule Job dialog box, 
which enables you to define a job that:

➤ Schedules the generation of a report

➤ Specifies one or more formats in which to send the 
report, and the report’s recipients

➤ Specifies the recurrence of the job

For more information on the Schedule Job dialog box, 
see, "Schedule Snapshot Dialog Box" on page 335.

Note: This option is available only before you generate a 
report or when you open a saved report.

Send Mail. Opens the Send Mail dialog box. You can send 
an email containing the generated report in various 
formats, or as a direct link. For details on the various 
formats, see "Export Report." on page 338.

Select one or more of the available formats for the 
generated report to be sent as attachments to an email 
recipient.

Note: Required fields are marked with an asterisk.

Archive Report. Enables you to save the report results in 
the database. After the report is archive, a  icon 
appears next to the report name.

Note: Enabled only for Topology reports.

Generate Direct Link. Creates a direct link to the specific 
location on the server of the selected report, or to the 
data that you have exported as a specific format.
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Export Report.

Enables you to select the export format for the report. The 
available options are: 

➤ Excel. The report data is formatted as an .xls (Excel) file 
that can be displayed in a spreadsheet.

➤ PDF. The report data is exported in PDF format.

➤ CSV. The report data is formatted as a comma-
separated values (CSV) text file that can be displayed in 
a spreadsheet.

Note: For the CSV formatted table data to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that the 
comma is defined as the List Separator value. 

➤ XML. The report data is formatted as an XML file that 
can be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

➤ Open the file in an HTML editor

➤ Copy the relevant table into the target file

Note: When you export a generated report, a dialog box 
opens asking whether you want to open the exported file. 
You can define whether to hide or display this message 
using the "User Preferences Dialog Box" on page 113.

Bar Chart. Displays the generated report as a bar chart.

Pie Chart. Displays the generated report as a pie chart.

Table. Displays the generated report in tabular format.

Show Short Labels. Toggles between displaying the chart 
labels minimal/maximum information.

Note: This option is available only for pie charts.

UI Elements (A-Z) Description
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Show Legend. Toggles between hiding and displaying the 
chart’s legend.

Note: This option is available only for pie charts.

Slice chart. Toggles between displaying the pie chart with 
exploded and unexploded segments.

Note: This option is available only for pie charts.

Expand All. Expands the tree structure.

Collapse All. Collapses the tree structure.

Delete from CMDB. Deletes the selected CI from the 
CMDB. 

Opens the Configuration Item Properties dialog box for 
the selected CI.

Refresh. Refreshes the report tree.

Select Columns. Select the columns you want to display 
in the report.

Sort Column Content. Enables you to set the sort order of 
the selected column’s content.

Find. Toggles between displaying and hiding the Find 
utility.

Find the next occurrence of the phrase/Find the previous 
occurrence of the phrase. Enables you to move to the 
next or previous result of the search for the string entered 
in the Find field.

Highlights all occurrences of the phrase. Highlights all 
occurrences in the CI tree of the string entered in the Find 
field.

Generate Report. Enables you to generate the selected 
report.

Note: This button appears disabled prior to defining the 
report parameters.

UI Elements (A-Z) Description
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Topology Report

This report displays the topology of a view in report format. 

<breadcrumbs> Displays the levels through which you have navigated to 
get to the current level. Appears horizontally across the 
top of the chart. 

Note: Each level in the list of breadcrumbs is a clickable 
link.

<Generated report> Displays the active generated report.

Find Enter a search name or a portion of a search name in the 
Find field to locate it in the list.

To access Select Admin > RTSM Administration > Modeling > 
IT Universe Manager and click the View Based Report 

 button. 

Important 
information

Every view in the RTSM can be displayed in report 
format. You define the settings for the report in the 
Report tab of the view in Modeling Studio.

UI Elements (A-Z) Description
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User interface elements are described below: 

UI Elements (A-Z) Description

<Bar graph/Pie 
chart>

Each segment of the pie chart/column in a bar graph 
represents a CI on the selected level of the view.

Click a slice/bar to drill down to the next level, if one 
exists. You can also display the information in table 
format.

When you hold the mouse over the relevant segment/bar, 
a tooltip indicates the number of instances there are for 
that CIT, the percentage of the pie it represents (when 
viewing the information in pie chart format), and the CIT 
or CIT attribute the slice/bar represents.

<Toolbar> For details, see "Toolbar Options" on page 337.
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Modeling Studio

This chapter includes:

Concepts

➤ Modeling Studio Overview on page 345

➤ View Formats on page 346

➤ Building a Business View on page 347

➤ Templates and Perspectives on page 350

➤ Predefined Folders and Views on page 351

➤ Creating Template Based Views on page 353

➤ Business CI Models on page 354

➤ Building a Perspective Based View on page 357

➤ Revealed CIs and Watchpoints on page 362

Tasks

➤ How to Create a Pattern View on page 367

➤ How to Create a Template on page 368

➤ How to Create a Perspective on page 370

➤ How to Create a Template Based View on page 373

➤ How to Create Multiple Template Based Views on page 375

➤ How to Define Report Settings on page 377

➤ How to Build an Instance-based Model on page 378

➤ How to Build a New Pattern-based Model on page 380

➤ How to Build a Perspective-based View Based on a Model on page 382
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➤ How to Build a Perspective-based View Based on a Collection of CIs 
on page 383

➤ How to Build a Business CI Model – Scenario on page 384

Reference

➤ Modeling Studio User Interface on page 386

Tip: For more information about using Modeling Studio in HP Business 
Service Management, see "Best Practices for Modeling" on page 223.
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Concepts

Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create 
your own views, or work with the out-of-the-box (factory) views provided 
with your HP Business Service Management installation.

The IT Universe model in the configuration management database can be 
very large, holding thousands of configuration item (CI)s. A view enables 
you to build a subset of the overall IT universe model, containing only those 
CIs relating to a specific area of interest. You can define your own views to 
display only the information that is relevant to your organization’s business 
needs.

The views are used to display performance status in Service Health, and for 
setting up SLAs in Service Level Management. HP Business Service 
Management supports three view formats: pattern views, template based 
views, and perspective based views, which are populated through different 
processes. For details, see "View Formats" on page 346.
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View Formats

HP Business Service Management supports three view formats, by which to 
populate your view:

➤ Pattern views are built from a Topology Query Language (TQL) query that 
defines the structure of the view. You can create a new TQL query as you 
build the view or base the view on an existing query. The view displays 
only those CIs and relationships that satisfy the query definition. When 
the view is displayed or refreshed, the Modeling Studio queries the RTSM 
for all elements that fit the query, and automatically updates the view 
with those elements.

➤ Template based views are based on a TQL query, to which a template is 
then applied. The template is a reusable view that includes parameters, 
which are saved as part of the template. This enables you to build 
multiple views with the same settings without having to re-enter the 
parameter information. The view displays only those CIs and 
relationships that satisfy the query definition and the conditions of the 
template. For details on templates, see "Templates and Perspectives" on 
page 350.

➤ Perspective based views are built by selecting a collection of individual 
CIs and applying a special type of template, known as a perspective, to it. 
Instance views, which no longer exist, are replaced by perspective based 
views. For details on perspectives, see "Templates and Perspectives" on 
page 350. 

When you select a view for editing from the view tree in the left pane, it 
opens on the editing pane in the appropriate editor. 
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Building a Business View

In the Modeling Studio, you can define your own views to model your 
business environment. 

This section includes the following topics:

➤ "The Structure of a View" on page 347

➤ "Setting the View Hierarchy" on page 348

The Structure of a View
The views you create should provide the business users with logical 
representations of your company’s structure, processes, and goals. To meet 
these requirements, you generally build multiple views representing 
different aspects of your business; for example, you could build business 
views that revolve around any of the following:

➤ Company structure, so that data is organized by the geographical location 
of branches, or by data centers.

➤ Business processes, so that data is organized by line of business, or by 
applications.

➤ Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the 
actual hierarchical structure of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

➤ Top level. The highest levels of the view, consisting of the root CI and the 
branches below it, are normally built from logical Business CI types such 
as Location, Line of Business, Customer, Application, and so on.

➤ Intermediate level. The intermediate branches of the view normally 
consist of System CI types, representing actual hardware and software 
and/or monitoring group CI types, representing groups containing 
monitors.
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➤ Bottom level. The lowest level of the view, consisting of leaf CIs at the 
ends of the subtrees, is built from the Monitor CI types. These CIs receive 
the actual data from the data sources, used to determine KPI status all the 
way up the view subtrees, and so provide business context to the view.

Note: The bottom level is only relevant when a monitoring solution such as 
HP Business Service Management is connected and modeled in the RTSM. 

Setting the View Hierarchy
The Pattern View Editor enables you to set the view hierarchy using the 
Hierarchy pane on the right side of the screen. There are two methods 
available for setting the hierarchy: Manual and Rule-based. The manual 
method is selected by default.

Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed 
in a tree format. You can create the hierarchy by manually dragging a 
selected query node under another query node or by using the toolbar 
buttons. The system only allows you to move a query node under another 
query node when the resulting hierarchy is valid. For details, see "Hierarchy 
Pane" on page 422.

It is possible to place a single query node from the view into the hierarchy 
multiple times. You can then adjust the hierarchy so that the query node 
appears in different layers, according to the required layout. The view results 
in such an instance would be the same as if you added another query node 
to the TQL query. Using the same query node twice in the hierarchy enables 
you to achieve the desired view results using a simpler TQL query.
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Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to 
group CIs by different criteria for the convenience of viewing the display. 
Click the Add Group By button and select one of the options. You can create 
a subgroup for CIs of the same type in the Topology Map using the Add 
Group by CI Type option. You can create a subgroup for a specific query 
node by selecting the Add Group by Query Node option. You can group CIs 
by a common attribute using the Add Group by Attribute button and 
entering a regular expression as described in "Query Node Grouping Dialog 
Box" on page 433. For details about regular expressions, see "Regular 
Expression Examples" on page 585.

You can also create nested groups (a query node group inside another query 
node group) to help fine-tune the TQL query results that are displayed in 
the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can 
use their operation state attribute to create more focused groups.

Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the 
Hierarchy Rules dialog box. You select a source CIT, target CIT, relationship 
type, and relationship direction, which define the conditions for a hierarchy 
rule. Any CIs in the view which satisfy the defined conditions are subject to 
the rule, that is, the target CI is placed on the layer below the source CI. For 
details on defining hierarchy rules, see "Hierarchy Rules Dialog Box" on 
page 396.
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Templates and Perspectives

A template is a reusable pattern view with defined parameters.  You use 
templates to build template-based views, setting the values of the 
parameters for each specific view. Any changes made to a template affect all 
existing views based on that template.

Template-based views can be opened in IT Universe Manager, like pattern 
views. You can also open the template itself in IT Universe Manager to view 
the results for various parameter values. If you want to save the results, you 
must save it as a template-based view. You define templates, template-based 
views, and pattern views in the Pattern View Editor. 

Perspectives are a type of template designed to be applied to a specific 
collection of CIs, similar to the pattern in a pattern view. For example, a 
perspective could comprise a node containing an IP Address. In that case, 
the resulting perspective-based view would include all the CIs from among 
the CIs in the CI selection, along with the IP Addresses contained in the 
node CIs. 

The most basic perspective is known as the Content Only perspective and 
consists of only the query node itself. If you apply the Content Only 
perspective to a CI collection, the resulting view contains only the selected 
CIs themselves.

Perspectives are also created and edited in the Pattern View Editor. You can 
have multiple views, templates, and perspectives open in the Pattern View 
Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in IT Universe Manager, 
however perspective-based views can be opened in IT Universe Manager, 
like all other views. For details, see "Building a Perspective Based View" on 
page 357.

In summary, the Views tree in the Resources tab of the CI Selector in the 
Modeling Studio can include five distinct entities: 

➤ pattern views

➤ templates

➤ template based views
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➤ perspectives

➤ perspective based views

You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are 
created and viewed:

Predefined Folders and Views

The Views tree in the Resources tab of the CI Selector in the Modeling Studio 
includes predefined folders and views, as described in the following 
sections:

➤ "Predefined Folders" on page 351

➤ "Factory Views" on page 352

➤ "Predefined Perspectives" on page 352

Predefined Folders
The hierarchical file folder system in the CI Selector can help you organize 
your views. Predefined folders are provided for the out-of-the-box views; 
you can modify these folders, or add additional folders according to your 
organization’s requirements.

Type of View Created in:
Can be opened in 
IT Universe Manager

Pattern View Pattern View Editor Yes

Template Pattern View Editor Yes, for the current 
session only

Template-based View Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based 
View

Perspective-based View 
Editor

Yes
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Factory Views
Your HP Business Service Management installation includes out-of-the-box 
pattern views, templates, and perspectives. These views provide a quick start 
for working with the RTSM for setting up SLAs, and for viewing system 
performance information in Service Health.

The out-of-the-box views are initially empty. As soon as CIs are added to the 
RTSM by one of the CI generators, the TQL query built into each pattern 
view is able to identify the CIs that meet the pattern requirements, and add 
them to the view.

Views for CIs are created when a discovery process is run; the out-of-the-box 
views that are provided correspond to the relevant Data Flow Management 
(DFM) packages. For example, the Oracle view (Root > Database > Oracle > 
Oracle) is populated with CIs that are created when Data Flow Management 
activates the jobs in the Database - Oracle module. For details on running 
DFM, see "How to Use Discovery Control Panel – Advanced Mode Workflow" 
in the RTSM Data Flow Management Guide.

For details on the cross-application processes for setting up the SAP views, 
see "Application Management for SAP Reports and Views" in Solutions and 
Integrations.

Some of the out-of-the-box views are set by default to display in specific 
HP Business Service Management applications. There are some 
out-of-the-box views that are hidden by default.

Some of the out-of-the-box views are considered basic to the system and 
cannot be deleted from the folders. 

Predefined Perspectives
HP Business Service Management also provides out-of-the-box perspectives. 
One example is the Content Only perspective, which includes only the 
elements of the view content itself, without any additional CIs. 

The following out-of-the-box perspectives are intended to be used in Service 
Health:
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➤ System Monitors only. This perspective enriches the model by adding 
child CIs down to the level of monitors. Use this perspective to create a 
Service Health view that includes System monitors only.

➤ End User Monitors. This perspective enriches the model by adding child 
CIs related to the end user experience of the application, such as Business 
Transaction and Business Transaction Flow. Use this perspective to create 
a Service Health view that includes monitoring statuses for End User 
Management only.

➤ Impact. This perspective enriches the model with all child CIs related by 
impact links. Use this perspective to configure additional monitors using 
the Monitor Deployment Wizard.

➤ Model and Dependency Hierarchy. This perspective enriches the model 
with all dependent CIs in the RTSM. Use this perspective to create a view 
with the full model hierarchy.

➤ APM Perspective. This perspective enriches the model with Business 
Transactions Flow and Business Transaction CIs. Use this perspective to 
add related infrastructure elements and SiteScope monitors to create a  
view that includes all APM information.

Creating Template Based Views

Template-based views based on the same template contain the same query 
nodes and relationships. They differ only in their parameter values. You 
create template-based views using the Template-based View wizard. The 
wizard enables you to create multiple views at one time based on the same 
template. When creating multiple views, you have the option of entering 
parameter values manually or importing them from a CSV file. The CSV file 
must be formatted correctly for the wizard to import the values. It must 
contain the name of at least one of the template parameters in the first row 
and it must contain at least one record. The records should be in separate 
rows and the parameter values for each record should be in the same row, 
separated by commas.
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The wizard also provides an Advanced Naming feature, which enables you 
to define an expression for the view names based on parameter values. For 
example, if your base template is called Server_Template, and one of the 
template parameters is Serial Number, you could define the view names to 
be Server <Serial Number>. In this way, the wizard automatically inserts the 
respective value of the parameter Serial Number into the name of each view.

An alternate way to assign names to the views when importing values from 
a CSV file is to include a column in the file called 
template_based_view_name. The file entries corresponding to this column 
are automatically entered by the wizard as the view names. Note that this 
naming method overrides the Advanced Naming feature; that is, view 
names are assigned the entries in the template_based_view_name column of 
the file, even when the Advanced Naming feature is selected.

For details on creating template-based views, see "Template-based View 
Wizard" on page 442.

You can also edit the parameters of a template-based view when the view is 
open in the Editor, from the Template Parameter Values dialog box. For 
details, see "Template Parameter Values Dialog Box" on page 448.

You cannot edit the report layout for a template-based view. To change the 
report layout, you need to make changes in the base template of the view.

Business CI Models

This section includes the following topics:

➤ "Instance-based Models" on page 355

➤ "Pattern-based Models" on page 356

➤ "Defining a Pattern-based Model Over an Instance-based Model" on 
page 357
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The collection of CIs which compose the view content of perspective-based 
views can be selected in two ways. You can select CIs from the CI Selector 
and drag them onto the editing pane. In this case, you can build a view by 
applying a perspective to the collection and the collection cannot be reused 
in another view without repeating the selection process. The other way to 
select the CIs to appear in the view is by creating a model.

A model is a reusable collection of CI instances that define a business entity, 
such as a business service or line of business. By creating a model, you are 
building a CI collection that can be reused with other perspectives to create 
different views. Any changes you subsequently make to the model are 
reflected in all the views based on that model. There are two types of 
models: instance-based models and pattern-based models.

Instance-based Models
You build an instance-based model by first selecting a business CI to serve as 
its basis. The available business CIs include group, application, business 
service, business unit, and line of business. Then, you can add CIs to your 
model in the following ways:

➤ Manually, by dragging CIs from the CI Selector into the Model Editor

➤ Revealing related CIs using a reveal path and selecting the ones to add to 
the model

➤ Defining a watchpoint for a selected CI and automatically adding CIs to 
the model

You can also begin building a model by dragging CIs onto the empty canvas 
and selecting Create a new model.

The model you create is a CI itself and the CIs in your model are related to 
the model by Contains relationships. You must save your model before 
applying a perspective to it to build a view.
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Caution: The changes you make in a model affect the entire universe, not 
just the views based on that model. Thus, if you delete a CI from a model, 
you are deleting the relationship that existed between the CIs from the 
RTSM.

When working in IT Universe Manager, you can add selected CIs directly to 
a new model or an existing model. For details, see "Add CIs to Model Dialog 
Box" on page 266.

Pattern-based Models
Another type of model you can build is a pattern-based model. In a pattern-
based model, you define a TQL query to determine the CIs included, rather 
than selecting them manually. You can base your pattern-based model on an 
existing TQL query or create a new TQL query. 

You must designate at least one query node in the model’s TQL query as 
output for the model. The CIs of that type which match the pattern of the 
TQL query are the ones included in the model output.

The pattern-based model created is saved as a CI like an ordinary model, and 
can be used to form the content of a perspective-based view. The new TQL 
query created is saved as an ordinary query and can be used as the basis for a 
pattern view.

Note: 

➤ Pattern-based models are not updated continuously. The model is 
calculated at the time it is saved and the TQL query runs at 12-hour 
intervals to update the model (at 12 noon and 12 midnight).

➤ When the user deletes a pattern-based model (either from the Modeling 
Studio or from the IT Universe), the Business Enrichment, Job Scheduler, 
and pattern-based model CI are also deleted.
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Defining a Pattern-based Model Over an Instance-based 
Model
When defining a pattern-based model, it is possible build it on top of an 
existing instance-based model. In this case, only the pattern of the model 
that you build is visible on the canvas, as in a new pattern-based model. 
However, the CIs in the instance-based model also remain in the new model 
and appear in the view results when the model is used to build a 
perspective-based view. Similarly, when you access the model in IT Universe 
Manager, both the CIs in the instance-based model and those retrieved by 
the pattern-based model are visible. The model is saved with the name of 
the original instance-based model, in effect creating a hybrid model with 
both instance-based and pattern-based components.

If you delete the model, only the additional pattern-based part of the model 
is deleted. The model reverts to an instance-based model and the CIs 
included in it become visible in the Model Editor.

Building a Perspective Based View

A perspective based view is composed of perspectives applied to a model or a 
collection of CIs. The perspective is a special type of template which is 
designed to be applied to a subset of the IT Universe model. 

The Content pane of the Perspective-based View Editor displays the models 
or CIs you have selected to serve as the basis of your view. The Perspective 
pane displays the selected perspectives. The Preview pane displays the 
resulting view based upon your content and perspective selections. When 
you make a change in the content or perspective selections, the view is 
updated accordingly in the Preview pane. For details, see "Perspective-based 
View Editor" on page 427.

This section includes the following topics:

➤ "Content" on page 358

➤ "Perspectives" on page 358

➤ "Views Based on Multiple Perspectives" on page 359

➤ "Including and Excluding Child CIs" on page 360
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Content
The content in a perspective based view can be selected in two ways:

➤ You can add individual CIs to the view manually, using the CI Selector. 
The CIs in the collection are independent of each other. In this case, the 
collection of CIs is not defined as a model and cannot be reused in 
another view.

➤ You can add one or more models to the view, using the CI Selector. 
Alternatively, you can start by working with a model in the Model Editor 
and select Generate View for Selected Model to build a view based on that 
model. In this case, the identical content can be used to build another 
view by selecting the same models.

You can select both individual CIs and models to form the content of a 
perspective based view, however in that case, the models are treated as 
ordinary CIs. The models themselves are included in the view without their 
hierarchy of child CIs. 

When working in IT Universe Manager, you can add selected CIs directly to 
the content of a new or an existing perspective based view. For details, see 
"Add CIs to View Dialog Box" on page 267. 

Perspectives
The perspectives you select for your view determine which CIs are included 
in the view. A perspective is a reusable pattern, similar to a template. The 
difference between a perspective and a regular template is that the 
perspective includes one or more query nodes designated as contact query 
nodes. A contact query node is a query node in the pattern which is used to 
apply the pattern to specific content and it is indicated by a small icon that 
appears next to the query node.
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For example, in the following perspective, a query node of type Windows is 
designated as the contact query node and it has an IP Address related to it by 
a containment relationship.

When this perspective is applied to a CI collection, the resulting view 
contains all the CIs in the original collection as well as the IP Addresses 
connected to the Windows CIs in the collection (the CIs that were added by 
applying the perspective).

A perspective can have several contact query nodes, but every disconnected 
graph within a perspective must have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are 
affected.

Views Based on Multiple Perspectives
You can select multiple perspectives to apply to the content of your view. 
There are two ways to select multiple perspectives:

➤ Perspective groups

➤ Perspective chains

In a perspective group, you select two or more perspectives to apply 
simultaneously to the same input content.
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In a perspective chain, you select two or more perspectives at different levels 
of the view creation. The perspective in the first level is applied to the 
original view content to generate results in the form of a CI collection that 
serves as input content for the next level. The perspective in the second 
level is then applied to this content to generate the view results. You can 
build views based on multiple levels of perspectives, each one generating 
input content for the following level.

It is possible to apply both of the above methods at the same time, that is, 
by selecting multiple perspectives in each of the levels of a perspective 
selection.

For example, select a collection of IP Subnet CIs as your input content and 
select a perspective that adds the node CIs related to the IP Subnets as the 
first level perspective. The results of this stage consist of the original IP 
Subnets and their related nodes. Then add a second perspective level and 
select two perspectives for it: one that adds CPU CIs related to nodes and 
one that adds File System CIs related to nodes. The final results include the 
original IP Subnets, their related nodes, and the CPUs and File Systems 
related to those nodes.

These options help to simplify the process of creating a perspective-based 
view, by breaking down the functionality of a perspective into its 
component parts. Instead of building a separate large and complex 
perspective for each required view, you can construct a custom perspective 
combination to match the requirements of your specific case from smaller 
and more basic perspectives.

Including and Excluding Child CIs
When adding CIs that have children to a view, the CI and its children are 
only included in the view if the pattern of the perspective includes children 
for the selected CI type. In that case, children are included for all CIs of that 
type. After creating a view, you can hide specific CIs from the view by 
selecting the CI in the View Results pane and selecting Hide CI from View 
from the shortcut menu or clicking the Hide CI from View button in the 
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toolbar. This option is only available for CIs that were added to the view via 
the perspective and were not part of the original content on which the view 
was based. Thus, if the view was based on a collection of CIs, the CIs in that 
collection cannot be hidden from the view. If the view was based on a 
model, the model itself cannot be hidden from the view, but the CIs 
contained in the model can be hidden.

When KPI status is calculated for a CI and displayed in Service Health, the 
status is based on all child CIs that exist in the RTSM for the parent CI. The 
Business Logic Engine calculates status from all child CIs attached to that 
parent CI, across all views. The calculation is based on all the relationships 
for the CI in the RTSM, without connection to the child CIs displayed in 
any particular view. To restrict the number of CIs displayed in the view, you 
can change the perspective to hide child CIs. This has no effect on KPI status 
– status is still calculated based on all child CIs, whether they are displayed 
in the view or hidden.

Whether or not all child CIs are displayed in the view does not influence the 
status calculations made for the parent CI and the status displayed in Service 
Health. 

For example, the following pictures show status in Service Health for the 
same CI, Group1, in two views: In the first view, child CIs are included, and 
in the second, they are excluded. The same status result is shown for the CI 
in both views, regardless of the perspective in use.
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When a CI has child CIs that are excluded from the view, the KPI tooltip in 
Service Health shows the number of hidden child CIs with KPIs attached, to 
indicate that the KPI status of the parent is based on CIs that are not in the 
view.

You can use the Find Visible and Hidden Child CIs option to view 
information on hidden children. For details, see "How to Find Visible and 
Hidden Child CIs" in Using Service Health.

Revealed CIs and Watchpoints

The Modeling Studio provides two advanced methods of adding CIs to an 
existing model: revealing related CIs and defining watchpoints.

This section includes the following topics:

➤ "Revealing CIs" on page 362

➤ "Watchpoints" on page 365

Revealing CIs
One approach to building a model is to add CIs related to the CIs in the 
model. The Modeling Studio provides a tool to help you reveal those CIs. 
The process of revealing related CIs involves constructing a reveal path, 
which is a chain of CI types that are related to each other. The first item in 
your reveal path is the CI type of the CI from which you started to reveal 
CIs. The Modeling Studio locates all of its related CIs and lists their CI types. 
By selecting one of those types, you build the next step of your path. All the 
related CIs of that type appear in the lower pane of the dialog box. You can 
select the ones you want to include in your model. The process is repeated 
to build the following step of the path.
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For example, if you begin to reveal CIs from a CI of type Windows, the 
Modeling Studio may reveal related CIs of types Interface, Network, and IP. 
If you select Network, the related CIs of type Network appear in the lower 
pane and can be added to the model by dragging them into the CIs Basket 
or clicking the CIs Basket icon:
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Click Next to build the next step of the path using Network as your 
selection. The Modeling Studio reveals related CIs of type Windows, Unix, 
and IP. Unix is selected and the Unix CIs appear in the lower pane and can 
be added to the model by dragging the selected ones into the CIs Basket 
pane:
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Click Next to build the next step of the path using Unix as your selection:

In this case, a reveal path of Windows > Network > Unix was constructed. At 
each step, you have the option of adding any of the revealed related CIs to 
your model. For details on revealing CIs, see "Reveal CIs Dialog Box" on 
page 435.

It is also possible to construct a reveal path without revealing CIs. For 
details, see "Create/Edit/Save Reveal Path Dialog Box" on page 393.

Watchpoints
Another method of locating related CIs to add to the model is by defining a 
watchpoint for a selected CI in the model. A watchpoint is a mechanism 
which is triggered when a new related CI of a specified type is created. Every 
watchpoint is defined in connection with a reveal path. If a new related CI 
of any CI type included in the path is created, the watchpoint is triggered 
and an indicator appears next to the model. For details on defining a 
watchpoint, see "New Watchpoint Dialog Box" on page 416.
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Note: You must save a new model before defining watchpoints for its CIs.

All the related CIs detected by the watchpoint are displayed in the 
Watchpoints Updates dialog box. The dialog box enables you to select the 
ones to add to your model and the ones to suppress, or exclude from your 
model. For details, see "Watchpoints Updates Dialog Box" on page 454.

You also have the option to include the detected CIs in your model 
automatically by selecting the check box in the New Watchpoint dialog box. 
In this case, all CIs detected by the watchpoint are added to the model. 

A watchpoint can also be used to detect CIs included in the model which are 
no longer related to the model. If such CIs are found along the reveal path 
connected to the watchpoint, they also appear in the Watchpoints Updates 
dialog box. You can accept the suggestion to remove the CIs from your 
model, or you can suppress the suggestion, thereby keeping the CIs in your 
model.

Note: Although a watchpoint is defined for an individual CI, the 
watchpoint results display related CIs of the CI types included in the reveal 
path for all CIs in the model.
366



Chapter 10 • Modeling Studio
Tasks

How to Create a Pattern View

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

➤ "Open a New View in the Pattern View Editor" on page 367

➤ "Add Query Nodes and Relationships to a TQL Query" on page 367

➤ "Set the View Hierarchy" on page 368

➤ "Define the Report Settings - Optional" on page 368

➤ "Set Permissions" on page 368

 1 Open a New View in the Pattern View Editor

Click the New  button and select Pattern View. In the New Pattern 
View dialog box, select the base TQL query on which your new view is 
based, or select Create new query to build a new TQL query. The Pattern 
View Editor opens. For details, see "New Pattern 
View/Template/Perspective Dialog Box" on page 414.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on page 35.

Note: If you are starting with a blank view, you must add at least one 
query node in order to save your view.
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 3 Set the View Hierarchy

Set the hierarchy for the view by moving the required query nodes in the 
Hierarchy pane. For details, see "Setting the View Hierarchy" on page 348.

When you are finished, click Save  to save the view.

 4 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "How to Define Report Settings" on 
page 377.

 5 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new view. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, 
see "How to Assign Permissions" in Platform Administration.

How to Create a Template 

This task describes how to define a new template.

This task includes the following steps:

➤ "Open a New Template in the Pattern View Editor" on page 369

➤ "Add Query Nodes and Relationships to a TQL Query" on page 369

➤ "Set Parameter Values" on page 369

➤ "Set the Template Hierarchy" on page 369

➤ "Define the Report Settings - Optional" on page 370

➤ "Set Permissions" on page 370
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 1 Open a New Template in the Pattern View Editor

Click the New  button and select Template. In the New Template 
dialog box, select the base TQL query on which your new template is 
based, or select Create new query to build a new TQL query. For details, 
see "New Pattern View/Template/Perspective Dialog Box" on page 414.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on page 35.

Note: If you are starting with a blank template, you must add at least one 
query node in order to save your template.

 3 Set Parameter Values

Right-click a query node or relationship in the TQL query and select 
Query Node Properties. In the Attributes tab, add an attribute with a 
parameterized value. For details, see "Query Node/Relationship Properties 
Dialog Box" on page 90.

Note: If you do not set any parameters, when you try to save your 
template, you must save it as a pattern view.

 4 Set the Template Hierarchy

Set the hierarchy for the template by moving the required query nodes in 
the Hierarchy pane. For details, see "Setting the View Hierarchy" on 
page 348.

When you are finished, click Save  to save the template.
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 5 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "How to Define Report Settings" on 
page 377.

 6 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new template. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, 
see "How to Assign Permissions" in Platform Administration.

How to Create a Perspective 

This task describes how to define a new perspective.

This task includes the following steps:

➤ "Open a New Perspective in the Pattern View Editor" on page 371

➤ "Add Query Nodes and Relationships to a TQL Query" on page 371

➤ "Select a Contact Query Node" on page 371

➤ "Set the Perspective Hierarchy" on page 371

➤ "Define the Report Settings - Optional" on page 372

➤ "Set Permissions" on page 372
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 1 Open a New Perspective in the Pattern View Editor

Click the New  button and select Perspective. In the New Perspective 
dialog box, select the base TQL query on which your new Perspective is 
based, or select Create new query to build a new TQL query. For details, 
see "New Pattern View/Template/Perspective Dialog Box" on page 414.

 2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on page 35.

 3 Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query 
node. Right-click the query node and select Use As Contact Query Node. 

Note: If you do not select a contact query node, when you try to save 
your perspective, you must save it as a pattern view.

 4 Set the Perspective Hierarchy

Set the hierarchy for the perspective by moving the required query nodes 
in the Hierarchy pane. For details, see "Setting the View Hierarchy" on 
page 348.

When you are finished, click Save  to save the perspective.
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 5 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you 
want to include in the report for each query node of the view. You can 
also set the order of the report columns, set the sort order of each column, 
and add a chart. For details, see "How to Define Report Settings" on 
page 377.

 6 Set Permissions

Apply viewing and editing permissions to users and user groups for the 
new perspective. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, 
see "How to Assign Permissions" in Platform Administration.
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How to Create a Template Based View

This task describes how to define a single template based view.

This task includes the following steps:

➤ "Prerequisites" on page 373

➤ "Define a New Template Based View" on page 373

➤ "Select a Template" on page 373

➤ "Select the Method for Adding Parameter Values" on page 374

➤ "Set Parameters" on page 374

➤ "Set Permissions" on page 374

 1 Prerequisites

If you want to base your view on a new template, create the template first. 
For details, see "How to Create a Template" on page 368.

 2 Define a New Template Based View

You define a new template based view using the Template-based View 
wizard. Click the New  button and select Template Based View. 

 3 Select a Template

On the Select Template page of the wizard, select a template on which to 
base your view. For details, see "Select Template Page" on page 443.
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 4 Select the Method for Adding Parameter Values

On the Import Parameter Values page of the wizard, select the method for 
adding the parameter values. For details, see "Import Parameter Values 
Page" on page 444.

 5 Set Parameters

On the Parameters page, enter the parameter values for the view. For 
details, see "Parameters Page" on page 445.

Note: You can also edit the parameters from within the Editor after 
creating the view, by selecting Show Parameters  from the toolbar or 
the shortcut menu.

When you are finished, click Finish to open the view in the Editor. Click 
Save  to save the view.

 6 Set Permissions

Apply viewing and editing permissions to users and user groups for that 
view. You set permissions in Admin > Platform > Users and Permissions, 
select a user or a group and select Permissions. For details, see "How to 
Assign Permissions" in Platform Administration.
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How to Create Multiple Template Based Views

This task describes how to define multiple template-based views.

This task includes the following steps:

➤ "Prerequisites" on page 375

➤ "Define New Template Based Views" on page 375

➤ "Select a Template" on page 375

➤ "Select the Methods for Adding Parameter Values and Naming Views" on 
page 376

➤ "Set Parameters" on page 376

➤ "Select the Location for Saving the Views" on page 376

➤ "Save the Views" on page 376

➤ "Set Permissions" on page 376

 1 Prerequisites

If you want to base your views on a new template, create the template 
first. For details, see "How to Create a Template" on page 368.

 2 Define New Template Based Views

You define new template based views using the Template-based View 
wizard. Click the New  button and select Template Based View. 

 3 Select a Template

On the Select Template page of the wizard, select a template on which to 
base your views. For details, see "Select Template Page" on page 443.
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 4 Select the Methods for Adding Parameter Values and Naming 
Views

On the Import Parameter Values page of the wizard, select the method for 
adding the parameter values. Also, if you want to use the Advanced 
Naming feature, select the check box on this page. For details, see "Import 
Parameter Values Page" on page 444.

 5 Set Parameters

On the Parameters page, enter the parameter values for the view. If you 
selected to import the parameter values from a CSV file, they are 
automatically entered in the table. You can edit the view names and 
parameter values manually on this page. You can also add new views to 
the table or delete views from the table. For details, see "Parameters Page" 
on page 445.

 6 Select the Location for Saving the Views

On the Select Location page, select the location in the view tree in which 
to save the new views. For details, see "Select Location for Views Page" on 
page 446.

 7 Save the Views

On the Summary page, review the details of the views you created. If 
there are no further changes, click Save to save the views in the selected 
location.

 8 Set Permissions

Apply viewing and editing permissions to users and user groups for each 
view created. You set permissions in Admin > Platform > Users and 
Permissions, select a user or a group and select Permissions. For details, 
see "How to Assign Permissions" in Platform Administration.
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How to Define Report Settings

This task describes how to define report settings for a view, template, or 
perspective.

This task includes the following steps:

➤ "Prerequisites" on page 377

➤ "Select Attributes to Appear as Report Columns" on page 377

➤ "Add Function Columns to the Report - Optional" on page 378

➤ "Set the Sort Order of the Column Content" on page 378

➤ "Add a Chart to the Report - Optional" on page 378

 1 Prerequisites

After defining the content and hierarchy of a view, template, or 
perspective, you can define the report settings. Select the Report tab in 
the Pattern View Editor. 

 2 Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy 
pane and select the attributes to appear as columns in the report for that 
query node. You select attributes in the Query Node Definition pane by 
moving them from the Attributes list to the Report Layout list. Set the 
order of the columns using the arrow buttons in the Report Layout list. 
For details, see "Query Node Definition Pane" on page 424.
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 3 Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node 
consisting of data derived from a function performed on one of its child 
query nodes. Click the Add Function  button to open the Add Function 
dialog box where you can select the relevant settings. For details, see 
"Add/Edit Function Dialog Box" on page 387.

 4 Set the Sort Order of the Column Content

Click the Set Sort Order  button to open the Sort Column Content 
dialog box. Determine the columns by which to sort the report by 
moving columns from the Available Columns list to the Sorted Columns 
list. Use the arrow buttons to set the sort order of the columns. Use the 
Sort Ascending/Sort Descending buttons to set the sort direction for each 
column. For details, see "Sort Column Content Dialog Box" on page 441.

 5 Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table, 
for a selected layer of the view. When the necessary conditions for adding 
a chart are satisfied, the Define Chart link in the Chart Properties section 
of the Query Node Definition pane is active. Click the link and enter the 
chart settings. For details, see "Chart Properties" on page 426.

How to Build an Instance-based Model 

This task describes how to build an instance-based business CI model which 
can serve as the basis for a view.

This task includes the following steps:

➤ "Create the New Model" on page 379

➤ "Add CIs to the Model Manually" on page 379

➤ "Reveal CIs" on page 379

➤ "Define Watchpoints for CIs in the Model" on page 379
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 1 Create the New Model

In the Modeling Studio, click the New  button and select Instance 
Based Model to open the New Model dialog box. Select a CI type and 
enter the values for its properties. For details, see "New Model Dialog Box" 
on page 414.

Note: You cannot create an instance-based model with an already existing 
name.

 2 Add CIs to the Model Manually

In the CI Selector, search for the CIs you want to include in your model. 
Select them and drag them into the model. 

Tip: You can select more than one CI by holding the CTRL key while 
selecting CIs.

 3 Reveal CIs

Select a CI in the model and reveal its related CIs along a reveal path. Add 
selected CIs from among the revealed CIs to your model. When you are 
done, save the model. For details, see "Reveal CIs Dialog Box" on 
page 435.

 4 Define Watchpoints for CIs in the Model

Right-click a CI in the model and select Watchpoint > New Watchpoint. 
The New Watchpoint dialog box opens. Select a reveal path and click OK. 
A small icon appears next to the CI indicating that a watchpoint is 
defined for it. For details, see "New Watchpoint Dialog Box" on page 416.
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How to Build a New Pattern-based Model 

This task describes how to build a new pattern-based model which can serve 
as the basis for a perspective-based view.

This task includes the following steps:

➤ "Define the New Model" on page 380

➤ "Enter the Model Details" on page 381

➤ "Select a TQL Query" on page 381

➤ "Add Query Nodes and Relationships to a TQL Query" on page 381

➤ "Set Output Query Nodes" on page 381

➤ "Save the Model" on page 381

 1 Define the New Model

You define a new pattern-based model using the Pattern-based Model 
wizard. Click the New  button and select Pattern Based Model. 

Note: You cannot create an pattern-based model with an already existing 
name.
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 2 Enter the Model Details

On the first wizard page, select New Model. Then select a CI type for the 
model and enter the properties. For details, see "Select CI Type Page" on 
page 418.

 3 Select a TQL Query

On the next wizard page, select a TQL query for the model. You can create 
a new TQL query or select an existing query from the tree. The TQL Query 
Editor opens with the selected query. For details, see "Query Selection 
Page" on page 419.

 4 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details 
on how to add query nodes and relationships to a TQL query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on page 35.

 5 Set Output Query Nodes

Select one or more query nodes in the TQL query to serve as output for 
the model by right-clicking them and selecting Add to Model Output. 
The query node is indicated by a small icon next to it.

 6 Save the Model

When you are finished, save the model with a unique name. If you 
created a new TQL query, the query is also saved independently of the 
model and can be re-used as a regular TQL query.
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How to Build a Perspective-based View Based on a Model 

This task describes how to build a view in the Modeling Studio based on a 
model and a perspective.

This task includes the following steps:

➤ "Open the Model" on page 382

➤ "Select a Perspective" on page 382

➤ "Save the View" on page 382

 1 Open the Model

In the Modeling Studio, select Models as the Resource type in the left 
pane, select the relevant model, and click Open Model  in the left pane 
toolbar. 

 2 Select a Perspective

In the Model Editor, right-click the model and select Generate View for 
selected model. The Creating New View dialog box opens. Select 
perspectives to apply to the model. For details, see "Creating New View 
Dialog Box" on page 394.

 3 Save the View

The Perspective-based View Editor opens with your new view. Optionally, 
build a perspective chain by selecting perspectives for additional levels of 
the view creation. Rename the view and save it in the correct folder. For 
details, see "Perspective-based View Editor" on page 427.
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How to Build a Perspective-based View Based on a 
Collection of CIs

This task describes how to build a view in the Modeling Studio based on a 
collection of CIs and a perspective.

This task includes the following steps:

➤ "Create the New View" on page 383

➤ "Add CIs to the View" on page 383

➤ "Select a Perspective and Save the View" on page 383

 1 Create the New View

In the Modeling Studio, click the New  button and select Perspective 
Based View to open the Perspective-based View Editor. For details, see 
"Perspective-based View Editor" on page 427.

 2 Add CIs to the View

In the CI Selector, search for the CIs you want to include in your view. 
Select them and drag them into the view. For details on the CI Selector, 
see "CI Selector" on page 173.

Tip: You can select more than one CI by holding the CTRL key while 
selecting CIs.

 3 Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your CI collection. 
Optionally, you can build a perspective chain by selecting perspectives for 
additional levels of the view creation. Rename the view and save it in the 
correct folder. For details, see "Perspective-based View Editor" on 
page 427.
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How to Build a Business CI Model – Scenario

This scenario describes how to build a business CI model for use in a human 
resources application.

This task includes the following steps:

➤ "Create a Model" on page 384

➤ "Create Application CI Models Within Your Model" on page 385

➤ "Add System CIs to Your Model" on page 385

➤ "Add CIs to Your Model as Related CIs" on page 385

 1 Create a Model

To create a model, you need to select a CI type and enter its key 
properties. 

Select Admin > RTSM Administration > Modeling > Modeling Studio to 
open the Modeling Studio. For details about how to create a model, see 
"New Model Dialog Box" on page 414. 

Example of a Business CI Model:

In this example, a human resources application called Onboard Employee 
is to be created. Select Business Process as the CI type and enter Onboard 
Employee as the name under the key properties.
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 2 Create Application CI Models Within Your Model

You can create models within your model by clicking the New Model icon 
 in the Model Editor. For details, see "Model Editor" on page 404. 

Example of Application CI Models:

Within the Onboard Employee model, create a model of type Application. 
Enter HR Enterprise Resource Planning (ERP) as the name under the key 
properties. The application CI is created as a model within the Onboard 
Employee model. Repeat the process to create the following applications: 
Active Directory (AD) and Customer Relationship Management (CRM). The 
Onboard Employee model now includes three application models.

 3 Add System CIs to Your Model

Add to your model the CIs for the servers or other software elements on 
which the applications are running.

Example of System CI Models:

Under the HR ERP application, drag the System CI SAP System. Under the 
AD application, drag the System CI Node. The System CIs are included in 
the model and their related CIs, such as Hosts and Monitors, are 
automatically added to the model as related CIs.

 4 Add CIs to Your Model as Related CIs

Add the CIs that are to be related to the CIs in the model but are not 
included in the model. For details, see "Model Editor" on page 404. 

Example of Related CIs:

Create an application CI of type Portal. Select the CRM application and 
click the Related CIs tab in the Information pane. Drag the Portal CI into 
the Information pane. The CI is added as a related CI to CRM.
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Reference

Modeling Studio User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Function Dialog Box on page 387

 ➤ Change Query Node/Relationship Type Dialog Box on page 389

 ➤ Choose Operation for Selected Items Dialog Box on page 391

 ➤ Conditions of Related CIs Dialog Box on page 391

 ➤ Create/Edit/Save Reveal Path Dialog Box on page 393

 ➤ Creating New View Dialog Box on page 394

 ➤ Cycle Definition Dialog Box on page 395

 ➤ Hidden CIs Dialog Box on page 396

 ➤ Hierarchy Rules Dialog Box on page 396

 ➤ Left Pane on page 397

 ➤ Manage CI Watchpoints Dialog Box on page 403

 ➤ Model Editor on page 404

 ➤ Modeling Studio Page on page 411

 ➤ Models Containing Selected CI Dialog Box on page 413

 ➤ New Model Dialog Box on page 414

 ➤ New Pattern View/Template/Perspective Dialog Box on page 414

 ➤ New Watchpoint Dialog Box on page 416

 ➤ Open Reveal Path Dialog Box on page 417

 ➤ Pattern-based Model Wizard on page 418

 ➤ Pattern View Editor on page 421

 ➤ Perspective-based View Editor on page 427
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 ➤ Query Node Grouping Dialog Box on page 433

 ➤ Query/View Definition Properties Dialog Box on page 434

 ➤ Reveal CIs Dialog Box on page 435

 ➤ Save Query Dialog Box on page 438

 ➤ Save View/Template/Perspective Dialog Box on page 439

 ➤ Select Data Sources Dialog Box on page 440

 ➤ Sort Column Content Dialog Box on page 441

 ➤ Template-based View Wizard on page 442

 ➤ Template Parameter Values Dialog Box on page 448

 ➤ TQL Query Editor on page 448

 ➤ Views Containing Selected CI Dialog Box on page 453

 ➤ Watchpoints Updates Dialog Box on page 454

 ➤ <Query/Template/Perspective Name> Dependencies Dialog Box 
on page 455

Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node’s functions 
and parameters you want to include in the report.

To access Click the Add Function button under the Report Layout 
box in the Query Node Definition pane of the Pattern 
View Editor.
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User interface elements are described below:

Important 
information

When defining the report columns for a selected query 
node in a view, template, or perspective, you can define a 
column consisting of data deriving from a function 
defined for one of its child query nodes. Select the 
relevant child query node, attribute, and function that 
you want to define.

First, select the required query node and function. The 
attribute list adjusts to display the relevant attribute for 
the selected combination. Select the required attribute.

Relevant tasks "How to Define Report Settings" on page 377

UI Element (A-Z) Description

Attribute Select an attribute from the list.

Function From the Function list, select the function you want to 
use to calculate the results on these columns. 

The following are the available options:

➤ Average. The average value of the selected attribute for 
all the CI instances of the selected query node.

➤ Concatenated List. Lists the values of the selected 
attribute for all the CI instances of the selected query 
node.

➤ Count. Calculates the number of CI instances of the 
selected query node.

➤ Distinct List. Lists the unique values of the selected 
attribute for all the CI instances of the selected query 
node.

➤ Max. The maximum value of the selected attribute for 
all the CI instances of the selected query node.

➤ Min. The minimum value of the selected attribute for 
all the CI instances of the selected query node.

➤ Sum. The sum of the selected attribute values for all 
the CI instances of the selected query node.
388



Chapter 10 • Modeling Studio
Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node or 
relationship after you have created a TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Related Query Node The child query node on which you want to perform the 
function.

Title The name of the function attribute displayed in the 
report.

To access In the TQL Query Editor or Pattern View Editor, right-
click the required query node and select Change Query 
Node Type. For relationships, right-click the required 
relationship and select Change Relationship Type.

Important 
information

You can change the CI type of the selected query node to 
any other valid type based on the existing relationships 
and conditions of the selected query node.

Relevant tasks ➤ "How to Define a TQL Query" on page 33

➤ "How to Implement a Discovery Adapter" in the RTSM 
Developer Reference Guide

➤ "How to Create a Pattern View" on page 367

UI Element (A-Z) Description

Expand All. Expands all the folders in the tree.

Collapse All. Collapses all the folders in the tree.

UI Element (A-Z) Description
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Tree View Tree View. Selects the display format of the CI 
type/Relationship tree. The following options are 
available:

➤ Display label

➤ Class name

➤ Legacy class name

<CI 
type/Relationship 
tree>

Select the required CI type or relationship.

Relationship 
Direction

Select the direction of the relationship.

Note: Only relevant for relationships.

Relationship Name The name of the relationship.

Note: Only relevant for relationships.

Relationship 
Restrictions

Select an option to define how to handle relationships 
between identical query nodes or self relationships in the 
query results. A self relationship is a relationship that 
leads from a query node to itself.

➤ Allow All Relationships. All relationships appear in the 
query results.

➤ Allow Self Relationships only. Only self-relationships (a 
relationship that leads to itself) appear in the query 
results.

➤ Allow Non Self Relationships only. Self-relationships 
do not appear in the query results.

Note: Only relevant for relationships.

UI Element (A-Z) Description
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Choose Operation for Selected Items Dialog Box

This dialog box enables you to create models and views from selected CIs.

User interface elements are described below:

Conditions of Related CIs Dialog Box

This dialog box enables you to define conditions for the CI types in a reveal 
path.

To access In the Modeling Studio, drag CIs from the CI Selector 
onto the empty canvas.

Important 
information

You can drag individual or multiple CIs onto the canvas. 
You can select ordinary CIs and/or models to drag onto 
the canvas. Use the CTRL key while selecting CIs to select 
multiple CIs.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Create a new model Select to build a model comprising the CIs in your 
selection. If the CIs you dragged onto the canvas include 
at least one CI that has no valid links to any of the model 
CI types, this option is disabled.

Create a new view Select to build a view based on the CI collection formed 
by your selection.

Edit the model of the 
selected CI

Select to edit the selected model in the Model Editor.

Note: This option only appears when a single model is 
dragged onto the canvas.

To access Click the Add Condition or Edit Condition buttons from 
the Conditions column of the Reveal CIs dialog box.

See also "Best Practices for Modeling" on page 223
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User interface elements are described below:

UI Element (A-Z) Description

Add the attribute condition you have defined.

Delete an attribute condition.

Move a selected row up.

Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or 
to link multiple conditions.

Attribute name Select an attribute from the list.

Brackets Click inside the Brackets box to display a list of brackets 
you can use to build more complex, logical statements.

Criteria Contains the attribute condition definition as defined in 
the Element Instances dialog box.

Not Select NOT if you want the condition statement to do the 
opposite of what is defined.

Note: If you select NOT, query results do not include data 
from the CI instances that were not assigned a value. For 
example, your system contains three node CIs: Node1 is 
assigned the value A, Node2 is assigned the value B and 
Node3 is not assigned a value. You create a query to 
retrieve all nodes that are equal to A and select NOT; the 
results of your query only include Node2 because Node3 
is not assigned a value.

Operator Select the required operator. For details, see "Attribute 
Operator Definitions" on page 49.

Value Enter or select the value of the attribute. The Value 
options vary according to the attribute type you select.
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Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing 
path.

User interface elements are described below:

To access To define a new reveal path, click the Reveal  button 
from the Model Editor, and select Create Reveal Path. 

To edit an existing reveal path, select a path from the 
Open Reveal Path dialog box and click Edit.

To save a reveal path, click Save Path from the Reveal CIs 
dialog box.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Description Enter a description of the path.

Name Enter the name of the path.

Preview Opens the Reveal CIs dialog box displaying the related 
CIs in the path.

Note: This button does not appear in the Save Reveal 
Path dialog box.

Reveal Path Build the path by clicking the  icon to open a dialog 
box with a CI type tree. Select the CI type for the next 
item in the path.

When you hold the pointer over a reveal path item, the 
following options are available:

➤ Delete Selected Item(s). Deletes the selected item 
from the reveal path.

➤ Add condition. Opens the Conditions of Related CIs 
dialog box, which enables you to set conditions for 
the reveal path item.

➤ Refine Query Node Type. Opens a CI type tree, which 
enables you to change the CI type of the reveal path 
item.
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Creating New View Dialog Box

This dialog box enables you to select a perspective to create a view from a 
model.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, right-click a model in the Model 
Editor, Perspective-based View Editor, or CI Selector and 
select Generate view for selected Model or click the 
Generate view for selected model icon  from the 
Model Editor.

Important 
information

You select perspectives in the left pane and move them to 
the right pane using the arrow buttons.

Relevant tasks "How to Build a Perspective-based View Based on a 
Model" on page 382

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Available 
Perspectives

A list of the available perspectives to apply to your 
model.

Selected Perspectives The perspectives you selected to apply to your model.
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Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, right-click a query node in the 
Hierarchy pane of the Pattern View Editor and select 
Define Cycles.

Important 
information

You can extend the TQL query definition of a view by 
defining a cycle in the view hierarchy. Select a query 
node in the Hierarchy pane to be the source query node. 
The Cycle Definition dialog box displays the valid target 
query nodes for that source. The target query node in the 
cycle, along with its hierarchy, is treated as a child or 
sibling of the source query node (depending on your 
folding rule selection). 

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Folding Rule Select one of the following options:

➤ Folded cycle under source. The target query node 
becomes a child of the source query node.

➤ Flattened cycle under parent. The target query node 
becomes a sibling of the source query node.

Target Displays the valid target query nodes for the selected 
source query node. A query node is defined as a valid 
target query node if all of the following conditions are 
true:

➤ it is related to the source query node

➤ it is an ancestor of the source query node (or the 
source query node itself)

➤ it is a query based node (not a grouping node)
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Hidden CIs Dialog Box

This dialog box enables you to restore hidden CIs to a view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Hierarchy Rules Dialog Box

This dialog box enables you to set the hierarchy of a view by defining 
hierarchy rules.

To access From the Perspective-based View Editor, click the Show 
Hidden CIs icon from the toolbar of the View Results 
pane.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

<check box> Select the check boxes for the CIs you want to restore.

CI Type The CI type of the excluded CI.

Name The name of the excluded CI.

Restore Restore. Includes the selected CIs in the view.

Select All Select All. Selects all the CIs in the list for inclusion in the 
view.

Unselect All Unselect All. Clears the check boxes of all the CIs in the 
list.

To access From the Hierarchy pane of the Pattern View Editor, 
when Rule Based is selected as the hierarchy method, 
click the Add Hierarchy Rule  button from the toolbar.

Important 
information

For each hierarchy rule you define, select a source CI 
type, target CI type, relationship, and direction.

See also "Best Practices for Modeling" on page 223
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Left Pane

This area enables you to browse views and TQL queries, search for CIs or 
models to open in the Editor pane, and select CI types to use in the TQL 
Query Editor or Pattern View Editor.

UI Element (A-Z) Description

Adds a hierarchy rule.

Deletes the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the 
selected hierarchy rule.

Relationship 
Direction

Select a direction from the drop-down list to edit the 
selected hierarchy rule.

Source Select a CI type for the source CI type from the drop-
down tree to edit the selected hierarchy rule.

Target Select a CI type for the target CI type from the drop-
down tree to edit the selected hierarchy rule.

To access Located to the left of the Editor pane in Modeling Studio.

Important 
information

The following tabs are available:

➤ CI Selector. See "CI Selector" on page 173.

➤ Resources. Enables you to select a model, view, or TQL 
query to open in the Editor pane.

➤ CI Types. Enables you to select CI types from the tree 
to add as a query node to your TQL query.

See also "Best Practices for Modeling" on page 223
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Resources Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

When Views or Queries is selected as the resource type, 
you can drag and drop views, queries, or folders to move 
them from one folder to another.

UI Element (A-Z) Description

New Folder. Creates a new folder in the resource tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Delete. Deletes the selected resource from the RTSM.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Collapse All. Collapses all the folders in the resource tree.

Note: This button only appears when Queries or Views 
are selected as the resource type.

Hide Empty Folders. When Queries or Views are selected 
as the resource type, displays only folders containing 
views or TQL queries.

When Models is selected as the resource type, Show only 
models with content displays only models containing 
CIs.
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When Views is selected as the resource type, click Filter 
Tree to filter the types of views and templates that appear 
in the tree.

When Queries is selected as the resource type, it enables 
you to filter the TQL queries that appear in the tree by 
query type.

When Models is selected as the resource type, click Filter 
Table to filter the models in the table by CI type.

Open Query. Opens the selected TQL query in a new tab.

Note: This button only appears when Queries is selected 
as the resource type.

Open View. Opens the selected view in a new tab.

Note: This button only appears when Views is selected as 
the resource type.

CI Properties. Views the properties of the selected model.

Note: This button only appears when Models is selected 
as the resource type.

Show views containing selected CI/model. Displays a list 
of views including the selected CI or model.

Note: This button only appears when Models is selected 
as the resource type.

Open Model. Opens the selected model in the Model 
Editor.

Note: This button only appears when Models is selected 
as the resource type.

Import From XML. Imports XML files that contain saved 
views or queries to the Modeling Studio.

Note: This button only appears when Queries or Views 
are selected as the resource type.

UI Element (A-Z) Description
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Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) 
available by right-clicking a resource:

Export To XML. Exports the view or query as an XML 
script. This option can be used to move a view or query 
from one workstation to another.

Note: This button only appears when Queries or Views 
are selected as the resource type.

<Resources> When Views or Queries is selected as the resource type, 
the available views or TQL queries are displayed under 
their respective folders in tree format. When Models is 
selected as the resource type, the available models are 
displayed in a table.

For views, the following view types are included:

➤  Denotes a pattern view.

➤  Denotes a template.

➤  Denotes a template-based view.

➤  Denotes a perspective.

➤  Denotes a perspective-based view.

Resource Type Select the resource type to display in the pane. The 
available options are Models, Views, and Queries.

Menu Item Description

Create a new 
View/Template/Pers
pective

Creates a new view, template, or perspective based on the 
selected view, template, or perspective.

Note: This option is only active for queries when a query 
of type view, template, or perspective is selected.

Delete Deletes the selected resource from the RTSM.

Export To XML Exports the view or query as an XML script. This option 
can be used to move a view or query from one 
workstation to another.

New Folder Creates a new folder in the resource tree.

UI Element (A-Z) Description
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CI Types Tab

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

New Template Based 
View

Edits the parameters of the selected template to define a 
new template-based view.

Note: This option is only active when a template is 
selected in the view tree.

Open 
Query/View/Model

Opens the selected view, TQL query, or model in a new 
tab.

Properties Opens the CI Properties dialog box for the selected 
model.

Note: This option is only relevant for models.

Refresh Refreshes the resource tree.

Remove Removes the selected model.

Note: This option is only relevant for models.

Rename Folder Renames the selected folder.

Save As Saves the selected TQL query with a new name.

Show containing 
views

Opens the Views containing selected CI dialog box for 
the selected model.

Note: This option is only relevant for models.

UI Element (A-Z) Description

Expand All. Expands all the folders in the CI Type tree.

Collapse All. Collapses all the folders in the CI Type tree.

Menu Item Description
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CI Types Tab Shortcut Menu

The CI Types tab includes the following elements (listed alphabetically) 
available by right-clicking a CI type:

Tree View Selects the display format of the CI type tree. The 
following options are available:

➤ Display label

➤ Class name

➤ Legacy class name

Adds the selected CI type to the TQL query which is open 
in the Editor pane.

Note: This button is only active when a view or TQL 
query is open in the Editor pane.

Refresh. Refreshes the CI Type tree.

<CI Type tree> The available CI types are displayed in tree format.

Menu Item Description

Add Selected CITs to 
Query

Selects to add the selected CI type to the TQL query open 
in the Editor pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show Element 
Instances

Opens the CI Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 82.

UI Element (A-Z) Description
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Manage CI Watchpoints Dialog Box

This dialog box enables you to add or remove watchpoints for a CI in a 
model.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Watchpoint  button and select Manage CI 
Watchpoints or right-click a CI in the model and select 
Watchpoint > Manage CI Watchpoints.

UI Element (A-Z) Description

Add Opens the New Watchpoint dialog box which enables 
you to add a new watchpoint.

Remove Deletes the selected watchpoint.

Automated A check mark indicates that the new CIs found by the 
watchpoint are to be added to the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path for the watchpoint.
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Model Editor

This feature enables you to create and edit models.

Content Pane

User interface elements are described below:

To access In the Modeling Studio, click the New  button and 
select Instance Based Model to create a new model or 
select Models as the Resource type and open an existing 
model.

Important 
information

The Model Editor contains the following panes:

➤ Content pane. Lists the CIs and models contained in 
the model.

➤ Information pane. Displays the properties, related CIs 
and watchpoints for the selected CI or model.

You can drag CIs from the CI Selector into the Content 
pane of an existing model to add them to the model. 
However, you cannot drag in a CI that is already included 
in the model.

You can drag CIs from the CI Selector into the Related CIs 
tab of the Information pane provided that the selected 
source and target CI can be related by a usage 
relationship.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Map Mode. Displays the CIs as icons in a diagram.

Text Mode. Displays the CIs in a list.

CI Properties. Opens the Configuration Item Properties 
dialog box for the selected CI.

Show models containing selected CI. Displays a list of 
the models containing the selected CI.
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Show views containing selected CI/model. Displays a list 
of the views containing the selected CI or model.

Open selected model in a new tab. Opens the selected 
model in a separate Model Editor tab.

Generate view for selected model. Creates a view based 
on the current model. The Creating New View dialog box 
opens, which enables you to select a perspective to apply.

Removes a selected CI from the model (it remains in the 
RTSM).

Insert new model. Opens the New Model dialog box 
which enables you to define a new model within the 
existing model.

Expand All. Expands the model hierarchy.

Collapse All. Collapses the model hierarchy.

Click Reveal for the following options:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Create Reveal Path. Opens the Create Reveal Path 
dialog box. For details, see Create Reveal Path dialog 
box.

➤ Open Reveal Path. Opens the Open Reveal Path dialog 
box. For details, see Open Reveal Path dialog box.

Click Watchpoint for the following options:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ New Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

UI Element (A-Z) Description
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CI Collection. Groups CIs in a collection under a model. 
Select one of the following options:

➤ Insert New CI Collection. Create a new empty CI 
Collection. After creating the collection, you can drag 
CIs into it from the CI Selector, the related CIs tab, or 
from the model itself.

➤ Join to CI Collection. Select a CI or several CIs in the 
model and join them to an existing CI collection or 
form a new collection.

➤ Decompose CI Collection. Select a CI collection and 
decompose it. Its CIs remain directly under the main 
model.

Find. Toggles between displaying and hiding the Find 
box and arrow controls.

Note: This button only appears in Text mode.

Refreshes the map and optimize the map layout.

Note: This button only appears in Map mode.

Fit to Window. Resizes the map to fit the size of the pane.

Note: This button only appears in Map mode.

Select the functionality of the cursor from the Mode 
drop-down. The following options are available:

➤ Select

➤ Drag Map

➤ Zoom In

Note: This feature only appears in Map mode.

Print. Selects Print, Print Preview or Print Setup.

Show External Relationships. Displays the related CIs for 
a selected CI.

Note: This button only appears in Map mode.

Hide External Relationships. Hides the related CIs.

Note: This button only appears in Map mode.

UI Element (A-Z) Description
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Shortcut Menu Options

Indicates that watchpoints are defined for the current CI.

Indicates that the watchpoints have detected new CIs 
related to the current model. Opens the Watchpoints 
Updates dialog box.

CI Type column Displays the type of each CI in the model.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the model.

Find Next Goes to the next occurrence of the selected search phrase 
in the model.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the model.

Highlight Highlights all occurrences of the search phrase in the 
model.

Name column Displays the name of each CI in the model.

Menu Item Description

CI Collection CI Collection. Groups CIs in a collection under a model. 
Select one of the following options:

➤ Insert New CI Collection. Create a new empty 
collection. After creating the collection, you can drag 
CIs into it from the CI Selector, the related CIs tab, or 
from the model itself.

➤ Join to CI Collection. Select a CI or several CIs in the 
model and join them to an existing CI collection or 
form a new group.

➤ Decompose CI Collection. Select a CI collection and 
decompose it. Its CIs remain directly under the main 
model.

Fit to Window Resizes the map to fit the size of the pane.

Note: This option only appears in Map mode.

UI Element (A-Z) Description
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Generate view for 
selected model

Select to create a view based on the current model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Hide External 
Relationships

Hides the related CIs from the map.

Note: This option only appears in Map mode.

Insert New Model Opens the New Model dialog box which enables you to 
create a new model within the existing model.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Print Select one of the following options:

➤ Print

➤ Print Preview

➤ Print Setup

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Refresh Layout Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.

Reveal The following options are available:

➤ Start Revealing. Opens the Reveal CIs dialog box. For 
details, see Reveal CIs dialog box.

➤ Open Reveal Path. Opens the Open Reveal Path 
dialog box. For details, see Open Reveal Path dialog 
box.

Remove Selected 
CI(s) from the Model

Deletes the selected CIs from the model (it remains in 
the RTSM).

Select Select the functionality of the cursor. The following 
options are available:

➤ Select

➤ Drap Map

➤ Zoom In

Note: This option only appears in Map mode.

Menu Item Description
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Information Pane - Properties Tab

This area displays the properties of the selected CI.

Show Containing 
Models

Displays a list of the models containing the selected CI.

Show Containing 
Views

Displays a list of the views containing the selected CI or 
model.

Show External 
Relationships

Displays the related CIs for the selected CI.

Note: This option only appears in Map mode.

Watchpoint The following options are available:

➤ Watchpoints Updates. Display the watchpoint results 
and select CIs to add to the model. For details, see 
Watchpoints Updates dialog box.

➤ New Watchpoint. Define a new watchpoint for the 
selected CI. For details, see New Watchpoint dialog 
box.

➤ Manage CI Watchpoints. Add new watchpoints to the 
CI or remove existing ones. For details, see Manage CI 
Watchpoints dialog box.

Zoom Select the size of the map from the list of percents.

Note: This option only appears in Map mode.

Important 
information

This pane is identical to the Properties tab of the 
Information pane in IT Universe Manager. For details, see 
"Configuration Item Properties Dialog Box" on page 273. 

Menu Item Description
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Information Pane - Related CIs Tab

This area displays the CIs related to the model by one of the triplets that 
includes an Impacted By (Potentially) relationship.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Information Pane - Watchpoints Tab

This area displays the watchpoints defined for the selected CI.

User interface elements are described below:

UI Element (A-Z) Description

Deletes the relationship to the selected CI.

Invert Direction. Switches the direction of the 
relationship for the selected CI.

Note: This option is only active for CIs related by a usage 
relationship.

<CI list> Lists the name and CI type of the CIs related to the 
model by usage relationships, as well as the direction of 
the relationship.

Filter by Select a field by which to filter the results and enter the 
value in the by box.

UI Element (A-Z) Description

Opens the Manage CI Watchpoints dialog box, which 
enables you to edit the watchpoint.

Automated Indicates whether the new CIs found by the watchpoint 
are automatically added to the view.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint Name The name of the reveal path associated with the 
watchpoint.

Watchpoint Path Displays the reveal path of the watchpoint.
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Modeling Studio Page

This page enables you to create and edit models and views.

Tip: For more information about using Modeling Studio in HP Business 
Service Management, see "Best Practices for Modeling" on page 223.

To access Select Admin > RTSM Administration > Modeling > 
Modeling Studio.

Important 
information

The Modeling Studio page contains the following panes:

➤ Left pane. Enables you to search for CIs or select a 
view, model, or TQL query to open. For details, see 
"Left Pane" on page 397.

➤ Editor pane. Displays the topology map of a selected 
view, model, or TQL query.

The Editor pane is a blank canvas before any views or 
models are opened. When you open a view, model, or 
TQL query, the relevant editor appears there. Multiple 
views, models, and queries can be open at the same time 
in the Editor pane, each within a separate tab.

See also Model Editor, Perspective-based View Editor, Pattern 
View Editor, TQL Query Editor
411



Chapter 10 • Modeling Studio
User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

New New. Selects one of the following options:

➤ Instance Based Model. To create a new instance based 
model.

➤ Pattern Based Model. To create a new pattern based 
model.

➤ Pattern View. To create a new pattern view.

➤ Template Based View. To create a new template-based 
view.

➤ Perspective Based View. To create a new perspective-
based view.

➤ Template. To create a new template.

➤ Perspective. To create a new perspective.

➤ Query. To create a new TQL query.

Save. Saves the changes to your view, model, or query.

For views, a dialog box opens which enables you to 
rename your view and save it in the appropriate folder.

Save As. Saves your view, model, or TQL query under a 
new name.

Undo. Reverses the last change you made.

Redo. Repeats the last action you took.

Maximize Workspace. Toggles between the regular 
display and a full-screen display of the editor.

<Menu> For details, see "Main Menu" on page 207.
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Models Containing Selected CI Dialog Box

This dialog box enables you to display a list of the models containing the 
selected CI.

User interface elements are described below:

To access Click the Show models containing selected CI  button 
in the Model Editor or select Show containing models 
from the shortcut menu.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

CI Properties. Opens the Configuration Item Properties 
dialog box for the selected model.

Show views containing selected CI/model. Displays a list 
of views containing the selected model.

Remove model. Deletes the selected model.

CI Type Displays the CI types of the models containing the 
selected CI.

Find Enter a model name or a portion of a model name in the 
Find box to locate it in the list.

Find Next Goes to the next occurrence of the selected search phrase 
in the list.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the list.

Name Displays the names of the models containing the selected 
CI.

Note: The name of the current model appears in faded 
text.
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New Model Dialog Box

This dialog box enables you to define a reusable model containing a 
collection of CIs.

User interface elements are described below:

New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or 
perspective using the Pattern View Editor.

To access Click the New  button and select Instance Based 
Model or drag a CI from the tree in the CI Selector onto 
the editing pane and select Create a new model.

Relevant tasks "How to Build an Instance-based Model" on page 378

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Define new CI 
Properties

Enter the values for the CI properties. You must enter 
values for key properties and required properties. The key 
properties are marked with a key symbol  and the 
required properties are marked with an asterisk.

Select CI Type Select a CI type from the list to serve as the basis for your 
model.

To access In the Modeling Studio, click the New  button and 
select Pattern View, Template, or Perspective from the 
drop-down menu.

Important 
information

After making your selection and clicking OK, you go 
directly to the Pattern View Editor to begin building your 
view. For details, see "Pattern View Editor" on page 421.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Create a Pattern View" on page 367, "How to 
Create a Template" on page 368, "How to Create a 
Perspective" on page 370

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Goes to the next occurrence of the selected search phrase 
in the list of TQL queries.

Goes to the previous occurrence of the selected search 
phrase in the list of TQL queries.

Highlights all occurrences of the search phrase in the list 
of TQL queries.

<TQL query tree> Displays the existing TQL queries in tree format.

Choose base query If you want to base your new view on an existing TQL 
query, select this option and select a TQL query from the 
tree. The Pattern View Editor opens with the selected 
TQL query on the canvas.

Create new query If you want to base your new view on a new TQL query, 
select this option. The Pattern View Editor opens with a 
blank canvas.

Find Enter a TQL query name or a portion of a query name in 
the Find box to locate a TQL query in the list.
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New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a CI in a model.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Watchpoint  button and select New Watchpoint or 
right-click a CI in the model and select Watchpoint > 
New Watchpoint.

Important 
information

If no reveal paths are found for the selected CI, no 
watchpoints can be defined.

You cannot define watchpoints for CIs in a new model 
until you save the model.

Relevant tasks "How to Build an Instance-based Model" on page 378

UI Element (A-Z) Description

Automatically update 
model

Select to automatically add all revealed CIs from the 
selected path to the model.

Control updates 
manually

Select to manually add revealed CIs from the selected 
path to the model.

Select Watchpoint 
reveal path

Select a reveal path from the drop-down list.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All reveal paths 
beginning with that CI type appear in the list in the 
lower drop-down box.
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Open Reveal Path Dialog Box

This dialog box enables you to open an existing path.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Reveal  button and select Open Reveal Path or right-
click a CI in the model and select Reveal > Open Reveal 
Path.

Important 
information

After selecting the reveal path you want to use, click 
Execute. If CIs are found on the selected path, the Reveal 
CIs dialog box opens for that path. If no CIs are found, a 
message appears stating that no CIs were found on the 
path.

UI Element (A-Z) Description

Description column Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you 
to edit the selected path.

Execute Opens the Reveal CIs dialog box for the selected reveal 
path.

Find Enter a path name or a portion of a path name in the 
Find box to locate a path in the list.

Find Next Goes to the next occurrence of the selected search phrase 
in the list of paths.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the list of paths.

Highlight Highlights all occurrences of the search phrase in the list 
of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths 
for CI type

Select a CI type from the drop-down list. All paths 
beginning with the selected CI appear in the table below.
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Pattern-based Model Wizard

This wizard enables you to build a pattern-based model.

Select CI Type Page
This wizard page enables you to select a CI type for the model and define its 
details.

To access In the Modeling Studio, click the New  button and 
select Pattern Based Model from the drop-down menu.

Important 
information

When you create a pattern-based model, the model is 
saved as a CI, as with an instance-based model. If you 
based your model on a new TQL query, the query is also 
saved and appears in the TQL query tree.

When you build a pattern-based model over an existing 
instance-based model, the model is saved with the name 
of the instance-based model. 

If you create a new pattern-based model with the same 
name as a previously deleted pattern-based model, you 
can select an old query on which to base the new pattern-
based model or you can create a new query.

Relevant tasks "How to Build a New Pattern-based Model" on page 380

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page

See also "Pattern-based Models" on page 356

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page
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User interface elements are described below:

Query Selection Page
This wizard page enables you to select a TQL query upon which the model is 
based.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Existing Model Select Existing Model to build a pattern-based model over 
an existing instance-based model. Select an existing 
model from the tree.

New Model Select New Model to create a new pattern-based model 
(unrelated to any other model). In the Select CI Type 
section, select a CI type from the list to serve as the basis 
for your model. Then enter the values for the CI 
properties in the Define New CI Properties section.

Wizard map The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page

UI Element (A-Z) Description

Goes to the next occurrence of the selected search phrase 
in the list of TQL queries.

Goes to the previous occurrence of the selected search 
phrase in the list of TQL queries.

Highlights all occurrences of the search phrase in the list 
of TQL queries.

<TQL Query tree> Displays the existing TQL queries in tree format.

Choose base query If you want to base your model on an existing TQL query, 
select this option and select a query from the tree. The 
TQL Query Editor opens with the selected query on the 
canvas.
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Create new query If you want to base your model on a new TQL query, 
select this option. The TQL Query Editor opens with a 
blank canvas.

Find Enter a TQL query name or a portion of a query name in 
the Find box to locate a query in the list.

UI Element (A-Z) Description
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Pattern View Editor

This feature enables you to build and edit pattern views, templates, and 
perspectives.

To access To open a new view in the Pattern View Editor, go to the 
Modeling Studio, click the New  button and select the 
required type of view.

To open an existing view in the Pattern View Editor, go to 
the Resources tab of the left pane in the Modeling Studio 
and select Views as the Resource type. Right click a view 
in the tree and select Open View or double click a view or 
drag a view onto the Editor pane. The topology map of 
the view opens in the Editor pane.

Important 
information

You can access the Editor in View mode or in Report 
mode.

➤ In View mode, the following panes are included:

➤ Query Definition pane. For details, see "TQL Query 
Editor" on page 448.

➤ Advanced pane. For details, see "Advanced Pane" on 
page 450.

➤ Hierarchy pane. Enables you to set the hierarchy of 
the view. (Located in the right portion of the Editor 
page.)

➤ In Report mode, the following panes are included:

➤ Hierarchy pane. Enables you to set the hierarchy of 
the view. (Located in the left portion of the Editor 
page.)

➤ Query Node Definition. Enables you to select the 
attributes to be included in the report and to set 
their order.

Note: To save your view, template, or perspective, use the 
Save button in the Modeling Studio main toolbar.

Relevant tasks "How to Create a Pattern View" on page 367, "How to 
Create a Template" on page 368, "How to Create a 
Perspective" on page 370

See also "Best Practices for Modeling" on page 223
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Hierarchy Pane

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Add Group By. Creates a subgroup in the hierarchy. The 
following options are available:

➤ Add Group By Attribute. Opens the Query Node 
Grouping dialog box, which enables you to select an 
attribute for a subgroup in the hierarchy.

➤ Add Group By CI Type. Create a subgroup in the 
hierarchy for the CI type of the selected query node.

➤ Add Group by Query Node. Create a subgroup in the 
hierarchy for the selected query node only.

Edit Group By Attribute. Opens the Query Node 
Grouping dialog box, which enables you to edit the 
attribute for a subgroup in the hierarchy.

Rename. Renames the selected query node.

Delete Query Node. Deletes the selected query node from 
the hierarchy tree.

Move Query Node Layer Up. Places the selected query 
node one layer higher in the hierarchy.

Move Query Node Layer Down. Places the selected query 
node under the query node above it in the hierarchy.

Note: If the selected query node is located at the top of 
the hierarchy tree, clicking Move Query Node Layer 
Down places it under the query node beneath it in the 
hierarchy.

Move Query Node Up. Moves the selected query node up 
in the hierarchy tree. The query node order in the 
hierarchy determines the query node order in the report 
generated for the view in Reports.
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Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically) 
available by right-clicking a query node in the hierarchy tree:

Move Query Node Down. Moves the selected query node 
down in the hierarchy tree. The query node order in the 
hierarchy determines the query node order in the report 
generated for the view in Reports.

Preview. Displays a preview of the topology report.

Note: This option only appears in the Hierarchy pane 
when Report mode is selected.

<Hierarchy tree> The query nodes of the TQL query are arranged in a 
hierarchical tree reflecting the hierarchy defined for the 
view.

You can click and drag query nodes to change the 
hierarchy. When you click a query node and begin to 
drag it, the query nodes under which it is possible to 
place your query node are highlighted in green.

Hierarchy Method Select the method of setting the hierarchy:

➤ Manual. Set the hierarchy manually, by dragging 
query nodes and using the toolbar buttons.

➤ Rule Based. Open the Hierarchy Rules dialog box 
which enables you to set rules for the hierarchy.

Menu Item Description

Add Group By 
Attribute

Add Group By Attribute. Opens the Query Node 
Grouping dialog box, which enables you to select an 
attribute for a subgroup in the hierarchy.

Add Group By CI 
Type

Add Group By CI Type. Creates a subgroup in the 
hierarchy for the CI type of the selected query node.

Add Group By Query 
Node

Add Group By Query Node. Creates a subgroup in the 
hierarchy for the selected query node only.

UI Element (A-Z) Description
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Query Node Definition Pane

Define Cycles Define Cycles. Defines a cyclical hierarchy. For details, see 
"Cycle Definition Dialog Box" on page 395.

Delete Query Node Deletes the selected query node from the hierarchy tree.

Move Query Node 
Down

Moves the selected query node down in the hierarchy 
tree.

Move Query Node 
Layer Down

Move Query Node Layer Down. Places the selected query 
node under the query node above it in the hierarchy.

Note: If the selected query node is located at the top of 
the hierarchy tree, selecting Move Query Node Layer 
Down places it under the query node beneath it in the 
hierarchy

Move Query Node 
Layer Up

Move Query Node Layer Up. Places the selected query 
node one layer higher in the hierarchy.

Move Query Node 
Up

Moves the selected query node up in the hierarchy tree.

Rename Renames the selected query node.

Subgraph Hierarchy Enables you to define whether the subgraph defined for 
the selected query node is displayed as flat or as folded 
under the query node.

Note: This option is only relevant for query nodes that 
have a defined subgraph.

Important 
information

The Query Node Definition pane is disabled for template 
based views. To make changes to the report layout, edit 
the based template of the view. When you open a 
template based view in the Editor and select the Report 
tab, a warning message appears containing a link to the 
base template of the view.

Menu Item Description
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User interface elements are described below:

UI Element (A-Z) Description

Up. Moves a selected attribute up in the report layout 
order.

Down. Moves a selected attribute down in the report 
layout order.

Edit. Edits the function for the selected attribute.

Delete. Deletes a selected attribute from the report 
layout.

Moves the selected attributes to the Report Layout list.

Add Function Add Function. Opens the Add Function dialog box, 
which enables you to define the functions to include in 
the report for the selected query node. Each function that 
you add is treated as an attribute and becomes a column 
in the report.

Note: This button is only active if there is a query node 
below the selected query node in the view hierarchy.

Attributes The list of available attributes for the selected query 
node.

Define Chart Define Chart. Displays the data for the current layer of 
the view in a graphical chart format. The Chart 
Properties fields are displayed.

The Define Chart option is only active for a query node 
or a grouping node that:

➤ is the top layer of the view and has a layer below it in 
the view hierarchy

➤ is the only query node on its layer of the view

➤ has at least one numeric attribute selected for the 
report layout
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Chart Properties

The Chart Properties portion of the pane includes the following elements 
(listed alphabetically):

Report Layout Displays the list of attributes selected to appear in the 
report. Use the toolbar buttons to change the order of the 
attributes in the report and to add functions.

Set Sort Order Opens the Set Column Sort Order dialog box which 
enables you to set the order of the report columns.

UI Element (A-Z) Description

Remove Chart. Removes the chart from the report. The 
report is generated in table format.

Breakdown by The chart is broken down by the CI or grouping node 
display label. This is fixed for all reports.

Chart Type Select Pie to create a pie chart or Bar to create a bar chart.

Value Select a value from the drop-down list.

UI Element (A-Z) Description
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Perspective-based View Editor

This feature enables you to create and edit perspective-based views.

Content Pane

User interface elements are described below:

To access In the Modeling Studio, click the New  button and 
select Perspective Based View to create a new view or 
drag CIs from the CI Selector onto the blank canvas and 
select Create a new view. 

To open an existing view in the Editor, select Views as the 
resource type in the Resources pane, select the required 
perspective-based view from the tree, and click Open 
View  or double-click the view.

Important 
information

The Perspective-based View Editor contains the following 
panes:

➤ Content pane. Drag CIs and/or models onto this pane 
to include them in your view.

➤ Perspective pane. Select perspectives to apply to the 
content to build a view.

➤ View Results pane. Displays a topology map with a 
preview of the current view. This pane includes most 
of the IT Universe Manager functionality.

Relevant tasks ➤ "How to Build a Perspective-based View Based on a 
Model" on page 382

➤ "How to Build a Perspective-based View Based on a 
Collection of CIs" on page 383

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Go directly to IT Universe Manager for the current view.

Properties. Opens the Configuration Item Properties 
dialog box for the selected CI.
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Show models containing selected CI. Displays a list of 
the models containing the selected CI.

Show views containing selected CI/model. Displays a list 
of the views containing the selected CI or model.

Open selected model in a new tab. Opens the selected 
model in a separate Model Editor tab.

Generate view for selected model. Create a view based 
on the selected model. The Creating New View dialog 
box opens which enables you to select a perspective to 
apply.

Removes a selected CI from the view content.

View Definition Properties. Opens the View Definition 
Properties dialog box which enables you to set properties 
for the view.

Find. Toggles between displaying and hiding the Find 
box and arrow controls.

CI Type column Displays the type of each CI in the view.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the view

Find Next Goes to the next occurrence of the selected search phrase 
in the view.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the view.

Highlight Highlights all occurrences of the search phrase in the 
view.

Name column Displays the name of each CI in the view.

UI Element (A-Z) Description
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Shortcut Menu Options

Perspective Pane

User interface elements are described below:

Menu Item Description

Generate view for 
selected model

Select to create a view based on the selected model. The 
Creating New View dialog box opens which enables you 
to select a perspective to apply.

Open selected model 
in a new tab

Opens the selected model in a separate Model Editor tab.

Properties Opens the Configuration Item Properties dialog box for 
the selected CI.

Remove Base CIs Deletes the selected CI or model from the view content.

Show Containing 
Models

Displays a list of the models containing the selected CI.

Show Containing 
Views

Displays a list of the views containing the selected CI or 
model.

UI Element (A-Z) Description

Delete the selected level of the perspective selection.

Shift the perspective selection from the current level to 
the previous one.

Shift the perspective selection from the current level to 
the following one.

Add a new level to the perspective selection. The results 
of the previous perspective level serve as the input 
content for the new level.

Open a dialog box with the available perspectives. Move 
the required perspectives from the available column to 
the selected column using the arrow buttons.
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View Results Pane

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Apply Over Model 
Hierarchy

For views based on models, select the Apply Over Model 
Hierarchy check box to include the model hierarchy in 
the view and apply the perspectives to the CIs included 
in the model as well as to the model itself. Clear the 
check box to exclude the model hierarchy from the view 
and apply the perspectives to the model itself only. In 
this case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a 
collection of CIs or on a model and a collection of CIs.

Perspectives Lists the selected perspectives.

A default perspective appears in the window before any 
selection is made. You can set the value of the default 
perspective using the Selected perspectives for new 
perspective based views infrastructure setting.

UI Element (A-Z) Description

Map Displays the view results in Map mode.

Text Displays the view results in Text mode.

Create a relationship between two CIs in the view.

Toggle between hiding and displaying the topology map 
legend.

Move up one level in the topology map.

Move down one level in the topology map. 

Delete the selected CI from the view.

Show CI Properties. Opens the Configuration Item 
Properties dialog box for the selected CI.

UI Element (A-Z) Description
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Refresh. Refreshes the view results.

Hide CI from View. Hides the selected CI from the view. 
This option is only relevant for CIs that were added to 
the view via the perspective. You cannot hide CIs from 
the original view content from the view.

Note: Hidden CIs can be restored from the Hidden CIs 
dialog box.

Show Hidden CIs. Opens the Hidden CIs dialog box 
which enables you to restore CIs that were hidden from 
the view manually.

Create view based on selected CI/s. Creates a new view 
based on the CIs selected from the View Results pane.

Expand preview display. Displays the preview in a 
separate pane.

<Breadcrumbs> At the top of the topology map, the breadcrumbs 
indicate the relevant query nodes in each layer of the 
view for the path to the selected layer. The first item in 
the path is the Top Layer. When you select a CI from the 
layer below, the parent CI forms the next item in the 
breadcrumb path. You can click on any item in the path 
to display that layer in the topology map.

UI Element (A-Z) Description
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Shortcut Menu Options

<Legend> Indicates the icons displayed next to CIs with any of the 
following special statuses:

➤ Added. When Change Timeframe is active, indicates 
that the CI was added.

➤ Candidate for Deletion. Indicates that the CI is a 
candidate for deletion.

➤ Changed. When Change Timeframe is active, 
indicates that the CI was changed.

➤ Impacted. When Impact Analysis is active, indicates 
an impacted CI.

➤ Impacted and Trigger. When Impact Analysis is active, 
indicates a trigger CI that is impacted.

➤ Note. Indicates that a note was added for the CI.

➤ Trigger. When Impact Analysis is active, indicates a 
trigger CI.

<Topology Map> The topology map in the View Results pane follows the 
layout of the topology map in IT Universe Manager. For 
details, see "Topology Map" on page 286.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 219.

Menu Item Description

<IT Universe Shortcut 
Menu options>

The IT Universe Manager shortcut menu options are 
available. For details, see "IT Universe Manager Shortcut 
Menu" on page 289.

Create view based on 
selected CI/s

Creates a new view based on the CIs selected from the 
View Results pane.

UI Element (A-Z) Description
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Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of CIs or to edit an 
existing grouping.

User interface elements are described below:

Hide CI from View Hides the selected CI from the view. This option is only 
relevant for CIs that were added to the view via the 
perspective. You cannot hide CIs from the original view 
content from the view. In the case of a view based on a 
model, the model cannot be hidden but its CIs can.

Show Hidden CIs Restore hidden CIs to the view.

To access Click the Add Group by  button in the Hierarchy pane 
of the Pattern View Editor and select Add Group by 
Attribute or right click the required query node and 
select Add Group by Attribute from the shortcut menu. 

UI Element (A-Z) Description

Expression capture 
group index

Enter the number of the relevant portion of the regular 
expression. Enter 0 if the entire expression is relevant.

Group by Select an attribute from the drop-down list.

Mask to group by Enter a regular expression pattern representing the 
structure of the selected attribute.

For details, see "Query Node Grouping" on page 349.

Menu Item Description
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Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or 
view.

User interface elements are described below:

To access In the Modeling Studio, click the Query/View Definition 
Properties  button in the TQL Query Editor or Pattern 
View Editor.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Base Query Select an existing TQL query on which to base your new 
query.

Note: 

➤ This field is only relevant for TQL queries.

➤ This field is optional.

Bundles A method of grouping TQL queries or views by category. 
Select the bundles associated with the current query or 
view or create a new bundle for it.

Note: This field is optional.

Description A description of the TQL query or view.

Inter-Layer Links Set the scope of inter-layer relationships displayed in the 
topology results.

Note: This field is only relevant for views.

Persistent Select to define the TQL query as persistent. A persistent 
query remains in the memory permanently.

Note: This field is only relevant for TQL queries.
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Reveal CIs Dialog Box

This dialog box enables you to search for CIs related to the CIs in a model 
and add them to the model.

Priority Select a priority level for the TQL query or view from the 
drop-down list (Low, Medium, High, Express, Not 
Active). This setting determines how often the query 
should be rerun automatically by the system to include 
updated information from the RTSM.

Note: When you change the priority of a view, the 
priority of the TQL query on which the view is based is 
also changed.

Scope Select the scope of the TQL query from the drop-down 
list. 

Note: This field is only relevant for Integration TQL 
queries.

Type Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

To access In the Model Editor of the Modeling Studio, select a CI, 
click the Reveal  button, and select Start Revealing or 
right-click a CI in the model and select Reveal > Start 
Revealing.

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The upper pane displays the CI types of the CIs related to 
the selected CI. The lower pane displays the CIs of the 
type selected in the upper pane.

The first step in the reveal path is the CI type of the CI 
you began with. When you select a CI type from the list 
in the upper pane, that CI type becomes the second step 
in the path. Click Next to display the CI types available 
for the next step of the path. 

The number at the top of the box in parentheses 
indicates the length of the constructed path thus far.

Relevant tasks "How to Build an Instance-based Model" on page 378

UI Element (A-Z) Description

Deletes a selected item from the CIs basket.

Adds a selected CI from the lower pane to the CIs basket.

Goes to the next occurrence of the selected search phrase 
in the list of CIs.

Goes to the previous occurrence of the selected search 
phrase in the list of CIs.

<Lower pane> Displays a list of related CIs of the type selected in the 
upper pane.

CI count Indicates how many related CIs of each type were found.

CIs Basket Displays the related CIs you selected to include in the 
model.

CI Type Displays a list of CI types of the CIs related to the selected 
CI. 
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Conditions A check mark indicates that conditions were defined for 
the selected CI type. Click the Conditions column for the 
CI type you want to select and click the Add Condition or 
Edit Condition button to open the Conditions of Related 
CIs dialog box. This enables you to define and edit 
conditions for the CI type.

Find Enter a CI name or a portion of a CI name in the Find 
box to locate a CI in the list of CIs.

Finish Click Finish when you have finished adding CIs to the CI 
basket.

Next Displays the CI types available for the next step of the 
path.

Reveal path Displays the reveal path being constructed.

Clicking the blue arrows in the path  displays a drop-
down list of the CI types available for the next step of the 
path.

Clicking the CI types in the path displays the following 
options:

➤ Jump to page. Refreshes the table with the available CI 
types for the selected step of the path.

➤ Edit Condition. Opens the Conditions of Related CIs 
dialog box.

➤ Delete Selected Item(s). Deletes the selected CI type 
from the reveal path (the path ends at the previous CI 
type).

Save Path Opens the Save Reveal Path dialog box which enables 
you to save the path. This option is only active when a 
unique reveal path has been constructed.

UI Element (A-Z) Description
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Save Query Dialog Box

This dialog box enables you to save a new TQL query.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, click the Save  button when 
defining a new TQL query.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

New Folder. Creates a new folder in the resource tree.

Delete. Deletes the selected resource from the RTSM.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.

Collapse All. Collapses all the folders in the resource tree.

Goes to the next occurrence of the selected search phrase 
in the tree.

Goes to the previous occurrence of the selected search 
phrase in the tree.

Highlights all occurrences of the search phrase in the 
tree.

<Resource tree> Select a folder in the tree in which to save the query.

Find Enter a folder name or a portion of a name in the Find 
box to locate a folder in the list.

Query Name Enter the name of the new TQL query.
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Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based 
view, perspective-based view, template, or perspective.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

To access In the Modeling Studio, click the Save  button when 
defining a new pattern view, template-based view, 
perspective-based view, template, or perspective.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

New Folder. Creates a new folder in the resource tree.

Delete. Deletes the selected resource from the RTSM.

Refresh. Refreshes the resource tree.

Expand All. Expands all the folders in the resource tree.

Collapse All. Collapses all the folders in the resource tree.

Goes to the next occurrence of the selected search phrase 
in the tree.

Goes to the previous occurrence of the selected search 
phrase in the tree.

Highlights all occurrences of the search phrase in the 
tree.

<Resource tree> Select a folder in the tree in which to save the view, 
template, or perspective.

Find Enter a folder name or a portion of a name in the Find 
box to locate a folder in the list.
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Select Data Sources Dialog Box

This dialog box enables you to select the required data sources for a TQL 
query node.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

New query Select New query if the view is based on a new TQL 
query.

Note: This field is not relevant for template-based views 
and perspective-based views.

View Name Enter the name of the new view, template, or perspective.

To access In the Modeling Studio, right-click a TQL query node and 
select Set Data Sources.

Important 
information

You can select the data sources from which the TQL 
query generates the results for each query node. For 
details on data sources, see "Integration Studio Overview" 
in the RTSM Data Flow Management Guide.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

<Data Source list> A list of available data sources.

All Data Sources Select to include CIs from all RTSM and external sources 
for the selected query node in the TQL query results.

Local Data Source Select to include CIs from the RTSM only for the selected 
query node in the TQL query results. 

Select Data Sources Select to include CIs from the selected sources only for 
the selected query node in the TQL query results.

UI Element (A-Z) Description
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Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a 
report.

User interface elements are described below:

To access In the Modeling Studio, click Set Sort Order in the Query 
Node Definition pane of the Pattern View Editor (in 
Report mode).

Important 
information

The report is sorted by columns following the order of 
the attributes in the Sorted Columns pane. Each selected 
column is sorted in ascending or descending order 
according to your selection.

Relevant tasks "How to Define Report Settings" on page 377

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Move to Sorted Columns. Moves the selected attribute to 
the Sorted Columns pane.

Move to Available Columns. Moves the selected attribute 
to the Available Columns pane.

Moves all the attributes to the Sorted Columns pane.

Moves all the attributes to the Available Columns pane.

Moves the selected attribute down in the Sorted Columns 
list.

Moves the selected attribute up in the Sorted Columns 
list.

Sort Ascending. Sorts the selected column in ascending 
order.

Sort Descending. Sorts the selected column in 
descending order.
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Template-based View Wizard

This wizard enables you to define template-based views manually or by 
importing parameter data from a CSV file.

Available Columns The attributes selected to appear as columns in the 
report.

Sorted Columns The columns selected to be sorted.

To access Click the New  button and select Template Based 
View.

Important 
information

The wizard enables you to create multiple template-based 
views based on the same template. When creating 
multiple views, the wizard includes the Save Views page 
as the final page. When creating a single template-based 
view, the wizard finishes with the Parameters page and 
opens the new view in the Editor. You can save the new 
view from within the Editor.

Relevant tasks ➤ "How to Create a Template Based View" on page 373

➤ "How to Create Multiple Template Based Views" on 
page 375

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

See also "Creating Template Based Views" on page 353

UI Element (A-Z) Description
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Select Template Page
This wizard page enables you to select a template on which to base your 
view.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

If you don’t want to use any of the templates in the tree, 
you can create a new template first and then build a view 
based on it. For details on creating a template, see "How 
to Create a Template" on page 368.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

Refresh. Refreshes the template tree.

Expand All. Expands all the folders in the template tree.

Collapse All. Collapses all the folders in the template tree.

Goes to the next occurrence of the selected search phrase 
in the tree.

Goes to the previous occurrence of the selected search 
phrase in the tree.

Highlights all occurrences of the search phrase in the tree.

<Template tree> Displays the existing templates in tree format.

Find Enter a template name or a portion of a name in the Find 
box to locate a template in the list.
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Import Parameter Values Page
This wizard page enables you to import parameter values from a CSV file.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

If you are creating a large number of views based on the 
same template, you can save the parameter values in a 
CSV file and import them directly into the wizard.

Note: If the CSV file contains any non-English 
characters, you must use UTF-8 encoding to ensure that 
the characters are displayed properly.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

Add parameter 
values manually

Select this option to enter the parameter values manually, 
whether for a single view or for multiple views.

Import parameter 
values from a CSV file

Select this option to import the parameter values from a 
CSV file. Click the ellipsis  button to browse your files 
for the required file.

Use Advanced 
Naming

Select the Use Advanced Naming option to automatically 
name the created views based on parameter values. In the 
box, enter an expression containing at least one 
parameter name in angle brackets. The views are named 
based on the values of the selected parameter.
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Parameters Page
This wizard page enables you to set the values of the template’s parameters 
for each new view created.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

If you are creating multiple views, click Next after you set 
the parameter values to proceed to the Save Views page. 
If you are creating a single view, click Finish after you set 
the parameter values to open the new view in the Editor.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

Adds a new view instance.

Deletes the selected view instance.

<Parameter 
columns>

In each parameter column, enter or select the required 
parameter value for each view.

Reset Resets the selected parameter to its original value.

Use Advanced 
Naming

Select the Use Advanced Naming option to automatically 
name the created views based on parameter values. In the 
box, enter an expression containing at least one 
parameter name in angle brackets. The views are named 
based on the values of the selected parameter.

Note: All view names must be unique.

View Name Enter names for each of the new views, or use the default 
names assigned.
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Select Location for Views Page
This wizard page enables you to select the location in which to save the 
created views.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

All created views must be saved in the same location

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

New Folder. Creates a new folder in the view tree.

Refresh. Refreshes the view tree.

Expand All. Expands all the folders in the view tree.

Collapse All. Collapses all the folders in the view tree.

Goes to the next occurrence of the selected search phrase 
in the tree.

Goes to the previous occurrence of the selected search 
phrase in the tree.

Highlights all occurrences of the search phrase in the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find 
box to locate a template in the tree.
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Summary Page
This wizard page displays the details of the created views before saving.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Save Views Page
This wizard page enables you to save the new views you created.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

Save view summary A summary of the views created including the name of 
the base template, the number of views created, and the 
location selected for saving the views.

Important 
information

This wizard page is only relevant when you are creating 
multiple template-based views.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > 
Parameters Page > Select Location for Views Page > 
Summary Page > Save Views Page

UI Element (A-Z) Description

Save Results A table displays the names of the new views and a 
message indicating whether each view was saved 
successfully or not.
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Template Parameter Values Dialog Box

This dialog box enables you to edit the parameters of a template-based view.

User interface elements are described below:

TQL Query Editor

This feature enables you to build and edit TQL queries.

To access From within a template-based view in the Modeling 
Studio, right-click a query node with parameters defined 
and select Show Node Parameters, or click the Show 
Parameters  button in the toolbar.

Important 
information

When you open the dialog box from the shortcut menu 
by right-clicking a query node with parameters defined, 
the dialog box only displays the parameters for the 
selected query node. When you open the dialog box 
from the toolbar, it displays all the parameters defined 
for any of the query nodes in the view.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

<Parameters> Edit the values of the parameters.

To access To open a new TQL query in the TQL Query Editor, go to 
the Modeling Studio, click the New  button and select 
Query.

To open an existing TQL query in the TQL Query Editor, 
go to the Resources tab of the left pane in the Modeling 
Studio and select Queries as the Resource type. Right click 
a TQL query in the tree and select Open Query or double 
click a TQL query or drag a TQL query onto the empty 
canvas. The TQL query opens in a new tab.

Important 
information

To save your TQL query, use the Save button in the 
Modeling Studio main toolbar.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Relevant tasks "How to Define a TQL Query" on page 33

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Show View Results in IT Universe. Goes directly to the 
selected view in IT Universe Manager.

Note: This button only appears for views, templates, or 
perspectives.

Create Relationship. Draws a relationship from one query 
node to another.

Hide/Show Legend. Toggles between hiding and 
displaying the topology map legend.

Calculate Query Result Count. Calculates the number of 
instances found for each TQL query node or relationship.

Preview. Displays a preview of the TQL query results as 
they would appear in IT Universe Manager.

Delete. Deletes the selected query node or relationship 
from the query.

For queries, opens the Query Definition Properties dialog 
box which enables you to edit the type, scope, and 
priority of the TQL query.

For views, opens the View Definition Properties dialog 
box.

Opens the Template Parameter Values dialog box which 
enables you to edit the parameters of a query node in a 
template-based view.

Note: This button only appears for template-based views.
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Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

<Legend> Indicates the icons displayed next to CIs with any of the 
following special designations:

➤ It is defined as a contact query node in a perspective

➤ It is defined as the output query node of a pattern-
based model

➤ It has attributes defined

➤ It has selected identities defined

➤ It is hidden in the query results

➤ It has a subgraph defined

<Main menu> For details, see "Main Menu" on page 207.

<Shortcut menu 
options>

For details, see "Shortcut Menu Options" on page 44.

<Topology Map 
Sidebar>

For details, see "Topology Map Sidebar" on page 219.

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Element (A-Z) Description
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User interface elements are described below:

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 93.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 95.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type/Element Type. The CIT of the selected query 
node/relationship.

➤ Element Name. The name of the query node or 
relationship. This appears only in the Modeling Studio.

➤ Show in query results. A green check indicates that the 
selected query node/relationship is visible in the topology 
map. A red mark indicates that it is not visible. In the 
Modeling Studio, this is indicated by the word Yes or No.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears. This item does not appear in the Modeling 
Studio.

Edit Click Edit to open the relevant dialog box for the selected 
tab.
451



Chapter 10 • Modeling Studio
Element Type Displays the subtype conditions defined for the query node 
or relationship. For details, see "Element Type Tab" on 
page 99.

Note: This tab appears only in the Modeling Studio.

Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 554.

Note: This tab appears only in Enrichment Manager.

Impacted Query 
Nodes

Indicates which query node is impacted by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Impacted Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 475.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 102.

Note: This tab appears only in Enrichment Manager and 
Impact Analysis Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 105.

UI Elements (A-Z) Description
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Views Containing Selected CI Dialog Box

This dialog box enables you to display a list of the views containing the 
selected CI.

User interface elements are described below:

To access Click the Show views containing selected CI/model  
button in the Model Editor or select Show containing 
views from the shortcut menu.

See also "Best Practices for Modeling" on page 223

UI Element (A-Z) Description

Show View Results in IT Universe. Goes directly to the 
selected view in IT Universe Manager.

Delete Selected Item(s). Deletes the selected view.

Disconnect view from perspective. Disconnects the 
selected view from its perspective. The view becomes a 
pattern view.

Find Enter a view name or a portion of a view name in the 
Find box to locate it in the list.

Find Next Goes to the next occurrence of the selected search phrase 
in the list.

Find Previous Goes to the previous occurrence of the selected search 
phrase in the list.

Highlight Highlights all occurrences of the search phrase in the list.

View Name Displays the list of views dependent on the selected 
template or perspective.

Note: The name of the current view appears in faded 
text.
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Watchpoints Updates Dialog Box

This dialog box displays the changes found in related CIs by a watchpoint 
defined for a model.

User interface elements are described below:

To access From within a model in the Model Editor, click the 
Watchpoint  button and select Watchpoints Updates 
or right-click a CI in the model and select Watchpoint > 
Watchpoints Updates.

Important 
information

The Watchpoints Updates dialog box indicates any 
changes found involving the CIs related to the model via 
the associated reveal path. If a new related CI is found 
which is not included in the model, the suggested update 
is an added CI. If a CI in the model is found to no longer 
be related via the path, the suggested update is a removed 
CI.

This option is only enabled when watchpoints are 
defined for the model and CIs have been found.

UI Element (A-Z) Description

Accept Select the check boxes for the CIs you want to add to 
your model or remove from your model.

Accept All Applies all the suggested changes to your model.

CI The names of the CIs found by the watchpoint.

CI Type The types of the CIs found by the watchpoint.

Clear All Clears the check boxes for all the found CIs.

Restore Select the check boxes for the CIs in the Suppressed CIs 
pane that you want to consider for inclusion in your 
model.

Show/Hide 
Suppressions

Toggle between hiding and displaying the Suppressed CIs 
pane of the dialog box.

Suggested Update Indicates whether the suggested change is an added CI or 
a removed CI.
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<Query/Template/Perspective Name> Dependencies 
Dialog Box

This dialog box enables you to clarify the status of dependent views when 
saving changes to a query, template, or perspective.

User interface elements are described below:

Suppress Select the check boxes for the CIs you want to exclude 
from your model or leave in your model.

Suppress All Declines all the suggested changes to your model.

To access In the Modeling Studio, make a change to a query, 
template, or perspective with dependent views. When 
you click Save, the dialog box opens.

Important 
information

Any change made to a resource affects the views based on 
that resource. Before the changes are saved, you need to 
specify the desired result on the dependent views. For 
each dependent view, select one of the available options: 
Delete, Re-Apply, or Detach.

UI Element (A-Z) Description

Delete Select this option to delete the selected dependent view.

Detach Select this option to detach the selected dependent view 
from the template or perspective. The view becomes a 
pattern view.

Note: This option is not relevant for queries.

Re-Apply Select this option to apply the revised query, template, or 
perspective to the selected dependent view. The view 
type remains the same as it was previously (pattern view, 
template-based view, or perspective-based view).

Resource The dependent views are displayed in a tree format.

UI Element (A-Z) Description
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Impact Analysis Manager

This chapter includes:

Concepts

➤ Impact Analysis Manager Overview on page 458

Tasks

➤ How to Define an Impact Rule – Workflow on page 460

Reference

➤ Impact Analysis Manager User Interface on page 464
457



Chapter 11 • Impact Analysis Manager
Concepts

Impact Analysis Manager Overview

Impact Analysis Manager enables you to define the interdependencies 
between components in your IT infrastructure to simulate how 
infrastructure changes (for example, a new software installation or upgrade) 
can impact your system.

By creating Impact rules based on TQL queries, you can determine the true 
origin of a problem and its business impact. Each Impact rule you define is 
attached to a specific Impact Analysis TQL query. For more information 
about TQL queries, see "Topology Query Language" on page 21.

You define Impact rules to specify a causal relationship between two or more 
Impact Analysis query nodes. Define one query node as the trigger, or the 
query node that represents the changes you want to make to the system, 
and another query node as the one that is impacted. After the causal 
relationship is established, Impact Analysis Manager enables you to 
determine the effect of the changes occurring in root cause query nodes.

You then run the Impact rules in IT Universe Manager to simulate how the 
changes impact your system and discover the root causes of the changes (for 
details, see "Run Impact Analysis Dialog Box" on page 302). This enables you 
to evaluate and handle accordingly, the possible implications of any action, 
update, new deployment, or a failure of the service delivery.

A simulated change in an impacted CI can alter the CI’s map status, which is 
manifested through an addition of a status icon to the CI’s symbol. The 
Topology Map displays the statuses of the trigger CIs as well as all statuses of 
the CIs that are impacted by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see 
"Show Impact Pane" on page 308.
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You can then generate a report displaying the following:

➤ CIs in the system that are impacted by the changes.

➤ Trigger CIs (the CIs that represent the changes you want to make to the 
system).

➤ CIs that belong to a specific business service. 
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Tasks

How to Define an Impact Rule – Workflow

This section describes how to define an Impact rule whereby a change in 
CPU operation impacts the node to which it is connected.

This task includes the following steps:

➤ "Create an Impact Analysis TQL Query" on page 460

➤ "Define an Impact Rule" on page 461

 1 Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact 
Analysis TQL and then add the TQL query nodes and relationships that 
define the query. 

Select Admin > RTSM Administration > Modeling > Impact Analysis 
Manager to open the Impact Analysis Manager. For details about how to 
create an Impact Analysis TQL query, see "New Impact Rule/Impact Rule 
Properties/Save As Impact Rule Wizard" on page 478. For details about 
how to add query nodes and relationships to a query, see "How to Add 
Query Nodes and Relationships to a TQL Query" on page 35.
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Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a 
Composition relationship. The TQL query results must comply with the 
direction of the arrows.

Note: An Impact Analysis TQL query is subject to certain validation 
restrictions. For details, see "Troubleshooting and Limitations" on 
page 114.

 2 Define an Impact Rule

When you define an Impact rule, you must specify the required causal 
relationship between the query nodes. Define one query node as the 
trigger, or the query node that represents the changes you want to make 
to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node 
and select Define Impacted to open the Impacted Query Nodes dialog 
box. Select the query node you want the trigger query node to impact. 
Then click the Add button to open the Impact Rules Definition dialog box 
to set conditions for defining impacted query nodes. For details about 
how to define an Impact rule, see "Impact Rules Definition Dialog Box" on 
page 476. 
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Note: The change state option in the Impact rule definition is no longer 
relevant for Impact Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the 
conditions under which the simulated change in the system is triggered. 
The Severity area defines the severity of the impact on the impacted query 
node.

The Impact rule in this example states that when the CPU operation is 
not in the normal state, the node is impacted. Since the severity is set to 
100% of the trigger’s severity, the severity of the node is the same as the 
severity of the CPU, which is determined when Impact Analysis is run.
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In the resulting TQL query, an upward arrow appears next to the query 
node defined as the trigger query node and a downward arrow appears 
next to the query node defined as the impacted query node.

Note: To retrieve the Impact Analysis results, you must run the Impact 
rule in IT Universe Manager. For details, see "How to Retrieve Impact 
Analysis Results – Scenario" on page 258.
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Reference

Impact Analysis Manager User Interface

This section includes (in alphabetical order):

 ➤ Details Dialog Box on page 465

 ➤ Impact Analysis Manager Page on page 466

 ➤ Impacted Query Nodes Dialog Box on page 475

 ➤ Impact Rules Definition Dialog Box on page 476

 ➤ New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard 
on page 478
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Details Dialog Box

This dialog box displays the new Impact rule you created in the Impact 
Rules Definition dialog box.

User interface elements are described below:

To access In the Impact Analysis Manager, click Next in the 
Impacted Query Nodes dialog box.

Relevant tasks "How to Define an Impact Rule – Workflow" on page 460

UI Element (A-Z) Description

Description The description of the new Impact rule.

State The category you chose from the State list in the Impact 
Rules Definition dialog box.
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Impact Analysis Manager Page

This page enables you to define Impact rules.

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and 
Impact rules. Each Impact rule is associated with a TQL query.

User interface elements are described below:

 

To access Select Admin > RTSM Administration > Modeling > 
Impact Analysis Manager.

Important 
information

When selecting query nodes to function as Impact 
Analysis triggers, they must comply with certain 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114.

Relevant tasks "How to Define an Impact Rule – Workflow" on page 460

See also "Impact Analysis Manager Overview" on page 458

Important 
information

You can create your own Impact rules, or work with the 
default rules provided with your HP Business Service 
Management installation.

The predefined folders are provided for the default 
Impact rules; you can modify these folders, or add 
additional folders according to your organization’s 
requirements.

You can drag and drop Impact rules or folders to move 
them from one folder to another.

UI Element (A-Z) Description

Create a new folder.

Creates an Impact rule. Opens the New Impact Rule 
Wizard.

Deletes the selected folder or Impact rule.
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The following elements are available by right-clicking a folder or Impact 
rule:

 

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when a new Impact rule is created or when 
changes are made to an existing one.) Saves the Impact 
rule to the RTSM.

Opens the Impact Rule Properties Wizard. Enables you to 
change the description of the rule.

Generates  a preview of the results of the selected Impact 
rule.

Represents a folder.

Represents an Impact rule.

<Impact Rules tree> Displays the existing Impact rules in tree format. 

Note: Only Impact Analysis rules appear in the tree. TQL 
queries of type Impact Analysis (created in the Modeling 
Studio) do not appear. 

UI Element (A-Z) Description

Delete Delete the selected folder or Impact rule.

Export To XML Displays a standard Save As dialog box, enabling you to 
save the Impact rule as an XML script. This option can be 
used to move an Impact rule from one workstation to 
another, provided the related TQL query is also relocated.

Import From XML Imports XML files that contain saved Impact rules to 
Impact Analysis Manager.

New Creates an Impact rule. Opens the New Impact Rule 
Wizard.

New Folder Creates a new folder.

UI Element (A-Z) Description
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Editing Pane

This area displays the selected Impact rule, which consists of query nodes 
that are defined in the TQL query and the relationships between them.

Preview Generates  a preview of the results of the selected Impact 
rule.

Properties Opens the Impact Rule Properties Wizard. Enables you to 
change the description of the rule.

Rename Folder Rename the folder.

Save (Enabled only when a new Impact rule is created or when 
changes are made to an existing one.) Saves the Impact 
rule to the RTSM.

Save As Displays the Save As Impact Rule Wizard, enabling you to 
create new Impact rules based on an existing query.

Important 
information

➤ When you select a folder in the Impact Rules pane, the 
editing pane is empty. 

➤ When you select an Impact rule in the Impact Rules 
pane, the editing pane displays the selected rule, which 
consists of TQL query nodes that are defined in the 
TQL query and the relationships between them.

Relevant tasks  "How to Add Query Nodes and Relationships to a TQL 
Query" on page 35

See also When selecting query nodes to function as Impact 
Analysis triggers, they must comply with certain 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114.

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Indicates a trigger query node. Located to the right of the 
trigger query node's icon. 

Indicates an impacted query node. Located to the right of 
the impacted query node’s icon.

Indicates query nodes that are both impacted and trigger 
query nodes.

<Main Menu> For details, see "Main Menu" on page 207.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two 
query nodes.

<Shortcut menu 
options>

For details, see "Shortcut Menu Options" on page 44.

<Toolbar> For details, see "Toolbar Options" on page 211.

<Tooltip> Hold the cursor over a query node or relationship to view 
its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the query node.

➤ CI Type. The CIT of the query node as defined in the CI 
Type Manager. For details, see "CI Type Manager" on 
page 483.

➤ Definitions of the selected query nodes and 
relationships. The attribute conditions, as described in 
"Query Node/Relationship Properties Dialog Box" on 
page 90.

➤ Names of the trigger and the impacted query nodes. 
This is only relevant if the query node over which the 
cursor is hovering is the trigger query node.
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CI Type Selector

This area displays a hierarchical tree structure of the CI Types found in the 
ODB. 

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Important 
information

The CI Type Selector is part of Enrichment Manager, 
Impact Analysis Manager, and Trigger TQL Editor. 

To create or modify a TQL query, click and drag query 
nodes to the Editing pane and define the relationship 
between them. Your changes are saved to the ODB. For 
details, see "How to Add Query Nodes and Relationships 
to a TQL Query" on page 35.

Note: The number of instances of each CIT in the ODB is 
displayed to the right of each CIT.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

UI Elements (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.
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Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the CIT Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 82.

UI Elements (A-Z) Description
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Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

User interface elements are described below:

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 93.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 95.
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Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type/Element Type. The CIT of the selected query 
node/relationship.

➤ Element Name. The name of the query node or 
relationship. This appears only in the Modeling Studio.

➤ Show in query results. A green check indicates that the 
selected query node/relationship is visible in the topology 
map. A red mark indicates that it is not visible. In the 
Modeling Studio, this is indicated by the word Yes or No.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears. This item does not appear in the Modeling 
Studio.

Edit Click Edit to open the relevant dialog box for the selected 
tab.

Element Type Displays the subtype conditions defined for the query node 
or relationship. For details, see "Element Type Tab" on 
page 99.

Note: This tab appears only in the Modeling Studio.

Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 554.

Note: This tab appears only in Enrichment Manager.

UI Elements (A-Z) Description
473



Chapter 11 • Impact Analysis Manager
Impacted Query 
Nodes

Indicates which query node is impacted by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Impacted Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 475.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 102.

Note: This tab appears only in Enrichment Manager and 
Impact Analysis Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 105.

UI Elements (A-Z) Description
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Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is 
the trigger Impact Analysis query node and which query nodes are impacted 
by the changes that occurred in the system.

User interface elements are described below:

To access Right-click the query node or relationship that functions 
as a trigger and select Define Impacted. The Impacted 
Query Nodes dialog box opens to display the query nodes 
in the TQL query.

Important 
information

Before creating the TQL query, you must know which 
query node in the query is the trigger Impact Analysis 
query node and which are impacted by the changes 
beforehand. The definition is performed here.

Relevant tasks "How to Define an Impact Rule – Workflow" on page 460.

UI Element (A-Z) Description

Impacted Query 
Nodes pane

Contains a list of the Impact Analysis query nodes in the 
Impact rule. Select the query nodes to be impacted by the 
trigger query node.
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Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query 
nodes, define the scope of the trigger conditions, and define the severity of 
the impact.

User interface elements are described below:

To access In the Impact Analysis Manager, click Add in the Details 
dialog box.

Important 
information

➤ In the Conditions area, set conditions for defining 
impacted query nodes. When this condition is met, 
the simulated change in the system is triggered.

For example, you can define an Impact Analysis 
condition that states that the operational state of the 
query node is other than Normal. When the 
operational state of the query node instance changes 
and is no longer Normal, the condition is met and the 
simulated changes in the system are triggered.

➤ In the Scope area, define how many instances of the 
trigger query node should fulfill the conditions for 
triggering the changes in the system.

You can apply the trigger conditions to a single 
instance of a trigger query node, to a certain 
percentage of the trigger instances, or to all of them. 

For example, you can define that impact is calculated 
when at least 10% of the system’s nodes are down.

➤ In the Severity area, define the severity of the Impact 
Analysis impact.

Relevant tasks "How to Define an Impact Rule – Workflow" on page 460

UI Element (A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Description A description of the Impact rule you are defining.
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Fixed severity Define a fixed severity level for every system change 
generated. Then, select the required severity level from 
the list.

Function Select Function (displayed when you selected the All and 
Range options in the Scope area) to define a severity level 
for the system changes, as a function of the severity levels 
of all the trigger query node instances that are included 
in the range. From the list, select either Average or Max.

For example, if you select Average, the severity level of 
the system changes is the average severity of all the 
trigger instances.

Operator Select the required operator. For a list of the operators you 
can use for defining an attribute condition, see "Attribute 
Operator Definitions" on page 49.

Range A certain percentage of all instances should fulfill the 
conditions. For example, if you enter a range of 50% to 
100%, the changes are triggered when 50% or more of 
the instances meet the conditions.

Severity relative to 
trigger severity (%)

Select Severity relative to trigger severity (%) (displayed 
when you selected the Any option in the Scope area) to 
define a severity level for each system change that is 
relative (as a percentage) to the severity of the trigger 
event.

Enter the percentage in the box provided.

State Choose the required state. The states that appear in the 
list are the states that are defined in the State Manager. 
For details, see "State Manager" in the RTSM 
Administration Guide.

Value comparison Select the required attribute.

UI Element (A-Z) Description
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New Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard

This wizard enables you to create or modify an Impact rule.

To access ➤ To create an Impact rule, right-click anywhere in the 
Impact Rules pane and click New or click the New  
button.

➤ To modify an Impact rule, right-click an Impact rule in 
the Impact Rules pane and select Properties.

➤ To create a new Impact rule based on an existing 
query, right-click an Impact rule in the Impact Rules 
pane and select Save As.

Important 
information

➤ Any major change made to the TQL query after 
creating an Impact rule causes the system to delete the 
rule. These changes include deleting a root cause or 
impacted query node or changing the Min and Max 
relationship definitions. For details, see "Cardinality 
Tab" on page 95.

➤ Minor changes, such as adding a query node to the 
TQL query, do not cause the deletion of the rule.

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, it cannot be used for the creation of an Impact 
rule.

Relevant tasks "How to Define an Impact Rule – Workflow" on page 460

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page
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Impact Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the 
Impact rule.

User interface elements are described below:

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, it cannot be used for the creation of an Impact 
rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 478.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display the Welcome page 
by changing the user preferences. For details, see "User 
Preferences Dialog Box" on page 113.

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule 
Base Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 235

UI Element (A-Z) Description

Rule Description (Optional) Enter a description of the Impact rule.

Rule Name Enter a unique name for the Impact rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the Impact rule name is either empty, contains a 
name used by another Impact rule, or uses invalid 
characters, the Next and Finish buttons are disabled.
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Impact Rule Base Query Page
This wizard page enables you to define the properties of the TQL query on 
which the Impact rule is based. You can use an existing query or create a 
new query.

User interface elements are described below:

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, it cannot be used for the creation of an Impact 
rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 478.

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 235

UI Element (A-Z) Description

Base the Impact rule 
on a new query

Select this check box if you want to base the Impact rule 
on a new TQL query. The query results are based on the 
attributes defined for the new TQL query.

Base the Impact rule 
on an existing query

Select this check box if you want to base the Impact rule 
on an existing TQL query. Select the required Impact 
Analysis TQL query from the drop-down list.

Base Query 
Description

(Optional) Enter a description of the TQL query.
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Impact Rule Groups Page
This wizard page enables you to define where you can run Impact rules.

Base Query Name Enter a unique name for the Impact Analysis TQL query.

If you selected the Base the Impact rule on an existing 
TQL option, select the Impact Analysis TQL query on 
which you want to base the rule.

Base Query Priority There is no need to make a selection here since all TQL 
queries of the type Impact Analysis are automatically set 
to inactive.

Save a new query 
based on the current 
definition

Select to save a new TQL query based on your Impact rule 
definition.

Note: This field only appears in the Save As Impact Rule 
wizard.

Important 
information

➤ The Impact Analysis TQL query that serves as the basis 
of the Impact rule, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, it cannot be used for the creation of an Impact 
rule.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Impact Rule/Impact Rule Properties/Save As Impact 
Rule Wizard" on page 478.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see "User Preferences 
Dialog Box" on page 113.

UI Element (A-Z) Description
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User interface elements are described below:

Wizard map The New Impact Rule/Impact Rule Properties/Save As 
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base 
Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 235

UI Element (A-Z) Description

UCMDB Enables you to run an Impact rule in IT Universe 
Manager. For details, see "IT Universe Manager Overview" 
on page 236.
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CI Type Manager

This chapter includes:

Concepts

➤ CI Types Overview on page 484

➤ CI Type Attributes on page 485

➤ CI Type Relationships on page 487

➤ Deprecated CI Types on page 487

➤ System Type Manager on page 488

Tasks

➤ How to Create a CI Type on page 490

➤ How to Create a Relationship Type on page 492

➤ How to Create a Calculated Relationship Type on page 493

➤ How to Create List and Enumeration Definitions on page 494

➤ How to Create an Enumeration Definition – Workflow on page 495

Reference

➤ View Descriptions for CI Types and Relationships on page 497

➤ CI Type Manager User Interface on page 497

Note to HP Software-as-a-Service customers: The data in CI Type Manager 
can be viewed but not edited.
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Concepts

CI Types Overview

A configuration item (CI) can represent hardware, software, services, 
business processes, or any component of your IT infrastructure. CIs with 
similar properties are grouped under a CI type (CIT). Each CIT provides a 
template for creating a CI and its associated properties. 

Every CI must belong to a CI type. The following are the main categories of 
CITs:

➤ Business Element. CITs that correspond to the logical elements of your 
business, such as processes and organizational groups.

➤ IT Process Record. CITs that correspond to changes that occur in your IT 
infrastructure.

➤ Monitor. CITs that handle incoming metrics collected from your business 
universe.

➤ Location. CITs that correspond to the location of devices and business 
organizations or people supporting a function.

➤ Party. CITs that correspond to an active entity such as a person or 
organization.

➤ CI Collection. A logical collection of CIs.

➤ Infrastructure Element. CITs that correspond to the physical elements 
(hardware and software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the CI 
Types pane. You can browse the CI Type model by expanding the tree in the 
CI Types pane. The CIT selected in the left pane is displayed in the topology 
map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on 
defining new CITs, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on page 505.
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CI Type Attributes

Every CI type has attributes which define it such as name, description, and 
default value. The CITs grouped under other CITs in the CI Type tree inherit 
attributes from the higher-level CITs. 

When you define a new CI type, you first select a Base Configuration Item 
Type from a list of existing CITs. Your new CIT inherits the attributes of the 
existing CIT. You can then set the attributes for the new CIT. You edit the 
attributes of an existing CIT by selecting a CIT from the tree in the CI Types 
pane and selecting the Attributes tab of the topology map. For details on 
CIT attributes, see "Attributes Page" on page 507.

This section includes the following topics:

➤ "CI Type Identification Methods" on page 485

➤ "CI Type Naming" on page 486

CI Type Identification Methods
Every CI created is given an automatically generated global ID, which is 
used to identify different instances of the same CI type. You can also select 
additional identification methods as described in "Details Page" on 
page 505.

If you select the Simple identification option, you can designate one or more 
of the CIT’s attributes as key attributes, which are used as identifiers of the 
CIT. When you define an instance of a CIT, the CIT’s key attributes are 
mandatory fields for CIs of that type. You can assign as many key attributes 
as you want to a given CIT. If you do not assign a key attribute when 
defining a new CIT, you must select the ABSTRACT_CLASS qualifier on the 
Qualifier page of the wizard. You can remove the key attributes of an 
existing CIT if there are no instances of the CIT. 

If you select other identification methods, you cannot define key attributes 
for the CIT, but it retains the key attributes of its parent CIT. These key 
attributes are mandatory fields for CIs of that type and they cannot be 
removed. For those identification methods, there are no restrictions on the 
qualifiers selected.
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CI Type Naming
Entity names in HP Business Service Management for RTSM-based 
applications follow the conventions described below: 

➤ CIT attributes values. All primitive types are supported: long, double, 
float, string, and so on.

➤ CIT attributes values-type string. All special characters are supported. The 
maximum length is 4000 characters.

➤ CIT name. Only the following characters are permitted: a-z, A-Z, 0-9 and 
underscore (_).  Note also:

➤ The first character must not be a number.

➤ The name field is case sensitive, but you cannot use the same name 
with different cases for different CITs.

➤ The maximum length is 200 characters.

➤ CIT attribute name. Only the following characters are permitted: a-z, A-Z, 
0-9 and underscore (_).  Note also:

➤ The first character may be a number.

➤ The attribute name field is not case sensitive.

➤ The maximum length is 200 characters.

➤ CIT attribute length. The total length of all the attribute values in one CIT 
cannot exceed 8K bytes due to a Microsoft SQL Server limitation.
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CI Type Relationships

A relationship defines the link between two CIs. Relationships represent the 
dependencies and connections between the entities in your IT environment. 
When you select relationships or calculated relationships in the drop-down 
box in the CI Types pane, the topology map displays all the valid instances 
of CITs linked by the selected relationship. For details about calculated 
relationships, see "Impact Modeling" on page 119.

The same attributes defined for CITs are also defined for relationships. You 
can also assign key attributes for relationships but it is not required. For 
details on defining new relationship types, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on page 505.

Deprecated CI Types

CITs and relationships that are scheduled to be removed in a subsequent 
product version are known as deprecated CITs.  Such CITs appear in the user 
interface in strikethrough font. You can hold the pointer over a deprecated 
CIT to display a tooltip with information about it, including which CIT 
replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or 
higher is selected for the topology map.

Deprecated CITs appear in the CIT tree in Modeling Studio, however it is not 
recommended to use them in building new TQL queries and views. In place 
of a deprecated CIT, use the CIT indicated in the tooltip as its replacement. 
Deprecated CITs do not appear in out-of-the-box queries and views.  

CIT attributes which are scheduled to be removed are deprecated attributes. 
They also appear in strikethrough font in the user interface. 
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The following image displays a TQL query containing a deprecated CIT:

System Type Manager

System Type Manager enables you to create a predefined list whose values 
define an attribute type. For more details on System Type Manager, see 
"System Type Manager Dialog Box" on page 525.

You can create the following attribute types:

➤ List. Enables you to create a predefined list of values, for example, 
Location.

➤ Enumeration. Enables you to create a predefined list of values, as well as 
assign each value a color. Enumerations are designed to be used as severity 
value lists by states. For details, see "State Manager" in the RTSM 
Administration Guide. 

Severity lists are used for:

➤ Retrieving Impact Analysis results in IT Universe Manager. For details, see 
"IT Universe Manager" on page 235.

➤ Creating an Impact rule. For details, see "Impact Analysis Manager" on 
page 457. 
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You can use both List and Enumeration values for:

➤ Editing the attributes of a CIT. For details, see "How to Create a CI Type" 
on page 490.

➤ Defining an attribute condition for a TQL query node or relationship. For 
details, see "Query Node/Relationship Properties Dialog Box" on page 90.
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Tasks

How to Create a CI Type

This task describes the process you follow to create a CIT using the Create CI 
Type wizard.

This task includes the following steps:

➤ "Prerequisites" on page 490

➤ "Define the CI Type" on page 490

➤ "Set the CI Type Attributes" on page 490

➤ "Assign Qualifiers to the CI Type" on page 491

➤ "Assign an Icon to the CI Type" on page 491

➤ "Customize the CI Type Menu" on page 491

➤ "Define the CI Type Default Label" on page 491

➤ "Define the Matching Rules" on page 491

 1 Prerequisites

From the CI Type Manager, select CI Types from the list box in the CI 
Types pane. Then select New to start the Create CI Type Wizard.

 2 Define the CI Type

Enter the name, description, and base configuration item type for the 
new CI type and select an identification method for it. For details, see 
"Details Page" on page 505.

 3 Set the CI Type Attributes

Edit the attributes of the new CI type. For details, see "Attributes Page" on 
page 507.
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Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see "How to Create List and Enumeration 
Definitions" on page 494.

 4 Assign Qualifiers to the CI Type

Assign qualifiers to the definition of the new CI type. For details, see 
"Qualifiers Page" on page 510.

 5 Assign an Icon to the CI Type

Select an icon to assign to the new CI type. For details, see "Icon Page" on 
page 514.

 6 Customize the CI Type Menu

Select the menu items and commands to appear in the shortcut menu for 
the new CI type. For details, see "Attached Menu Page" on page 515.

 7 Define the CI Type Default Label

Define the attributes to appear in the CI type label. For details, see 
"Default Label Page" on page 519.

 8 Define the Matching Rules

If necessary, define the matching rules for the new CI type. For details, see 
"Matching Rules Page" on page 521.

Note: This step is only relevant for customers running HP Universal 
CMDB Configuration Manager.
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How to Create a Relationship Type

This task describes the process you follow to create a relationship type using 
the Create Relationship wizard.

This task includes the following steps:

➤ "Prerequisites" on page 492

➤ "Define the Relationship" on page 492

➤ "Set the Relationship Attributes" on page 492

➤ "Assign Qualifiers to the Relationship" on page 493

➤ "Customize the Relationship Menu" on page 493

➤ "Define the Relationship Default Label" on page 493

 1 Prerequisites

From the CI Type Manager, select Relationships from the list box in the CI 
Types pane. Then select New to start the Create Relationship Wizard.

 2 Define the Relationship

Enter the name, description and base CI type for the new relationship. For 
details, see "Details Page" on page 505.

 3 Set the Relationship Attributes

Edit the attributes of the new relationship. For details, see "Attributes 
Page" on page 507.

Note: List and Enumeration definitions are created in the System Type 
Manager. If required, you can create additional List and Enumeration 
definitions. For details, see "How to Create List and Enumeration 
Definitions" on page 494.
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 4 Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see 
"Qualifiers Page" on page 510.

 5 Customize the Relationship Menu

Select the menu items and commands to appear in the shortcut menu for 
the new relationship. For details, see "Attached Menu Page" on page 515.

 6 Define the Relationship Default Label

Define the attributes to appear in the relationship label. For details, see 
"Default Label Page" on page 519.

How to Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship 
type using the Create Calculated Relationship wizard.

This task includes the following steps:

➤ "Prerequisites" on page 493

➤ "Define the Calculated Relationship" on page 493

➤ "Assign Qualifiers to the Relationship" on page 494

➤ "Add Required Triplets" on page 494

 1 Prerequisites

From the CI Type Manager, select Calculated Relationships from the list 
box in the CI Types pane. Then select New to start the Create Calculated 
Relationship Wizard.

 2 Define the Calculated Relationship

Enter the name, description and base CI type for the new calculated 
relationship. For details, see "Details Page" on page 505.
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 3 Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see 
"Qualifiers Page" on page 510.

 4 Add Required Triplets

Add the required triplets. For details, see "Triplets Page" on page 512.

How to Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration 
definitions.

This task includes the following steps:

➤ "Create a List Definition" on page 494

➤ "Create an Enumeration Definition" on page 494

 1 Create a List Definition

You can create a List definition of predefined values. For example, a List 
definition called Location might contain:

➤ New York

➤ Boston

➤ Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" 
on page 522.

 2 Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a 
color for each value on the list. For details, see "Create/Update 
List/Enumeration Definition Dialog Box" on page 522. For an example of 
an Enumeration definition, see "How to Create an Enumeration 
Definition – Workflow" on page 495.
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How to Create an Enumeration Definition – Workflow

The following steps describe how to create an Enumeration definition.

Note: To retrieve the required results, you must follow each step in this task.

To create an Enumeration definition:

 1 Select Admin > RTSM Administration > Modeling > CI Type Manager.

 2 From the Main Menu, select CI Types > System Type Manager to open the 
System Type Manager dialog box.

 3 Click the Add button to open the Create List Definition dialog box.

Note: Alternatively, you can select Admin > RTSM Administration > 
Administration > State Manager and then click the New Enumeration 
button to open the Create Enumeration Definition dialog box.

 4 Select Enumeration.

 5 In the Name box, enter the required name. 

 6 (Optional) In the Display Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented

0 Green Normal

1 Orange Major

2 Red Critical
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 7 Click the Add  button to create a new row.

 8 In the Value box, enter Normal, in the Key box, enter 0, and in the Color 
section, select Green.

 9 Click the Add  button to create another row.

 10 In the Value box, enter Major, in the Key box, enter 1, and in the Color 
section, select Orange.

 11 Click the Add  button to create another row.

 12 In the Value box, enter Critical, in the Key box, enter 2, and in the Color 
section, select Red.

The following image shows the Enumeration Definition section after the 
changes:

 13 Click OK to save your changes.
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Reference

View Descriptions for CI Types and Relationships

You can view a complete list of available CI types in tree format in the left 
pane of CI Type Manager. You can search incrementally for a specific CI type 
as described in "CI Type Manager" on page 501. To see a description for a 
particular CI type, select it from the tree and hold the pointer over the icon 
which corresponds to it in the Topology Map. A tooltip containing a 
description of the CI type is displayed.

For relationships, select Relationships in the left pane and search 
incrementally by the first letter of the relationship. Select the relationship 
you want and hold the pointer over its icon in the Topology Map to display 
a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, refer to the 
HP Software BTO Data Model Reference file. 

CI Type Manager User Interface

This section includes (in alphabetical order):

 ➤ Add/Edit Attribute Dialog Box on page 498

 ➤ Add/Remove Relationship Dialog Box on page 501

 ➤ CI Type Manager on page 501

 ➤ Create Configuration Item Type/Relationship/Calculated Relationship 
Wizard on page 505

 ➤ Create/Update List/Enumeration Definition Dialog Box on page 522

 ➤ System Type Manager Dialog Box on page 525
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Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to 
edit an existing attribute of a CIT.

Details Tab

User interface elements are described below:

To access In the CI Type Manager, select the Attributes tab, then click 
the Add  button, or select an attribute and click the Edit 
button or double-click the attribute.

Important 
information

In Edit mode, fields that cannot be changed are disabled.

UI Element (A-Z) Description

Attribute Name Enter a unique name for the new attribute. Only the 
following characters are permitted: a-z, A-Z, 0-9 and 
underscore (_).  Note also:

➤ The first character may be a number.

➤ The attribute name field is not case sensitive.

➤ The maximum length is 200 characters.

Attribute Type Select one of the following options:

➤ Primitive. Choose from one of the following field types: 
boolean, bytes, date, double, float, integer, integer_list, long, 
string, string_list, xml.

➤ Enumeration/List. Contains a list of Enumerations and 
Lists defined in the System Type Manager. For details, see 
"System Type Manager" on page 488.

This option enables you to define an attribute with a 
predefined value. For example, a location attribute might 
be defined by a location list containing the following 
values: Singapore, Paris, New York. 
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Advanced Tab

User interface elements are described below:

Default Value Enter or select a default value for the attribute. The options 
for the Default Value field vary depending on the attribute 
type you selected. 

Note: If you select the integer_list or string_list Primitive 
attribute type, you can enter multiple values.

Description Enter a description for the new attribute.

Note: This field is optional.

Display Name Enter a name for the new attribute to identify it in 
HP Business Service Management.

Note: This field is optional.

Scope Select the scope of the new attribute (the class model to 
which it belongs).

Value Size Enter a value for the maximum physical size of the new 
attribute. (Enabled for bytes and string only).

UI Element (A-Z) Description

Asset Data Select to display the attribute value in the Asset Report.

Change 
Monitored

Select to define attributes whose values are being marked as 
Change Monitored in CI Type Manager. The changes in the 
values of such attributes are saved in the CMDB History 
database.

Note: 

➤ When this qualifier is selected for a given attribute, the 
attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 82.

➤ Change Monitored is not relevant for attributes of the 
type list of integers or list of strings.

UI Element (A-Z) Description
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Comparable Select to enable this attribute to be used for comparing 
compound CIs.

Editable Select to enable future editing of the attribute. Only 
attributes that are marked as Editable (or ones that have 
values) are displayed in the Properties tab in IT Universe 
Manager.

Enable Auto 
Truncate by DFM

If selected, when attributes of type STRING exceed the size 
limit, Discovery truncates the value. For details, see "Data 
Validation on the Data Flow Probe" in RTSM Data Flow 
Management Guide.

Index Select to accelerate the attribute retrieval performance. This 
option is recommended for attributes that are used 
frequently in search conditions. For example, IP address is 
usually an index attribute of a node.

Lower Case When this option is selected, the attribute value appears in 
lower case.

Password When this option is selected, the attribute value appears as 
asterisks (a hidden value).

Probe-side ID If selected, this attribute is used by the probe to identify a CI.

Required Select to define this attribute as a required one, if its value is 
required for the creation of the CIT.

Static Select to define this attribute as static.

Unique When this option is selected, different instances of this CI 
type must have unique values.

Upper Case When this option is selected, the attribute value appears in 
upper case.

Use Update Value 
Policy

Select this option to add the ALLOW_VOLATILITY qualifier. 
For details on this qualifier, see "The ALLOW_VOLATILITY 
Qualifier" on page 31.

Visible Select to display this attribute in the Properties tab in 
IT Universe Manager.

UI Element (A-Z) Description
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Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships 
between CITs, which define their physical or logical connections.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

CI Type Manager

This page enables you to view the information in the CI Type model, which 
contains the definitions of all configuration item types (CITs) defined in the 
system and the relationships that define the connections between them. 
Each CIT has its own attributes, as well as the attributes inherited from its 
parent CIT.

To access In the CI Type Manager, right-click a CIT or two CITs 
and select Add/Remove Relationship.

Important 
information

When adding a relationship between two CITs, select 
the two CITs to be linked by holding down CTRL and 
clicking the CIT names. Then right-click one of them 
and select Add/Remove Relationship.

UI Element (A-Z) Description

<query node1 to 
query node2>

Select the relationships to add in the direction of the 
first query node to the second.

<query node2 to 
query node1>

Select the relationships to add in the direction of the 
second query node to the first.

Relationship Name A list of the possible relationships.

To access Select Admin > RTSM Administration > Modeling > CI Type 
Manager.
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

New. Opens the Create Configuration Item Type Wizard 
which enables you to define a new CI type. For details, see 
"Create Configuration Item Type/Relationship/Calculated 
Relationship Wizard" on page 505.

Delete. Deletes the selected CI type or relationship.

Refresh. Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

Save. Saves changes made to a CI type.

Enables you to import CITs from an external file.

Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

Enables you to export a CIT as a PDF.

<CI 
Type/Relationship 
Box>

Select one of the following options:

➤ CI Types. Display the CI types in the CIT model.

➤ Relationships. Display the relationships in the CIT model.

➤ Calculated Relationships. Display the calculated 
relationships in the CIT model.
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<Editing Pane> The following tabs are available:

➤ Dependencies. Displays the CI Type model in a topology 
map, including the CITs and the relationships between 
them. The name of the selected CI type or relationship 
appears in the border at the top of the pane. When you 
point to a CIT, a tooltip displays the display name of the 
CIT and its description.

➤ Details. Enables you to edit the basic information about 
the CI type selected in the left pane. For details, see 
"Details Page" on page 505.

➤ Attributes. Enables you to edit the attributes of the 
selected CIT. For details, see "Attributes Page" on 
page 507.

➤ Qualifiers. Enables you to assign qualifiers to the selected 
CIT. For details, see "Qualifiers Page" on page 510.

➤ Triplets. Enables you to create a calculated relationship. 
For details, see "Triplets Page" on page 512. This tab 
appears only for calculated relationships.

➤ Icon. Enables you to assign an icon to the selected CIT. 
For details, see "Icon Page" on page 514. This tab does not 
appear for relationships.

➤ Attached Menu. Enables you to customize the shortcut 
menu of a CI by adding menu items and commands (for 
example, ping, run a program, open a URL). The 
customized menu is displayed when you right-click a CI 
instance in IT Universe Manager. For details, see 
"Attached Menu Page" on page 515.

➤ Default Label. Enables you to define attributes that appear 
in the CIT label. You can include more than one attribute 
by using the function buttons. For details, see "Default 
Label Page" on page 519.

➤ Matching Rules. Enables you to define matching rules for 
use in HP Universal CMDB Configuration Manager. For 
details, consult the Configuration Manager 
documentation. This tab does not appear for 
relationships and only appears when UCMDB is running 
with Configuration Manager.

UI Element (A-Z) Description
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Shortcut Menu

CI Type Manager includes the following options available by right clicking a 
CI type in the CI Types pane or the Dependencies map:

<Main Menu> For details, see "Main Menu" on page 207.

<Toolbar> For details, see "Toolbar Options" on page 211.

CI Types Pane A hierarchical tree structure of the CI Type model containing 
the inheritance relationships among CITs, and displaying 
the number of instances of each CIT in the RTSM. All CITs 
included in the CI Type model are classified as either a CIT 
or a relationship. You can drill down and view the 
relationships and neighbors of the selected CIT in the 
topology map. You can search in the list of CITs or 
relationships using the Incremental Search by entering the 
first letter of the CIT or relationship repeatedly until you 
reach the required selection. You can also search for a CIT or 
relationship by entering its full name. 

UI Element (A-Z) Description

Add/Remove 
Relationship

Opens the Add/Remove Relationship dialog box, which 
enables you to add or remove relationships from CITs. For 
details, see "Add/Remove Relationship Dialog Box" on 
page 501.

Delete Selected 
Item

Deletes the selected CI type. This option is only available for 
CI types that have no children and no instances.

Export To XML Enables you to export a CIT as an XML file. Use this option 
to move CITs from one server to another.

New Opens the Create Configuration Item Type Wizard which 
enables you to define a new CI type. For details, see "Create 
Configuration Item Type/Relationship/Calculated 
Relationship Wizard" on page 505.

Show CIT 
Instances

Opens the Show All Instances dialog box, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 82.

UI Element (A-Z) Description
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Create Configuration Item Type/Relationship/Calculated 
Relationship Wizard

This wizard enables you to define a new configuration item type or 
relationship.

Details Page
This wizard page enables you to enter basic information about the new CI 
type you are defining.

To access Click a CI type or relationship in the topology map or CI 
Types pane of the CI Type Manager and select New or click 
the New  button in the CI types pane.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page 
> Matching Rules Page

Important 
information

For general information about the Create Configuration 
Item Type Wizard, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 505.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page 
> Matching Rules Page
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User interface elements are described below:

UI Element (A-Z) Description

Base CI Type Select a base CIT for the CIT you are creating. The new CIT 
inherits the base CIT’s attributes.

Note: This field only appears in the Create CI Type Wizard. 
It is not relevant when editing an existing CIT in the Details 
tab of CI Type Manager.

Created By The user who created the new CIT.

Note: This field is optional.

Description A description for the new CIT.

Note: This field is optional.

Display Name The name of the CIT as it appears in the HP Business Service 
Management interface. 

Note: This field is optional.

Identification Every new CI defined has an identification based on its 
CMDB ID and global_id properties. You can set an additional 
identification method for instances of the selected CIT. The 
following options are available:

➤ Simple identification. Select attributes from the Available 
Attributes pane and move them to the Selected Attributes 
pane. These attributes are defined as the CIT’s key 
attributes. CIT instances with matching values for all of 
the key attributes are merged into a single instance.

➤ Advanced identification. Click the Edit button to define 
an XML identification rule. For an example of an XML 
identification rule, see "How to Create an Identification 
Rule Document" in the RTSM Data Flow Management 
Guide.

➤ Inherited from parent. The CIT uses the same 
identification method as its parent CIT.

➤ No identification. No additional identification method.

Note: For relationships, only the Simple identification 
option is available.
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Attributes Page
This wizard page enables you to edit the attributes of the CI type.

User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Name The unique name of the new CIT. Only the following 
characters are permitted: a-z, A-Z, 0-9 and underscore (_).  
Note also: 

➤ The first character must not be a number.

➤ The name field is case sensitive, but you cannot use the 
same name with different cases for different CITs.

➤ The maximum length is 200 characters.

Scope Select the scope of the new CIT (the class model to which it 
belongs).

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains: 

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page 
> Matching Rules Page

UI Element (A-Z) Description

Add. Defines a new attribute. For details, see "Add/Edit 
Attribute Dialog Box" on page 498.

Select a row and click the Edit button to open the Edit 
Attribute dialog box. For details, see "Add/Edit Attribute 
Dialog Box" on page 498.

Note: If you modify an attribute belonging to a CIT’s parent, 
the text turns light blue. If you modify an attribute 
belonging to the CIT itself, the text remains dark blue.

UI Element (A-Z) Description
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Delete. Deletes a selected attribute. This option is only active 
for newly defined attributes.

Reset. Resets the attribute settings after editing a pre-existing 
attribute.

Select Columns. Selects the columns to appear using the 
Select Columns dialog box. For details, see "Select Columns 
Dialog Box" on page 580.

<Attributes> Displays all attributes associated with the new CIT. 
Attributes appearing in black are ones that the new CIT 
inherits from the base CIT. Attributes appearing in dark blue 
are ones that are private to this CIT and its descendants. 
Attributes appearing in light blue are inherited ones that 
have been modified for the new CIT.

Asset Data Indicates whether the attribute value is displayed in the 
Asset Report. For details see "Asset Report" on page 569.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 82.

BDM Scope Indicates whether the attribute is included in the BDM class 
model.

Change 
Monitored

Select to define attributes whose values are being marked as 
Change Monitored in CI Type Manager. The changes in the 
values of such attributes are saved in the CMDB History 
database.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 82.

UI Element (A-Z) Description
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Comparable Indicates whether this attribute is to be used for comparing 
compound CIs. For details, see "Compare CIs Report" on 
page 587. The changes in the value of such an attribute are 
saved in the CMDB History database.

Note: When this qualifier is selected for a given attribute, 
the attribute appears as a visible column in the Element 
Instances dialog box. For details, see "Element Instances 
Dialog Box" on page 82.

Default Value The default value for the attribute. This value appears when 
the new CIT is defined and there is no runtime value for the 
attribute.

Description A description of the attribute.

Display Name The attribute name that appears in the HP Business Service 
Management interface. 

Editable Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that 
have values) are displayed in the Properties tab in 
IT Universe Manager.

Enable Auto 
Truncate by DFM

Indicates whether the auto-truncate feature for attributes of 
type STRING is enabled. 

Index Indicates whether the attribute has been defined as an index 
attribute, which enables you to accelerate the attribute 
retrieval performance. 

This option is recommended for attributes that are used 
frequently in search conditions. For example, IP address is 
usually an index attribute of a node. 

Key Indicates whether the attribute is defined as a key attribute.

Note: This column is only relevant when Simple 
identification is selected as the identification method.

Lower Case Indicates whether to keep the attribute value in lower case.

Name The actual name of the attribute (compare to Display Name). 
The name must be in English.

UI Element (A-Z) Description
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Qualifiers Page
This wizard page enables you to assign qualifiers to a CI type definition.

Probe-side ID Indicates whether this attribute is used by the probe to 
identify a CI.

Required Indicates whether this attribute is defined as a required one, 
whose value is required for the creation of the CIT.

Static Indicates whether this attribute is defined as static.

Type The type of the attribute.

Unique Indicates whether this attribute is defined as unique, for 
which different instances of this CI type must have unique 
values

Upper Case Indicates whether to keep the attribute value in upper case.

Visible Indicates whether this attribute is displayed in the Properties 
tab in IT Universe Manager.

Important 
information

Qualifiers enable you to define added attribute definitions 
to the CIT. In the Qualifiers list, select the required qualifiers 
using the Add buttons to move your selections to the 
Configuration Item Type Qualifiers list. You can make 
multiple selections by holding down the CTRL key.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page 
> Matching Rules Page

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Moves all qualifiers to the Configuration Item Type 
Qualifiers list.

Select the qualifier and click this button to add the qualifier 
to the Configuration Item Type Qualifiers list. Select 
multiple qualifiers by holding down the CTRL key.

To remove a qualifier from the CIT definition, select the 
qualifier from the Configuration Item Type Qualifiers list 
and click this button.

Removes all qualifiers from the Configuration Item Type 
Qualifiers list.

To define a new, custom qualifier, enter the qualifier name 
in the text box and click Insert. The qualifier appears in the 
Configuration Item Type Qualifiers list.

<Configuration 
Item Type 
Qualifiers>

The list of qualifiers that define attributes of the new CIT. 
For example, you can use a qualifier to define a CIT as 
abstract, which means that you cannot create instances from 
it.

<Qualifiers> For a list of the available qualifier options, see "Qualifier Tab" 
on page 102. 
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Triplets Page
This wizard page enables you to create a calculated relationship. Each row 
on the Triplets page represents one of the allowed steps in the path leading 
from the source CI to the target CI in the topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important 
information

➤ This page is displayed if you select Calculated 
Relationships in the drop-down box in the CI Types 
pane.

➤ For details about calculated relationships, see "Impact 
Modeling" on page 119.

➤ For general information about the Create Configuration 
Item Type Wizard, see "Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard" on 
page 505.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page > Matching Rules Page

See also "Impact Modeling" on page 119
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User interface elements are described below:

UI Element (A-Z) Description

Defines the allowed steps in a path in the topology graph 
leading from the source CI to the target CI in the calculated 
relationship. Opens the Add Triplet dialog box. For details, 
see "Add Triplet Dialog Box" on page 78.

Select a row and click the Edit button to edit the triplet. 
Opens the Edit Triplet dialog box. For details, see "Add 
Triplet Dialog Box" on page 78.

Delete. Deletes a selected triplet.

Relationship The required relationship connecting the two query nodes.

Relationship 
Direction

The source and target of a relationship.

➤  The direction is from source to target.

➤  The direction is from target to source.

Source The required source query node.

Target The required target query node.
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Icon Page
This wizard page enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

User interface elements are described below:

Important 
information

Each CIT is displayed with a default icon. However, you can 
attach different icons to the same CIT when certain 
conditions apply. For example, you can associate different 
icons with the same CIT when one of its attribute values 
changes.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page > Matching Rules Page

UI Element (A-Z) Description

Adds a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Removes a row.

Note: Only active if Change the Configuration Item Type 
icon according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.
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Attached Menu Page
This wizard page enables you to customize the shortcut menu of a CI by 
adding menu items and commands (for example, ping, run a program, open 
a URL). The customized menu is displayed when you right-click a CI 
instance in IT Universe Manager.

Change the 
Configuration 
Item Type icon 
according to its 
attribute value

Enables you to assign an icon for each attribute value. For 
example, you could define two values for the City attribute: 
if City=London, one icon is displayed. If City=Beijing, another 
icon is displayed.

Note: If you change the icon of a CIT that appears in an 
existing view, the CIT's icon is not updated in the view.

Configuration 
Item Type Main 
Icon

Select the group to which the CIT belongs.

Icon Select an icon to associate with the value you entered in the 
Value column.

Value Enter a value corresponding to the attribute you selected. 
You can add a new line for each value you enter.

Important 
information

If a CIT does not have a method defined specifically for it, 
the CIT inherits all the menus from its parent CIT or the 
nearest ancestor that does have a method defined for it.

If you create or modify a menu, the change occurs only in 
the specific CIT that is being edited.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page > Matching Rules Page

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Select a menu item from the tree and click the button. A 
new entry appears under the selected item.

Removes a menu item.

Moves a selected menu item up in the menu.

Moves a selected menu item down in the menu.

<Tree> Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the 
default menu items.

Command To connect to a specific location on the World Wide Web, 
select URL, and enter the exact Internet address, for 
example, http://www.hp.com/go/software. (Available only if 
you select the URL command type option.)

Note: If you use a variable in the Command field, use the 
format command name %1 and define the CIT attributes as 
described in Parameters. The parameter values replace %1 
according to their order in the list. For example, %1 is 
replaced by the first parameter in the list, %2 is replaced by 
the second parameter in the list, and so on.

Description Enter a description for the method. (This is for internal use 
only and does not appear in the menu.)

Existing Method Select to choose a command from a list of defined methods 
inherited from the IT Universe CIT and all its ancestors.

Icon Select the icon to appear next to the menu option in the 
shortcut menu.

Note: This field is optional.

Menu Item Name Enter a name for the new menu item as it should appear in 
the menu.
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Method Enables you to add a command to the menu.

Note: To create a method and not override the existing 
method, it is recommended to create a new menu item and 
place the new method there. 

Method Name Enter a name for the command.

New Method Select to add an action (for example, ping) to the menu 
item.

Parameters To add attributes to the command or URL, click the Add 
Parameter button and select the attribute from the list.

To delete an existing entry, select it and click the Remove 
Parameter button.

Note: Parameters are not relevant when Inner Process is 
selected.

Require user 
confirmation

Select the check box for users to confirm access to a menu 
item before the item is displayed.

Separator To place a separator between two menu items:

Click OK to place a separator underneath the selected menu 
option. 

Shortcut Press any key combination to create a shortcut for the menu 
item, for example, CTRL+H. 

Note: This field is optional.

UI Element (A-Z) Description
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Sub-Menu Select to create a sub-menu under the selected menu option.

Type Choose a command type:

➤ URL. Opens a web page to the specified URL. Enter the 
URL of a Web page for the command to open in the URL 
box.

➤ Inner Process. Triggers an internal HP Business Service 
Management action. Select an action from the drop-down 
list of actions. 

➤ Execute. Triggers an executable action. Enter an 
executable command in the Executable box.

Note: In the Executable box, enter only the name of the 
executable file (for example, notepad.exe). Do not enter a 
path to the executable file. A path cannot execute a 
program.

UI Element (A-Z) Description
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Default Label Page
This wizard page enables you to define attributes that appear in the CI type 
label. You can include more than one attribute by using the function 
buttons. This is the final step of the Create Configuration Item Type Wizard.

User interface elements are described below:

Important 
information

You build a label by selecting attributes in the CI Type 
Attributes pane and adding them to the Format pane, using 
the operators in the Format pane to connect them.

The label appears as the title under a CI of the new CI Type. 
The label definition can be customized to include different 
attribute values. For example, if the function label of the 
node CIT is composed of hostname and network, the 
displayed label is: server1 10.0.65.0.

Labels can also be created using regular expressions.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label 
Page > Matching Rules Page

UI Element (A-Z) Description

Adds the selected attribute to the Format pane. 

Adds parentheses to the formatted text (use in conjunction 
with the other functions).

Places an AND operator between two attributes in the 
formatted text. For example, 
network_netaddr&network_domain displays the network 
address and the domain of a query node.

Places an OR operator between two attributes in the 
formatted text.
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Adds a regular expression (using regular expression syntax) 
to the label definition. The structure of the entry is (v1, v2, 
v3), where v1 represents the selected attribute, v2 represents 
the regular expression itself (which divides the value into 
groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of 
a first name, a space, and a surname, the regular expression 
would be (name, (\S*)(\s*)(\S*), 3), which indicates that the 
surname can be used for the name attribute in the default 
label.

For examples of how to use regular expression syntax, see 
"Regular Expression Examples" on page 585.

Undoes the last change in the Format pane.

Reverts the last change in the Format pane that was made 
using the Undo button.

Clears the Format pane.

Restores the default settings.

CI Type Attributes Displays the available options of attributes to be included in 
the CIT label.

CI Type Label 
Definition Format

Displays the attributes that you select to appear in the CIT 
label.

For example, to label a node by its host name and operating 
system, choose the host_hostname and host_os attributes. 
The CIT label is host1 UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight 
it and press the DELETE key.

UI Element (A-Z) Description
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Matching Rules Page
This wizard page enables you to define matching rules for comparable 
attributes for use in HP Universal CMDB Configuration Manager.

User interface elements are described below:

Important 
information

This page is only relevant when Configuration Manager is 
installed. For details on matching rules, refer to the 
Configuration Manager documentation.

Note: You can activate the Matching Rules page manually 
by setting the Enable Configuration Manager Matching 
Rules setting to true in the Infrastructure Settings Manager.

Wizard map The Create Configuration Item 
Type/Relationship/Calculated Relationship Wizard 
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets 
Page > Icon Page > Attached Menu Page > Default Label Page 
> Matching Rules Page

UI Element (A-Z) Description

Moves the selected comparable attributes to the Matching 
Rules pane. Select multiple attributes by holding down the 
CTRL key.

Removes an attribute from the Matching Rules pane. 

Moves all attributes to the Matching Rules pane.

Removes all attributes from the Matching Rules pane.

Set the order of the matching rules using the up and down 
buttons.

Comparable 
Attributes

A list of all the attributes of the selected CI type with the 
comparable qualifier selected.

Matching Rules The attributes selected to determine matching rules for 
Configuration Manager.
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Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition. 
The List or Enumeration definition you have created appears in the System 
Type Manager dialog box, where you can edit it if required (for details, see 
"System Type Manager Dialog Box" on page 525).

User interface elements are described below:

To access Click the Add button in the System Type Manager dialog 
box.

Important 
information

You can access the Create/Update Enumeration Definition 
dialog box from the State Manager as well. For details, see 
"State Manager" in the RTSM Administration Guide.

Relevant tasks "How to Create List and Enumeration Definitions" on 
page 494

UI Element (A-Z) Description

Display Name Enter the name you want to appear in the list of System 
Type Definitions. If you leave this field empty, the entry in 
the Name field is used.

Enumeration Enables you to create a predefined list of values, as well as 
assign each value a color. For details, see "Enumeration 
Definition Area" on page 524.

List Enables you to create a predefined list of values. For details, 
see "List Definition Area" on page 523.

Name Enter a unique name for the definition.
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List Definition Area

This area enables you to create a predefined list of values. 

The following elements are included (unlabeled elements are shown in 
angle brackets):

To access Select List in the Create List/Enumeration Definition 
dialog box.

Important 
information

For example, a Location attribute might be defined by a 
location list containing the following values:

➤ New York

➤ Boston

➤ Baltimore

UI Element (A-Z) Description

Add a List definition. Double-click inside the row and 
either select a date from the calendar that appears (if 
you chose the type Date) or type the required value.

Delete a List definition.

Type Choose one of following field types:

➤ Date

➤ Double

➤ Integer

➤ Long

➤ String
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Enumeration Definition Area

This area enables you to create a list from a predefined list of values (similar 
to List), with capabilities such as assigning a color for every value.

User interface elements are described below:

To access Select Enumeration in the Create List/Enumeration 
Definition dialog box.

Important 
information

Enumerations are designed to be used as severity value 
lists by states. You can use Enumerations for lists that 
require key values. 

See also "How to Create an Enumeration Definition – 
Workflow" on page 495

UI Element (A-Z) Description

Add an Enumeration definition.

Remove an Enumeration definition.

Color Select a color that indicates the severity level. 

Note: Gray is only enabled when you create an 
Enumeration of the type Admin.
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System Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the 
Create List/Enumeration Definition dialog box.

Key Type a number to create an enumeration that describes 
a severity list for a category.

Assign key values according to the following rules:

➤ The list of key values must always begin with zero 
(0). (Zero represents the Normal state.) Otherwise, it 
does not appear in the State Manager (for details, see 
"State Manager" in the RTSM Administration Guide).

➤ The list must always be numbered consecutively.

For an example of an Enumeration definition, see 
"How to Create an Enumeration Definition – 
Workflow" on page 495.

Value Type a value, either a string or a number, for example, 
Red or my value. The value appears in the tooltip for 
the CI in IT Universe Manager.

To access From the CI Type Manager, select CI Types > System 
Type Manager.

Relevant tasks "How to Create List and Enumeration Definitions" on 
page 494

See also "How to Create an Enumeration Definition – 
Workflow" on page 495

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Create a predefined list whose values define an attribute 
type. You can create a definition for the following attribute 
types:

➤ List definition.

➤ Enumeration definition.

For a description of these attribute types, see "Create/Update 
List/Enumeration Definition Dialog Box" on page 522.

Enables you to edit an existing definition. For details, see 
"Create/Update List/Enumeration Definition Dialog Box" on 
page 522.

Delete an existing definition. Select the system type 
definition you want to delete and click the Delete button.

Sorts the list in alphabetical order.

<System Type 
Definitions>

The list of Enumeration and List definitions created in the 
System Type Manager.
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Enrichment Manager

This chapter includes:

Concepts

➤ Enrichment Manager – Overview on page 528

Tasks

➤ How to Define an Enrichment Rule – Scenario on page 532

➤ How to Add Enrichment Query Nodes and Relationships to an 
Enrichment TQL Query on page 537

Reference

➤ Enrichment Manager User Interface on page 539
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Concepts

Enrichment Manager – Overview

Enrichment rules can be used for several purposes:

➤ Adding new CIs and relationships to the RTSM.

➤ Deleting specific CI instances from the RTSM.

➤ Updating the attribute values of specific CI instances in the RTSM.

Enrichment query nodes and relationships differ from other query nodes 
and relationships in that they are conceptual deductions that represent real 
relationships and CIs that cannot be discovered automatically by the 
discovery process.

Enrichment query nodes and relationships are created as part of a TQL 
query, whose other TQL query nodes are regular ones, meaning TQL query 
nodes that already exist in the RTSM. For more information about TQL 
queries, see "Topology Query Language" on page 21.
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The following example displays a regular query node of type Node linked to 
a Websphere AS Enrichment query node by an Enrichment Composition 
relationship.

By placing an Enrichment query node within a TQL query context, the 
query receives data from its attributes, and uses it to insert new information 
into the RTSM.
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When you create Enrichment rules, the following results can occur:

➤ The RTSM is enlarged. Add Enrichment query nodes and relationships 
that are currently not included in the RTSM.

The following Enrichment rule example displays a regular Windows query 
node (that already exists in the RTSM) connected to a Log File 
Enrichment query node by an Enrichment Composition relationship.

This Enrichment rule states that for every Windows CI instance that is 
found in the RTSM, a new Log File CI instance is created, and linked to 
the Windows CI with a Composition relationship.

➤ Specific CI instances are deleted from the RTSM. For an example, see 
"How to Define an Enrichment Rule – Scenario" on page 532.

➤ The values of CI attributes are updated. Use an Enrichment rule to update 
the attributes of a CI that already exists in the RTSM.

The following Enrichment rule example illustrates that a regular Windows 
query node (that already exists in the RTSM) has been updated with an 
Enrichment rule.
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This Enrichment rule states that every Windows CI found in the RTSM is 
updated with the attribute value defined in the Enrichment rule.
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Tasks

How to Define an Enrichment Rule – Scenario

This task describes how to create the following Enrichment rule:

An IP Address CI is connected to two identical Node CIs: one Node CI is 
identified by its IP address and the other is identified by its lowest MAC 
address. For every such instance, delete the Node CI that is identified by its 
IP address from the RTSM.

Note: To reach the required result, you must implement each one of the 
following steps.

This task includes the following steps:

➤ "Create an Enrichment TQL Query" on page 533

➤ "Define the Query Node of Type Node that Is Identified by its Lowest 
MAC Address" on page 535

➤ "Define the Query Node of Type Node that is Identified by its IP Address" 
on page 535

➤ "Define the Enrichment Rule" on page 536
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 1 Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment 
rule and then add the regular TQL query nodes and relationships that 
define the query.

Note: You can add Enrichment query nodes and relationships only after 
at least one regular query node has been added to the query. 

Select Admin > RTSM Administration > Modeling > Enrichment Manager. 
For details about how to create an Enrichment TQL query, see "New 
Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule 
Wizard" on page 549. For details about how to add query nodes and 
relationships to a query, see "How to Add Query Nodes and Relationships 
to a TQL Query" on page 35.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the 
Network folder) is created in Enrichment Manager.
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The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules 
pane.

a

In this Enrichment TQL query, an IP Address query node is linked to two 
query nodes of type Node by a Containment relationship. The TQL results 
must comply with the direction of the arrows.

Note: A TQL query is subject to certain validation restrictions. For details, 
see "Troubleshooting and Limitations" on page 114.
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 2 Define the Query Node of Type Node that Is Identified by its 
Lowest MAC Address

At the top of the Enrichment Manager page, select Query mode. In the 
editing pane, right-click the required query node of type Node, select 
Query Node Properties to open the Query Node Properties dialog box. 
Then define an attribute condition in the Attribute tab. For details on 
how to define an attribute condition, see "Attribute Tab" on page 93.

Example of an Attribute Condition Definition that Identifies the Node by 
its Lowest Mac Address:

In the Attribute tab, this attribute condition definition identifies the 
required Node by its lowest MAC address.

➤ Attribute name — Node is Complete

➤ Operator — Equal

➤ Value — True

 3 Define the Query Node of Type Node that is Identified by its 
IP Address

At the top of the Enrichment Manager page, select Query mode. In the 
editing pane, right-click the required query node of type Node, and select 
Query Node Properties to open the Query Node Properties dialog box. 
Then define two attribute conditions in the Attribute tab. For details on 
how to define an attribute condition, see "Attribute Tab" on page 93.

Example of an Attribute Condition that Enables a Node to Be Identified 
by its IP Address:

This attribute condition is the first attribute condition you need to define 
in the Attribute tab to enable the query node of type node to be identified 
by its IP Address.

Attribute name — Node is Complete

Operator — Equal

Value — False
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This is the second attribute condition you need to define in the Attribute 
tab to enable the query node of type node to be identified by its IP 
address.

Attribute name — Node is Complete

Operator — Is null

Value — Value cannot be changed

 4 Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of 
type Node that are identified by their IP addresses. From the toolbar, 
select Enrichment mode. In the Enrichment Rules pane, select the 
doubleHosts1 Enrichment rule. Then right-click the query node of type 
Node that is identified by its IP address and select Delete 
Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that 
all node instances that have identical attribute and cardinality settings are 
removed from the RTSM. The Enrichment query now looks like this.
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How to Add Enrichment Query Nodes and Relationships 
to an Enrichment TQL Query

This section describes how to add Enrichment query nodes and 
relationships to an Enrichment TQL query in Enrichment Manager. 

To add Enrichment query nodes and relationships to a TQL query:

 1 From the tree in the Enrichment Rules pane, select the Enrichment rule to 
which you want to add Enrichment query nodes and relationships or 
create a new one. For details, see "New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard" on page 549.

 2 From the Query/Enrichment drop-down at the top of the page, select 
Enrichment Mode.

 3 From the tree displayed in the CI Type Selector, click and drag the query 
nodes you want to function as an Enrichment query node on to the 
editing pane. These are the TQL query nodes that are included in the 
query. Added Enrichment query nodes are displayed by an added 
indicator.

Note: You can add more than one Enrichment query node to a rule.

 4 Link the Enrichment query node to an existing TQL query node or query 
nodes, to provide the Enrichment query node with the needed context 
for its operation.

Following are the Enrichment rule validations:

➤ You must link the new Enrichment query node to at least one of the 
existing TQL query nodes in the rule.

➤ Enrichment query nodes can only be linked to one another with an 
Enrichment relationship.
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➤ If the new Enrichment query node must be contained (according to its 
CIT definition) in another query node, you must use the Composition 
relationship to connect this Enrichment query node to an existing 
TQL query node.

➤ You cannot link an Enrichment query node to a TQL query node that 
is hidden.

 5 To add a relationship between two query nodes, do one of the following:

➤ Select the required query nodes by holding down CTRL and clicking 
the TQL query nodes, right-click and select Add Relationship.

➤ Click the Create Relationship icon and draw a line between the 
required query nodes.

Added Enrichment relationships are displayed by an added indicator. 

The Add Relationship dialog box opens. For details, see "Add/Edit 
Relationship Dialog Box" on page 68.

 6 Click OK. The selected query nodes are linked by the relationship you 
have selected.
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Reference

Enrichment Manager User Interface

This section includes (in alphabetical order):

 ➤ Enrichment Manager Page on page 539

 ➤ New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment 
Rule Wizard on page 549

 ➤ Query Node/Relationship Definition Dialog Box on page 554

 ➤ Query Node Definition – Advanced Attribute Dialog Box on page 556

Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are 
based on a specific TQL query, can be used for several purposes, including:

➤ Adding new CIs and relationships to the RTSM.

➤ Deleting specific CI instances from the RTSM.

➤ Updating the attribute values of specific CI instances in the RTSM.

To access Select Admin > RTSM Administration > Modeling > 
Enrichment Manager.

Important 
information

Enrichment Manager has two modes in which you can 
work. Always check the Enrichment/Query mode list in 
the toolbar to verify the currently selected mode.

Relevant tasks "How to Define an Enrichment Rule – Scenario" on 
page 532
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Enrichment Rules Pane

This area displays a hierarchical tree structure of predefined folders and 
Enrichment rules. Each Enrichment rule is associated with a TQL query.

User interface elements are described below:

Important 
information

You can create your own Enrichment rule, or work with 
the out-of-the-box (factory) Enrichment rules provided 
with your HP Business Service Management installation.

The default folders are provided for the out-of-the-box 
queries. You can modify these folders, or add additional 
folders according to your organization’s requirements.

You can drag and drop Enrichment rules or folders to 
move them from one folder to another.

UI Element (A-Z) Description

Creates a new folder.

Creates an Enrichment rule. Opens the New Enrichment 
Rule/Properties wizard.

Deletes the selected folder or Enrichment rule.

Refreshes the data content of the hierarchical tree 
structure that may have been modified by other users.

(Enabled only when an Enrichment rule is created or 
when changes are made to an existing one.) Saves the 
Enrichment rule to the RTSM.

Opens the New Enrichment Rule/Properties wizard. 
Enables you to change the description and the activation 
state of the Enrichment rule.

Generates a preview of the results of the selected 
Enrichment rule.

Represents a folder.
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The following elements are available by right-clicking a folder or 
Enrichment rule:

Represents an Enrichment rule.

<Enrichment Rule 
tree>

Displays the existing Enrichment rules in tree format. 

Note: Only Enrichment rules appear in the tree. TQL 
queries of type Enrichment (created in the Modeling 
Studio) do not appear in the tree.

UI Element (A-Z) Description

Delete Deletes the selected folder or Enrichment rule.

Export To XML Displays a standard Save As dialog box, enabling you to 
save the Enrichment rule as an XML script. This option 
can be used to move an Enrichment rule from one 
workstation to another, provided the related TQL query is 
also relocated.

Import From XML Imports XML files that contain saved Enrichment queries 
to the Enrichment Manager.

New Creates an Enrichment rule. Opens the New Enrichment 
Rule wizard.

New Folder Creates a new folder.

Preview Generates a preview of the results of the selected 
Enrichment rule.

Properties Opens the New Enrichment Rule/Properties wizard. 
Enables you to change the description and the activation 
state of the rule.

Rename Folder Renames the folder.

UI Element (A-Z) Description
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Editing Pane

This area enables you to create and define Enrichment query nodes and 
relationships.

Save (Enabled only when a new Enrichment query is created 
or when changes are made to an existing one.) Saves the 
Enrichment rule to the RTSM.

Save As Displays the Save As Enrichment Rule wizard, enabling 
you to define a new name and description for a query. 
This option can be used for creating a new Enrichment 
rule based on an existing one.

Important 
information

➤ When you select a folder in the Enrichment Rules 
pane, the editing pane is empty.

➤ When you select an Enrichment rule in the 
Enrichment Rules pane, the editing pane displays the 
selected rule, which consists of TQL query nodes that 
are defined in the TQL query and the relationships 
between them, and the Enrichment query nodes and 
relationships that are created and added to the rule.

➤ The Enrichment Manager has two modes in which 
you can work: Enrichment mode and Query mode.

The mode in which you are working determines the 
options that appear in the shortcut menu. For details, 
see the editing pane description below.

➤ You can calculate the number of instances that were 
created as a result of an Enrichment rule and remove 
the instances created from an Enrichment rule from 
the RTSM. For details, see "Additions Count" on 
page 211 and "Remove Enrichment Results" on 
page 217.

Relevant tasks "How to Define an Enrichment Rule – Scenario" on 
page 532

See also For details on how to create a TQL query, see "How to 
Add Query Nodes and Relationships to a TQL Query" on 
page 35.

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

UI Element (A-Z) Description

Indicates an added Enrichment query node or 
relationship.

Indicates a query node or relationship that has 
been deleted from the RTSM.

Indicates an updated query node or relationship.

Query and Enrichment 
mode

The Enrichment Manager has two modes in 
which you can work: Enrichment mode and 
Query mode.

Working in:

➤ Query mode enables you to define regular 
(non-Enrichment) relationships and query 
nodes and add them to the TQL query you 
defined.

➤ Enrichment mode enables you to define 
Enrichment relationships and query nodes and 
add them to the TQL query you defined.

<Main Menu> For details, see "Main Menu" on page 207.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between 
two query nodes.

<Shortcut menu> options For details, see "Shortcut Menu Options" on 
page 44.
543



Chapter 13 • Enrichment Manager
CI Type Selector

This area displays a hierarchical tree structure of the CI Types found in the 
ODB. 

<Toolbar> For details, see "Toolbar Options" on page 211.

<Tooltips> Hold the cursor over a query node or relationship 
to view its tooltip.

The tooltips contain the following information:

➤ Element name. The name of the query node.

➤ CI Type. The CIT of the query node as defined 
in the CI Type Manager. For details, see "CI 
Type Manager" on page 483.

➤ Definitions of the selected query nodes and 
relationships. The attribute conditions, as 
described in "Query Node/Relationship 
Properties Dialog Box" on page 90.

Important 
information

The CI Type Selector is part of Enrichment Manager, 
Impact Analysis Manager, and Trigger TQL Editor. 

To create or modify a TQL query, click and drag query 
nodes to the Editing pane and define the relationship 
between them. Your changes are saved to the ODB. For 
details, see "How to Add Query Nodes and Relationships 
to a TQL Query" on page 35.

Note: The number of instances of each CIT in the ODB is 
displayed to the right of each CIT.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

UI Element (A-Z) Description
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User interface elements are described below (unlabeled elements are shown 
in angle brackets):

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) 
available by right-clicking a CI Type:

UI Elements (A-Z) Description

Click Add CI Type to Map to move the selected CI type 
to the Editing pane.

Click Refresh to refresh the CI type tree.

Click Search to search for the CI type entered.

Click Expand All to expand all subtrees within the CI 
type tree.

Click Collapse All to collapse the subtrees within the CI 
type tree.

<Search window> Enter the name or part of a name of a CI type for which 
to search.

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to CI Type 
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances Opens the CIT Instances window, which displays all 
instances of the selected CIT. For details, see "Element 
Instances Dialog Box" on page 82.
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Advanced Pane

This area displays the properties, conditions, and cardinality for the selected 
query node and relationship.

User interface elements are described below:

Important 
information

The Advanced pane appears in the lower part of the 
window in the following managers and user interfaces: 
Modeling Studio, Impact Analysis Manager, Enrichment 
Manager, the Input Query Editor and Trigger Query 
Editor in DFM.

A small green indicator  appears next to the tabs that 
contain data.

Relevant tasks ➤ "How to Define an Impact Rule – Workflow" on 
page 460

➤ "How to Define an Enrichment Rule – Scenario" on 
page 532

➤ "How to Define a TQL Query" on page 33

➤ "How to Create a Pattern View" on page 367

➤ "How to Create a Template" on page 368

➤ "How to Create a Perspective" on page 370

UI Elements (A-Z) Description

If the window is not wide enough to display all the tabs, use 
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the 
current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node 
or the relationship. For details, see "Attribute Tab" on 
page 93.

Cardinality Cardinality defines how many query nodes you expect to 
have at the other end of a relationship. For example, in a 
relationship between a node and an IP Address, if the 
cardinality is 1:3, the TQL query retrieves only those nodes 
that are connected to between one and three IP Addresses. 
For details, see "Cardinality Tab" on page 95.
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Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

➤ CI Type/Element Type. The CIT of the selected query 
node/relationship.

➤ Element Name. The name of the query node or 
relationship. This appears only in the Modeling Studio.

➤ Show in query results. A green check indicates that the 
selected query node/relationship is visible in the topology 
map. A red mark indicates that it is not visible. In the 
Modeling Studio, this is indicated by the word Yes or No.

➤ Include subtypes. A green check indicates that both the 
selected CI and its children are displayed in the topology 
map. A red mark indicates that only the selected CI 
appears. This item does not appear in the Modeling 
Studio.

Edit Click Edit to open the relevant dialog box for the selected 
tab.

Element Type Displays the subtype conditions defined for the query node 
or relationship. For details, see "Element Type Tab" on 
page 99.

Note: This tab appears only in the Modeling Studio.

Enrichment Rules Displays the Enrichment rule defined for the selected query 
node or relationship. If the Enrichment rule is used to 
update the attributes of a CI, click Edit to open the Query 
Node/Relationship Definition dialog box and edit the rule if 
required. For details, see "Query Node/Relationship 
Definition Dialog Box" on page 554.

Note: This tab appears only in Enrichment Manager.

UI Elements (A-Z) Description
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Impacted Query 
Nodes

Indicates which query node is impacted by the changes that 
occur in the selected trigger query node. If required, you can 
click Edit to open and modify the Impacted Query Nodes 
dialog box. For details, see "Impacted Query Nodes Dialog 
Box" on page 475.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node 
or the relationship. For details, see "Qualifier Tab" on 
page 102.

Note: This tab appears only in Enrichment Manager and 
Impact Analysis Manager.

Selected Identities Displays the element instances that are used to define what 
should be included in the TQL query results. For details, see 
"Identity Tab" on page 105.

UI Elements (A-Z) Description
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New Enrichment Rule/Enrichment Rule Properties/Save 
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access ➤ To create a new Enrichment rule, right-click anywhere 
in the Enrichment Rules pane and click New or click 
the New  button.

➤ To modify an existing Enrichment rule, right-click an 
Enrichment rule in the Enrichment Rules pane and 
select Properties. 

➤ To create a new Enrichment rule based on an existing 
query, right-click an Enrichment rule in the 
Enrichment Rules pane and select Save As.

Important 
information

➤ When creating a new Enrichment rule, bear in mind 
that the application does not allow you to make any 
changes in the TQL query that are necessary for the 
rule. These changes include the following:

➤ Deleting, from the Enrichment TQL query, the 
query nodes or relationships connected to the 
Enrichment query node, causing a query node to 
become unattached to any relationship.

➤ You cannot change the cardinality definition to 0 
(not required) of a query node or relationship that is 
used in an Enrichment rule. For details on 
relationship cardinality, see "Query 
Node/Relationship Properties Dialog Box" on 
page 90.

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not valid, 
you cannot save it.

Relevant tasks "How to Define an Enrichment Rule – Scenario" on 
page 532
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Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the 
Enrichment rule.

Wizard map The New Enrichment Rule /Enrichment Rule 
Properties/Save As Enrichment Rule wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 21

Important 
information

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, you cannot save it.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard" on page 549.

➤ By default, this wizard is set to display a Welcome 
page. You can choose not to display this page by 
changing the user preferences. For details, see "User 
Preferences Dialog Box" on page 113.

Wizard map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 21
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User interface elements are described below:

UI Element (A-Z) Description

Rule Description (Optional) Enter a description of the rule.

Rule is Active (Optional) Select this option to activate the rule in the 
system as soon as it is saved.

Default: Not selected.

Note: 

➤ If an active Enrichment rule is deactivated (by clearing 
the Rule is Active check box), all changes that occur in 
the RTSM relating to the rule are deleted from the 
system. When you deactivate an Enrichment rule, a 
red X appears next to the Enrichment rule in the 
Enrichment Rules pane.

➤ To reactivate the rule, right-click the rule in the 
Enrichment Rules pane and select Properties. In the 
General Attributes page, select Rule is Active.

Rule Name Enter a unique name for the Enrichment rule. 

The rule name cannot contain any of the following 
characters: \ / : " < > | % ?

Note: If the rule name is either empty, contains a name 
used by another Enrichment rule, or uses invalid 
characters, the Next and Finish buttons are disabled.
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Rule Base Query Page
This wizard page enables you to define the properties of the TQL query on 
which the Enrichment rule is based.

User interface elements are described below:

Important 
information

➤ An Enrichment TQL query that serves as the basis for 
Enrichment rules, is subject to certain validation 
restrictions. For details, see "Troubleshooting and 
Limitations" on page 114. If the TQL query is not 
valid, you cannot save it.

➤ For important information on the effects of making 
changes to the TQL query after creating it, see "New 
Enrichment Rule/Enrichment Rule Properties/Save As 
Enrichment Rule Wizard" on page 549.

➤ By default, this wizard is set to display a Completion 
page after clicking Next in this page. You can choose 
not to display the Completion page by changing the 
user preferences. For details, see "User Preferences 
Dialog Box" on page 113.

Wizard map The New Enrichment Rule/Enrichment Rule 
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 21

UI Element (A-Z) Description

Base the Enrichment 
rule on a new query

Select this check box if you want to base the Enrichment 
rule on a new TQL query. The TQL results are based on 
the attributes defined for the new TQL query.

Base the Enrichment 
rule on an existing 
query

Select this check box if you want to base the Enrichment 
rule on an existing TQL query. Select the required 
Enrichment TQL query from the drop-down list.

Base Query 
Description

(Optional) Enter a description of the TQL query.
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Base Query Name Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an 
existing TQL option, select the Enrichment TQL query on 
which you want to base the rule.

Base Query Priority Select a priority level for the new TQL query (Low, 
Medium, High, or Express). This setting determines how 
often the query is rerun automatically by the system to 
include updated information from the RTSM.

Save a new query 
based on the current 
definition

Select to save a new TQL query based on your 
Enrichment rule definition.

Note: This field only appears in the Save As Enrichment 
Rule wizard.

UI Element (A-Z) Description
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Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query 
node/relationship. The key attributes and the required attributes of the 
selected query node appear in bold.

To access Right-click a query node or relationship when in 
Enrichment mode (select Enrichment from the 
Query/Enrichment drop-down at the top of the 
Enrichment Manager page) and select Update 
Relationship/Query Node.

Important 
information

Use an Enrichment rule to update the value of CI 
attributes in the RTSM, or to add data to attributes that 
currently do not have values. You can use this option, for 
example, for simultaneously adding a note to all CI 
instances.

You must fill in the value of the key attributes and the 
required attributes of the Enrichment query node. The 
method you use to define these values determines the 
number of instances created.

If you enter a dynamic value, you can create numerous 
instances. For example, entering the dynamic value of a 
host_key for the CIT Node or an IP address attribute for 
the CIT IpAddress.

Relevant tasks "How to Define an Enrichment Rule – Scenario" on 
page 532
554



Chapter 13 • Enrichment Manager
Attributes Area

User interface elements are described below:

Set Attributes Area

User interface elements are described below:

UI Element (A-Z) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

➤ The Value box in the Set Attributes area.

➤ The combination of the values in the By Attribute 
boxes in the Set Attributes area.

➤ The Value column if you selected Simple in the Type 
column in the Query Node Definition - Advanced 
Attribute dialog box.

➤ The combination of the values in the Value column 
and the column to the right of the Value column if you 
selected By Attribute in the Type column in the Query 
Node Definition - Advanced Attribute dialog box.

UI Element (A-Z) Description

(Appears only if you selected an attribute of the field type 
string.) Opens the Query Node Definition - Advanced 
Attribute dialog box.

Define query node and relationship attributes of the type 
string using simple or complex expressions. You can also 
create complex expressions using regular expression 
format.

Advanced (Appears only if you selected an attribute of the field type 
string.) Displays the attribute value you defined in the 
Query Node Definition - Advanced Attribute dialog box.
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Query Node Definition – Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes 
of the type String using simple or complex expressions. You can also create 
complex expressions using regular expression format.

By Attribute Define an attribute using attributes from other query 
nodes in the TQL query.

➤ In the box to the left, select the required query node.

➤ In the box to the right, select the query node’s required 
attribute.

The attribute definition appears in the Value column in 
the Attributes area.

RegExp Group (Appears only when you select an attribute of the field 
type string.) Enter the group number only if you are 
adding a regular expression using regular expression 
syntax. This is the part of the regular expression pattern 
to focus on when creating the attribute. A set of 
parentheses ( ) constitutes a group.

Regular Expression (Appears only when you select an attribute of the field 
type string.) Add a regular expression using regular 
expression syntax. Enter the regular expression pattern.

Value (in the Set 
Attributes area)

Define a constant value. Enter the required value in the 
Value box or select a value from the Value list.

Note: The value definition appears in the Value column 
in the Attributes area.

To access Select an attribute of the type string in the Query Node 
Definition dialog box. Select Advanced and then click the 
Advanced button.

Relevant tasks "How to Define an Enrichment Rule – Scenario" on 
page 532

UI Element (A-Z) Description
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User interface elements are described below:

UI Element (A-Z) Description

Define an attribute value using simple or complex 
expressions. Creates a new entry in the Type column. 
Click the new entry and select either Simple or By 
Attribute. For details, see the description for the Type 
column below.

Delete an attribute value.

Move a selected row up.

Move a selected row down.

Advanced Value (This list is only available if you select By Attribute in the 
Type column.) Click the entry inside the box and select 
the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp Group (This list is available only if you select By Attribute in the 
Type column.) Click inside the RegExp Group column, 
click the  button, and enter the group number 
in the Value for RegExp Group dialog box that opens. 
This is the part of the regular expression pattern to focus 
on when creating the attribute. A set of parentheses ( ) 
constitutes a group.

Regular Expression (This list is only available if you select By Attribute in the 
Type column.) Click inside the Regular Expression 
column, click the  button, and enter the regular 
expression pattern in the Value for Regular Expression 
dialog box that opens.
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Type Click the entry inside the Type column and select one of 
the following options:

➤ Simple. Define a constant value using a simple 
expression.

➤ By Attribute. Define an attribute using attributes from 
other query nodes in the TQL.

Default is: Simple

Use first attribute 
with value

Use the first attribute value listed in this dialog box that is 
not empty.

Value ➤ If you select Simple in the Type column, click inside 
the Value column, click the  button, and 
enter the required value in the Value for Simple dialog 
box.

Note: If you define an attribute value using only one 
Simple expression, the Value column cannot be empty.

➤ If you select By Attribute in the Type column, click 
inside the Value column and select the required value 
from the list.

UI Element (A-Z) Description
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RTSM Data Model Introduction

This chapter includes:

Concepts

➤ BTO Data Model (BDM) Overview on page 562

Reference

➤ Data Model Documents on page 563

➤ Upgrade Documents on page 564
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Concepts

BTO Data Model (BDM) Overview

The BTO Data Model (BDM) enables you to manage the business functions, 
services, processes, and activities of your IT Universe model.

The BDM documents are located in the following folder: 

\\<Business Service Management root directory>\AppServer\
webapps\site.war\amdocs\eng\pdfs
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Reference

Data Model Documents

BDM – Conceptual Data Model
The conceptual model presents a high level picture of the BTO Data Model 
(BDM) organized in structured layers. This document is a map of the 
concepts being modeled, as well as the scope of the model. This conceptual 
data model provides a starting point for understanding the semantics of the 
domain modeled.

Note: As this is an abstract representation of the model, the document does 
not include every entity or relationship.

BDM – Data Model UMLs
This document represents the data model in a visually appealing set of UML 
diagrams. Rather than a single, large, complex UML diagram of the entire 
model, small diagrams with specific points of view are presented. The 
purpose of the UML diagrams is to provide a pictorial representation of the 
model entities and their relationships to each other.

Note: To make the UML diagrams easier to understand, some relationships 
and entities may have been excluded.

BDM – Data Model HTML
This document includes all the BDM class information in HTML format.
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BDM – Business Model and Best Practices
This document covers the business part of the RTSM data model, as well as 
some best practices and guidelines on how to model your business.

CMS Data Model Documentation
This document covers all BDM classes and a subset of the CMS classes. It 
includes the following information:

➤ Class descriptions

➤ Attribute information

➤ Object scoping (BDM/CMS)

➤ Qualifier information

➤ Hierarchy information

Note: This document can be automatically generated from the RTSM user 
interface. 

Upgrade Documents

RTSM Class Mapping Summary
This mapping document presents a high level view of the class mappings 
between versions 8.0x and 9.0x, including the hierarchy changes.

RTSM Class Model Comparison
This document covers the differences between the 8.0x class model and the 
9.0x data model in greater detail. The document includes the following 
information:

➤ Class and attribute mapping

➤ New classes and attributes 
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➤ Qualifier changes

➤ Deprecation information

➤ Removed classes

➤ Key attribute changes

➤ Hierarchy changes
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Exporting the RTSM Data Model to a UML 
Tool

This chapter includes:

Concepts

➤ Export to UML Tool – Overview on page 568

Tasks

➤ How to Export the Class Model on page 569

➤ How to Convert XML of Selected Part of Class Model on page 570

Reference

➤ Tool Plug-in Input on page 572

➤ Export Class Model to UML Wizard on page 574

Note: Currently, Altova UModel versions 2008 and 2009 are supported.
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Concepts

Export to UML Tool – Overview

The Export to UML tool enables you to export selected sections of the RTSM 
class model to a format compatible with UML tools, and to view the model 
as a UML diagram.

The input for the tool is the RTSM class model XML file retrieved by the 
JMX service UCMDB:service=Class Model Services/
exportClassModelToXml().

Note: To access the JMX console, enter the following address in your 
browser: http://<server_name>:21212/jmx-console, where <server_name> 
is the name of the machine on which HP Business Service Management is 
installed.
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Tasks

How to Export the Class Model

This task describes how to use the Export Class Model to UML tool wizard.

This task includes the following steps:

➤ "Prerequisites" on page 569

➤ "Run the UML Tool" on page 569

➤ "View the Exported File in Altova" on page 569

 1 Prerequisites

Set up the tool by extracting the following zip file to any location: 

<HP BSM root directory>:\odb\tools\ExportClassModel.zip

 2 Run the UML Tool

You use the Export Class Model to UML wizard to choose the CIT and its 
attributes to be exported to the UML tool.

For details on working with the Export to UML wizard, see "Export Class 
Model to UML Wizard" on page 574.

 3 View the Exported File in Altova

 a In Altova, select File > Import From XMI File.

 b Select the XMI file. The class model entry appears in the Model Tree 
pane.

 c Right-click the entry and select Show in new diagram > Content. 
Click OK.
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How to Convert XML of Selected Part of Class Model

This task describes how to use the custom plug-in to convert the XML of a 
selected part of the class model to the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java 
class, it must implement the ITransformToUML(ExportToUML.jar) interface; 
the transformToUML() method receives an XML string as a parameter and 
returns a byte array that is written to the output file.  

For details on the custom plug-in input, see "Tool Plug-in Input" on 
page 572.

This task includes the following steps:

➤ "Activate the Plug-in Using a Java Class" on page 570

➤ "Activate the Plug-in Using an XSLT Text File" on page 571

Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in 
the ExportToUML directory, as follows:

Continue with the procedure for exporting the class model. For details, see 
"How to Export the Class Model" on page 569.

<ConverterToUML>
<Name><display name></Name>
<Class><fully qualified class name></Class>

</ConverterToUML>
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Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML 
and is written to the output file.

Add the display name and full path of the XSLT file to the config.xml file in 
the ExportToUML directory, as follows:

Continue with the procedure for exporting the class model. For details, see 
"How to Export the Class Model" on page 569.

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full_path_of_the_XSLT_file></XsltFile>

</ConverterToUML>
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Reference

Tool Plug-in Input

The input for the plug-in is an XML string (selected classes/attributes/valid 
links) in the following form:  
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<?xml version="1.0" encoding="ISO-8859-1"?>
<Class-Model>

    <Class class-name="hostresource" display-name="Host Resource" 
visibility="public">
        <Attribute name="isvirtual" display-name="Is Virtual" visibility="public"/>
        <Attribute name="city" display-name="City" visibility="public"/>
    </Class>
    <Class class-name="host_node" display-name="Computer" visibility="public">
        <Derived-From class-name="host"/>
    </Class>
    <Class class-name="vax" display-name="VAX" visibility="public">
        <Attribute name="root_actualdeletionperiod" display-name="Actual Deletion 
Period" visibility="public"/>
        <Attribute name="data_allow_auto_discovery" display-name="Allow CI Update" 
visibility="public"/>
        <Derived-From class-name="host_node"/>
    </Class>
    <Class class-name="host" display-name="Host" visibility="public">
        <Attribute name="host_iscomplete" display-name="Host Is Complete" 
visibility="public"/>
        <Attribute name="host_isroute" display-name="Host Is Route" visibility="public"/>
        <Attribute name="host_hostname" display-name="Host Name" visibility="public"/>
        <Attribute name="host_os" display-name="Host Operating System" 
visibility="public"/>
    </Class>
    <Class class-name="unix" display-name="Unix" visibility="public">
        <Derived-From class-name="host_node"/>
    </Class>
    <Valid-Link ID="host_member_host" display-name="Member" visibility="public">
        <End1 class-name="host"/>
        <End2 class-name="host"/>
    </Valid-Link>
    <Valid-Link ID="host_container_f_hostresource" display-name="Container link" 
visibility="public">
        <End1 class-name="host"/>
        <End2 class-name="hostresource"/>
    </Valid-Link>

</Class-Model>
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Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported 
to the UML tool.

User interface elements are described below:

To access Browse to the location where you extracted the tool. 
Right-click ExportClassModel.jar in the 
ExportClassModel directory. Select Open With > Java 2 
Platform SE binary.

Important 
information

By default the tool opens the ClassModel.xml file in the 
ExportClassModel directory. You open other files 
through the File > Open Class Model File menu.

Relevant tasks "How to Export the Class Model" on page 569

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links 
> Export Selected Items

See also "Tool Plug-in Input" on page 572

UI Element (A-Z) Description

File Displays a list of XML files. Open the file that contains 
the class model.

Select Attributes 
Pane

Select the attributes to be displayed in the UML tool.

The attributes of the selected CIT are displayed in this 
pane. The attributes are colored as follows:

➤ Attributes inherited from the parent CIT are black.

➤ Attributes specific to this CIT are dark blue.

Select CI Types Pane The CITs displayed here are retrieved from the 
ClassModel.xml file.

Select the CIT and its sub nodes to be exported to the 
UML tool.

Use the buttons to select or clear all subindex.
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Select Valid Links
This wizard page enables you to select links that can be used between two 
CITs.

User interface elements are described below:

Export Selected Items
This wizard page enables you to export the selected CITs and their attributes 
to the UML tool.

Important 
information

General information about the wizard is available in 
"Export Class Model to UML Wizard" on page 574.

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links 
> Export Selected Items

UI Element (A-Z) Description

Removes the filter from the list of CITs.

Filter by Enables you to filter the list of valid links. You can filter 
the list of CITs and you can sort the list by CIT or 
relationship.

Important 
information

General information about the wizard is available in 
"Export Class Model to UML Wizard" on page 574.

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links > 
Export Selected Items
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User interface elements are described below:

UI Element (A-Z) Description

Export Click to browse to the UML file, in XMI format, to which 
you want to add the UCMDB CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid 
links message is displayed in the Select Valid Links page.
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Working with Tables

This chapter includes:

Reference

➤ Columns User Interface on page 580
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Columns User Interface

This section includes (in alphabetical order):

 ➤ Select Columns Dialog Box on page 580

 ➤ Sort Column Content Dialog Box on page 582

Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in 
displaying. You can hide a column or display a hidden column. 

The following elements are included:

Description Click the Select Columns  button. This button appears 
above every table in a report. 

Important 
information

The order of the columns in the list in the Visible 
Columns pane determines the order of the columns 
displayed in the table. To change the order of table 
columns, move them to the required position using the 
up and down arrow buttons or by dragging a column to a 
new location.

UI Element (A-Z) Description

Displays a column. Moves the selected column from the 
Available Columns pane to the Visible Columns pane.

Hides a selected column. Moves the selected column from 
the Visible Columns pane to the Available Columns pane.

Displays all hidden columns. Moves all the columns from 
the Available Columns pane to the Visible Columns pane.
580



Chapter 16 • Working with Tables
Hides all columns. Moves all the columns from the Visible 
Columns pane to the Available Columns pane.

Move a selected column up in the list in the Visible 
Columns pane.

Move a selected column down in the list in the Visible 
Columns pane.

Available Columns The columns in this pane do not appear in the table.

Visible Columns The columns in this pane are visible in the table.

UI Element (A-Z) Description
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Sort Column Content Dialog Box

This dialog box enables you to set or change the sort order for the entries 
displayed in a table.

The following elements are included:

Description Click the Sort Column Content  button.

Important 
information

To sort a table by one column:
Move the column name from the Available Columns to 
the Sorted Columns list. Select the name and decide 
whether to sort in ascending (upward triangle) or 
descending (downward triangle) order by clicking the 
relevant button.

To sort a table by more than one column:
Move the column names from the Available Columns to 
the Sorted Columns list. For each column, decide 
whether to sort in ascending or descending order. 

To change the order in which columns are sorted:
In the Sorted Columns list, select an entry, and click the 
Up or Down arrow to change the order. (Entries higher in 
the list are sorted before entries lower in the list.) A 
number is displayed in the table’s column headers.

Note: Only columns that are displayed can be sorted. For 
details on how to define which columns are displayed in 
the table and in which order, see "Select Columns Dialog 
Box" on page 580.

UI Element (A–Z) Description

Moves the selected column from the Available Columns 
pane to the Sorted Columns pane. You can double-click 
the selection to perform the same procedure.

Moves the selected column from the Sorted Columns 
pane to the Available Columns pane.

Moves all the columns from the Available Columns pane 
to the Sorted Columns pane.
582



Chapter 16 • Working with Tables
Moves all the columns from the Sorted Columns pane to 
the Available Columns pane.

Moves the selected column up or down in the list to 
increase or decrease its priority in establishing the sort 
order.

Enables you to sort the column content in ascending or 
descending order.

In the Sorted Columns pane, select a column name and 
click the ascending or descending button.

Available Columns The columns whose content is not sorted.

Note: You can select multiple columns.

Sorted Columns The columns whose content is sorted in either ascending 
or descending order.

UI Element (A–Z) Description
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Regular Expression Examples

This chapter includes:

Reference

➤ Examples of Regular Expressions on page 586
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Examples of Regular Expressions

➤ Enter a regular expression to define an IP address (aa.yy.zz.mm):

➤ Enter a regular expression to create the label by the first or last letters of 
the selected attribute:

To:
In the First Field 
Enter:

In the Second Field 
Enter:

Create label by aa (.*)([.].*[.].*[.].*) 1

Create label by yy (.*[.])(.*)([.].*[.].*) 2

Create label by zz (.*[.].*[.])(.*)([.].*) 2

Create label by mm (.*[.].*[.].*[.])(.*) 2

To:
In the First Field 
Enter:

In the Second Field 
Enter:

Create label by the first letter (.)(.*) 1

Create label by the last letter (.*)(.) 2

Create label by the first two 
letters

(..)(.*) 1

Create label by the last two 
letters

(.*)(..) 2
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